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Support

If you need some help using this program, here are some sources of information that
may be of use:

e Program help - Choose Help topics from the Help menu to open Xara Web Designer 7
help (containing hundreds of pages of information).

e Status line - Try reading the text on the status line at the bottom of the main Xara Web
Designer 7 window. It always describes what actions are currently possible and what
they will do (even during drags), and helps you learn to use the Xara Web Designer 7
tools. It also gives details of what buttons and controls do as you move the pointer
over them. See Status Line for more details.

e ToolTips (on page 18) - If you hold the mouse pointer over a button or control for a
short while, then small message appears telling you what it does.

e Menus - If you want to know what a menu item does, highlight it and press "F1".

¢ Dialog boxes - If you want to know what a dialog box does or how to use it, click
"Help".

e Movies - There are demo movies to help you make the most of Xara Web Designer 7.
Choose Movies from the Help menu to view a list of available movies or click here
http://www.xara.com/products/webdesigner/tutorials-demos/ to view a list of available
movies.

e The TalkGraphics forums - You can share tips and ideas, ask questions or offer
solutions to other Xara Web Designer 7 users at the TalkGraphics forum
(www.talkgraphics.com), which also includes many other graphics related forums.

e Xara Xone - Visit the Xara Xone (http://www.xaraxone.com) for a host of excellent
Xara Web Designer 7 support resources, including over ten years of Xara Designer
tutorials, hints & tips, featured artists, and Xara shareware

e "The Outsider" newsletter (http://www.xara.com/outsider) - Subscribe to our monthly
newsletter "The Outsider" (with monthly tutorials and tips, offers, inspirational art, and
more).

¢ Join the Xara community on Facebook http://www.xara.com/facebook or follow our
news on Twitter http://www.twitter.com/xaragroup.

Support website

http://support.xara.com
Our own support site offers comprehensive FAQ page (frequently asked questions)
which is constantly updated and available 24 hours, 7 days a week; always the best

source for instant answers. You can also contact our technical support staff using the
form on this page, if you cannot find the answer to your question!

www.Xara.com
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Purchasing and unlocking Xara Web Designer 7

Purchasing and unlocking Xara Web Designer 7

When you run the downloaded trial version of Xara Web Designer 7 , the start screen
will present you with three options. Check the option you require and you will be
presented with further instructions.

Enter the serial number

Select this option if you have already purchased your copy of Web Designer and enter
the serial number that you were given in the email confirming your purchase. Enter your
email address so your copy can be registered (if you have already registered this will be
ignored). Then click Register Online and Activate.

Once your copy is activated you can download the full template set by selecting the
Download Templates option in the Web Designer Help menu.

Purchase the program.
Select this option if you would like to purchase a copy of Web Designer. You will be
given an serial number when you purchase.

Continue the trial

Select this option if you would like to continue using the free trial. To the right of this
option it will tell you how many days of the trial you have left. Then click TEST THE
PROGRAM NOW.

Important note: Please keep a record of the email address and password you used
when purchasing Xara Web Designer 7 since you may need them in the future, for
example if you wish to upgrade.

Other ways to purchase

If you do not have the trial you can order directly on our website
www.xara.com/ordering. and you will be given an serial number that can be used to
unlock the trial later.

Xara titles are great value for the money, but we offer further generous discounts to
academic establishments on all our products. You can find details on our website.

Affiliate Program

Xara Web Designer 7 page templates include a small ‘Made with Xara Web Designer 7’
link at the bottom. You can easily delete this link if you don’t want it, but if you leave it on
your published website you can earn commission from customers introduced to Xara
through your links, or you can have that commission donated to charity. Select "HELP" >
"AFFILIATE PROGRAM" to find out more or, if you are already an affiliate, to change your
commission settings.

Wwww.Xara.com
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Web Designer vs Web Designher Premium

Web Designer Premium offers a host of additional features for pro users, including web
authoring and publishing features and extra graphic tools. There is an upgrade path for
existing owners of Xara Web Designer 7, see http://www.xara.com for details.

Web Authoring and Publishing

Presentations

Animation (flash and gif)

New Widgets

Animated page and layer transitions
Sitemaps

FTP explorer

Extra templates and widgets
Header code

Graphics Tools

e Freehand and Brush

e Quickshape
¢ In the Text Tool: Find and replace
¢ In the Fill Tool: some fill shapes and profiles
¢ In the Transparency Tool: some transparency shapes and profiles
e Shadow
e Bevel

e Mold

¢ Feathering

e 3D Extrude

¢ In the Photo tool: red eye, panorama, content aware, masking

Galleries

e Line
e Frame
¢ In Page & Layer: browse objects

General

Combine shapes

Advanced Paste

Color naming and some color models
Printing

Screen capture

Some import and export formats

www.Xara.com
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Web Designer vs Web Designer Premium

Web Authoring and Publishing

Presentations. With Web Designer Premium you can create web-based 'slide-show'
style presentations that your website visitors can step through using the keyboard arrow
keys. Apply animated transition effects as each step and page is displayed. You can
also easily remotely host a web meeting (a ‘Webinar’) to showcase your presentation,
step by step and page by page, to a group of invited participants.

Animation (Flash and gif). Web Designer Premium includes a genuinely easy way to
create really efficient Flash animations. It also supports animated GIF creation.

New Widgets. You can make your websites more eye-catching and dynamic with our
new smart widgets that enable you to add an advanced selection of slick photo and text
animations to your web pages without the need for coding knowledge. More widgets will
be automatically downloaded and added to your gallery over time.

Animated page and layer transitions.Web Designer Premium makes it easy to add a
wide range of animated effects to the layers and page links in your website. You can
add animated transitions to any page link or pop-up layer in your web pages.

Sitemaps. You can automatically generate a sitemap to assist search engines with the
crawling of your website.

FTP explorer. You can browse, view and delete files and folders on your FTP server
using Web Designer Premium's built-in Web Space Explorer.

Extra templates and widgets. Web Designer Premium offers some additional
templates that relate to features not supported in the classic version of Web Designer, in
particular presentations and Flash animations. Plus there is a selection of e-commerce
widgets.

Easily add header code to a page or website. Web Designer Premium allows you to
enter HTML code into the head of your web pages, as well as the body, giving you
greater versatility to customize your website. You can easily add your own code (or code
from a widget provider) into individual pages or all pages in your website.

Graphics Tools

Freehand and Brush tool. You can use this tool to draw in a freehand manner, as you
would with a pencil. It can also be used to create brush strokes. And it includes the
option to draw variable width lines using a compatible pressure sensitive drawing device
such as a graphics tablet.

Quickshape tool. The Quickshape Tool lets you quickly create almost any regular,
symmetrical shape with sharp or rounded corners.

Some options in the text tool (Find and replace). The Find & Replace function
performs live search so that as you type the search string the text is searched and
highlighted in real-time.

Some additional options in the Fill Tool (some fill shapes and profiles). The Fill

Tool lets you apply color fill to objects. Premium includes conical, diamond, 3 color and
4 color fills and a Fill profile control.

Wwww.Xara.com
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Some additional options in the Transparency Tool (some transparency shapes
and profiles). The Transparency Tool lets you specify how much of the underlying
colors and objects appear through an object. Premium including non-mix type
transparency types and a transparency profile control.

SHADOW TooL. The Shadow Tool lets you apply, remove, and modify semi-transparent
(or "soft") shadows.

BEVEL TOOL. The Bevel Tool gives objects an appearance of depth instead of being flat
on the page.

Mold tool. The Mold Tool lets you perspectivize shapes to give an impression of depth.

Feathering Tool. The Feather Tool enables you to blur the edges of an object so it
blends, or fades, into a background object.

3D Extrude Tool. The Extrude Tool provides a fast and easy way of turning 2D drawn
shapes and text into high quality 3D extruded versions, with colored light illumination
and very high quality shading.

In the Photo Tool: red eye, panorama, content aware, masking:

¢ Red Eye. The Red Eye tool allows you to quickly remove red eye effects from faces
in your photos.

e Panorama. Web Designer Premium includes a tool that can automatically stitch
together up to 6 photographs into a single wide, high-resolution panorama.

e Masking. A number of operations can take a mask to indicate which parts of a photo
or drawing are to be operated on. E.g. content aware scaling, simple cut/copy/paste,
clone and photo enhance.

Galleries

Line Gallery. The Line Gallery can be used to apply a range of line styles or attributes,
such as brush strokes, dash patterns, arrow heads, and more.

In Page & Layer Gallery: Premium offers the additional ability to browse objects in the
Page & Layer Gallery, not just page and layers.

General

Combine shapes. The menu option "ARRANGE" > "COMBINE SHAPES" (or right click and
choose COMBINE SHAPES) provides you with a range of advanced options to combine
shapes to make new shapes, such as adding, cutting, or slicing. You can use combine
shapes on any type of object, including bitmaps.

Advanced Paste. Additional options which give more flexibility to pasting operations:
Paste position, Paste size, Paste replacing selection, Paste in current layer and Paste in
place in current layer.

Color naming and some color models. Premium includes support for RGB, greyscale,
3D and web palette colors. Also the ability to name a color: If you want to use a color
many times throughout a document, you can create your own Named Color, which will
appear on the Color Line. When you edit it later all objects using this color are instantly
changed.

www.Xara.com
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Web Designer vs Web Designer Premium

Printing. In Web Designer Premium you can print your documents!
Screen capture. Web Designer Premium includes an easy to use screen grab utility.

Some additional import and export formats. Import graphics from the web, AVI
export, Flash and animated GIF export.

www.Xara.com
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Introduction

It's evident that the vast majority of websites are of a graphical nature. The presentation
of your website matters a great deal. You want a competent, professional looking
website. We believe you should not have to use multiple different tools - graphics and
HTML editing - to create your website. We believe you should have complete freedom to
include any text, graphics, photos anywhere on the page.

Creating websites should be like creating PDF files - you should not need to know
anything about what happens 'under the hood'. You would not expect to edit the PDF file
data directly. You should not need to know, or even see, the HTML that goes into
creating your website.

What makes Web Designer so special?

Web Designer is unique in that it's the only truly free-form web design tool, that allows
true freedom of web page design, with 'anything anywhere' yet produces completely
accurate WYSIWYG results. In other words you can position text, graphics, photos
anywhere on the page, any size, any angle, overlaid, with transparency...and Web
Designer will produce a pixel accurate perfect working HTML page.

Web Designer can do things that are regarded as near impossible with other web-
authoring software, such as repel text around irregular shapes and photos. It includes
advanced vector graphics tools to draw anything from simple shapes to complex
company logos and graphics. It includes automatic optimisation of graphics (not only
producing optimized resolution images, but automatically detecting repeating elements
across the website so producing faster, more optimized websites).

It supports CSS layers with advanced features such as transparency, even graduated
transparency, mouse-over effects and more. It creates cross-browser, cross-platform
totally XHTML compatible HTML websites.

On top of all this Web Designer is perhaps the easiest, simplest to learn web authoring
tool available.

Web Designer is aimed at graphic designers who do not want to learn HTML or scripting
languages. For graphics designers it's the perfect 'rapid website prototyping' tool.

It's also aimed at beginners who just want the easiest possible way of create
professional looking websites.

Web Designer provides no programming tools, no script editing and doesn't even
provide an 'HTML view'. Our design philosophy is this: You do not need to know the
PDF programming language in order to produce PDF files. So neither should you have
to know anything about HTML or Javascript in order to create great websites.

www.Xara.com
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Introduction

A Website In 6 Steps

For those with short attention spans (that's most of us), you can discover the main
benefits of Web Designer by just following the instructions in the initial opening
document when you start Web Designer. This is both a basic introduction and an actual
website you can experiment with. You can also find this example document in the
DESIGNS GALLERY.

=¥ Click the DESIGNS GALLERY tab, open the INTRODUCTION category and just double
click on the first document.

fua)eb subisaq

Here you can find out how to change your website colors, edit your text, drag and drop
photos, move objects around the page and more.

Undo
Remember you can undo any change you make using the uNDO button or "Ctrl +
= Z". If you hold the button down you can race back through all your actions, right

back to the beginning.

www.Xara.com
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Getting Help

If you need some help using this program, see Support (on page 9).

Support website

http://support.xara.com
Our own support site offers comprehensive FAQ page (frequently asked questions)
which is constantly updated and available 24 hours, 7 days a week; always the best

source for instant answers. You can also contact our technical support staff using the
form on this page, if you cannot find the answer to your question!

Document info

"FILE” > “DOCUMENT INFO" displays information about the selected document such as its
size and any fonts or plug-ins used. This is a good way to find out if you are missing a
required font or plug-in that could prevent the document from displaying correctly.

Anything you type into the comment field is stored as part of the file. This comment is
displayed whenever you display the document info dialog box.

About Xara Web Designer 7

Choose "HELP" > "ABOUT XARA WEB DESIGNER 7". This displays general information
about the program. If you contact Xara support, you may be asked for this information.

www.Xara.com
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Tooltips

When you move over a button, the tooltip tells you the
function of the button.

Export and preview web page

About Xara Web Designer 7

Choose "HELP" > "ABOUT XARA WEB DESIGNER 7". This displays general information about
the program. If you contact Xara support, you may be asked for this information.

www.Xara.com
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Getting Started

This section gives an overview of the main functionality of Web Designer. Later sections
go into more detail about each tool.

Program Layout
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Info Bar - changes with each tool
Zoom

Preview Website

Design Gallery (Galleries bar)

Page & Layer Gallery (Galleries bar)
Selector Tool

Photo Editing Tool
Drawing Tools
Text Tool

Shadow Tool

Tabs for all open documents - icon
identifies document type.
Color Line

® 9600000000

Note: All Web Designer infobars now have improved text rendering for easier viewing, if
you have ClearType text enabled in your Windows Control Panel.

There are four buttons in the top bar that relate to website functions. Three of these
have flyout bars which are shown when you move the mouse pointer over them,
revealing more web function buttons.

Export and preview web page/website

Link properties
Website options

Export

aﬁﬂﬁ@

Move your mouse pointer over each button in the flyout bar to see a tooltip describing the
button.

There are two ways to create a new website. Either by starting with a pre-designed
template and then customizing this with your own text, photos and color scheme. Or by
creating a website from scratch, placing all the required elements, text, graphics and
photos on the page where you require.

Note: By default Web Designer opens a new document showing just one page. To view
all the pages in your website document, right click a page and choose MULTIPLE PAGE

www.Xara.com
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VIEW. You can now scroll the Web Designer window up and down to view all the pages
in the document.

Zooming / Scrolling / Pushing your page

These common operations are made very easy:

e To Zoom in or out, hold "Ctrl" and use the mouse-wheel
e To push the page, press your mouse-wheel and push (yes it's a button as well)
e To scroll use the mouse-wheel (or the scroll bars of course)

Web documents are displayed in single page mode
by default and print documents in multi-page view
mode. Switch between display modes by right
clicking on the page or pasteboard and selecting or
deselecting MULTIPLE PAGE VIEW from the drop-
down menu. An example of multiple page view is
shown to the left.

You can drag and drop items between pages.
When you make document-wide Theme color
changes, you can see how the changes affect all
pages.

The current page is marked with 4 corner brackets.

In this example you can see some items have been placed on the pasteboard area
beside the pages. These are not exported as part of your website. The pasteboard area
is useful as a place to keep temporary or working graphics, photos or other objects.

Flyout Bars

Some tools on the main toolbar are grouped together under a single icon. These icons
have a small triangle indicator in the bottom right corner and when you move the mouse
pointer over one of these icons a flyout bar appears. The bar holds the other tool icons
that are in this group. Simply move the mouse pointer over each one to see a tooltip,
and click to select the tool you want.

If you select a modal tool from a flyout bar, that tool becomes the primary tool for that
group. So you'll then see its icon highlighted on the main toolbar.

There are also some flyout bars on the toolbar at the top of the window. Again these are
used to group together closely related operations under a single icon. This makes them
conveniently accessible while not taking up too much space on the bar.

See the Customizing chapter (on page 294) in the pdf manual for more information on
flyout bars.

www.Xara.com
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Objects On The Page

Whether you customize a template or create your own graphics from scratch, you can
rotate, resize and position anything on the page, anywhere you like. You can easily
resize the page to be any required size and add new web pages as required. Certain
features, such as changing color schemes, work across all pages simultaneously.

These are the basic types of page element:

e Text: Using the TEXT TOOL you can create anything from single word headings to
columns of text or even blocks of text that flow from one block into another. You can
also create bulleted or numbered lists. The TEXT ToOL InfoBar provides controls over
the font, size, line spacing and more. You can resize text either by using the
SELECTOR TOOL or by selecting the text in the usual fashion and choosing alternative
point or pixel sizes. Perhaps surprisingly you can even rotate text by any angle, and
by using REPEL TEXT UNDER (right click an object to see this option) you can
automatically flow text around objects on the page, such as photos.

e Graphics: Any type of logo, heading and most buttons that appear on your website
are graphics. Web Designer is a vector graphics program which means you can edit
the shape, rotate and resize your graphic objects with no loss of quality (unlike pixel
photo editing tools such as Photoshop). And although there is no vector graphics
standard for web pages (for websites all graphics have to be either JPG, GIF or PNG
formats) Web Designer creates the correct format and resolution automatically. For
example, if you want to create a colored panel to place behind your text, you'd do this
by drawing a rectangle or rounded rectangle object on the page, and placing this
behind your text. When you save your website, this is automatically converted into a
PNG graphic image of the correct resolution.

e Photos: There are few websites that do not contain photos of some sort. Xara Web
Designer 7 has a great range of photo editing tools. You can drag and drop photos
directly from your camera or File Explorer window onto the page, rotate, enhance,
crop, and Web Designer automatically generates the correct resolution JPG image.
Replacing existing photos in templates is as easy as drag and drop - and you can
alter the size and angle of photos 'inside’ their frame very easily. You can easily
create clickable photo thumbnails that pop-up an enlarged version and optionally
include gallery controls that allow your visitors to browse your photos or view an
automatic slideshow.

e Placeholders: These are graphic objects on the page which represent the size and
position of dynamic "widgets" such as a Flash animations, movies, or forms. When
your site is exported the placeholder graphic is replaced by the code required to make
the widget work and so the working widget appears at the same position on your
page. See the Website Widgets (on page 261) chapter in the pdf manual for details.

Object Based Web Design

All the types of elements described above are collectively referred to as objects.

One of the unique benefits of Web Designer is that you have complete freedom to place
any object anywhere on the page, and your website will faithfully reproduce this.
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The SELECTOR TOOL can be used to select any object on the page, and to
move (just drag it), resize and rotate the objects.

You can adjust the stacking order (that is whether an object appears in front or behind
others on the page) by right clicking and choosing ARRANGE or using the ARRANGE menu
options. With the SELECTOR TOOL you can resize objects by dragging on the corner
resize handles. You can rotate any object by dragging just inside the corner selection
handles. And although websites do not support rotated text, Web Designer knows to
automatically create the appropriate graphic image so the resulting page will always look
exactly right.

To add some text to your website, select the TEXT TooL and click anywhere on
the page and start typing.

You can also create text columns, by clicking and dragging horizontally in the TEXT ToOL,
or text areas by dragging diagonally. See the Text section (on page 43) in the pdf
manual for more details and the Chapter Text Handling (on page 151) for a complete
reference of text functions of Xara Web Designer 7.

You can use the drawing tools to create rectangles, rounded >
rectangles, circles and ellipses, and just about any shape you like using "
the SHAPE EDITOR TOOL. See the Drawing tools (on page 54) section in

the pdf manual for more detail.

Stacking Order

All objects on the page are placed one on top of another. The most recently drawn or
created object is always on top, that is, in front of any others. You can adjust the
stacking position by right clicking and choosing ARRANGE or using the ARRANGE MENU
options.

For example, when you draw a new rectangle it always appears to cover all the objects
behind it. By right clicking and choosing ARRANGE or pressing "Ctrl + B" (or the menu
ARRANGE -> PUT TO BACK) the object is moved behind everything else. Similarly Ctrl+F
brings any selected object to the top, that is in front of everything else.

There is an added complication: Layers. All objects are collected into Named Layers,

and each layer can be turned on or off to show or hide everything on that Layer. See
the Layers section (on page 61) below for more detail.
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The Selector Tool

This tool is a general purpose tool that allows you to select, move, resize and
rotate all objects on your web page.

You can do all these things by just dragging on the objects on the page, or on the
selection handles around the object, or you can enter precise numeric values. The
selected object is shown with 4 or 8 handles around the outside, and the status line at
the bottom of the screen also tells you what is selected.

Drag on any corner handle to resize an object. Drag just inside the corner handles
(shown left) to rotate. Rectangles and rounded rectangles have eight handles so you
can stretch them as well as resize. Other objects, such as groups, blocks of text, photos
show only 4 handles and can't be stretched (because they would distort).

Nudging Objects

The arrow keys can be used to nudge the selected object, one pixel at a time. If you
hold "Shift", it nudges objects 10 pixels at a time.

Rotating Objects

There are two ways to rotate an object. Either click on the object a second time, so the
selection handles change to show rotation handles, which you can then drag on to rotate
the object. Or, when it's showing the square selection handles, move the mouse pointer
just inside the corner handles until you see the mouse pointer change to a rotation
indicator - you can then also drag to rotate the selected object.

Unusually you can rotate just about anything in Web Designer, including photos,
headings, even blocks of text. Since web browsers can't display text at an angle, Web
Designer will automatically convert any rotated text into graphics when exporting as a
website.
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InfoBar

When an object is selected, the InfoBar - just above your document - shows all the
relevant controls for the current tool. This bar changes depending on which tool is
selected. This is the InfoBar in the SELECTOR TOOL:
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The InfoBar, just above your document, shows controls for the selected tool.

You can enter numeric values into any field. e.g. to reduce the size of an object by 20%
you can enter 80% into the W field (which is a % size). The little padlock selects whether
both the width and height change together.

Copying Objects

You can use the usual "epbIT" > "copY" ("Ctrl + C") and "EDIT" > "PASTE" ("Ctrl + V")
options or right click an object and choose copy, but a really quick way to copy any item
is drag on it with the right mouse button.

You can also copy and paste a page anywhere in your document from the current
document or another document — see Copying and pasting pages.

Website Toolbar

The WEBSITE TOOLBAR at the top of the Xara Web Designer 7 provides convenient
access to the main web functions you'll use regularly.

Preview

Link
Website Options

Export

iy B ol EE

Move your mouse pointer over each button in the flyout bar to see a tooltip describing the
button.
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Creating a website

There are two ways to create a new website. Either by starting with a pre-designed
template and then customizing this with your own text, photos and color scheme. Or by
creating a website from scratch, placing all the required elements, text, graphics, photos
and placeholders on the page as you require.

Placeholders are graphic objects on the page which are substituted in the final website
for elements such as Flash animations, YouTube videos, Interactive Maps, HTML
snippets and ‘'widgets' of all kinds. See later sections in the correspondending chapter of
the pdf manual for more information on placeholders.

Previewing Your Website

When creating your website in Web Designer, your working document shows an
accurate static preview, but to check the behavior of pop-ups, mouseover effects
and Flash and other widgets it's necessary to use true Browser Preview.

There are two preview options, in the flyout bar on the web toolbar.

E R

PREVIEW WEBSITE exports all the pages of your site and then brings up the preview
window. So all the pages and links in your site should be working.

The navigation buttons in the top bar of the preview window allow you move back or
forward, just like in a web browser, and the Home button returns you to the page you
started the preview on.

PREVIEW PAGE exports and previews only the current page. So it's useful if you have a
large site which takes some time to export as a whole. You can just quickly preview the
page you are working on, without exporting the rest of the site.

You can preview your website or web page in full screen mode by clicking the

VIEW FULL SCREEN button at the top right of the preview window (press "Esc" to
exit or "F11" to enter and exit full screen mode). When you close the preview
window and next reopen it, Web Designer displays the last mode you chose for
the window, i.e., normal, maximised or full screen.

If you've not yet exported your site, these previews export to a temporary folder on your

computer. Once you’'ve exported, the same export location is used each time you
preview, so your exported site is continually updated as you preview.
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Choose your preview browser

Although this internal preview uses a simplified version of the Internet Explorer browser
by default, you can choose one of the five most popular browser types to view your page
or website from the preview window.

To preview your website in your favorite web browser, click one of the following from the
bar at the top of the preview window:

Note: These buttons are only enabled if you have installed the browsers on your PC.

Previews your page or website in Google Chrome

2

Previews your page or website in Mozilla Firefox

Previews your page or website in Internet Explorer

Previews your page or website in Opera

Previews your page or website in Safari

When you click on one of the above buttons, the browser opens in the page that you are
currently viewing in the preview window.

If you want to preview your pages in a browser other than these types, you can right
click on the exported .htm file and select OPEN WITH..., or you can just drag and drop the
file onto an open browser window. Once you have exported then each time you click the
Preview buttons, the export is updated as well, and so it's just necessary to click the
Reload button in your browser (or press "F5").

Using Templates, Clipart & Widgets

| ™) Open the DESIGNS GALLERY by clicking the DESIGNS GALLERY tab in the Galleries
bar (or use "FILE" > "NEW FROM DESIGNS GALLERY").

fgeb subisaq

This shows folders containing collections of website designs and associated graphic
files that each follow a specific theme. There are also folders of widgets, like forms, e-
commerce facilities, web gadgets, and many other features. Browse through the folders
and double click to open any file as a new document.

www.Xara.com



28

Getting Started

Each theme section has a collection of alternative page layouts and some other useful
page elements such as buttons or expanding text panels. Each theme generally also
contains a complete website template and several ‘color schemes’. You can change
your entire site to a different color scheme by just dragging and dropping the scheme
from the gallery onto your page, or by just double-clicking on it.

Some of the folders in the gallery (most notably the widget folders) are downloaded
automatically from Xara’s servers when you are online and you open the gallery.
Therefore the selection of folders and the items available in the folders will change
periodically. Check back regularly to see the latest updates.

Adding New Pages To Your Website

You can drag any template design from the DESIGNS GALLERY onto your page. If this is a
page template, it will add a new page to your website, after first asking if you want to
match any color changes. If you drag a clipart item such as a button, heading or photo
object, this gets added onto the page where you dropped it, and again you will be asked
if you want to match any color changes you've made.

In addition to themed web page sections, the DESIGNS GALLERY also has folders
containing additional button designs, banners, headings, photo objects and more. Just
drag the required design from the gallery onto your page. You will be asked whether you
want the graphic to match the colors of your website or not. If you choose not to you can
still edit the colors of the imported graphic - see below.

Your imported graphic is just another object on the page, and can be re-positioned,
resized and rotated using the SELECTOR TOOL as usual.

[:'B To add a new page of the same design, the easiest way is to right click the page
and choose DUPLICATE CURRENT PAGE Or use the DUPLICATE CURRENT PAGE button
on the standard toolbar.

This replicates the current page below. You can then just delete or edit the elements as
required. This has the advantage of keeping the same navigation structure.

F You can add a new blank page by right clicking and choosing NEW PAGE or use
=t the INSERT BLANK PAGE button in the 'page’ flyout menu bar.

You can delete pages by right clicking and choosing DELETE CURRENT PAGE Or
click the DELETE CURRENT PAGE button in the 'page’ flyout menu bar.

Embedding Movies, Flash And Other Widgets

You can embed a wide variety of interactive widgets easily; YouTube™ videos, Google
Maps, Flash files or any HTML snippet. This is done using placeholders, which are
objects (simple rectangles or photos) that have an associated piece of HTML or Flash
file that is substituted for the placeholder when saving your website. For full details on
widgets and placeholders, see the Website Widgets Chapter (on page 261) in the pdf
manual.
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The DESIGNS GALLERY contains a frequently updated selection of widgets from a variety
of providers. Simply drag and drop these onto your web page. A web browser window
appears which takes you to the widget providers site, where you can choose and
customize the widget. When you're done you click the INSERT button at the bottom of the
browser window and the widget is inserted into your page with an automatically
generated preview image. It's that easy!

Or you can find widget sites yourself and just as easily add the code to your site.

Flash Clipart

Xara Web Designer 7 includes the ability to create Flash animations from scratch (see
the Flash Animations section in the pdf manual), but also includes a range of Flash
templates you can customize. Flash templates cannot be dragged onto the page
directly, but have to be opened as a separate animation document, where you can
customize it as required, and then save the Flash (.swf) file to your local disk. Then use
"FILE" > "IMPORT" or drag and drop the .swf file onto your web page.

A placeholder image is automatically rendered for you and this will appear on your page.
Preview your page to see your working Flash animation. Alternatively you can create
your own placeholder object (e.g., a rectangle) and use the PLACEHOLDER tab of the wes
PROPERTIES dialog to associate it with your Flash file.

Widgets

Some of the items in the DESIGNS GALLERY are dynamic widgets that you can add to your
website quickly and easily. When you drag one of these onto your page, a browser
window opens onto a widget website which allows you to configure the widget.
Therefore you must be online to use widgets.

Once you’ve finished configuring your widget click the INSERT button at the bottom of the
browser window. A placeholder image is automatically generated which is a static
snapshot of what your widget will look like when it's viewed in your website. The widget
won’t work on the page in Xara Web Designer 7 - you just see the preview image.
Simply preview your page to see the widget in action!

If you find other interesting widgets out there on the Internet, normally the widget
provider will give you a piece of HTML code to copy and paste into your website. With
Xara Web Designer 7 this is very easy. All you need to do is go into the SELECTOR TOOL
and then paste the code into your page. Xara Web Designer 7 will detect that you've
pasted HTML code and will render a placeholder image for you automatically, which will
appear on your page after a few seconds. The code is already attached to the
placeholder, so just preview your page to see your widget working!

Alternatively you can paste widget code directly into the head of your page if necessary.
Click the Placeholder tab (on page 211) in the weB PROPERTIES dialog and click the
HTML CODE (HEAD) button, then paste your code into the HTML code (head) dialog.

For more information see the Widgets Chapter (on page 261) in the pdf manual.
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Website Colors

All the templates use a small set of theme colors, and various shades of those theme
colors. The easiest way to re-color your site is to use one of the alternative color
schemes provided with each web theme in the DESIGNS GALLERY. Just drop a scheme
onto your page to change the color of the whole site, or double-click on it.

Or you can edit each of the theme colors individually yourself. These appear on the left
side of the Color Line along the bottom of the window.

L 2 00 o

ne
1 rect 8 jle: Clicktc 7 ril -:N'lur; Shift-click to set line colour; Right click For context menu; ¢

Current Outline and Fill Color

Color Editor

Eye dropper color picker

‘No color’ patch.

‘Theme’ Colors and Linked Colors

Fixed palette of standard colors

Hold pointer over a color to see its name

Status line. Shows what is selected, and provides hints

00000

Simply click on any of the Theme Colors and select the Edit option (if you hover the
mouse pointer over the color you will see a tooltip name).

V¥ Color editor

B (Current fill color | ~ 94

6
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When editing a color you can drag the eye dropper to pick colors off screen, even
from other open windows

Select the color to edit: Fill color/Line color of the selected object or any of the
named theme colors

Click to show extended color controls

Previous Color

Actual color

Drag here to select any shade of the selected hue

Drag here to select any hue

OO0 ®© ©

The Color Editor provides easy way of choosing any color. Click the Extended Controls
to enter RGB values.

Note that when you change a Theme Color in this way, all the related shades used
throughout the document will change as well.

Coloring Shapes

You can fill any drawn shape with a color, either by dragging the color from the Color
Line and dropping it on to the shape, or by first selecting the object and then clicking on
the Color Line.

n Alternatively right click the shape and choose FILL COLOR or click the
small Color Editor icon (or press "Ctrl + E") to display the Color Editor,
where you can set any color you like.

You can give drawn objects a graduated color fill using the FILL TOOL (ON PAGE 177).

Coloring Imported Clipart

When you import a clipart graphic by dragging from the DESIGN GALLERY, using the "FILE"
> "IMPORT" option, or dragging a .web or .xar file onto your page, you will usually be
asked whether you want to match the colors. If you select not to, then any named colors
used in this graphic will be added to the Color Line. Clicking on any color on the Color
Line will give you the option to edit the color.

Coloring Photos

If you try to color a photo it turns it into a 'contoned' photo. For example, to make any
photo black and white, right click and choose "CONTONE" > "MAKE BLACK AND WHITE" Or
select it and click on the white color patch on the end of the Color Line. You can set the
light or dark color to be any two colors, not just white and black - right click, choose
"CONTONE" > "LIGHT" and click a color in the Color Editor.

Note: If the photo is inside a group, as many of the photo objects in the templates or
clipart are, then you will have to select the photo inside the group first. You can do this
by holding "Ctrl" down when clicking on the object in the SELECTOR TooL. Another way of
directly selecting the photo is to click on it in the PHOTO TOOL.

www.Xara.com



32

Getting Started

Page Background Color

Most of the page designs in the DESIGN GALLERY have two types of background. A wide
page background that extends across the background of the whole browser window.
And on top of this is drawn the web page elements, that usually consists of various

colored panels.

On the Color Line there is usually one color named '‘Background Color', another 'Panel
Color', and by editing these you can control the various background colors. The other
colors used are typically Theme Color 1, 2 etc

Button Text 1

Button Text 2

Button Text 4

Button Text 5

Button Text 6

Button Text 7

Text8

12)

Lorem ipsum dolor sit amet

" o Cupdatat excepteur ea dolore sed n
= "A‘w’! adipisicing id? Nula lorem deserunt alquip
) ¢ officia reprehendert fugiat, dolor excepteur in
z‘d " et officia ex sunt ut, nula consequat. Laboris,
& ! lorem excepteur qui labore magna enim

ipsum adipisicing ut. Sint in veniam minim
dolore consectetur enim deserunt molit deserunt ullamco. Molit aliqua enim pariatur excepteur

Labore nulla sunt, in, excepteur reprehenderi lorem fugiat ipsum veit sunt' Non veniam ullamco amet
officia ut, ex molit excepteur exerciation fugiat eu ut esse cupidatat in velt. Non eu ulamco in pariatur nisi
voluptate molit quis sed voluptate ea amet proident dolore eit

Reprehenderi, ad eu labore, in ipsum culpa pariatur ut culpa. Dolore molit in, reprehendert ullamco
incididunt veniam minim excepteur paristur clum. Fugiat sed magna culpa sint ut commodo fugiat ulsmco
Anim nostrud cilum ad quis lorem enim nostrud tempor labore aute voluptate, enim magna aiqua
Occaecat dolore veniam amet fugiat ipsum molit voluptate akquip ex duss anim dolor sint

© Lorem ipsum dolor 2010

@ Background Color

Panel Color
Theme 1 & 2 colors

Setting the page background color
When you open a new blank page ("FILE" > "NEW" > ) the page defaults to being white.
This is the background on which you place all the elements of your website.
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If you drag a color from the Color Line over the page, and drop it, it will set the page
background to that color. In the Web Browser this background color is shown over the

whole area of the window background.

!ll'l! " Welcome

Headline text: incididunt irure ipsum enim non ut cillum sunt ad aliquip nisi duis lorem amet
dolore exercitation dolor. Tempor commodo eiusmod veniam.

Sed aute cupidatat eiusmod sint s&. qui magna sint sed ewsmod do labore sed alquip. Qui, ullamco, cllum deserunt amet dolor ut velt
excepleur consequat officia dolore. ipsum qui, duis eu dolor it nisi in reprehendert do rure do eit. Incididunt nulla labore I, nisl, irure dolor
nisi i esse ncdidunt psur nostrud non psum, sute excepteur. Est in ut fugiat ad est eiusmod dolore
ewsmod n d molit rure dolore excepteur, anm sunt. Mot anim nulla venam mnummm

Consectetur consequat reprehendert ut ut anim nuls. Deserunt cilum reprehendertt eiusmod incididunt ut ipsum? Culpa es, adipisicing rure
est ea, ut culpa nostrud deserunt magna commodo quis amet e, commodo culpa velt

Gr—o Lorem Ipsum Dolor
Sed aute cupidatat eusmod sint st, qui magna sint sed eismod do lsbore sed aiquip. Qui, ullamco, cllum deserunt amet dolor ut
‘ veit excepteur. In voluptate incididunt quis irure ut dolore quis excepteur in allquip rure dolor ea in molit sed amet ut. Eusmod sint
dolor. rure, dolore eu proident, ex cupidatat, qui duis voluptate alquip quis exercitation, magna adipisicing. Dolore incididunt s2.
Nulla cillum nulla, labore reprehendert cilum duis. Lorem deserunt molit fugat consequat labors.
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However you can also make the page background one color, as described above, and
then set the area around the page to a different color. This area around the page is
referred to as the pasteboard. Just drop a color onto the pasteboard to set its color and
set the page color as described above. Now when you preview your page you'll see the
browser window background color is set to the pasteboard color and you can see the
page rectangle with its own color.

Tlogotype Welcome

MWSWMWWMW

i w 4

\ \
Headline text: incididunt irure ipsum enim non ut cillum sunt ad aliquip nisi duis lorem amet
dolore exercitation dolor. Tempor commodo eiusmod veniam.

Sed aute cupidatat eiusmod sint sit, qui magna sint sed eiusmod do labore sed aliquip. Qui, ulamco, cillum deserunt amet dolor ut velt
excepteur consequat officia dolore. Ipsum qui, duis eu dolor sit nisi in reprehenderit do. irure do el incididunt nulla labore. In, nisi, irure dolor
nisi id esse incididunt ipsum consectetur minim magna nostrud non consectetur ipsum, aute excepteur. Est in ut fugiat ad est eiusmod dolore
esmod in id molit rure dolore excepteur, anim sunt. Molit anim nulla veniam id. Est, excepteur deserunt sint

Consectetur consequat reprehenderit ut ut anim nulla. Deserunt cillum reprehendertt eiusmod incididunt ut ipsum? Culpa ea, adipisicing irure
‘est ea, ut culpa nostrud deserunt magna commodo qQuis amet ea, COmmodo culpa vell.

= Lorem Ipsum Dolor
Sed aute cupidatat elusmod sint st qui magna sint sed eiusmod do labore sed alquip. Qui, ullamco, cilum deserunt amet dolor ut
. veit excepteur. In voluptate incididunt quis irure ut dolore quis excepteur in aliquip rure dolor ea in molit sed amet ut. Elusmod sint
dolor. Irure, dolore eu proident, ex cupidatat, qui duis voluptate aliquip quis exerctation, magna adipisicing. Dolore incididunt st
Nulla cilum nulla, labore reprehendert cllum duis. Lorem deserunt molit fugiat consequat laboris.

You can use the color editor to edit these colors. Right click on the page and choose
CHANGE PAGE BACKGROUND to bring up the color editor, then you can edit the page color.
To edit the pasteboard background color, right click on the pasteboard and choose
CHANGE BACKGROUND COLOR.

To set a repeating background texture, drag the photo or bitmap onto your
document. Open the BITMAP GALLERY, scroll to the photo you just loaded, click
on it to select it, and then click the BACKGROUND button on the gallery.

1e6 dewyg n
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Page Background Layer

When you set the page background color by dropping a color onto the page as
described above, this actually adds another layer to your document, which you can see
if you open the PAGE & LAYER GALLERY. It's called the PAGE BACKGROUND LAYER.

This layer is normally locked, so you can’t select and edit its contents. But you can
unlock it in the PAGE & LAYER GALLERY in order to perform some limited editing of it, to
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customize your page background. Just click on the lock symbol next to the "Page
background" layer to unlock it.

Now if you click on the page background, you'll see a rectangle becomes selected (see
status bar). This rectangle covers your whole page - it's used to set the page color. You
can now do some limited editing of this rectangle, such as give it a graduated fill using
the FILL TOOL, or give it rounded corners using the RECTANGLE TOOL.

Note: You must also set the pasteboard color too, before you can give your page
anything other than a flat color.

Offsetting the top of your page

Normally if you just set the page and pasteboard to different colors, when you preview
you'll see that the page extends right to the top of the browser window. You can'’t see
any of the pasteboard color above your page. However you can add an offset so that
there is some space above your page in the web browser.

To add an offset, you change the page origin. Normally the page origin is set to be the
top left corner of your page. By moving the origin up 20 pixels, for example, you add a
20 pixel margin to the top of your page when it’s viewed in a web browser.

You can change the origin in two ways. The easiest way is to open the "UTILITIES" >
"oPTIONS" dialog (or right click a page and choose PAGE OPTIONS), go to the GRID &
RULER tab and increase the value of the Y coordinate of the origin point. This is normally
set to the vertical size of your page, so just increase it by the margin size you would like.
So for example if your page is 700 pixels tall, change the Y value of the origin coordinate
from 700 to 720, in order to add a 20 pixel offset.

Alternatively you can set the origin point interactively. Turn rulers on by right clicking and
choosing "SHOW GRID/GUIDES" > "SHOW RULERS" or by choosing SHOW RULERS from the
wiNDow menu ("Ctrl + L"). Then click and drag on the crosshairs button, which is located
where the horizontal and vertical rulers join, at the top left of the canvas. Now you are
dragging around the origin position, so position it the appropriate distance vertically
above the top left corner of your page.

Changing the horizontal position of the origin has no effect on the horizontal positioning
of your page, so this should be left unchanged.
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Advanced backgrounds

Web browsers do not allow a graduated color background over the whole visible window
(i.e. as a real HTML background), but they do support repeating, tiled, bitmaps as
backgrounds. So you can use this to create a full-window graduated background, by
creating a bitmap, which is then tiled (repeated) across the page.

Newpage | ButtonText2 ButtonText3 ButionText4 ButtonText5 Button Text6 Bution Text 7

Culpa ex ipsum do nulla in quis aute
irure ipsum et laboris veniam. Ex non
ad incididunt et esse dolor ullamco nisi
excepteur aliquip ea excepteur et nisi.
Do ullamco eu, nisi sint lorem labore
voluptate velit.

Nutia fugiat proident in veniam reprehenderit
eusmod. krure et, aute esse ulamco lorem

do proident excepteur proident. Excepteur,

proident nisi Pariatur in minim veniam
reprehendert dolor ut aliqua. Pariatur E
occaecat in psum nostrud ut aliqua ex fugiat
consectetur in duis ea eu. Cupidatat nulla

aliqua aliquip cllum excepteur dolore in.
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By creating a long thin strip as on the left, when set as a background,you get a graduated
color background across the whole page.

To create this effect, follow these steps;

1. Draw a tall thin rectangle. This needs to be as tall as any user is likely to make
their browser window so it doesn't repeat vertically. A value of 1000 pixels or more
is recommended, which is much taller than your page. You may need to zoom out
to draw one large enough. It should be very narrow.

2. Make sure your rectangle has no outline: Click it in the SELECTOR TooL and set it to
have no outline. Click on the 'no color' cross-hatch patch on the Color Line (or
select 'none' from the Line Width drop down menu on the top button bar).

3. Ensure the rectangle is a few whole pixels wide, and then ensure it is on exact
whole pixel X and Y coordinates: In the SELECTOR TOOL select the rectangle, edit
the Width (W) value, press "Enter"”, then edit the X and Y positions to be whole
numbers.

4., Using the FILL TooL (on page 177), give it a graduated color fill as required: Just
drag on the rectangle. Make sure it's graduated top to bottom by adjusting the fill
arrow if necessarily.

PNG
|
5. Export the rectangle as a PNG image. . Click the EXPORT AS PNG icon .Once
exported drag it back onto the page from your File Explorer.
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6. Open the BITMAP GALLERY, scroll down to see the graphic you just loaded (it will be
a very thin, almost invisible thumbnail in the gallery), and select it (click on it in the
gallery) and then click the BACKGROUND button on the BITMAP GALLERY. You can
now delete the original rectangle from the page.

Note: This will only work across the whole browser window background if you haven’t
given the pasteboard background its own color. If you have set the pasteboard
background, then the graduated fill will only be applied to the background of the page
area.

Linked shades

“You can create colors that are lighter or darker shades of another color, so that when
you alter the 'parent’ color, all the lighter and darker shades change to match the new
hue. For example a graduated color shade on a button, such as this:

This is a simple rounded rectangle with a

H graduated color fill created with the FILL TOOL. In
the FILL TOOL you can click on the either end of the
arrow to set the color.

If you create the main green color as a named color, and then make a lighter or darker
shade of the color, as a linked shade, when you now edit the named color the shades
change as well, so you get simple re-coloring of complex shaded objects.

(—— —
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To create a linked shade, open the extra controls in the Color Editor and select the
'NORMAL COLOR' drop-down menu and choose 'SHADE OF ANOTHER COLOR'.

\,’" Color editor ‘;‘

[ [Theme Color1___| ]

o

Shade of another color Ky -

snsce Bl B~

o Click this button to reveal the extra controls.

e You can now select any light or darker shade of the parent color. The cross marks
the parent color.

9 Select sHADE from this drop-down list and then the parent color.
You can also create a Linked Shade that appears on the Color Line (so you can easily

apply it to other objects). When you select to create a new Named Color you can choose
to make this a linked 'Shade of another color'.
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Photos

You can replace any photo by dragging and dropping it from your File Explorer onto any
photo in Web Designer. If you drop it onto the background then it is imported and placed
on the page where you dropped it. All imported photos are shown as 500 pixels wide,
but you can of course change this to be any size in the usual way with the SELECTOR
TOOL.

0 Aris Black = v

holiday_ websitelLweb * X

ictures » Sample Pictures v [ 42 | se e Pictures

&= Libwies b Pictures » P

Share with

Organize ~ Slide show

¢ Favorites 5 Pictures librar
B Desktop e Picture
8 Downloads

amg a
%, Recent Places i %
s _a
4 Libraries '

3 Documents Chrysanthemum. Desertjpg Hydrangeasjpg Jellyfishjpg Koala.jpg
My Documents »9

\ Public Documents a i

/ o Music

i Pictures

5 MyPictures Lighthouse jpg
Public Pictures

Penguinsjpg Tulips.pg

Sample Pictures
B Videos

Nutla fugiat proident in veniam eiusmod. Iny
Pariatur in minim veniam reprehendert dolor ut akua. Pariatur occaecat in ipsum nostrud ut aliqua ex fugiat consectetur in duis ea e, Cupidatat
nulla aliqua aliquip cilum excepteur dolore in.

Mage i Xorn

DOSEEEE 6 600 4000 400 o0 >

1 text cursor (0 characters, 0 words) on layer MouseOff

Drag and drop your photo over any existing picture to replace it. Drop onto the background to
import as a new photo

{'/ When you replace an existing photo, the FILL TooOL is selected and a
pair of fill arrows are shown at right angles on the photo.
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This is because the photo is really a fill inside a shape. You can drag on the picture to
re-position it, or drag on the ends of the fill arrows to resize and rotate the picture inside
its outline shape.

Drag on photo to re-position inside its frame. Drag on end of arrows to resize and rotate.

Replacing Multiple Photos

Some templates in the DESIGNS GALLERY, particularly photo album styles, can have
multiple photos replaced at once. Select multiple photo files using Windows File
Explorer ("Ctrl + click" to add more files to the selection, or "Shift + click" to select a
range of files). Then drag and drop them onto the page in Xara Web Designer 7. Photos
are replaced one by one from the top of the page downwards. This makes it easy to
rapidly fill a photo album page with your own photos!

If you drag in more photos than can be fitted on the current page, Xara Web Designer 7
will look at any following pages in the document, to see if they can accommodate some
or all of the remaining photos. If that still doesn’t exhaust the supply of photos imported,
Xara Web Designer 7 will duplicate the current page as many times as necessary in
order to accommodate all the photos.

This powerful mechanism means that you can create a multi-page photo album website
rapidly, by loading an album template from the Designs Gallery and then dragging in
your photos.

Importing Large Photos

When importing high resolution photos (anything above 1920 pixels either wide or high)
into a web document, Web Designer automatically resizes the photo down to HD screen
size without asking you if you want to import a lower resolution version. For a web
document, even at the reduced size, there should be more than enough resolution in
your photos for high quality results on your website, so it’s rarely necessary to import
digital camera images at full resolution for web use.
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The Photo Tool

The Photo Tool provides a range of ways to enhance and crop any photo.

To crop a photo, just drag across the photo while in the ENHANCE PHOTO TOOL.
@ You can adjust the crop edges by dragging on the crop handles around the
outside of the photo.

Or use the CLIP TOoL for more control over crops.

See the section on Photo Handling (on page 218) for background information on the
advanced way in which Xara Web Designer 7 handles photos, and the section on

the Photo tool to find out how to use the Photo tool.

Thumbnail Photos With Pop-ups

You can very easily create small thumbnail photos (just resize it to be tiny), that when
clicked will show an enlarged version. Simply resize your photo to be small, the usual
way using the SELECTOR TOOL.

Select the small thumbnail photo, and select the POP-UP PHOTO option in the LINK
tab of the Web Properties dialog (click the LINK button in the WEB TOOLBAR).

When the selected object is clicked:
@ Do nothing
@ Link to Web or Email address: Correct automatically

@ Link to file (PDF, AVI, etc.)

O Pop-up photo: Settings

Use common website link colours (See Website tab)

Open link Not specified -
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Click the seTTINGS button next to the popup photo option, to change to the IMAGE tab of
the Web properties dialog.

Wi Mouse-over Placeholder Image
Photo pop-up
Pop-up photo: Pop-up width: m pix  Options...

Pop-up Title

Image Caption [&lt Text)

Web image type

OL reme choose the type automatically

@ JPEG (Best for ph Quality:

@ PNG (Best for graphics)

There you can change how your pop-up appears. One option allows you to place a title
above each pop-up photo. Set the title for each photo using the TITLE field. You can also
optionally show a caption below each popup photo. Just set the IMAGE CAPTION (Alt text)
for the thumbnail on the same dialog. See the popup photo section of the Web
Properties Dialog chapter for full details of the options available.

In Internet Explorer the Image caption ("ALT"-Text) will be also shown in a tooltip pop-up
as you mouse-over the image. To show different text, typically something like 'Click to
enlarge' as you move over the thumbnail image, go to the MOUSE-OVER tab and set
SHOW POP-UP TEXT t0 be CLICK TO ENLARGE.

Photo Resolution - It's All Automatic!

When importing high resolution photos (anything above 1920 pixels either wide or high)
into a web document, Web Designer automatically resizes the photo down to HD screen
size without asking you if you want to import a lower resolution version. For a web
document, even at the reduced size, there should be more than enough resolution in
your photos for high quality results on your website, so it's rarely necessary to import
digital camera images at full resolution for web use.

If you’re not sure whether you will need the full resolution photo you can import the
original photo and then optimize it down later. To optimize a photo, right click on it and
choose the opTIMIZE option from the context menu. Or you can optimize all the JPEG
photos in your document at once, using "UTILITIES" > "OPTIMIZE ALL JPEGS".

Web Designer always stores the full resolution image (unless you chose to import
reduced resolution images when asked during import, as mentioned above). This means
you can resize or crop your image as required with no loss of quality. Web Designer
automatically converts all photos into the correct resolution JPEG image when saving
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your website. You do not need to bother about dpi, image size, pixels or anything like
that. What you see in Web Designer (at 100% zoom) is exactly what will be produced on
your web page.

If you want to size a photo, or any object, to a specific size, just enter the required size
into the SeLecTOR TooL InfoBar width or height fields.

When you drop a photo on the page (assuming you're not replacing an existing photo),
it's sized to be 500 pixels wide. But if you want this to be exactly 200 pixels wide, just
enter 200pix into the W size field of the SELECTOR TOOL. You can enter it in any unit e.g.
entering 2in will make it 2 inches wide.

Text

You can edit the text by selecting the TEXT TooL and clicking on the text.

You have all the usual word processing facilities, and can paste text from the system
clipboard. Double click will select a word, triple click will select a whole line - which can
be useful for selecting all the text in a button. As usual the InfoBar provides a wide range
of controls for this tool. Alternatively you can right click within text and choose ADVANCED
TEXT PROPERTIES.

IAnaI vI'IBpx ~ i3
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The font menu displays a list of fonts and is split into three sections. The top section
shows fonts already used in the document, the next section shows web safe fonts, and
finally the lower section shows all fonts installed on your computer.

Live font size pop-up

T T

5 60

Fonts used in Helvetica 45 Light
Palatino Linotype

thIS document Times New Roman

Arial
Arial Black

Comic Sans MS
Courier New
Georgia

Web safe fonts Impact

Lucida Sans
Palatino Linotype
Tahoma

Times New Roman
Trebuchet MS
Verdana

vy v oww

Styles available
for the selected font

vy v e wvww

18thCentury
( Abbess
Acclamationltal
AcmeFont
Addled

All other fonts { | & '

jiess
ALIENENLUUNIEMD
KLRGNIE SNOw

Amsthyat

\ Andale Mono IPA ObOdOfOhOj
AsticFont

Arial 4
Arial Black 4

The three sections of the font menu. In this example Courier New is selected showing the
available bold and italic variants. Not all fonts have such variants.

The font menu offers live font selection. As you traverse the menu, the selected text
changes font allowing you to immediately preview what the font will look like in the
document.

Font Size

The font size field shows the font size in pixels, as this is the most reliable method of
setting the text size for use in a web browser. But you can enter any size in points (or
any other unit for that matter), by entering a value with pt after it (for point) e.g. 72pt or
lin and this will get converted to the correct pixel size.

Web Safe Fonts

Only a small set of fonts can be used safely for the main text of a website - only those
fonts that you know will exist on the computer of the viewer of your website. Although
there are no guarantees, there is a common subset of fonts that are widely used by
something like 98% of all computers, including Apple Mac and some Linux
computers. These fonts are called the 'web safe fonts', and are listed at the top of the
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font menu. If you try and save a website using non-web safe fonts you will get a
warning.

If you turn any text object into a graphic, you are free to use any font. See the Groups
section (on page 49) below for details about this.

Creating New Text Objects

There are three types of text object - a single line of text, a column of text or a
rectangular text area. To create a simple line of text, select the TEXT TooL and then you
can click anywhere on the background and start typing. To create a column click and
drag horizontally on the background, and then start typing. You can adjust the column
width at any time. To create a text area, click and drag diagonally. You can adjust the
width and height of a text area by clicking and dragging on it in the TEXT TOOL.

Rotated Text

Unusually (uniquely for a web authoring tool) you can rotate any text object, even
columns of text, using the usual rotate feature of the Selector tool. But because web
browsers do not support native rotated text Web Designer converts any rotated text into
a graphic when the page is exported as a website.

Bulleted and numbered lists

Use the bullet and numbered list buttons on the TEXT TooL info bar to quickly enter
bulleted or numbered lists. You can right click on a numbered list and choose LIsT
PROPERTIES... from the context menu to change the numbering scheme for your list. See
the Text Tool chapter (on page 151) for more information.

Soft Shadows, Color Filled Text, Transparent Text

You can apply any of these effects using the appropriate tools, e.g., if you drag across
some text in the FILL TOOL it will give it a graduated color, or if you drag on it with the
SHADOW TooL it will give it a soft shadow.

In all these cases Web Designer will automatically convert the text to be a graphic on
your exported website.

Text Repel Around Objects

If you right click on an object like a photo and select the menu option 'REPEL TEXT UNDER
(ON PAGE 165)"" you can make text flow around the object that is on top of the text.

Many of the objects, such as photos, side panels, buttons and headings used in the
templates from the DESIGNS GALLERY are automatically repelling - the text will always
flow around these objects as you drag them around.

Repelling objects only repel text that is behind the object - so you may have to 'bring to
front' the object in order for the repel to work ("Ctrl + F"). Alternatively if you only want an
object to repel text within an individual layer, you can prevent text that is below that layer
from being repelled (useful for popup layers within a web page) - see Layer Properties
(on page 277).

All operations in the TEXT TOOL are live - the text re-formats and re-flows as you adjust
the column width or move repelling objects around.
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Note: You can now also repel text around anchored objects (on page 46).

Anchored Objects

If you want a graphical object to appear next to a particular part of a block of text, you
can anchor the object to the text so it moves with it.

Right click the object and choose ANCHOR TO TEXT. Using the SELECTOR TOOL click and
drag the anchor symbol that appears in the top left of the object to the location in the text
where you would like the object anchored. Now if you edit or move the text, the
anchored object moves with the anchor point.

Note: You can also repel text (on page 45) from an anchored object.

Text Panels

Just as some DESIGN GALLERY buttons stretch to accommodate the text, so some text
panels can adapt to the width or length of text entered into them.

This panel stretches This panel stretches horizontally and vertically.
horizontally and Reprehenderit sed dolor consectetur eiusmod ex, in

\ vertically. ) minim mollit anim occaecat consequat cillum cupidatat
Reprehenderit sed dolor 2 amet pariatur. Veniam lorem laboris, occaecat nostrud,
consectetur eiusmod ex, velit et. Duis commodo elit. Quis officia laboris ullamco
in minim mollit anim ’ quis voluptate enim esse proident ut ut ut officia in
occaecat consequat fugiat. Incididunt, in commodo, cupidatat incididunt

cillum cupidatat amet lorem ea quis deserunt quis, aute irure, fugiat dolor.
pariatur. Veniam lorem laboris, occaecat
nostrud, velit et. Duis commodo elit. Quis officia Aute ullamco et. Lorem do, adipisicing cillum, dolore, culpa ipsum mollit
laboris ullamco quis voluptate enim esse cupidatat ullamco non. Nostrud cillum occaecat aute deserunt mollit officia
proident ut ut ut officia in fugiat. Incididunt, in qui culpa occaecat excepteur culpa eu aute ea lorem occaecat, ut enim.
commodo, cupidatat incididunt lorem ea quis
deserunt quis, aute irure, fugiat dolor.

The panel background changes to accommodate longer or wider blocks of text.

You can adjust the width of a text column by going into the TEXT TooL and dragging the
column width handles (under the first line of text). Most of the DESIGN GALLERY templates
provide a few text panels in keeping with the theme. Some text panels will only stretch
vertically, others will stretch vertically and horizontally.

To create your own stretching button or text panel, use one of the existing ones from the
DESIGN GALLERY and adapt this by re-coloring the background or adjusting text color /
size / width.

Note: You can create new stretching components using Xara Designer Pro.
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Spell Checker

On the TEXT TOOL InfoBar is a button that selects the spell checker options and
language. If you select CHECK SPELLING AS YOU TYPE this will also mark all
unrecognized words with a red dotted underline. Right click on any marked word
to be presented with suggested alternatives.

Embedded Fonts

Web Designer stores the character shapes of all the fonts used in your document. This
means if you give someone else your .web file, or transfer the file to another computer
they will see exactly what you see, even if the correct fonts are not installed on that
computer. But this only embeds the characters that are used in the document (it's not a
full font that is included). So on computers with the fonts missing, any text that is added
in the missing fonts may be missing the correct character shapes.

Text Tip: There are a lot of shortcuts available in the TEXT TooL. Refer to the reference
section on keyboard shortcuts (on page 318) to see them all. One useful one for
experimenting with page layouts, "Ctrl + Shift + L", inserts a block of random pseudo
Latin.

Page Size

The pages in the DESIGNS GALLERY are designed to be a width that is known to fit the
vast majority of computer screens. Creating wider pages is not recommended, even
though you will probably have a wider computer screen, experience shows most viewers
prefer to have a fixed width page. However you can adjust the page size to be anything.

You can set any page size you like by selecting the PAGE sizE tab of the OPTIONS DIALOG
(right click and choose PAGE OPTIONS or PAGE OPTIONS from the FILE menu). It's not
recommended that you make the page width more than 990 pixels, as that's the
maximum width for many computer screens (1024 minus a small amount for the scroll
bar). A more common page width is typically around 800 pixels.

You can directly adjust the height and width of your page by just dragging on the bottom
or right margin of the page. Go into the SELECTOR ToOL and hover the pointer over the
bottom edge of the page, and it will change to indicate you can now drag resize the
page up or down as required.

!

Changing The Page Size of Templates

You can change the vertical size of the pre-designed templates by just dragging on the
bottom edge of the page. However you will often need to move and resize various
objects on the page. For example many templates have a footer group. You can just
drag this using the SELECTOR TOOL to the new position. Sometimes the main text will be
on a colored background rectangle. Again using the SELECTOR TOOL you can drag on the
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lower resize handle to extend this down the page as required. Most templates use
columns of text which will just grow vertically as you add more text.

Hint: If you hold "Ctrl* down while dragging you can ensure the drag will be exactly
vertical or horizontal.

Saving Your Work. Creating A Website

Use the SAVE or SAVE AS menu options to save your work in progress. This saves a file
with the .web extension, which is the native file format for Web Designer (this is not a
website). You are recommended to regularly save your work as you go along. If you
want to edit or update your website in future, you must save a .web file this way and use
to do further updates.

It's also recommended that you work with the automatic backup facility turned on. This is
controlled from the BACKUPS tab of the "UTILITIES" > "OPTIONS" dialog. When on, a
backup of your modified open documents is taken regularly. Here you can also choose
how the program should behave when you close it. You can either be prompted about
saving or discarding each open modified document, or have all documents automatically
saved to the backup location and restored the next time you start.

To save your website, that is the HTML and associated files for publishing to the
web, use the "FILE" > "EXPORT WEBSITE" menu option or click this button on the top
bar.

This saves a .htm file for each page and a folder alongside these which contains all the
graphic files that make up your website.

When you export a website, all the pages are exported together, and each page
unnamed has _1, _2 ... appended to the end of the name you give when you export. The
_FILEs folder contains all the graphics and other files that go to make up your website.
You can name each page individually if you wish using the PAGE tab of the weB
PROPERTIES dialog or using the PAGE & LAYER GALLERY (on page 270).

The default name given to your website is index.htm as this is the usual name for the
first page of a website.

You can preview your saved website in any web browser, by dragging the index.htm (or
any .htm) file from your Windows File Explorer onto a browser window.

Automatic backups

The BACKUPS tab of the "UTILITIES" > "OPTIONS" dialog allows you to turn the automatic
backup facility on and off. This facility saves a copy of all your modified open documents
at regular intervals. It's recommended that you work with this backup option turned on,
so your work is saved regularly. You can also choose whether you are prompted about
unsaved documents when closing the program, or if instead all open documents should
be backed up and restored for you when you next start up.

See the Document Handling chapter (on page 83) for full details about these facilities.
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Stretchy Objects

Many of the graphic objects, such as buttons and text panels, can automatically

adjust their size depending on the size or length of text. For example some of the
buttons are called 'stretch buttons' which means that the length of the button adjusts

to accommodate the label text on the button. Most template sets, and all of the buttons
in the Button folder in the DESIGNS GALLERY, have both fixed width and stretchy versions.
It's recommended that if building a set of navigation buttons (typically either a horizontal
or vertical collection of links or buttons) that you use fixed width so they are all the same
size.

EH I[ onger button Iex

Similarly many of the side or text panels in the templates, and sometimes the main text
area, can also adjust their vertical, and sometimes their horizontal size. In the case of
text panels you can adjust the width of the column in the TEXT TOOL by dragging on the
left or right end of the column indicator.

sequat parniatt xcept onsequat
This panel stretches horizontally and
vertically.
Amet officia irure sed. Eu in sint This panel
lorem magna, ex ullamco dolor amet stretches
Veniam cillum esse eu, sed proident horizontally and
eu lorem minim fugiat proident amet vertically.
adipisicing occaecat? Do id labore Amet officia irure
sed consectetur deserunt incididunt. sed. Eu in sint
Minim do consequat, esse eu veniam ut consectetur, ut lorem lorem magna, ex ullamco dolor amet.
ut, commodo velit in. Aliqua irure ad eu qui aliquip ea Veniam cillum esse eu, sed proident eu
reprehenderit pariatur veniam voluptate. Quis officia sint. Esse lorem minim fugiat proident amet adipisicing
lorem ut esse dolor. Amet dolore tempor et irure non fugiat. occaecat? Do id labore sed consectetur
deserunt incididunt. Minim do consequat,

esse eu veniam ut consectetur, ut lorem ut,
commodo velit in. Aliqua irure ad eu qui
aliquip ea reprehenderit pariatur veniam
voluptate. Quis officia sint. Esse lorem ut
esse dolor. Amet dolore tempor et irure non
fugiat.

Groups

You can group together any selection of objects on the page. Groups act much like a
single object, in that you can drag them around the page, resize and rotate them as if
they were one object. Many of the items in the template designs from the DESIGNS
GALLERY such as buttons, text panels, and photo objects are grouped items.

For example, you can draw a simple button from scratch by drawing a rectangle with the
RECTANGLE TOOL, and then placing a text label on top of this with the TEXT TooL. These
are separate objects and you can move them around independently in the SELECTOR
TooL. But if you select both in the SELECTOR TOOL (you can lasso drag around to
enclose them both, or hold "Shift" and click on additional objects) and right click and
choose GROUP (or press "Ctrl + G" or use the menu "ARRANGE" > "GROUP"), these now
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become a grouped object (Hint: The status line at the bottom always tells you what is
selected). Now when you drag, resize, rotate this object, all component parts of the
group are moved and transformed as if they are one object.

Important: Grouped objects are usually converted into a single graphic object when you
export your web page.

By un-grouping (right click and choose UNGROUP or press "Ctrl + U"), you can access all
the parts of your group again to make any changes. An alternative is that you can
sometimes edit items directly inside a group. For example when using the TEXT TOOL to
edit text or the Photo tool to edit a photo, a click will automatically select the item inside
a group.

Converting Text To Be A Graphic

As mentioned above only a very limited number of fonts are available in web browsers.
If you want to use a different font on a button or, say, as a heading, you can do this by
ensuring it is converted to a graphic, and all you need to do is group the object to make
this happen automatically. You can still edit the text inside the group, but groups are
automatically converted into a graphic when the website is exported.

A Oiffereat Foat

So all you need to do to include a font like this is to group it. It doesn't have to be
grouped with anything - you can group it with itself, by just right clicking and choosing
GROUP or pressing "Ctrl + G".

Soft Groups

There is another type of group, called a 'Soft Group', which is a more loosely connected
set of objects. The difference between Groups and Soft Groups is:

e When you group items they must all be on a single layer (if they are not they are
moved to a single layer when you group the items). Soft groups retain their layers, so
you can tie together items across multiple layers.

e Groups are usually converted into a single graphic when exported as HTML for a
website. Soft Groups are not and each object is exported as a separate item. Text
inside a soft group is kept as text in the HTML, whereas text in Groups is converted
into a graphic (with some exceptions).

¢ You can nest groups inside other groups. For complex drawings consisting of many,
sometimes thousands of shapes, creating a hierarchy of nested groups is a good
organizational technique, just like having folder inside other folders. Soft Groups
however cannot be nested and are designed primarily a way of tying multiple objects
on different layers together.

Because Soft Groups can contain items on different layers, when you select a Soft
Grouped item on one layer it will automatically select the corresponding 'soft grouped'
item/s on other layers, often a layer that is not even visible. See the section on Layers
below to understand more about this.
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Most buttons are Soft Groups, that is when you select, move or resize a button you are
in fact performing these operations on two copies of the button, one called the
'MouseOff' version and another 'MouseOver' version.

Some of the more complex panel objects in the DESIGNS GALLERY are Soft Groups. This
is so that you can move it around as a single object, but the component parts, the
photos, background shapes, are all exported into the HTML as separate items for
maximum efficiency.

Synchronized Text

There is another useful feature of Soft Groups. If you have the same text on two or more
objects within a Soft Group, the text will be synchronized when you edit it. This is the
mechanism used to keep the button text the same on both the normal and MouseOver
buttons - see below.

Repeating Objects

It's common to have items like navigation buttons, headers or logos repeating on all
pages of your document or website. Xara Web Designer 7 provides the ability to repeat
any item in the same place on any of your web pages. When you update one of the
copies, all changes are automatically replicated across all pages.

See the Repeating Objects (on page 122) section of the Object Handling chapter for
details.

Links, Buttons & Navigation Bars

You can add a web link to any object, a button, graphic or some text.

Select the object and just click the link icon on the top bar to enter the web
address that you want to link to.
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When the selected object is clicked:
@ Do nothing

O Link to Web or Email address: Correct automatically

@ Link to file (PDF, AVL, etc.)

@ Pop-up photo: Settings

Use common website link colors (See Website tab)

Open link Not specified v

Enter the web address you want to link to in the highlighted field.

The Link tab of the Website Properties dialog allows you to control what happens when
you click the linked object on the page. You can jump to any other web page (you can
quickly select to link to any other page within your website by using the LINK TO drop
down) and you can control whether this opens the page in a separate window. You can
also link to any pop-up layers if you have created these.

So to set one of your buttons to be a link, just select it (click on it in the
SELECTOR TOOL), click the icon, and enter the web address, or just select one of
your pages from the drop- down list and click AppLY. That's it.

Link to Anchor

You can link to any text or object anywhere in your website by using 'anchors'. First you
need to apply a name to the object you want to link to. This is called the anchor. Right
click the item (which can be a graphic or some text) and then select NAMES or choose
NAMES from the UTILITIES menu to display the name dialog. Enter any unique name you
like and click Apbp.

To link to this anchor from anywhere in your website (a button or just a link on some
text) open the link dialog (shown above), and choose from the LINK TO ANCHOR drop
down list of names.

Link to File

Sometimes you may want to provide a document, movie or other file to visitors to your
site. To do this use the LINK TO FILE option. Select the object on your page that you want
to link to the file. Then choose the Link to file option and browse for your file.

www.Xara.com



Getting Started

53

This copies the file into a support folder alongside your design file, so that the file gets
published along with the rest of your site. The folder is named using the name of your
design file, with “_files” appended. Click ok, preview your page and try the link. When
you want to modify the file, just go through the same process - browse for your
new/updated file. See the Web Properties dialog chapter (on page 196) for more
information on this feature, and the Document Handling chapter for information about
support folders (on page 81).

Changing Button Text

This is easy - in the TEXT TOOL, just click on the button text and edit it.

Hint: if you triple-click on the button text that selects the whole line of text for easy
replacement when you type.

Note: You can’t edit the text of navigation bars this way, if the bar is set to be a site
navigation bar. You need to edit the labels using the Navigation Bar Properties dialog
instead - double-click a navigation bar to display it.

Mouseover (Rollover) Buttons

You will have noticed that most buttons highlight as you move the mouse pointer over
them in your browser. This is called a mouseover, or sometimes a rollover effect. This is
all automatic for most buttons used in the templates or from the Button section of the
DESIGNS GALLERY.

For the more advanced user: this mouseover effect is created using Named Layers. In
fact the buttons are Soft Groups that consist of two styles, the mouse-off and the
mouse-over styles on separate layers. The Soft Group means that both layers are
changed at the same time when you do anything to the button, such as change the text,
or move or resize it. See the Layers (on page 61) section below for more detail.

Adding New Buttons

In the DESIGNS GALLERY, each Theme has a collection of button graphics that you can
just drag onto the page. Typically there are two types of button. The ones called Stretch
Button will elongate to accommodate the button label text.

In addition there is a Buttons category that has a set of general button designs that can
be added to your page in the same way.

Or you can copy any existing button - this is probably the best way for adding more
buttons to a navigation bar. You can copy / paste, but a much quicker shortcut is to drag
with the right mouse button held down. (This is a general shortcut to copy any object).
You can now just edit the text and link as required.

Tip: If you hold the "Ctrl" key while dragging it will constrain the drag to be perfectly
horizontal or vertical, making it really easy to create a row or column of buttons.
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Button Bars (NavBars)

Home Contact Travel Far East Africa Europe

Most websites, and so most of the template designs we provide, have a row or column
of buttons to navigate around the website or to other places. This is called a Navigation
Bar and Xara Web Designer 7 includes special support for these bars. To edit a havbar,
double click on it, or right-click and choose EDIT NAVIGATION BAR from the context menu.
The Navigation bar dialog opens. Here you can change the button labels, links and
tooltips, add and delete buttons, re-order and even add menus and sub-menus.

When you double-click on the URL field in the dialog, a Link dialog opens which is the
same dialog used to set links on normal objects, as described earlier in this chapter and
in detail in the Web Properties Dialog chapter. Because you can't apply a transition
effect to a navigation bar link, the Link transition controls are grayed out.

In the Navigation Bar Properties dialog you can also turn on the SITE NAVIGATION BAR
option. This makes your bar automatically appear on new pages you add to your site
and buttons/links are added to the bar automatically for each new page. However you
can’t edit your bar on canvas when this option is turned on — you can only edit it using
this dialog.

To update a navigation bar across all pages, if it's not an automatic site navigation bar,
just right click and choose REPEAT ON ALL PAGES. This will make the button bar a
repeating object and copy it from the current page onto all other pages.

Read the Navigation Bars Chapter (on page 248) for full details about Navigation Bars.

Drawing Tools

Web Designer provides all the graphics tools you need to create just about any
graphical object on your page, as well as a range of pre-designed graphical
elements in the Designs Gallery. There are four basic drawing tools that let you
create rectangles, ellipses, or any shape you like.

Web Designer provides vector drawing tools which means you can resize, edit the
outline shape and re-color with no loss of quality. You can zoom in to see almost infinite
detail, and all edits are undoable.

Current attributes (styles)

An ‘attribute’ is some characteristic of an object which you can modify in Xara Web
Designer 7. For example a shape’s attributes include its color, its outline width and its
outline color.

As mentioned above you can change the attributes of an object after you've drawn it, by
selecting it and then changing its fill color, line width, or any of its other attributes. But
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Xara Web Designer 7 also keeps track of the ‘current’ attributes, which are the attributes
that get applied to newly drawn objects as they are created.

Setting current attributes manually

If, for example, you want the next rectangle you draw to be red, make sure you have
nothing selected (press "Esc" or click an empty part of the page) and then click red on
the color line. You've now set the current fill color attribute to red. Now when you draw a
new shape, it will be filled red. You can set other current attributes the same way — by
first making sure nothing is selected before changing the attribute’s value.

Setting current attributes automatically

By default, Xara Web Designer 7 automatically updates the current attributes for you, to
match the object you last drew, or last selected. So for example if you draw a rectangle
and then make it green, the next shape you draw will also be green. If you have a blue
rectangle in your design and you wish to draw another one just like it, first select the
blue rectangle (this makes its attributes current) and then the next shape you draw will
also be blue. So by simply clicking an object, you set the current attributes to match that
object.

This allows you to use existing objects as a ‘palette’ of available styles. Click an object
to select it, then draw new objects in that style.

You can turn off this behavior in the General tab (on page 296) of the "Utilities" >
"Options" dialog. Select the Ask before setting current attribute checkbox. Now Web
Designer will ask you before changing the current attributes to those recently used.

Attribute groups

Many designs consist of a combination of closed filled shapes and open shapes (lines
where the start and end points are not coincident). Normally it wouldn’t be desirable to
have the attributes of an open shape used for a closed shape, nor vice-versa. Therefore
the attributes for open and closed shapes are kept separate — these are known as
attribute groups. Setting the values of one group does not affect the other group. So for
example, selecting a filled rectangle with no outline will not change the current line width
to zero for open shapes.

For the same reasons, text attributes make up a third attribute group. The text attribute
group is only set when you select text objects, or when you set the attributes manually
while in the text tool.

Exempt attributes

Some attributes do not get set as current automatically even when ‘Give new objects
most recent attributes’ is on. This is because some attributes can cause problems if they
become current.

Other attributes can adversely affect the way designs export, or significantly increase
the time taken to render the design and so should not be applied unnecessarily.
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Examples of attributes which are copied automatically:

o Fill colors, fill styles, line width, line color, line style, line join style, line endcap style,
arrow headsftails, text font, text font size, text margins.

Examples of attributes which are not copied automatically:
e Transparency, shadow.

Resetting current attributes

You can reset all current attribute groups instantly by pressing "Esc" when you have no
objects selected. If you have objects selected, pressing "Esc" clears the selection, so
just press "Esc" again to reset the current attributes back to their default values.

Shape Tool

B The SHAPE EDITOR TOOL allows you to create detailed vector based shapes, and

Bl also to edit the outline of any shape.

For preset shapes such as rectangles or ellipses, or if you want to edit the outline of
your text character shapes, you need to convert the object to an editable shape first.
You can do this by selecting the "Ctrl + 1" key shortcut. You can then use the SHAPE
EDITOR TOOL to perform various advanced vector editing. Refer to the reference section
(on page 127, on page 126) on how to use this very powerful tool.

Straight Line and Arrow Tool
/ﬂ The STRAIGHT LINE TOOL makes it easy to draw single segment straight lines
o and to add arrow heads and tails to any lines.

Simply click and drag on the page to draw a straight line. You can click on any existing
line to select it, and once selected you can click-drag on either end to move the end of
the line around.

Adding arrowheads and tails using the Straight Line tool

The infobar has two dropdown lists on the left which allow you to choose an arrow head
or tail style for each end of the selected line.

o Arrow head

Arrow tail
Arrow head/tail size

0 Reverse path

The slider on the infobar allows you to change the size of the arrow head and tail on the
current selected line. Or you can enter a percentage value into the size text field to the
right of the slider.
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By default new arrowheads are created with a width of around 6 times that of the line
width and that is taken as the 100% size, as indicated by the size slider. If you make the
line wider, the arrowhead width also updates accordingly. Therefore enter a value less
than 100% to reduce the size of the arrowhead (and tail), or greater than 100% to
increase. Although the slider only takes the size value up to a maximum of 800%, you
can enter percentage values larger than this into the size text field.

Reverse path

Press the Reverse path button on the infobar to switch around the head and talil
of the selected line.

Adding more line segments

Lines created with the STRAIGHT LINE TOOL are of course fully compatible with the other
drawing tools. So if you want to add more segments to a line, make it curved, or perhaps
even turn it into a closed shape, use the SHAPE EDITOR TOOL.

Rectangle Tool

To draw a rectangle, select the RECTANGLE TOOL and just drag across the page. n
You will see a solid filled shape as you drag across the page, indicating the fill
and line color and boundaries of the shape you are drawing.

Click the 'curved corners' button on the InfoBar to make this a rounded rectangle
- and you can drag on the curved corner handle to adjust the roundedness.

[ [ R,
You can drag on any corner handle to resize an object.

Drag and drop a color from the Color Line onto your shape to re-color it. See Coloring
Shapes (on page 31). With the SELECTOR TOOL you can drag it, resize it and rotate it as
required. See Selector Tool (on page 23). You can put this rectangle behind all other
objects as a background image, by pressing "Ctrl + B" for 'Put to back'. Alternatively if
it's in front of all other objects ("Ctrl + F") then you can right click on it and select REPEL
TEXT UNDER to make the text on your page repel around the outside of this shape
(another Web Designer first for any web authoring tool.)
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Fill Tool

<r/ You can easily put a graduated color fill onto a shape using this tool
(and a lot more besides). Select the tool and just drag across your
object.

The fill arrow can be adjusted by dragging the ends to alter the direction, angle and
extent of the graduation.

Rounded rectangle with a graduated fill.

Note: If you drag with the FILL TOOL across a grouped item, such as a text panel, then
everything in the group takes on the same fill style. To overcome this you must first
select just the item you want to fill. You can do this several ways. A single click on the
item with the FILL TooL will select just that item, as will a click in the SELECTOR TooL with
the "Ctrl" key pressed (this is called 'select inside' because it selects just the one item
inside the group). Now when you drag it will fill only the selected object.

To edit the start or color of the fill just drag and drop a color from the color line onto the
shape, or you can select the end of the Fill Arrow in the FiLL TooL and use the Color
Editor ("Ctrl + E").

You can create a multi-stage graduated fill by making sure the fill arrow is visible (select
it with the FILL TOOL), now just drag a color from the Color Line and carefully drop it on
the arrow line where you want the new color. You can now drag this fill point, or select
"Ctrl + E" to adjust the color using the Color Editor. There are different fill styles, for
example this is a circle with a circular fill.

The shadow is another ellipse with a graduated color fill and feathered (see below).
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Transparency Tool

=

Modern browsers support advanced transparency effects, and so does Web Designer.
You can adjust the transparency of any graphic or photo to make it see-through. Try it
on your rectangle example. Just select the TRANSPARENCY TOOL, and adjust the large
slider on the InfoBar.

More than this, Web Designer supports graduated transparency. It works very like the
graduated color fill. In the TRANSPARENCY TOOL just drag across your shape and you can
see the transparency fades. You can adjust the degree of transparency of each end of
the fill arrow, by clicking on either end of the arrow, and adjusting the Transparency
slider.

Preview this and you'll find this works in your browser as well.

Shadow Tool

A very popular graphics effect is to create a soft drop- shadow under a graphic or some
text. This serves to lift the object away from the background.

The sHADOW ToOL lets you add a soft shadow to any object, text, graphics or
photo. Select the sHADOW TooL and just drag on the object. You can adjust the
shadow blur and transparency using InfoBar controls.

Some text with a soft shadow.

To adjust the position of an existing shadow, go into the sHADOW TooL and drag on the
shadow

Advanced note: Note that because a shadow itself is semi- transparent (part of the
objects below show through the shadow) objects with shadows are converted to PNG
images when saved on a web page (it's the only image format that supports
transparency). PNG images can be quite large, especially for photos. It's perfect for
images such the above shadow graphic.

You may find you can convert the whole graphic to a JPEG to save space. Whether this
works or not depends on what's behind the shadow. If it's a plain or static non-text
background you can probably use a JPEG which is a much smaller file size (quicker
website download). To force an object to be a JPEG use the Image tab of the Web
Properties dialog.

JPEG images cannot have semi-transparent parts, so when creating a JPEG of a semi-
transparent object Web Designer includes the background (what's behind the semi-
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transparent part) as part of the JPEG image, but because of the pixel perfect positioning
on the web page you can't tell this. This doesn't work if the shadow or semi-transparent
object is placed over some text, as the text will be included as part of the graphic.

Example Graphics

This is a perfect example of what can be created in Web Designer. This button
combines many of the features described above - it's drawn by combining just a few
feathered shapes, and using graduated transparency (the white reflection effect). The
text has a slight soft shadow and the button has a glow shadow. The whole thing is
grouped. (You do not need to draw this button as it's provided in the Button category of
the DESIGNS GALLERY).

The huge benefit of vector graphics, compared to 'bitmap' graphics created in pixel
editing software such Photoshop, is that you can re-color, edit, rotate, and resize the
button with no loss of quality. Make it huge and it remains pin sharp:

On top of that you can re-color using the Named Color system, and it will even stretch
as required - everything in Web Designer remains non-destructive (which means you
can always edit it, with no loss of quality).

Something that would take skill and time to produce using alternative graphics software,
is trivially easy in Web Designer.

Right-click menus

When you right-click any object in the Xara Web Designer 7 workspace, a drop-down
menu lists useful operations that are relevant to the object clicked on. For example, if
you right-click a rectangle you've drawn previously, the drop-down menu allows you to
perform actions only relevant to a rectangle.

If you right-click a photo, however, some of the menu options that appear apply only to
photos, while others are similar to the actions you can perform on a rectangle. The
object-specific operations are listed towards the top of the right-click menu's list, e.g., in
the case of a rectangle the first three actions above apply only to rectangles.
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You can also right click both the page and pasteboard to see a menu of page- and
pasteboard-related operations you can apply.

If you select more than one object and right-click, the menu lists actions specific to
multiple objects, such as group, align and combine, as well as the common operations
such as cut, copy and delete. Similarly if you right-click objects that you have previously
grouped, actions specific to a group are displayed.

It's recommended that you right-click any object or multiple objects in the workspace to

access the menu specific to those objects. Once you've done this a few times you will
know which actions you can quickly perform with right-click menus.

Layers, Mouseover (Rollover) & Pop-ups

As mentioned earlier all objects have a stacking order on the page - from the backmost
to the frontmost item.

Backmost

These objects are stacked over each other.

In addition, all items can be placed into named layers. Each layer can have any number
of objects, and has the ability to be turned on or off. When the layer is turned off all
objects on that layer become invisible.

The layers are controlled from the PAGE & LAYER GALLERY in the Galleries bar.

In Web Designer layers are used to provide mouseover (sometimes called rollover)
features on your website. These include highlighting buttons (they highlight when you
move the mouse over them) and also other pop-up effects such as text panels
containing a detailed product description.
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Mouseover Effects

There are two types of mouseover effect you can control. Firstly the one used by
mouseover buttons, where any object with a web address can display an overlapping
graphic object that appears on a layer called MOUSEOVER. See below for more detail.

There is a more powerful mouseover ability where you can make the contents of any
layer appear as your mouseover, or click any object on your page. This pop-up layer can
contain text, graphics, photos or any combination of these things. More below.

The MouseOff and MouseOver Layers

All the main objects on your website are placed on the bottom layer, usually called
MOUSEOFF. Buttons that highlight when you move the mouse over them on the web page
have an alternative graphic on the layer called MOUSEOVER.

Page & Layer Gallery

New layer Properties... Pages

Duplicate Delete Layers

"

= Popup layer
= MouseOver @
2 MouseOff L S Bt S

If you open the PAGE & LAYER GALLERY you can show or hide any layer by checking or
un-checking the visibility icon (the eye symbol). This is a way of showing what your
MouseOver elements will look like on your page.

The current layer is always highlighted in the PAGE & LAYER GALLERY - the MouseOff
layer in the above diagram - and this is the layer that all new objects are drawn on. To
place objects on any other layers just click the required layer in the PAGE & LAYER
GALLERY, ensure the eye and the lock icon are open for that layer.

Note: The MouseOver layer must always be above, that is on top of, the MouseOff
layer, as shown in the above example.

To edit the objects on a layer both the 'eye’ and ‘'lock’ icons have to be open - this means
you can see and edit the layer (as shown above in the MouseOff layer).

Mouseover (Rollover) Buttons

Almost all the ready-made buttons from the DESIGNS GALLERY have a mouseover effect
in Web Designer. These are created by having two versions of each button, the main
one on the MouseOff layer and a 'highlight' one on the MouseOver layer.
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Normally you do not need to know or care about this because both buttons behave as
one - the changes you make to one, such as editing the label text, are reflected on the
other version. If you move, drag or resize a button on the MouseOff layer, the other
version on the MouseOver layer will change as well, even if you can't see it. This is done
using Soft Groups (on page 117, on page 50).

Creating Your Own Mouseover Buttons

You can create your own mouseover buttons from scratch by drawing the necessary
elements from rectangles, text, etc. Just draw the main parts of the button on the
MouseOff layer (remember to group it (on page 49)) and place the corresponding
'highlight' version on the MouseOver layer. As long as the MouseOff version has a web
address link, then the MouseOver version will automatically be displayed as you move
the mouse over it on the web page. (The MouseOver layer must be on top of the
MouseOff layer).

In other words, you give the main object a web address using the link option, and
then select the MouseOver Layer in the PAGE & LAYER GALLERY, and place the
required mouseover versions of your button on this layer so it overlaps the linked
object.

Technical note: Any graphic object on the MouseOver layer will be displayed as long
as at least 50% overlaps with the object on the MouseOff layer. The two versions of
mouseover buttons are kept in sync by using the Soft Groups feature. When you select
the button on one layer, it automatically selects the Soft Grouped version on the other
layer, even if the layer is switched off. When you edit the text of the button on one layer,
it's automatically synced with the other version of the button.

To ensure the text on both the Off and Over states changes when you edit either, Soft
Group the buttons on both layers. To do this you will need to enable both layers in the
PAGE & LAYER GALLERY, and lasso select around both buttons. The status line should tell
you if you have everything selected. Select "ARRANGE" > "APPLY SOFT GROUP". Now
when you edit the text on the Off layer it will also change on the over layer, even if it's
hidden. (Note this only works if the Off and Over text are the same to start with, and
relies on the objects being Soft Grouped).

Once you have a working button, you can easily turn it into a navigation bar. Select the
button (along with its MouseOver state if it has one) and then choose "ARRANGE" >
"CREATE NAVIGATION BAR". The navigation bar dialog appears allowing you to configure
your bar. See the Navigation Bar chapter (on page 248) for more information on this,
including how to have different first and last buttons in your bar.

Layer ordering in website documents

If your website document has mouseover effects, popup layers and perhaps even
mouseover effects on those popup layers, there are some important rules you need to
follow in terms of how you order the layers in your document. If you don't follow these
ordering rules, you may find that some of the effects don't work.

Considering the layers in turn from background to foreground (which is working upwards

in the PAGE & LAYER GALLERY), first you must have all the static layers. These are layers
which are always visible and are not used as popups. In most designs there will only be
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one — the "MouseOff" layer. But some designs may have several, in which case they
must be the first layers in the layer stack.

Next comes the MouseOver layer, if there are mouseover effects on the static layer(s).
This contains the mouseover states for all your mouseover buttons. This must be
followed by the "MouseDown" layer, if you have mousedown effects on the static
layer(s).

Next you may have a popup layer. If the objects on this popup layer have mouseover
effects, then the next layer following the popup layer must be the layer holding those
effects. It must have a name that begins with "MouseOver", E.g. "MouseOverPopupl".
And then if the popup layer also has mousedown effects, a layer whose name begins
with "MouseDown" must follow containing those effects.

Then you can have another popup layer, followed again by any mouseover and
mousedown layers for that popup layer. And so on - you can have as many popup
layers as you like.

So to summarise the above, in general the layer ordering needs to be as indicated by
the following list, which is shown in the same order as displayed by the PAGE & LAYER
GALLERY (foreground to background). All layers are optional and the layer names can be
anything you like, except for the characters shown in Bold, which identify the special
mouseover and mousedown layers.

MouseDown popup n
MouseOver popup n
PopUp layer n

MouseDown popup 1
MouseOver popup 1
Popup layer 1
MouseDown
MouseOver

Static layer n

Static layer 2
MouseOff

Note that you only need to be concerned with these ordering rules if you are building
complex pages with multiple popup effects! If you are just using the template designs
provided in the DESIGNS GALLERY, you should not have any problems with layer ordering
on your website.

Moving Objects From One Layer To Another

You can cut an object (Ctrl+X), select a new layer (click on its name in the Page & Layer
Gallery) and Paste (Ctrl+V) or right click a page and choose PASTE > PASTE IN CURRENT
LAYER.

A useful alternative is called PASTE IN PLACE (Ctrl+Shift+V), or EDIT -> PASTE -> PASTE IN

PLACE IN CURRENT LAYER, which will paste it at exactly the same position you copied it
from. Or you can use the Page & Layer Gallery and drag an object from one layer to
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another. You need to ensure the two Visible and Editable check boxes are checked in
order to see and edit the object on the new layer.

Pop-up Layers

A more powerful alternative allows you to display the contents of any layer as a result of
mousing over, or clicking, any object. This can be used for a range of different pop-up
effects such as pop-up photos, menus or detailed object descriptions.

To do this, place all the objects you want to pop-up on a new layer (in the PAGE & LAYER
GALLERY click NEw while you have a layer selected - don't use the MouseOver layer),
then set the Mouseover property (MOUSE-OVER tab of the Web Properties dialog) of the
original object to trigger the display of this layer when you mouseover any other object.
For example you can make a pop-up, like this, appear as you mouse over some text:

This is 8 pop-up that appears as
you mowve ower the highlighted
word. This a great way of adding
more details or an explanation of
a feature, or product, without
cluttering the main Window

8

This is some text with a pop-up on some highlighted text

s

Here are the steps to create a pop-up text block like this:

1. Click NEw in the PAGE & LAYER GALLERY, While you have a layer selected, to create
a new layer.

2. Draw a rounded rectangle with the RECTANGLE TooL, click a (pale) color patch on
the cOLOR LINE to give it a fill color. For good measure give it a soft shadow (select
the sHADOW TOOL and just drag on the rectangle).

3. Create a block of text on top of your rectangle. Select the TEXT TooL and drag
diagonally across the rectangle. Type your text. You probably want to hide the pop-
up layer now, so just un-check the 'eye' checkbox of your new layer.

4. Back on the base (MouseOff) layer (click it in the PAGE & LAYER GALLERY to set this
as current layer) now select the text you want to trigger the pop-up, using the usual
method (in the Text tool). Then open the Web Properties dialog (right click and
choose Web Properties or press "Ctrl + Shift + W") and on the MOUSE-OVER tab
select the new layer from the sHow POP-UP LAYER drop-down menu. Click oK.

5. Preview and test your mouseover effect.

If you want the pop-up to only appear when you click, then select the same option on the
LINK tab of the same Web Properties dialog instead.

Note: The mouseover layer appears and disappears as you move the mouse pointer on
and off the triggering object. If you use a click method to display the layer (from the Link
dialog), then the layer is revealed by a click on the object, and is hidden when you click

anywhere else on the page.
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Pop-up Photos

There is a second, easier, way of showing enlarged photos from thumbnails, that does
not involve creating new layers. See the Photo section (on page 41) earlier in this
chapter. This method is better for when you have large pop-up photos as the pop-up
photos are not loaded until the thumbnail image is clicked.

Creating Buttons, Banners And Other Web Graphics

Web Designer is great tool for creating any standalone web graphics for use with other
programs or other web authoring tools. You can draw these objects from scratch using
the drawing tools, or use ready-made web clipart from the DESIGNS GALLERY. Just draw,
design or import an item from the DESIGNS GALLERY onto a blank page. Manipulate this
as required - size it, color it and change the text or fonts as required, and then export the
item as a PNG or JPG.

For example this is how to create a standalone button graphic from a template:

Open the DESIGNS GALLERY and then the Web Button category (or Icons or
Banners - whatever category you require).

fuaeb subisaq IF

Double click on a design to open this in a new document. Edit this as required e.g. you
can:

¢ Resize it (or rotate) it using the SELECTOR TOOL

e Change the color by clicking on the appropriate colors on the left end of the Color
Line and choosing ‘edit'

e Change the text with the TEXT TOOL

When you're happy, select the object and export it as a PNG  FEGrE[IN =i}
or JPG using the buttons in the Website bar (these are on a L
flyout bar on the Export HTML icon).

For almost all graphics, such as buttons, headings, icons and other non-photographic
objects you should use PNG format. For items that contain photos or that have large
textured parts made from photos, then JPEG is a better format. If you're saving a rotated
photo, or one with a soft shadow, or soft edge, then this should be in a PNG format, but
be warned this will be a lot larger file than JPEG.
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If you click the SeTTINGS button in the Export file dialog you can access an advanced
control panel that lets you optimize the image.

JPEG Export Bitmap Options
(41%) SELECTED

Palette Options ~ Bitmap Size  Options  Image Map = Browser Preview

B Proar

JPEG Quality
0 100

Here you can compare side-by-side two different versions of the same image. For
example you can compare a JPEG against a PNG version of the same graphic to
compare the quality and / or file size, or you can compare two differently optimized PNG
images. Refer to the reference chapter on the Export dialog (on page 288) in the pdf
manual. The in the above example the JPEG compression is being adjusted to produce
the optimum file size.

Publishing Your Website

You will need a web hosting company to host your website. Quite often your existing
Internet provider will include 'web space' as part of your normal subscription. The dialog
shown below also contains suggested hosting solutions in its PROFILE list. Most
companies also offer the ability to purchase your own domain name (e.g. like
www.xara.com) and have this set to point to your web pages.

You require three bits of information in order to publish your website;

e The FTP Host Address. If you have a domain name this is often the same as your
domain name. If you choose one of the standard hosting options in the profile list this
field will normally be set for you automatically.

e An FTP username

e And associated password
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Simply enter these details into the PuBLISH tab of the WEB PROPERTIES dialog.

Profiles

FTP Details

To allow you to publish your websites directly from this
program enter the details required to connect to your web
space using FTP. Get this information from your ISP.

FTP host address: ftp.webhoster.com

FTP username:

Enter password here only if you want it to be remembered
on this computer, Otherwise you will be asked for the
password each time you publish.

FTP password:

Sub-folder (optional): /sitell

The website URL is optional, but required if you want your
website to include a sitemap or be included in the user
ga”er‘j.

Website URL:

M Include my website in the user gallery More Info

Other settings
Re-publish changed files only

The optional Sub-folder lets you publish your website into a sub-folder. e.g. if you're
publishing to the xara.com domain (of course you can't do this) and want the web
address to be;

xara.com/products/web_designer

Then you'd set a sub-folder to be 'products' and the page name of 'web_designer'. If you
set a sub-folder this way then all the pages in your website will be published to this
folder.

E Once you've set your Publish details, you can then click the PuBLISH icon on the
top bar (on the Export HTML flyout bar) or use menu "FILE" > "PUBLISH

WEBSITE".
(Note: you must have exported your website first.)

Your website will be published. A progress bar will show you the progress of the upload
of the pages to the web server.
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The details you enter into the FTP DETAILS section of the dialog are associated with the
current document.

See the Web Properties Dialog chapter (on page 214) for full details on how to use this
dialog.

Note: Many web servers use case sensitive filenames. So, for example, the web
address xara.com/products.htm is not the same thing as xara.com/Products.htm. To
reduce confusion and the likelihood of errors Web Designer enforces that all page
names are all lower-case and contain only allowable characters. This means that
spaces are not allowed in page names. We suggest using an underscore as an
alternative separator.

Important: If you have not set any specific page name, then the name you exported to
last will be used for all the pages in your website. E.g., if you open a template website,
and export this as 'test' to your file system, and now publish this, it will be published as
test.htm to your web server, and all additional pages will be test_2.htm, test_3.htm etc.

If you have not set an export filename, when you first publish you will be asked to enter
a filename. index.htm is the usual name for the first page of a website.
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Starting Xara Web Designer 7

To start Web Designer:

Choose Start -> All programs -> Xara -> Xara Web Designer 7.

P Or double click the Xara Web Designer 7 icon on your desktop

CI/“

(shown left).

Xara Web

Designer 7

This may vary depending on which version of Windows you are using.

Starting a new document

Primarily, there are two different types of documents in Xara Web Designer 7, i.e. web
page and photo. To start a new document:

Choose "FILE" > "NEW"

This opens a sub menu with several pre-defined template documents to start from.

=l Edit Arrange Utilities Window Help

Strg+N

Strg+0

Blank photo

Sty g+'w

The first template is the default and is used to create a new document after starting Xara
Web Designer 7.

The NEW DOCUMENT button on the Standard control bar creates a new
document using the default template (shortcut "Ctrl + N").

You can save your own templates with the "FILE" > "SAVE TEMPLATE" command — see
"Changing the template document (on page 294)" for details.
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Opening an existing document

To open an existing document:

e Drag & drop a file. Select the file in Windows Explorer or on your desktop, and drag it
over an existing open document to import it into that document, or any other part of
the Web Designer window to open the document.

e Or double click a Web Designer file.

e Or to open a recently used file, select it from "FILE" > "OPEN RECENT"

e Or select "FILE" > "OPEN" (shortcut "Ctrl + O").

e Or click the oPEN button on the standard control bar.
=

The open dialog will be displayed. The dialog allows multiple file selection, "Ctrl + click"
to select several files or "Shift + click" to select a range of files.

E As in Explorer windows, you can switch the file display to a detailed or thumbnail
view with this button

If sHow PREVIEW in the upper right corner is checked, the selected file is shown in an
even bigger preview (this does not work for a multiple file selection).
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The Xara Web Designer 7 window

W Xara Wew Designer 7 - [holiday wessitel.web *] 13

File Edit Apange

Raid M R 3

Hete
v O CED () B S
5 o 1@ angle 2
ppin wibhEwe:

holiday_websitelweb * X

home products store news gallery contact blog about

Nulla fugiat proident in veniam reprehenderit eiusmod. Irure et, aute esse

ullamco lorem do proident excepteur proident. Excepteur, proident nisk

Pariatur in minim veniam reprehenderit dolor ut aliqua. Pariatur occaecat in
aliqua ex fugiat consectetur in duis ea eu.

Cupidatat nulla aliqua aliquip cilum excepteur dolore in = :

SEEP= o

P
LR
Nothing selected: 11

Title bar

File name for currently displayed file
Standard button bar

Galleries bar

InfoBar

Toolbar

Rulers

Page

Pasteboard

Color line

Status line

Live drag / snapped indicators
Web toolbar

060868000 000000

Document tabs for every open file
The Web Designer window is similar to a conventional sheet of paper on a drawing

board or easel. The white rectangle represents the sheet of paper (the spread or page).
The gray border is the pasteboard.
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You can change the size of the page by right clicking it and choosing PAGE OPTIONS,
then click the PAGE si1zE (on page 300) tab.

Selected document and title bar

You can have more than one file open at a time in Web Designer, which displays all
open documents as tabs at the top of the workspace.

The current document is displayed in the workspace and its name is highlighted gray in
the document tabs. The current document type is indicated in the top left corner of the
Web Designer window, next to the menu options. The current document receives all
input. Any unsaved changes in a document are indicated with a star after the file name.

N shopping_website.web X Jio] hol photos.jpg (from web file) X

Document tabs show all open documents, with the current document tab highlighted gray.

Control bars

These contain buttons that you can use to operate Web Designer. You can customize
control bars in several ways, such as re-ordering, creating, and hiding bars.

The default window shows the standard button bar with commonly used buttons:

s

You can customize the standard control bar in the same way as other control bars.

Those icons with a triangle indicator in the bottom right corner have "fly-out bars" on
them. Hold the mouse pointer over these icons and you’ll see the fly-out bar appear,
with more icons.

For information on customizing control bars, refer to "Customizing Web Designer (on
page 301)".

InfoBar

This is a special control bar. Its contents change when you select different tools.
InfoBars specific to certain tools are described in their relevant chapters.

You cannot customize the InfoBar.

The InfoBar for the Selector Tool
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Main toolbar

This is a control bar that initially contains all the tools available in Web
Designer (see left). You can customize the toolbar, or move tools to other
control bars.

Some of the toolbar icons have a small triangle indicator in the bottom right
corner. This indicates that there is a flyout bar containing more tool icons. Hold
your mouse pointer over the icon to see the flyout bar appear. You can then
move the mouse pointer over each icon in the bar to see a tooltip indicating
what each one does.

Click on a tool to select it (some tools have keyboard shortcuts, t0o).
For information on customizing control bars, refer to "Customizing Web
Designer (on page 301)".

Rulers
You can hide the rulers, change their zero point (origin), and
use them to create guidelines. For more information, see
Rulers (on page 86).

The status line

1 line: Click to select only this point handle; Drag to move; Shift-Cli

o Selected objects

e Available options

© Indicators

9 Mouse pointer X-Y

This appears at the bottom of the window. The status line tells you about the selected
objects, available options, live drag/snapping indicators, and the X/Y position of the
pointer.

The indicators

These appear on the right of the status line:
"k Live drag indicator
This indicator shows whether live drag is active or not (it is active by

default). Double click the indicator to toggle live drag on/off. When
active, if you reposition, resize, or rotate an object, the whole object
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moves (not just an outline), making it far easier to judge the effect of
your edits in real time. Drawing in the STRAIGHT LINE, RECTANGLE
and ELLIPSE TOOLS is also live with this option on. If your computer is
unable to cope with a particularly complex document, it will
automatically turn active drag off to ensure editing remains fast and
efficient.

) Snapped indicator
This indicator is active when Snap to objects is enabled (by default
7 in web documents - click the sNAP TO OBJECTS button (shown on the
nr

lower left) to toggle off and on. Snap to objects allows you to see
potential snapping paths and points relative to other objects and the
page center and edges by showing blue snapping lines for snapping
paths and red dots for points as you drag an object. For more
information on snapping, refer to "Object Handling (on page 114)".

X/Y co-ordinates

Web Designer shows measurements relative to the bottom left corner of the page area
or spread. However, this is configurable. For more information refer to "Object Handling
(on page 97)".

Normal/full screen modes

In normal screen mode part of the window is occupied by the title bar, menu bar, and
scroll bars. This can be inconvenient if you want the maximum possible editing area.
Web Designer has a second screen mode, fullscreen, which displays a more
streamlined screen. You can configure each screen mode as you wish. For example,
each can have its own configuration of the control bars. The configuration is
remembered and applies whenever you swap between screen modes.

Normal/full screen is controlled by "wiNDow" > "FULL SCREEN" or right click and choose
FULL SCREEN ("8" on the numeric keypad).

To display the menu bar in full screen mode, move the pointer to the top of the screen.

Opening a second window

You may want to open a second window onto the same document to:

e Get an enlarged or reduced view of the document;

e Show another part of the document;

¢ Have two views of the same area at different quality settings (quality settings are
described later.)

Choose "wINDOW" > "NEW VIEW" to open another window. You can have several
windows open on the same document.

Selecting which window to display

Each window that you have currently open is displayed as a tab below the infobar. Click
on a tab to display the window or click on the wiNnDow menu and choose a window name
at the bottom.
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Ordering multiple windows

"WINDOW" > "ARRANGE VIEWS" helps you organize multiple windows. Each window has its
own title bar but no control bars. Click on a window to make it the current window.
Pressing "Ctrl + F6" steps through the windows in sequence.

ARRANGE VIEWS displays the windows arranged vertically or, for more than three
windows, as tiles.

Minimizing multiple windows

Minimizing one of several windows displays an icon on the background of the main Web
Designer window. Double click the icon to reopen the window.

Changing the zoom value

It's often useful to enlarge your view of the document to examine details or reduce your
view to get an overall impression. Scalings above 100% show an enlarged view (similar
to looking through a magnifying glass); below 100% a reduced view. The only change is
your view of the document; the size of the document itself and the objects in it are
unchanged (changing the document size is described later). To change the zoom value
you can use either the zoom TooL, mouse, or control bars.

Some shortcuts are available for quick setting of zoom values: The plain numeric keys
(1, 2, 3, 4) set the zoom to between 100% and 400%. The number 5 key sets it to 50%.

Using the Zoom Tool

To zoom:

e Select the zoom ToOL from the Main Toolbar.

o Or press "Alt + Z" to toggle between the current tool and the zoom TooOL.

Or press and hold down "Alt + Z" to temporarily swap to the zoom ToOoL (release "Alt +
Z" to return to the previous tool).

e Or press "Shift + F7" to select the zoom TOOL.
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Changing the zoom value using the mouse

If you have a mouse wheel:
e Hold "Ctrl" and scroll your mouse wheel to change the zoom level.

You can also configure a mouse button to zoom in or out. Furthermore, you can change
the mouse wheel action between scrolling and zooming in "UTILITIES" > "OPTIONS" >
"MOUSE TAB (ON PAGE 299)" or right click and choose "PAGE OPTIONS" > "MOUSE" tab. The
opposite action is available then by pressing "Ctrl".

Alternatively, select the zoom ToOL, and

e Click to zoom in (enlarge).

e "Shift + click" to reduce the zoom value (to see more of the document).

e Drag the mouse diagonally to create a rectangle. When you release the mouse
button, the area within the rectangle is enlarged to fit the window.

Changing the zoom using the zoom InfoBar/control bar

There is a flyout bar on the standard toolbar which gives you quick access to zoom
functions, without having to go into the zoom TooL. There is also a flyout bar on the
ZOOM TOOL icon on the main toolbar.

Hold the mouse pointer over the zoom icon on the standard toolbar to see the
=l flyout bar.

To change the zoom:

(@ Shortcut "Ctrl + R". Click the PREVIOUS zOoOM button. This is the zoom value
aimal before the current setting. Using this button lets you flip zoom in and out on the
document. This is useful for switching between examining an area in detail and
an overall view. The previous zoom value is stored for each window. You can
swap between windows and the previous zoom values are retained.

J©f Shortcut "1" Click the Zoom to 100% button. The zoom factor is changed to
e 100%.

@J Shortcut "Ctrl + Shift + J". Click the zoom TO DRAWING button. The window
shows all the objects in the document.

Shortcut "Ctrl + Shift + P". Click the ZooM To PAGE button. The window shows
/ the entire page or pair of pages.

Shortcut "Ctrl + Shift + Z". Click the zoom To SELECTION button. The selected
object or objects fill the window.

Type a value into the text box. Press ".J" to implement

=, 100% the change, or select preset zoom values including those
—r above (page, drawing, selected, previous) in the drop-
down menu.
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Sliding the document within the window

The quickest and easiest way to move around the document is to use the middle mouse
button (normally the mouse wheel) if you have one. Click and hold the middle button
down and then move the mouse. Release the button to return to your previous tool.

To move the document within the window you can also:

¢ Use the scroll bars and arrows at the side of the window.
e Use the mouse wheel to scroll the document up and down ("Shift + mouse wheel" for
left and right)

m ¢ Or select the pusH TooL from the main toolbar ("H").

e Or press the space bar or "Alt + X" to toggle between the current tool and the PusH
TOOL.

e Or press and hold down the space bar or "Alt + X" to temporarily switch to the PUSH
TooL (release key(s) to return to the previous tool). You can then use the mouse to
drag the document around in the window.

The PUsH TooL InfoBar is the same as the zoom TooL InfoBar (described above).

Displaying the scroll bars is optional. Choose "WINDOW" > "BARS" > "SCROLLBARS" t0 turn
them off.

You can change the mouse wheel action between scrolling and zooming in "UTILITIES" >
"OPTIONS" > "MOUSE" or right click and choose "PAGE OPTIONS" > "MOUSE". The opposite
action is available then by pressing "Ctrl".

Changing the page size

When you open a new Web Designer document, the page size is 760 x 700 pixels (SVA
web page). However, you can change the page size if required, e.g. to support other
screen resolutions such as VGA.

1. Choose Menu "UTILITIES" > "OPTIONS" or right click a page and choose "PAGE
OPTIONS".

2 If necessary, click the PAGE SIZE tab.

3. Choose the required page size.

If you select cusTom in the size selector, you can set a custom width and height in the
fields below it.

Every page in the document (exported website) can have a different size. With the

option ALL PAGES IN WEBSITE THE SAME SIZE you will set the page size to the same value
for all pages in the document.
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You can resize the height and width of the page by dragging the
lower and right border of the page with the selector tool.

mn |

Multiple pages in the document

A Xara Web Designer 7 document can have multiple pages. Each page is exported to a
separate HTML page and so each document in Xara Web Designer 7 corresponds to a
website.

By default when you open or create a new web document, Web Designer shows only
one page. Print documents however are displayed in multiple page view by default.
Right click a page or its pasteboard and select/deselect MULTIPLE PAGE VIEW to toggle
between display modes.

The current page

If you click a page in a multi-page document it will become the current page.

The current page is relevant when inserting, duplicating, or moving
pages as described in the following sections.

The current page in the document is shown by indicators on the
page’s corners.

Inserting pages into your document

Right click a page and choose NEW PAGE Or NEW DOUBLE PAGE SPREAD. A new blank
page is inserted after the page.

or

Right click a page and choose DUPLICATE CURRENT PAGE Of DUPLICATE CURRENT DOUBLE
PAGE SPREAD. A duplicate of the current page is inserted after the page.

The new page will be the
same as the original page,
including its size and
orientation, and will include all
its content so that you can
use it as a template for new
content.

You can also use the Menu
items under "EDIT" > "PAGES"
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In addition, the standard toolbar has a flyout bar which allows you to add, duplicate and
delete pages quickly.

Hold the mouse pointer over each icon in the bar to see a tooltip for each available
operation. You can add a new blank page, duplicate the current page or delete the
current page.

Moving pages within the document

If you wish to move a page’s location within the document page order you can do so.

To move the current page:

e Choose "EDIT" > "PAGES" > "MOVE PAGE UP" or right click and choose MOVE PAGE UP to
swap the current page with the one previous to it.

e Choose "EDIT" > "PAGES" > "MOVE PAGE DOWN" or right click and choose MOVE PAGE
DOWN to swap the current page with the one after it.

These menu options will be grayed out of if you are on the first or the last page of the
document respectively.

Removing pages from your document

To delete the current page from your document right click and choose DELETE CURRENT
PAGE Or select "EDIT" > "PAGES" > "DELETE CURRENT PAGE". The current page and all its
content will be deleted.

Navigating between pages

As well as the usual methods of moving through your document (such as scrollbars and
the mouse wheel), there are also some other ways to navigate through the pages:

Page up: Moves up the document. The amount moved depends on your zoom level.
The further you are zoomed out the bigger the move.

Ctrl + Page up: Go to and center on the previous page.

Page down: Moves down the document. The amount moved depends on your zoom
level. The further you are zoomed out the greater the move.

Ctrl + Page down: Go to and center on the next page.

Or click the up or down arrow on the status line: Page 2 of 9

The status line is also useful for knowing what page(s) you are currently viewing.

Note: All of these movements are relative to the page you are viewing, not the current
page.
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Page & Layer Gallery

You can also use the PAGE & LAYER GALLERY to conveniently manage the pages in your
document. It allows you to view, add, duplicate, delete, re-order and rename pages all
from a single view.

By default the PAGE & LAYER GALLERY is open on the right of the Web Designer window
in pages mode, only displaying pages (rather than their contents) with a thumbnail for
each page of the current design. Click on a thumbnail to go to that page.

For more information see PAGE & LAYER GALLERY (on page 270).

Saving the document

This section covers saving in Web Designer’s own format (native format). Refer to
Importing and Exporting (on page 281) for details of exporting in other formats.

We recommend that you always save documents regularly. A complicated document
may represent many hours of work and power failures or computer crashes always
happen at just the wrong moment. Make sure you have the automatic backup facility
turned on, so that regular backups are taken of your open documents as you work. See
the Automatic Backups (on page 83) section below for details.

Save option (on the File menu)

igi ("Ctrl + S", or click the sAVE button on the standard control bar.)
™

This provides a quick way to save a document using the same file name. The option is
disabled unless the document has unsaved changes, i.e. you have made changes, but
haven't saved them to disk.

For a new document that has not been saved to disk, this option acts like "Save as"
(described below).
Save as (on the File menu)

This opens a dialog box letting you save the document under a different name or to a
different directory. This option is useful for making backups of Web Designer
documents.

Save all (on the File menu)

This acts like a series of SAVE or SAVE As commands to save all currently open files.

Support folders

Some documents which are used to create websites need to reference external files
which cannot be embedded in the .xar design file. For example you may have a Flash
(.swf) file which is used on your website and so you’ll want to keep that file with the
design file because you can’t export a fully working website from the design file without

www.Xara.com



82

Document handling

also having the Flash file. And if you were to send the design to someone else, or move
it to another computer, you'd want the referenced Flash file to go along with the main
design file.

So Xara Web Designer 7 uses an optional “support folder” right alongside the design file
to hold these important external files.

Support folder naming

The design file and its corresponding support folder are tied together by their names.
The support folder for “mySite.xar” is always “mySite_xar_files”. This naming convention
makes it obvious which support folder belongs to which design file. So if you rename,
copy or move a design file, always remember to do the same to the corresponding
support folder, if it exists! And if you send a design file to someone else, send any
support files folder along with it.

If you load a design that has a support folder, and then subsequently do a SAVE As to
save another copy of that design, Xara Web Designer 7 will copy the whole support
folder too, if there is one.

Support folder contents

When you use the Placeholder Tab (on page 211) of the Web Properties dialog to insert
a reference to an external file into your website design (using the Browse buttons), Xara
Web Designer 7 will automatically copy that file into the design’s support folder for you.
If the support folder doesn’t already exist, it will be created.

Note that if you subsequently change a placeholder object to reference a different file,
the original file will not be automatically deleted from the support folder. So if a file is no
longer needed, you need to remove it manually.

You can also manually copy any files you like into the support folder of a design,
creating the folder manually if required. Xara Web Designer 7 will never delete any files
from it, whether or not they are referenced from the corresponding design file. The
reason for this is that there are many different ways in which a design may reference an
external file. For example you may insert a complex piece of HTML code into your
design, which somewhere references an external file which you’ve placed in the support
folder. Or perhaps one of the external files references another external file! There’s no
way that Xara Web Designer 7 can be sure that a file is not used by the website, so it
never deletes files.

Exporting websites with support folders

When you export a website document, any files in the corresponding support folder are
copied to the folder which contains all the generated images for your website. So if you
export “mySite.xar” to “index.htm”, then any files in folder “mySite_xar_files” are copied
into the “index_htm_files folder”.
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Closing the document

To close the document:

e Choose "FILE" > "CLOSE".
e Or press "Ctrl + F4", or "Ctrl + W".
e Or click the smaller, lower X of the two in the top right hand corner.

Automatic Backups

Xara Web Designer 7 will optionally save regular backup copies of your open
documents while you work. This helps you avoid losing your work in the event of a
power failure or other abnormal program closure. It's also useful if you decide to return
to an earlier version of your document, should you want to do so.

To turn automatic backups on or off, open the "uTILITIES" > "OPTIONS" dialog and choose
the BACKUPS tab.

Tune-ups Units View Backups

Automatic back Ip ophions

h,l_lp open doc

open docume
 on Program sta

Backup location:
G:\Dokumente und Einstellungen'R 3 Browse. ..

Keep revision[s) of each document

Backup open documents

To turn backups on select this checkbox and choose how often you would like backups
to be taken. The suggested period is 10 mins, which means each open document will be
backed up if it's more than 10 mins since the last backup of that document was taken (or
since the document was created or opened).

Note that once the configured period since the last backup has expired, the next backup
is only saved when the program has been idle for at least 15 secs. This is to avoid
interrupting your work as much as possible and to avoid backing up the document while
it is being actively modified. In normal use it's unlikely that there won'’t be regular
inactive periods of 15 secs or more, allowing a backup to be taken soon after it is due.
But note that if you are actively editing for an extended period of time it could be
significantly longer than the configured backup period before the next backup runs.

The Automatic Backup facility does not save modifications to open ‘edit inside’ sub-
documents. Only the parent main document is saved when a scheduled backup runs, in
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its current state without the unsaved group edits. For this reason it's recommended that
you save ‘edit inside’ edits back to the parent document regularly.

When a backup is taken, you'll see the save progress bar appear at the bottom of the
Xara Web Designer 7 window while the save is completed.

Backup location

User the BROWSE button if you want to change the folder where your backups are stored.

You can access the backup documents saved here at any time using the "FILE" > "OPEN
RECENT" > "BACKUPS" menu option. This opens a file dialog onto your backup folder so
that you can browse, open, or delete any of your backup files.

Revisions

By default up to 10 revisions of each design are kept in your backups folder, but you can
choose to change this number in the revisions field. Older revisions in excess of the
number chosen are deleted automatically. Each backup file is named using the name of
the document from which it is taken, suffixed by the date and time at which the backup
was taken.

Warning: Note that if you have multiple documents that share the same filename in
different folders on your computer, their backups will also share the same names in the
backups folder. Therefore try and use unique filenames for your designs to avoid the
backups of one design overwriting another with the same name.

Untitled documents

Documents that you have created and not saved are backed up using the name
"Untitled” followed by a number and the date/time. This name and number corresponds
to those shown in the titlebar when you are editing new unsaved documents.

Warning: Since all new unsaved documents are named Untitled1, Untitled2, etc.
backups of these documents are likely to be overwritten relatively quickly. Therefore you
should always save important documents with a unique name of your choice, so that
you can easily identify backups of that document in the backups folder.

Backup open documents on program close

The Backups tab in the Options dialog also allows you to turn on AUTOMATIC BACKUP
AND RESTORE. When this option is on, when the you close Xara Web Designer 7 you will
not be prompted to save any modified documents that you have open. Instead all open
documents are backed up to the backups folder and the program closes. Then when
you next start the program, the same documents are automatically reloaded so that you
can continue working where you left off.

Note that if you have any "Edit inside" sub-document views open, these are silently
closed and saved back to the main document when the program is closed, and the main
document is backed up. The ‘edit inside’ sub-document views are not re-opened on next
program start. See editing inside groups.
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Recovering from abnormal program closures

If you have automatic backups turned on and the program closes abnormally (perhaps
due to a power failure for example) the program should detect this when it is next
restarted. It will then offer you the chance to restore the most recent backup version of
each document that was open at the time of the last backup.

Abnormal closure will not be detected if no automatic backup completed since the last
normal program closure.

Backups on system shut down

If you shut down Windows without first closing the program, all open documents are
backed up to the backup folder even if ‘Backup open documents on program close’ is
not turned on. This allows system shutdown to proceed without Xara Web Designer 7
interrupting it by prompting you about unsaved or modified documents. On next program
startup you'll be asked whether or not you want to restore the documents that were open
at the time of the system shut down.

Recovering backups

You can access your document backups using the "FILE" > "OPEN RECENT" > "BACKUPS"
menu option. This opens a file dialog onto your backup folder so that you can browse,
open, or delete any of your backup files. It's a good idea to use this file dialog to clear
out any old unwanted backups periodically.

Note that when you load a backup document, it is not automatically associated with the
design file from which the backup was taken. It's treated as an independent document in
its own right. Therefore if you decide to keep a backup document you should use "FILE"
> "SAVE AS" to save it elsewhere with a suitable name.

On-screen grid

To help you lay out your document, Web Designer can display a grid on the screen (the
grid appears only on the screen; it is never exported or printed.) The grid helps you align
objects (similar to using graph paper as a drawing aid).

Right click and choose "sHOW GRID/GUIDES" > "SHOW GRID" to turn display of the grid
on/off or choose "SNAP TO" > "SNAP TO GRID". You can also choose "WINDOW" > "SNAP TO
GRID".

The grid points then act like magnets, and as you move objects, they snap to the
nearest grid point. By default web documents have snap to grid on, with a 1 pixel grid.

The type of grid (isometric/rectangular), the 0,0 point (the origin), and spacing of grid
points is controlled by the GRID & RULERS TAB (on page 298) of the options dialog box.
Any changes you make apply only to the selected document.

Magnetic object snapping is also enabled by default in web documents. Object snapping

is a very powerful way of accurately aligning lines, points and the edges of objects to
any other object so they exactly touch.
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You can even use this to align the centers of objects, or align objects to the center of the
page, or align them horizontally and vertically anywhere in the middle of the page or
edge of the page.

To toggle object snapping, click the sNAP TO OBJECTS button or right click and
‘@ ¥ choose "SNAP TO" > "SNAP TO OBJECTS". YOou can also choose "WINDOW" > "SNAP
L )

TO GRID".

Refer to Object Handling (on page 114) for details on snapping to grid and snapping to
objects.

Rulers

Rulers are turned off by default. To turn them on:

¢ Right click and choose "sHOW GRID/GUIDES" > "SHOW RULERS" to turn display of the
grid on/off.

e Press "Ctrl + Shift + R".

e Or select "wINDOW" > "BARS" > "SHOW RULERS".

Web Designer uses rulers to:

Control text margins, tabs and indents (on page 162) in the TEXT TOOL.

Let you know which part of the page you are viewing;

Show the current pointer X/Y position;

Apply guidelines. If "wiINDOW" > "SNAP TO GRID" is active, guidelines snap to divisions
on the ruler. For more information on guidelines, refer to the guides & guidelines
section in "Object Handling (on page 114)".

As you create or scale objects, you can use the rulers to check their size. You can also
more accurately use the SELECTOR TOOL (See "Selecting objects" for more information).

Rulers are displayed at the left and top of the window. A dotted line on each ruler follows
the current pointer position.

The units and number of divisions on the rulers are the same as those set for
customizing the on-screen grid. These are set using the Grid & Ruler Tab (on page 298)
of the options dialog box. The current units and any scaling factor are displayed on the
right hand end of the top ruler.

Displaying/hiding rulers

Right click and choose "SHOW GRID/GUIDES" > "SHOW RULERS" ("Ctrl + Shift + R") to turn
rulers on/off. Any change applies to the current window and subsequent windows you
open. It does not affect other open windows.

Changing the ruler zero points

It is often easier to measure objects if you align the origin (0,0) point of the rulers with
the object. To move the origin (0,0) point, drag the square at the intersection of the two
rulers.
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10 5 You can drag vertically or horizontally along
ERERERRRRR IRRRARRRRRN  the rulers or over any part of the Web
Designer editing window. As you do, a dotted
line will outline the new position.

This also moves the grid origin so that
divisions on the ruler always align with the
grid.

You can also move the zero point under the GRID & RULER tab (on page 298) of the
Options dialog.

View quality

There are five different quality settings available in the "WINDOWS" > "QUALITY" menu,
which affect how the document appears in Xara Web Designer 7:

Outline only. This is now fully anti-aliased for higher quality screen display.
Outline with blend steps.

Full color (no anti-aliasing).

High quality (full anti-aliasing and image smoothing)

Very high quality (best anti-aliasing in the industry. New bi-cubic photo display
considerably improves the quality of scaled down photos).

FULL cOLOR shows the document colored, but with anti-aliasing turned off.

On the OUTLINE setting only the outlines of the shapes appear (they are drawn as wire
frames). This makes it easier to select objects hidden behind other objects.

The quality setting has no effect on how the document exports or prints, except for
bitmap exports which do use the current quality setting.
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Galleries

Xara Web Designer 7 uses galleries to provide convenient access to libraries of content
like templates, fonts, colors, clip-art and bitmaps/photos. This section of the help gives
general information on features which are common to multiple galleries. Individual
sections describe features specific to a particular gallery.

o X Page & Layer Gallery # X
New page Duplicate

Delete Help...

fue)eb subisaq I

fua)eb dewyg (W

&

By default the Page & Layer Gallery is open in Pages mode (displaying only pages, not their
layers) and docked on the right of the Web Designer window

o Page & Layer

Designs
Bitmap
O Fil

The PAGE & LAYER GALLERY shows you, and allows you to manipulate, the pages in your
document and the layers within each page.
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The DESIGNS and FILL GALLERIES allow you to choose from different templates and styles
provided with Xara Web Designer 7.

The BITMAP GALLERY shows you the bitmaps and photos which are used by all the
currently open documents.

Some galleries are described in detail later.

Displaying a gallery
To display a gallery:

1. Click or hover the mouse pointer over the vertical tab for the gallery to the right of
the workspace (the gallery bar). The gallery opens automatically. When you move
the mouse pointer away from the gallery, it automatically closes.

2. To keep a gallery open while you work, click the AuTo HIDE (pin) button in its top
right corner. The AUTO HIDE button changes so the pin points downwards to
indicate that the gallery is now ‘pinned’ to the workspace.

3. Toclose a ‘pinned’ gallery, see Closing a Gallery (on page 95).

E Unpinned: gallery closes when you move the mouse pointer away from the
gallery.

m Pinned: gallery stays open when you move the mouse pointer away, and can
also be moved and docked (on page 90) elsewhere.

Note: By default the FILL GALLERY does not display its title, just its icon, until it has been
opened. Web Designer always displays the title of the last gallery that you have viewed.
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Moving and docking a gallery

You can ‘detach’ any gallery from the gallery bar and move it to a more convenient
location anywhere in the workspace. You can also dock the gallery (or a gallery group)
in the top, bottom, left or right of the workspace.

Bution Text 6 Bution Text 7

‘imaged jpgl12, PEG, 23K
350 by 463 pinels, 0.2 MP, 24-bit. 96 dy

‘pacaglypgdld’, JPEG, 37 K
570 by 750 pisels, 0.4 MP, 24-bit, 96 dy

‘Bitmap', Standard bitmap, 5 M
1920 by 1080 pixels, 21 MP, 24-bit, 96

% «/<HEN ¢

1 rectangle on layer Pasteboard background:

You can move a gallery anywhere in the workspace
To move a gallery:

1. Open a gallery and click the AuTo HIDE button to pin the gallery. The button
changes to a downward-pointing pin to indicate that the gallery can be moved and
pinned elsewhere.

2. Click and drag on the gallery’s title bar to move it around. You can either leave the
gallery ‘free floating’ anywhere in the workspace or dock it in a new location.

If you move either the Bitmap or the Fill galleries, the two galleries are grouped and

move together. Access an individual gallery by clicking its tab at the bottom of the group
or click and drag a gallery tab to move it away from the group.
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When you click and drag on a dockable gallery’s title bar, a number of arrows appear on
the workspace, indicating where you can dock the gallery.

Page & Layer Gallery
New page  Duplicate
Delete elp

Newpage Newpage ButionTextd Buion Textd ButtonTextS Bution Text 6  Bution Text 7

B =
1 03
& »

"‘-"l'-leacﬂ!ng Text

Dragging a gallery causes docking arrows to appear in the center, top, bottom, left and right of
the workspace. Dock the gallery by dragging it to an arrow.
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y
Were
Y ‘besch-photo (Optimised)813, JPEG, 18
N « 500 by 332 pixels, 0.2 MP, 24-bit, 96 dpi
.

g | JPEG, 4K
350 by 456 porels, 0.2 MP, 24-bit, 96 dpi

imagel0] jpg’, JPEG, 26K
430 by 642 paels, 03 MP, 24-ba, 96 dpi

imaged jpgl12, JPEG, 23K
350 by 463 pinels, 0.2 MP, 24-bit, 96 dpi

paraglipgld’, IPEG, 37K
570 by 750 piaels, 0.4 MP, 24-ba, 96 dpi

| =
¥ ¢/ 5NN o

Nothing selected

Example of a gallery that has been docked to the left of the workspace
To dock a gallery:

1. Click and drag the gallery to the arrow pointing towards the location where you
want to place the gallery. For example, if you want the gallery at the top of the
screen, move it to the upward pointing arrow at the top of the workspace.

2. When the mouse pointer reaches the arrow, a gray transparent box highlights the
gallery’s new location.

3. Let go of the mouse button to dock the gallery. Now when you close or ‘auto hide
the gallery, its tab will be displayed in the new location.

4. Hover over or click its tab to reopen the gallery.

Note: To move all galleries back to their default position, choose CONTROL BARS from
the wiNDOW menu, click GALLERIES then RESET.
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Using galleries

To fold or unfold a section in a gallery:

e Click the FOLD/UNFOLD icon.

¢ Or double click the title strip.

o Or right click a section to display a pop-up menu. Select FOLD/UNFOLD section. The
pop-up menu also has options to scroll to the previous section or next section.

Bitmap gallery

@ shopping_website.web
| Untitled2 *
[ holiday_websitel.web * )

P

‘Default’, Standard bitmap, 32K
256 by 256 pixels, 0.1 MP, 4-bit, 96 dpi

'imagel07.jpg73', JPEG, 26 K
430 by 642 pixels, 0.3 MP, 24-bit, 96 dpi

'beach-photo (Optimised)811', JPEG, 18
500 by 332 pixels, 0.2 MP, 24-bit, 96 dpi

‘paragljpg911’, JPEG, 37K
570 by 750 pixels, 0.4 MP, 24-bit, 96 dpi

This illustration shows the gallery is unfolded. Other galleries are similar.

The buttons along the top depend on the gallery (e.g. FILL and TRANSP are specific to the
BITMAP GALLERY.) However, most galleries have these buttons:

APPLY applies the selected item in the gallery. Click on an item to select it.
MORE opens a menu where you can then choose:

e FIND is described later in searching for an item name.
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e SORT is described later in re-ordering items in a gallery.

e PROPERTIES provides control over size of the icons and amount of information
displayed in the gallery.

e ADD (clipart, fill, and fonts galleries) is described later in adding to a gallery.

e REMOVE (clipart, fill, and fonts galleries) is described later in deleting sections from a
gallery.

Selecting items

To select an item:

e Click an item to select it.

e Or click an item, then "Shift + click" on another item; all items in between the two
points will be selected.

e Or "Ctrl + click" to add that item to the selection.

Re-ordering items in the gallery

In some galleries, "MORE" > "sORT" opens a dialog box. You can sort by name and,
depending on the gallery, by other criteria. The primary key controls the initial sort. For
some sort parameters such as file type or name length, there may be two or more files
with the same type or name length. These files can be further sorted using the
secondary key.

Searching for an item name

You can search, for example, for all names containing the word red:
- Choose "MORE" > "FIND".

Type "red" into the text box.

Select "SEARCH NAMES & KEYWORDS" t0
search only the item names, e.qg. file,
color, etc., or "SEARCH ALL INFORMATION"
to search the names and keywords
available in some galleries.

Find gallery item...

Find itei uding the text: Find first

Find next

Adding to a gallery

You may want to add extra items to these galleries (DESIGN & FILL GALLERIES only). To
do this:

1. Copy the files you want to add into a new directory (folder) using the Windows
Explorer.
- For the DESIGNS GALLERY these files can be any of a wide range of vector or
bitmap file types.
- For the FILL GALLERY they can be any of the bitmap formats supported by Web
Designer (listed in importing and exporting (on page 281)).
2. Inthe appropriate gallery, click the pisc DESIGNS/FILLS button. This opens a dialog
box.
3. Use the dialog box to select the directory you want to add.
4. Click ADD. This creates a new section in the gallery.
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If you later want to add more items to the folder:

Copy the new files into the existing folder.

In the gallery, click bisc DESIGNS/FILLS. This opens a dialog box.
Use the dialog box to select the folder you want to add.

Click UPDATE to update the section in the gallery.

ML=

Deleting sections from a gallery

To delete a section from a gallery (DESIGNS & FILL GALLERIES only):

1. Click on the title strip of the section or sections you want to delete.
2. Click "REMOVE".

If you later want the section again, add its folder to the gallery (described earlier).

Closing a gallery

By default a gallery’s AUTO HIDE button is enabled (i.e., the gallery’s AUTO HIDE button in
the top right corner is unpinned), so that the gallery closes automatically when you move
the mouse pointer away from it.

However if you have disabled the AuTo HIDE button (pinned the gallery), you have to
close the gallery manually.

To close a free-floating gallery, click the cLOSE button in the top right of the gallery. The
gallery closes and its tab is displayed in the gallery bar.

To close a docked gallery, click the AuTO HIDE (pin) or CLOSE button in the top right of the
gallery. The gallery closes and its tab is displayed in the workspace border where you
docked it.

To re-open the gallery, hover over or click on its tab.

Note: To remove a gallery completely, choose GALLERIES from the UTILITIES menu and
choose the gallery you want removed.

Removing a gallery from the workspace

By default, when you close a gallery, Web Designer returns it to the gallery bar so that
you can reopen it by hovering the cursor over its icon or tab. However you can configure
Web Designer to remove any gallery from the workspace if it's not needed.
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To remove unwanted galleries from the workspace, do one of the following:

e Choose GALLERIES from the UTILITIES menu and choose the gallery you want
removed. The selected gallery disappears from your workspace. If you want to
reinstate a gallery, choose GALLERIES from the UTILITIES menu and choose the gallery
you want to reinstate.

e Choose CONTROL BARS from the winDow menu and scroll down the list of available
control bars to find GALLERIES. Click the GALLERIES box to show the Galleries toolbar.
Click cLosE. In the Galleries toolbar that is now displayed above the workspace, you
can toggle display of a gallery by clicking its toolbar button.

Restoring the default control bars/galleries

Choose "wINDOW" > "CONTROL BARS" and click RESET to restore the control bar setup to
the default setting.

Undo and Redo

What are undo and redo?

We all make mistakes or change our minds. Web Designer makes it easy to correct
mistakes or cancel unwanted changes. Every action you make is recorded in an undo
list which lets you undo not just the last operation, but also to step back by undoing
successive operations. In this way, you can experiment freely knowing that you can
always undo anything that doesn‘t look correct.

The undo command

"UNDO" cancels the effects of the last operation. To undo an operation:

¢ Click unDO on the standard control bar.

e Or choose "EDIT" > "UNDO" (the exact wording tells you what the next undo step is, i.e.
undo scale).

e Or press "Ctrl + Z".

e Or press the comma key (in any tool except the TEXT TOOL).

You can repeat the undo command to step back through the sequence of previous
operations.

The redo command

Redo cancels the last undo command. To redo the last operation:

¢ Click the REDO button on the standard control bar.

e Or choose "EDIT" > "REDO" (the exact wording tells you what the next redo step is, i.e.
redo scale).

e Or press "Ctrl + Y".

e Or press the period (full stop) key (in any tool except the TEXT TOOL).

You can only redo immediately after undo. You cannot redo after changing the
document (for example, by moving or adding an object).
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The Selector Tool

The SELECTOR TOOL is the main tool for selecting, moving, scaling, and rotating
objects. It is typically used more than any other tool and is the central tool for
manipulating documents.

1 23 4 S5 6N7
Position )Y‘_ I sie ﬁ % I Scae H [[1. :;,:]- @ Ange E- a “‘ %

Dimensions of selection
% size controls

Lock aspect ratio
Rotate and skew

Flip

Scale line widths

Apply names

1]
&
O
8
(7]

To use the SELECTOR TOOL:

e Click on the SELECTOR TOOL on the MAIN TOOLBAR.
e Or press "Alt + S", "V", or "F2".

When switching to the SELECTOR TOOL, if there are objects selected inside a group or
other composite object type, the parent object (group) becomes selected instead.

Because the SELECTOR TOOL is the most used tool, there is an additional shortcut that
lets you switch to the SELECTOR TOOL to perform a selection or other operation, and
quickly switch back to the previous tool. If you are using another tool, you can easily
switch to the SELECTOR TOOL:

e Press and release "Alt + S" to switch to the SELECTOR TOOL. Press again to return to
the previous tool.

Selecting objects

To select a single object, click on any visible part of the object.

Change object selection

Once an object is selected, you can use the following keys to change the selection:

End selects the back object.

Home selects the front object.

e "Tab" selects the next object towards the back.

"Shift + Tab" selects the next object towards the front.

Front and back objects are described in "Object handling (on page 97)".
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Marquee selection

To select multiple objects, press and hold down the mouse button. Dragging the mouse
draws a selection rectangle, and all objects wholly within the selection rectangle are
selected.

Some other drawing programs call this marquee selection.

If you have an object in the way which is preventing you from drawing a rectangle
because you end up moving the object, hold down "{" while dragging out the selection
rectangle.

Extend Selection

To select additional objects:

e "Shift + click" on them.
e Or "Shift + drag" the mouse pointer. This draws a selection rectangle and adds
objects within the rectangle to the selection.

Select under

Hold down "Alt" to select objects hidden by other objects. By "Alt + clicking" you can
step through several overlapping objects.

Select inside

"Ctrl + click" on the object to select inside. This is used to select an object which is
inside a group. This lets you, for example, edit the outline of one object in the group,
without having to ungroup. The other objects remain unchanged.

Note that some operations are not permitted with select inside. For example, marquee
selection and right-click copy does not work for select inside.

Moving objects selected under or inside

If you need to move a selected object that’s either under others or inside a group, then
just dragging doesn’t work as it will select and drag a different object. To overcome this
hold "Ctrl + Alt" and start dragging. This will always drag the existing selected object.
You can let go of the keys once you've started dragging.

Or you can use the arrow keys on the keyboard to nudge the object.

Selecting and layers

You cannot select objects in locked or invisible layers.

See "PAGE & LAYER GALLERY (on page 270)" for more details on layers.
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Selecting all objects

To select all objects:

e Choose "EDIT" > "SELECT ALL",
e Or press "Ctrl + A".

Deselecting an object

To deselect all objects:

¢ Click anywhere on an unused part of the document,
e Or choose "EDIT" > "CLEAR SELECTION",

e Or press "Esc".

To deselect one object from several:

o "Shift + click" on the object. This deselects that object. Other objects remain selected.

Selection markers

Selection markers Each selected object displays a single
/ \ selection marker to show it is selected.
o . This is a useful reminder when selecting
o and deselecting several objects.
Status line

The status line at the bottom of the window also describes what is selected.

Selection bounds handles

Selection bounds handles let you scale and stretch selected objects. See Stretching and
squashing objects for more details. Successive clicks on an object alternate between
showing selection bounds and rotation handles.

Selection bounds handles  Gjick again Rotation handles

/ \ to show the / \

] ] ] r — ‘\

. . . L — J
Tab

With any selected object, pressing "Tab" and "Shift + Tab" will move through the
selected objects (previous and next object in the document).

www.Xara.com



100

Object Handling

Moving objects
To slide an object across the page

1. Choose the SELECTOR TOOL.
2. Drag the object to the required position. Hold down "Ctrl" to restrict the direction of
movement to one of the constrain angles.

The constrain angles are user definable. Refer to "Customizing Web Designer (on page
294)"

Hold down "Ctrl + Alt" and you can drag the selected object even if the pointer is not
over it. This is useful when the selected object is hidden behind another object or part of
a group. Release "Ctrl" and "Alt" after you start the move unless you want to constrain
the move.

You can also move objects using the arrow cursor keys. This is described on the next
page.

Magnetic object snapping is also enabled by default in web documents. Object snapping
is a very powerful way of accurately aligning lines, points and the edges of objects to
any other object so they exactly touch. It also helps you align to the horizontal and
vertical center lines of the page.

To toggle object snapping, click the sSNAP TO OBJECTS button or right click and
'@ choose "SNAP TO" > "SNAP TO OBJECTS". You can also choose "WINDOW" > "SNAP
TO OBJECTS".

Click and drag on the object you want to snap. As you drag, Web Designer displays a
magnet icon whenever you are near a "point of interest" or potential snapping site
relative to a visible object on the page.

To snap in a path relative to the page center (both horizontally and vertically), move the
object over the lines that appear as you drag on the page. A red dot on the line also
indicates potential "point to path" snapping points, so that you can snhap the object to a
point such as the center or center line of the page.

See Snapping (on page 110) for details on snapping to grid and snapping to objects.

Drop copy

During a move (and while still holding the left mouse button down) click the right mouse
button or press + on the numeric keypad to drop a copy of the object. The original object
doesn’t move. You can do this as many times as you wish to create a series of
duplicated objects.

You can also hold down the right mouse button and drag a copy of the object. Left click
to leave a copy at the current mouse position.
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Fills

Usually, moving an object also moves the fill with it:

Normal move left to right with a linear filled object.
This also applies to rotating, skewing, scaling and
stretching objects.

To do this click the "-" key on the numeric keypad during
the move.
The same move, but pressing "-" (minus) during the drag.

Nudging objects

Usually you can move an object a small amount by using the arrow keys to nudge the
object (these keys sometimes have other uses, especially in the TEXT TOOL).

Nudging is not affected by either magnetic or grid snapping (snapping is described
later).

Nudge modifiers

To modify the nudge distance, use these key combinations while using the arrow keys:

Ctrl nudge 5 times the normal distance
Shift nudge 10 times the normal distance

Ctrl + Shift nudge by I/5th the normal distance
Alt nudge by 1 pixel

Alt + Shift nudge by 10 pixels

You can change the normal nudge distance under the GENERAL tab in "UTILITIES" >
"OPTIONS". Refer to "Customizing Web Designer (on page 298)".

Nudge works in most tools.

Cut, copy and paste

These let you move or copy an object in the same document or between different
documents. The procedure is:

1. Select the object.
To remove the object, choose "ebiT" > "cuT" (or "Ctrl + X"). To copy the object but
not remove it, choose "ebIT" > "copy" (or "Ctrl + C"). Either option puts the object
(or a copy of it) onto the clipboard.

3. Choose "EDIT" > "PASTE", "Ctrl + V", or "INSERT". This pastes the clipboard contents
into the document.
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Note that if the objects you copy are all on the same layer, then you can paste those
objects to any layer by first making it the current layer and then choosing "EDIT" >
"PASTE" > "PASTE IN LAYER" Or "PASTE IN PLACE IN CURRENT LAYER". The layer from which
the objects were copied is ignored in this case.

However if the objects you copy are on several different layers, then the layer structure
is maintained when you paste.

This allows you to copy layered data within a document or to a different document. Any
layers which are missing in the target document are created automatically by this
operation. So for example if you copy a mouse-over button, which has one object on the
MouseOff layer and another object on the MouseOver layer, to a new document, the
MouseOff and MouseOver layers will be created if they don’t already exist and the
button objects copied onto them.

"Ctrl + Shift + V" or "EDIT" > "PASTE IN PLACE" pastes the clipboard contents into the
same X/Y position from where they were cut or copied. This only applies to objects cut
or copied from within Web Designer. Objects imported from other programs are always
pasted into the center of the current view.

The object remains on the clipboard so you can paste the same object several times.

If there is a choice of formats on the clipboard, Xara Web Designer 7 will display a PASTE
SPECIAL dialog which allows you to choose the format you want to paste in (eg. When
pasting in text you may have the choice of pasting in unformatted text or Rich Text).

In addition you may see the following paste options, depending on the clipboard
contents:

Paste unformatted text

Pastes any text on the clipboard into your document without any formatting.

Paste format/attributes

Preserves the format (e.g., font and font size) or style attributes (e.g., line and fill color)
of the pasted object.

Paste in current layer

The same as PASTE IN PLACE, except your object will only be pasted into the current
layer.

This is useful if you want to display or hide just your pasted object when layers above or
below are displayed.

Paste in place in current layer

The same as PASTE IN CURRENT LAYER, except your object will be pasted into the current
layer in the exact same position from which you copied it.

Wwww.Xara.com



Object Handling

103

Removing objects from the document

First select the objects you want to remove. You can then either cut the objects to the
clipboard or delete them.

Cutting objects

Choose "Edit" > "Cut", or press "Ctrl + X".The contents of the clipboard are overwritten
and you can paste the deleted object(s) somewhere else if desired.

Deleting objects

<>< Right click and choose DELETE or choose DELETE from the EDIT menu,
or press the "Delete" key, or click the DELETE button on the STANDARD
control bar.

In this case the deleted objects are not put onto the clipboard. If you accidentally delete
an object, undo retrieves it.

Duplicating and cloning

Both these options create a copy of the selected object. The original object is deselected
and the duplicate or clone becomes the selected object.

You can also duplicate an object during moving, rotating, scaling, or skewing. During the
drag action (and while still holding the left mouse button down) click the right mouse
button or press "+" on the numeric keypad to drop a copy of the object. The original
object doesn’t move. You can do this as many times as you wish to create a series of
duplicated objects.

So an easy way to create one or more copies of an object that is exactly horizontally or
vertical aligned, is to drag the object, hold "Ctrl" to constrain the movement, and right
click (or press "+" on the numeric keypad) for each copy required.

To quickly create a line of objects, draw one, then drag while holding "Ctrl" and right click for
each copy required.

Duplicating

Right click and choose DUPLICATE, or choose "EDIT" > "DUPLICATE", or press "Ctrl + D".
The copy is displaced slightly, usually down and to the right, from the original.

The duplicate distance is user definable, see "Customizing Web Designer (on page
298)"
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Cloning

Choose "Edit" > "Clone", or press "Ctrl + K". This
places a copy exactly on top of the original. Cloning is
an easy way to create concentric shapes.

This example uses an original large letter "A" with a
black fill and a 4pt thick white outline and a clone with
no fill and a 1pt black line.

Moving objects forward and backwards

Complex documents have objects stacked on top of each other, such as this target:

OXKD

The target on the left is made from three circles stacked on top of each other.

To ensure that objects overlay each other in the correct order, you often need to
rearrange their order from front to back. The front object always covers lower objects,
and objects always cover other objects which are further back. Each new object you
create is always created on top of older ones.

Right click an object and choose ARRANGE, which gives you these options:

e BRING TO FRONT ("Ctrl + F"): This makes the selected object the front object, and it will
hide any other object it covers.

e MOVE FORWARD ("Ctrl + ©# + F"): This moves the object up a level towards the front
rather like climbing a staircase one step at a time.

e MOVE BACKWARD ("Ctrl + {+ + B"): This moves the object one level towards the back.

e PUT TO BACK ("Ctrl + B"): This moves the object to the back.

These options move objects forwards and backwards within their layer. Right click and
MOVE TO LAYER IN FRONT/MOVE TO LAYER BEHIND lets you move objects between visible
layers (invisible layers are skipped when moving objects).

Read more in Layers (on page 270).
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Rotating objects

This is part of the SELECTOR TOOL.

ﬂ} When in rotate mode, the transformation center (around which the object rotates)
initially appears in the center of the object, as shown by a small target like this.

Simply click on an object again to put the selector into rotate mode.

To move the transformation center, drag the transformation center target where
required.

Attention: If the rotation center is moved, it remains in this location for any selected
object until all objects are deselected, at which point it returns to the center of any
selected object.

Rotating using the mouse

The SELECTOR ToOL must be in rotate/skew mode (the selection handles are arrow
shaped).

Dragging the side handles stretches the object. This is described in Stretching and
squashing objects.

Drag on a corner arrow. As you drag, the object rotates around the transformation
center. The InfoBar shows the current rotate angle.

"{r+ drag" to rotate the object around its center (the transformation center is ignored).

Hold down "Ctrl" to restrict rotation to the constrain angles.

The constrain angles are user definable. Refer to "Customizing Web Designer (on page
297)".

To create a copy while rotating, click "+" on the numeric keypad while rotating, or click
the right mouse button.

Rotating by exact angles (using the InfoBar)

Type an angle into the rotate box and press "J". Positive angles rotate anti-clockwise
and negative angles rotate clockwise.

Anal [ ¢« Click the arrows to the right to nudge the rotate
& — —— angle.
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Rotating objects in Resize Mode
Rotate areas

e

Skew areas
Rotate
Mouse Icon
] L]
Skew
Mouse lcon
| | [ ] | |

It is possible to rotate and skew an object even if not in rotate mode. Using resize mode,
move the mouse pointer into the according small areas near the selection area handles
as illustrated above. The mouse pointer changes into a rotate or skew icon, showing you
that you are now able to rotate or skew the object by dragging with the mouse.

Scaling (resizing) objects
This is part of the SELECTOR TOOL.

Scale Line Widths button

The SCALE LINE WIDTHS button on the SELECTOR TOOL infobar is used in many operations
where the width and height of the selected objects are important. It controls whether the
line attributes (not just line widths) are taken into account when working out the size and
position of the selected object(s).

With the SCALE LINE WIDTHS button set, scaling an object also
scales its line widths. With this button unset, line widths remain
unchanged.

You can toggle this button during drags by clicking "/" on the numeric keypad.

If you have a rectangle with a 4 pixel line width, as you turn SCALE LINE WIDTHS on and
off you'll see that the X, Y W And H fields in the SELECTOR TooL change as the effects of
the line width are included and excluded.

The following features are affected by SCALE LINE WIDTHS:

Position and size as reported on the SELECTOR TooL infobar XYWH fields
Changing position and size by entering values into the infobar XYWH fields
Changing size by entering values in the W% H% fields

Scaling/stretching objects by dragging in the Selector tool

Alignment

Snapping
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The line attributes that are taken into account when SCALE LINE WIDTHS is turned on are:

¢ Line width

End caps

e Join type

Dash pattern

Arrowheads

Brush style

Stroke type (inc. variable width strokes)

In general, if you are interested in the visual positions of objects you should turn SCALE
LINE WIDTHS on. If you're interested in the exact positions of lines (e.g. where the centers
of lines are, as is typical in technical drawings) then you should turn SCALE LINE WIDTHS
off.

Lock Aspect button

100 | %} o With the LocK ASPECT button set, the width/height aspect ratio
(100 remains constant as you scale the object.

In other words, the shape remains in the same proportions as the original. It's
recommended that this button remains selected most of the time in order to ensure that
when you resize objects they do not become squashed.

With this button unset, you can change the aspect ratio as you scale the object, in other
words, you can stretch object one way or another when dragging a corner resize handle
or when entering a new size.

Scaling using the mouse

The SELECTOR TOOL must be in .~ Drag any corner handle to resize
scale mode (the selection

bounds handles are squares). If * &

necessary, click on the object to Drag a side handle to stretch
change to scale mode. . . .

Drag one of the corner handles. The object scales as you move the pointer diagonally.
The InfoBar shows the current scaling. The object will scale between the dragged
handle and the opposite one. To use any other point of the object as the fixed point
move the transformation center to it and use the InfoBar buttons to scale.

Hold "Shift" while dragging to scale the object around its center. This works
independently of the position of the transformation center.

"Ctrl + drag" scales the object in multiples of its original size (x2, x3, and so on).

To create a copy while scaling (leaving the original in place) right click, or press "+" on
the numeric keypad.

Dragging the side handles stretches or squashes the object. This is described in
Stretching and squashing objects.
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Scaling using the InfoBar

o Type into the SCALE TEXT boxes and press ".".
e Scalings below 100% reduce the object. 50 halves the size of the object.
e Scalings above 100% enlarge the object. 200 doubles the object size.

e If LOCK ASPECT is set, you can type into either text box to resize the object by the
desired percentage. If this button is unset, you can enter separate values for both
the width and height.

9 Alternatively, type the required size of the object into the w or H text boxes.

If the LOCK ASPECT button is on, this scales the object and maintains the aspect ratio.
You can enter the size in any unit, such as 1 cm.

Scaling with the InfoBar buttons (or number boxes) always scales around the
transformation center. You can position this anywhere else in the object, as described in
Rotating objects.

Flipping objects

This is part of the SELECTOR TooL. Clicking on the FLIP buttons
flips the object vertically or horizontally around the transformation

center.
The scale and aspect ratio do not change; the object just flips.

Stretching and squashing objects

This is similar to scaling objects except that the object is scaled in one direction only.
Stretching and squashing are basically the same action — stretching makes the object
larger, squashing makes it smaller.

Stretching/Squashing using the mouse

The SELECTOR TOOL must be in scale mode. (The selection handles are squares.) If
necessary, click on the object to change to scale mode.

Use the side, top and bottom handles, instead of the corner handles, to stretch or
squash a shape in one dimension only. Note that these handles are shown only on
rectangles which are not photo filled, because stretching other objects in one dimension
rarely produces useful results (photos become distorted).
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1\' Drag one of the side handles. The
Side Handles

object scales as you move the
pointer in the appropriate direction.
The InfoBar shows the current
scaling.

The LOCK ASPECT button is ignored.

Right click or press "+" on the numeric keypad while dragging to stretch or squash a
copy of the object, leaving the original in place.

Stretching/squashing using the InfoBar

The LOCK ASPECT button must be unset (if it is set, you scale the object instead of
stretching or squashing it).

Type into either the width or height text box (as appropriate) and press ".". Alternatively

enter a % scale (width or height). So entering 200% into the top % scale box will make
the object twice as wide, but the same height.

If the LOCK ASPECT is set then it will not stretch.

Skewing objects

“ This is part of the SELECTOR TOOL.

Left is the original object, to the right with a horizontal
skew

Skewing using the mouse

Switch the SELECTOR TOOL to rotate/skew mode. (The selection handles are arrow
shaped) by clicking on the object.

Drag a side, top or bottom arrow to skew the object. Note that these handles are shown

only on rectangles which are not photo filled, because skewing other objects rarely
produces useful results (eg. photos become distorted).
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e ,_,—’.‘\ As you drag, the object skews in the direction of movement
‘ (vertical or horizontal).
; A 4 »
L Andle PR -

The InfoBar shows the current skew angle.

"{+ drag" to skew the object around its center. Hold down "Ctrl" to restrict the skew to
the constrain angles. Right click, or press "+" on the numeric keypad as you drag to
create a copy, leaving the original where it was. Or right-drag with the mouse to create
instant copies, additional copies by left clicks.

You can also skew an object in the SELECTOR TOOL's resize mode using the skew areas.
Read more under Rotating objects in resize mode (on page 106).

Skewing using the InfoBar

Pl B2 To skew horizontally type an angle into the skew text box and press
g2

Snapping

Snapping makes it easier to position edges, or specific points on objects, exactly where
required. It can be used to align edges to a specific point or line, or to evenly space
objects, using the grid.

Xara Web Designer 7 offers three types of snapping.

e Snap to grid
e Magnetic snapping (snap to objects)
e Snap to guidelines or guide objects

Grid snap is useful for making objects evenly spaced, or making the sizes exact
multiples of a given value. Guidelines are useful for aligning edges (although it’s a lot
more powerful using guide objects) and lastly magnetic snap is a general purpose way
of accurately positioning lines, points or object edges relative to other objects or to the
page center or edges.

Snap to grid

When SNAP TO GRID is selected, grid points act like magnets. Right click on the
pasteboard and choose "SNAP TO" > "SNAP TO GRID" or use the menu option "wiNDOW" >
"SNAP TO GRID", (or press "." (decimal point) on the numeric keypad). You can control the
grid spacing from the options dialog (right click and choose PAGE OPTIONS or use the
menu command "UTILITIES" > "OPTIONS") on the Grid and Ruler tab. By default web
document templates have snap to grid on, with a single pixel grid, so that normally all
object dimensions and positions are whole pixels.
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When dragging objects the edges will snap to grid points. If the size of the object is such
that opposing edges can't both be snapped, the edge that snaps depends on the
direction the object is dragged in.

‘Object dragged In'this direttion |

‘These edges are not snapped

. . . . Iheoutside eédges are snapped to grid

B T T S S

This shows a coarse grid with 5 subdivisions between major divisions. The shape has a very
thick gray outline. Because the object has been dragged down and to the left, the lower and
left outside edges are snapped to the nearest grid point.

Note: The default grid spacing is 50 pixel spacing for major grid lines with 50
subdivisions. This means the grid is spaced at exactly one screen pixel and so may
appear not to be working at a normal 100% zoom. If you zoom in to say 500% then you
can see it does snap correctly.

Alternatively, change the grid values to have, say, 10 subdivisions which means that the
grid points are on 5 pixel boundaries.

Snapping and line widths

The SCALE LINE WIDTHS control on the SELECTOR TOOL
InfoBar affects whether snapping happens to the bounds of
objects including their outlines.

The above example shows a shape with a very thick gray outline. It also shows (thin
black line) the outline of the shape itself (you can see the thick outline is drawn equally
on either side of the center line so that it partly overlaps the inside of the shape and
partially goes outside).

With scale line widths on, the width of the outline is deemed to be important and so
‘snap to grid’ will snap the bounds of objects, including outlines, to the grid. Snap to
objects will allow you to snap using the bounds or the outline center lines. If the outlines
as they appear on screen are small, so there is little difference between these two
shapping positions, bounds snaps are favored. So zoom in if you want to snap outline
centers in this case.

With scale line widths off, ‘snap to grid’ and ‘snap to objects’ will snap the center lines of
objects, ignoring the outline widths.

Because snapping honors the Scale line widths switch it means that the bounds used by
shapping are always the same bounds that are reported in the SELECTOR TOOL infobar.
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Magnetic object snapping (snap to objects)

Magnetic object snapping makes it much easier to accurately position objects relative to
each other or relative to the page center or edges.

So, for example, if you want several lines to start at exactly the same point, or want a
line to exactly join the edge of a circle, then using "magnetic object snap" is useful.

You can even use this to align the centers of objects, or align objects to the center of the
page, or align them horizontally and vertically anywhere in the middle of the page.

Magnetic snapping works when either moving or scaling objects using the SELECTOR
TOOL.

Magnetic snapping to objects is enabled by default in web documents. To
LIE  toggle it on and off, click the SNAP TO OBJECTS button in the top toolbar.
Alternatively right click the pasteboard and choose "SNAP TO" > "SNAP TO
OBJECTS", or use the menu option "WINDOW" > "SNAP TO OBJECTS". You can
also toggle it on/off during dragging by tapping ‘s’.

Click and drag on the object you want to snap. As you drag, Web Designer displays a
magnet icon, blue lines and red points whenever you are near a "point of interest" that it
has snapped to.

Snap indicators

Snap indicators are shown whenever a snap occurs. That is whenever a point of interest
on the object you are dragging comes in range of a point of interest in the document
(which could be on another object or be part of the page). Web Designer snaps to the
point of interest and the mouse pointer changes to show a magnet symbol so you know
a snap has happened.
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Also further indications are shown dynamically on screen to help you see what snap has
occurred.

¢ Ared dot indicates that a specific point has snapped

¢ A blue line indicates a shap to some feature of another object (e.g. to the edge of a
rectangle).

¢ An orange line indicates a snap to a page feature (corners, edges, center)

The snap indicator lines pulse to show that they are temporary "live" indicators and to
help them be seen over different background colors.

The snapping distance is controlled by the MousE tab of the opTIONS dialog box
("uTILITIES" > "OPTIONS" or right click a page and choose PAGE OPTIONS).

G Options

Effects & Plugins Photo Editing Scaling
Tune-ups Units View Backups

General  Grid and Ruler Internet Mouse  Ppage Size

Mouse options

Mouse button function

Middle mouse button (wheel): Push Tool

Mouse wheel movement (=Ctrl to swap)

O Scroll up/down @® Zoom in/out
(+=Shift to scroll left/right)

Reset defaults

Magnetic snap radii

point (XN une

You can specify two snap distances in the "Magetic snap radii" section, which control
how close things need to be before they will snap together. The size of a circle around
points (point) and the distance either side of lines (lines). It's usually best to make the
point value larger than the line value, so that it's easier to snap to the end points of
lines.

Customizing Web Designer (on page 294) has full details of the Options dialog.
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Guide Objects and Guidelines

Guide objects and guidelines are objects on a special layer, the guides layer. A guide
layer is automatically created when you create a guideline (see below), or you can
create one manually by right clicking in the PAGE & LAYER GALLERY and selecting CREATE
GUIDE LAYER (see Layers (on page 270) for more information).

Use SNAP TO GUIDES in the wiNDOw menu (or key 2 on the numeric keypad) to turn on
snapping to guide objects.

Any object placed on the guides layer becomes a guide object. These can be any object
type including lines at any angle, irregular shapes, and quickshapes. You can create,
scale, and delete objects on the guides layer as usual, but they always appear as thin
dotted red outlines; any applied line width or fill color is ignored. This information is
retained, and if you later move the object from the guides layer to a normal layer, line
thickness, and colors are shown again.

You can use guide objects to draw construction lines such as lines passing through a
vanishing point for perspective drawing.

Placing objects onto the Guides Layer

First ensure there is a guide layer in the PAGE & LAYER GALLERY, see above. You can
create objects directly on the guides layer by selecting it and creating objects as usual.

Page & Layer Gallery You can also cut or copy

New layer ~Properties... Pages objects from another layer

S — o and then paste those objects
& into the guides layer. To
paste the objects in the same
relative position on the guides
layer use the keyboard
shortcut "Ctrl + Shift + V".

The Page & Layer Gallery showing a guides layer above
two other layers, and selected.

MOVE TO LAYER IN FRONT and MOVE TO LAYER BEHIND on the ARRANGE menu (or right click
and choose "ARRANGE" > "MOVE TO LAYER IN FRONT/BEHIND") will skip the guides layer
and so cannot be used to move objects onto the guides layer.
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Creating a guideline

Guidelines are vertical or horizontal lines and are a quick and easy way to align a series
of objects on the page.

e Turn rulers on ("Ctrl + L") or right click and choose "SHOW GRID/GUIDES" > "SHOW
RULERS"
e Drag from a ruler onto the page.

Or

e Double click on the ruler to create a guideline aligned to the click point.

This automatically creates a guides layer and puts the guidelines on that layer.
Or, using the PAGE & LAYER GALLERY:

Right click in the PAGE & LAYER GALLERY and choose PROPERTIES.

If necessary, click the GUIDES tab.

Select horizontal or vertical.

Click NEW.
Type in the required position.

ISHEE S

Deleting a guideline
Using the Selector TooL drag the guideline onto the appropriate ruler (the vertical ruler
for vertical guidelines, horizontal ruler for horizontal).

Or, right click on the guideline and then choose DELETE.

Summary of shortcuts on the numeric keypad

+ Makes a copy while dragging, resizing, skewing, and so on. The original object
doesn‘t change.

/  Toggles leaving line widths unchanged during scaling and scaling with changing
line widths.

- Toggles leaving fills unchanged during moves, scaling, skewing, etc.
*  Toggles object magnetic snap on and off.

2 Toggles snap to guides on and off.
Toggles snap to grid on and off.

Grouping and ungrouping objects

The Shadow and Transparency Tools offer different results depending on whether
objects are grouped or not. For more information see "Transparency (on page 189)" and
"Shadows (on page 191)".
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You will often create complex shapes from several different objects. The "ARRANGE" >
"GROUP" menu option (or right click selected objects and choose GrRouP) lets you lock
those objects together to form what appears as a single object. You can then select the
grouped objects and copy, rescale, move or perform any other operation on the entire

group.
To create a group

1. Select all the objects you want in the group.
2. Right click and choose GRouP or choose GROUP from the ARRANGE menu (or "Ctrl +
G") to create the group.

Ungrouping objects

1. Select the group.
2. Right click and choose UNGROUP or choose UNGROUP from the ARRANGE menu (or
"Ctrl + U").

After this, all the individual objects in the group remain selected.

To add more objects to a group

Select the group.
Ungroup ("Ctrl + U")
Select the extra objects.
Group again ("Ctrl + G")

o=

You can also incorporate a group into a second group by omitting step 2. Web Designer
remembers the original grouping information. If you ungroup the objects later, the
original group remains.

Removing objects from a group

1. Ungroup the objects.
2. "Shift + click" on the objects you want to remove. This deselects them; the other
objects remain selected.

You can then choose "ARRANGE" > "GROUP" to regroup the remaining objects.

Selecting a single object from within a group

This feature is useful for changing an object's color, for example. "Ctrl + click" on the
object (you can also use this to select a "group within a group"). Pressing "Tab", or "Shift
+ Tab" moves the selection within the group, to the next, or previous object. Once you
have selected an object inside a group, you can also use "Alt + click” to select the object
under the selected one.

This is called “select inside”.
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Groups and layers

There’s more about layers in Layers (on page 270).

If all the objects to be grouped are in one layer, the group is created in that layer. The
group is at the level of the highest member of the group, i.e. the group does not
automatically become the front object.

If the objects are in more than one layer, then the group is created in the layer
containing the object nearest the front.

Soft Groups

Ordinary Groups as described in “Grouping and ungrouping objects (on page 115)” sit
on a single layer, they cannot span layers. SOFT GROUPS are an alternative way of linking
objects together where the objects can be across several different layers.

Selecting one member of a Soft Group also selects all other members of the same Soft
Group — even members that are on invisible or locked layers. This means when you
delete, move, rotate or otherwise transform one member of a Soft Group, all the other
members are similarly modified.

The status line indicates when a Soft Group is selected.

Soft Groups are useful for keeping closely related objects together. For example the
MOUSEOFF and MOUSEOVER states of a web button are Soft Grouped together, so that if
one state is moved or transformed, so is the other state.

Creating Soft Groups

To create a Soft Group, select all the objects that are to be included in it and then
choose “ARRANGE" > "APPLY SOFT GROUP" (or press “Ctrl + Alt + G”). Note that if the Soft
Group is to include members on invisible or locked layers, you'll need to make those
layers temporarily visible and editable using the PAGE & LAYER GALLERY in order to select
the objects and Soft Group them.

An object cannot be a member of more than one Soft Group and Soft Groups cannot be
nested (soft groups as members of soft groups).

Removing Soft Groups

To disband a Soft Group, select it and choose “ARRANGE" > "REMOVE SOFT GROUP” (or
press “Ctrl + Alt +U”). The objects don’t get deleted, they are just no longer linked
together by a Soft Group.

Text Synchronization

Any text objects which have the same text value and which are members of the same
Soft Group are kept synchronized if any of those text objects are edited. So change the
text in one object and any other text objects that had the exact same characters will also
be changed to match. Only the text value itself if synchronized, so different text objects
can have different sizes, fonts and text attributes.
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Text synchronization using Soft Groups is useful where a label is duplicated in several
places, perhaps in different styles and you want each object to show the same label.

Alignment
This lets you accurately align or distribute two or more objects.

Quick aligning

Select the objects you want to align, and right click the selection to choose ALIGN from
the drop-down menu, and then do one of the following:

¢ Align the objects vertically by choosing LEFT EDGES, CENTERS Of RIGHT EDGES.
¢ Align the objects horizontally by choosing TOP EDGES, CENTERS Or BOTTOM EDGES.

Aligning and distributing space

If you want to distribute space between the objects as well as align them, select the
objects, right click the selection and choose "ALIGN" > "ALIGNMENT" to display the Object
Alignment dialog. Alternatively choose "ARRANGE" > "ALIGNMENT" ("Ctrl + ¢+ L").

The small diagram at the top of the dialog box shows
you the effect of selecting each option. The selected

objects in the document do not change until you click
APPLY.

object Alignment

The alignment dialog is a non-modal dialog, which
means you can keep it on screen and continue to work
on the document at the same time. So you can change
tools, draw, and change your object selection, and then
easily select from the various alignment options.
If you've got your selection wrong, you can change the
Within: selection, and just click the APPLY button to apply the

1 last alignment settings again. This can be a real-time
saver.

Hornzontal postions:

Distribute left edges -

Apply Cloze

www.Xara.com



Object Handling

119

Within
This section of the dialog controls the boundaries within which you align or distribute the
objects. The options are:

SELECTION BOUNDS: The boundaries are the outer
edges of the selected objects. Their relative position
on the page or spread has no effect.

-

BOUNDS OF BACK OBJECT: The boundaries are the
outer edges of the backmost selected object. This
object is not affected by the alignment.

You can use this to define the "reference" object when
you want to align several objects in a row, for instance.
With the normal "Selection bounds" options on the
leftmost object is the reference object (the one that
won't move)

! PAGE(S): If the objects are on a single page, the
boundaries are the edges of the page. (This lets you,

: for example, center objects on the page or align
against the page edge.)

d

[]

-

Aligning

To align objects, for example, so their left edges are aligned to the left.

1. Select the objects and right click the selection.
2. Choose "ALIGN" > "LEFT EDGES" from the drop-down list.

The selected objects move to align the left edges.
Alternatively:

1. Choose "ALIGN" > "ALIGNMENT" or press "Ctrl + Shift + L" or choose ALIGNMENT
from the ARRANGE menu to open the Object Alignment dialog.

Select the required WITHIN option, e.g. Selection bounds.

Select ALIGN LEFT for horizontal positions.

Leave vertical positions to NO CHANGE.

Click APPLY.

SHES S

The selected objects move to align the left edges.
All the align options act in a similar way. For brevity, only the left align option, shown in

the illustration of the dialog box is described. Experiment to learn about the other
options.
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To quick-select any combinations of vertical and horizontal alignment click with the
mouse in the diagram:

« A simple mouse click aligns horizontal and vertical positions to the clicked position to
any of the nine combinations of top-centrally-bottom/left-centrally-right.

e "Ctrl + mouse click" leaves the horizontal position unchanged and arranges the
objects in a to a top, centrally, or bottom aligned row.

e "{t+ mouse click" leaves the vertical position unchanged and arranges the objects in a
left, centrally, or right-aligned column.

Distribute

The distribute options will position all the selected objects evenly across the "Within"
area (usually within the selection bounds, but it could be the page or spread).

Again all the distribute options work in a similar way. The following examples show how
the different vertical position options align objects:

TOP EDGES DISTRIBUTION: the tops of the objects are
evenly spaced. BOTTOM EDGES distribution is the
inverse—the bottom of the objects are evenly spaced.

|
r-—-r

CENTERS DISTRIBUTION: the centers of the objects are
evenly spaced.

i —
‘-1 Lt Bl

EQUI-SPACED DISTRIBUTION: the objects are evenly
spaced from each other.

#|¢ > -

The horizontal position options are similar but operate in the horizontal direction.

So, for example, to distribute this collection of randomly positioned ellipses, so they are
all equally spaced and aligned to the top edge:

Select the shapes
Display the Alignment dialog ("Ctrl + ¢+ L")

Q O Ensure WITHIN shows SELECTION BOUNDS
e Select Horizontal positions: Distribute centers
e Select Vertical position: Align top
e Click APPLY

@m And they will now look like this, all equally spaced horizontally
and aligned to the top.

Remember if you make a mistake you can always undo the operation.
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Copying Styles: Paste Attributes

This lets you copy attributes (such as line pattern or fill color) between objects. It is a
quick way of applying multiple attributes to an object.

The square has a specific color, shadow,
line and fill style. Copying it and then
pasting its attributes on to the circle in the
middle, results in the circle to the right.

v

Select the object from which you wish to copy the attributes.

Copy the selection to the clipboard. ("epbiT > "copy", or "Ctrl + C".)
Select the object(s) to which you want to apply the attributes.
Choose "EDIT" > "PASTE ATTRIBUTES", or "Ctrl + Shift + A".

o=

The object remains on the clipboard until overwritten by a cut or copy operation. This
lets you repeat paste attributes as many times as required.
Style libraries

It's quite easy to use this technique to create documents that can be used as style
libraries. Create a series of small objects with a variety of useful fill, color and other
attribute styles. Then the quickest way to use one of these styles is:

¢ Click on the source object, "Ctrl + C" to copy the style

¢ Move to the destination object (which can be in another document, "Ctrl + Tab" to
quickly switch between open documents), click on the object to apply the style to

e Press "Ctrl + Shift + A" to apply the attributes

Note: Most attributes can be copied this way, including fill styles, etc.

Naming objects

% You can apply hames to any object in Xara Web Designer 7 using the APPLY,
REMOVE OR INSPECT NAMES OF OBJECTS button on the SELECTOR TooL infobar.

Naming is a general mechanism which has a variety of uses, some of which are
described below. Most commonly hames are used to form loose sets of objects.

Adding names

To add a name to an object, select the object and open the NAMES dialog using the
button on the SeLECTOR TOOL infobar or right click on the object and choose NAMES...

Type the new name into the APPLY NAME field, or use the drop down list on the same
field to select a name which is already used elsewhere in the current document. Click
ADD. You should see the name appear in the NAMES APPLIED list.
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Names applied

The NAMES APPLIED field shows you the names applied to the current selection. If more
than one object is selected, a list of names is only shown if all objects in the selection
have exactly the same set of names applied. Otherwise “<many>" is displayed,
indicating that there are differences in terms of the names applied to different objects in
the selection.

To remove a hame from the selected object(s), click the name in the NAMES APPLIED list
to select it and then click the REMOVE button.

Repeating Objects

It's common to have items like navigation buttons, headers or logos repeating on all
pages of your website.

Web Designer provides the ability to repeat any item in the same place on any of your
web pages. When you update one of the copies, Web Designer automatically replicates
those changes across all pages that have a copy of the repeating object.

On most of the template designs the main navigation buttons are repeating. You can
make any object such as a button a repeating object by right clicking it and choosing
REPEAT ON ALL PAGES. The object is copied to the same place on all pages, displaying
the repeating symbol icon in the top right hand corner. If you make any further changes
to this item all the copies will be automatically updated.

However if the bar is set to be a SITE NAVIGATION BAR it automatically appears the same
on all pages of your site and there is no need to make it a repeating object.

Logo text and footers are also normally set to be repeating objects in the templates.

Again this means you can edit them on one page, and the same object is automatically
updated on all other pages.
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Note: This uses the current page as the source of the repeating items to update across

all the other pages.
:

The red box highlights the repeating object symbol, shown on every instance of the repeating
object

If you don't want a copy of the repeating object on a page, just delete it from that page.
When edited, the repeating object is only automatically updated to those pages that
already have it. This means you can choose which of the pages in your document
should have the repeating object and which should not.

If you want a repeating object on just a few pages of a large website, you can:

1.  First make your object repeat on all pages of your site, using Arrange > Repeat on
all pages.

2. Select one of the repeating objects and copy it to the clipboard ("Ctrl + C").

3. Hit the Delete key and choose the Delete from all pages option when prompted.

4. Now simply paste the repeating object onto each page that needs a copy of it.

Editing the contents of a repeating object

When Web Designer creates a repeating object, the repeating items are placed in a
containing 'repeating group’, similar to a normal group.

If you want to edit an item inside this repeating group, press Ctrl+click on the item to
select it inside the repeating group. Alternatively if you go into a specific tool you can
usually click directly on any object that is applicable to that tool and it will be selected
inside its repeating group (or any other type of group). So for example you can select a
rectangle that’s inside a repeating group by simply going into the Rectangle tool and
then clicking on the shape. As with any other edits made to a repeating object, any edits
you make inside a repeating group are applied to all instances of that repeating object
on other pages.
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Locking a repeating object

You can lock a repeating object right clicking it and choosing LOCK REPEATING OBJECT.
Once locked, the object is not selectable. But editing any other copies of that repeating
object on other pages, which aren’t locked, will change all copies, including the locked

copy.

Note that although the instance you locked is now unselectable, and so uneditable, all
other instances of the repeating object can be edited, and will all update accordingly
apart from the locked instance.

Headers/Footers

You may have pages in your site of varying lengths and want some repeating objects to
be positioned relative to the top of each page and others (e.g. footers) positioned
relative to the bottom of each page. You can configure Xara Web Designer 7 to do this,
so header and footer repeating objects will move with respect to the top and bottom of
each page.

The position of a repeating object on the page determines whether it is considered to be
a header or footer. If any part of the object is in the top half of the page, Xara Web
Designer 7 treats it as a header and will move it to the same position relative to the top
of each page.

Objects entirely in the bottom half of the page are treated as footers and Xara Web
Designer 7 positions them relative to the bottom of each page, irrespective of page
length.

For some repeating objects, this automatic decision making about whether the object
should be positioned relative to the top or bottom of pages may be inappropriate. So if
required you can force any repeating object to be positioned relative to the top or bottom
of pages by right clicking on it and choosing "REPEAT POSITION" > "TOP" Or "REPEAT
POSITION" > "BOTTOM".

To restore normal automatic positioning behavior to a repeating object, right click it and
choose "REPEAT POSITION" > "AUTOMATIC".

Stopping objects repeating

Right click an object and choose STOP UPDATING to turn off the repeating nature of an
object, or all of its copies in your website. Choosing STOP UPDATING from the ARRANGE
menu also allows this.

You'll be asked whether you want to just stop the selected object repeating or all copies
of the object in the website. Choose the ALL option. Now the different copies of that
object can be independently edited and the next time one is changed it won’t update any
of them.

Use this if, for example, you’ve used REPEAT ON ALL PAGES to copy an object to all pages

of your website, but then you want to make those objects different on each page so that
they are no longer tied together.
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STOP UPDATING is also useful if you want to make a copy of a repeating object (eg. a
footer or logo) on one page and you don’t want that copy to be updated. In this case
choose the JuST THIS COPY option when prompted.

Note that you can’t use STOP UPDATING on Navbars which have the SITE NAVIGATION BAR
option turned on in the NAVBAR DIALOG. That's because site navigation bars always
update across the whole website. See the Navigation Bar chapter for more information
on site navigation bars.

Deleting repeating objects

If you don't want a copy of the repeating object on a page, just delete it from that page.
Xara Web Designer 7 displays a prompt asking whether to delete just that copy or all
copies of that repeating object.

Pressing "Ctrl + Delete" will delete just the selected repeating object without asking
whether you want to delete all instances or just this one.
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Drawing a line or shape

You can use either the STRAIGHT LINE & ARROW TOOL oOr the SHAPE EDITOR TooOL ("F4") to
draw lines and shapes:

p™ The SHAPE EDITOR Tool is best for drawing precise curves and lines. It is also the
main tool to edit lines and shapes.

/ﬂ The STRAIGHT LINE & ARROW TOOL is best if you want to draw single segment
o straight lines, or add arrow heads and tails to any types of lines.

The Straight Line & Arrow tool

This tool makes it easy to draw single segment straight lines and to add arrow heads
and tails to any lines.
Why a straight line tool?

Prior to the addition of this simple tool, many users new to Xara Web Designer 7 had
great difficulty doing something as simple as drawing a straight line using the other
drawing tools! That's because the SHAPE EDITOR is more geared to drawing multi-
segment lines.

Hence the need for this tool, which makes it obvious how to do something elementary.

Drawing & editing straight lines

Simply click and drag on the page to draw a straight line. You can click on any existing
line to select it, and once selected you can click-drag on either end to move the end of
the line around.

Adding arrowheads & tails

The infobar has two dropdown lists on the left which allow you to choose an arrow head
or tail style for each end of the selected line.
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@ Arrow head
g Arrow tail

Arrow head/tail size
@ Reverse path

The slider on the infobar allows you to change the size of the arrow head and tail on the
current selected line. Or you can enter a percentage value into the size text field to the
right of the slider.

By default new arrowheads are created with a width of around 6 times that of the line
width and that is taken as the 100% size, as indicated by the size slider. If you make the
line wider, the arrowhead width also updates accordingly. Therefore enter a value less
than 100% to reduce the size of the arrowhead (and tail), or greater than 100% to
increase. Although the slider only takes the size value up to a maximum of 800%, you
can enter percentage values larger than this into the size text field.

Reverse path

Press the REVERSE PATH button on the infobar to switch around the head and tail
of the selected line.

Adding more line segments

Lines created with the STRAIGHT LINE TooL are of course fully compatible with the other
drawing tools. So if you want to add more segments to a line, make it curved, or perhaps
even turn it into a closed shape, use the SHAPE EDITOR TOOL.

The Shape Editor tool

3 The SHAPE EDITOR TOOL is the main tool used for both creating precise curves,
- lines, and shapes, as well as editing or altering lines and shapes.

320,2p% KIS
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v EHEETE vy~ v HEIE v~ v HIEETEE v -

Add/Change/Edit Indicator
Make curve

Make line

Smooth join

Sharp join

Break at points
Delete points
Reverse paths
Positions of handles
Smoothing

60000 00000

The InfoBar, shown above, provides a wide range of controls as well as precise numeric
control.

www.Xara.com



128

Drawing Lines and Shapes

All lines and shapes in Xara Web Designer 7 are made from a sequence of curve and
line sections. Curves are sometimes called "Bézier" curves after the mathematician who
first described them.

Although this section describes the SHAPE EDITOR TOOL,
you can also edit lines and shapes using the SELECTOR
TooL if you have the sHow EDIT OBJECT handles button
selected on the SELECTOR TOOL InfoBar.

Point handles

Selected handle

/
\

Curve sections Straight line section

The sections or segments of a line are marked by small black point handles. You can
drag, add and delete these handles to manipulate the shape of the line or outline.

Some objects such as quickshapes, rectangles, ellipses, and text have to be converted
into editable shapes before you can use the SHAPE EDITOR TOOL on them. Select the
"ARRANGE" > "CONVERT TO EDITABLE SHAPE" menu ("Ctrl + Shift + S") to do this.

To draw a straight line segment

Using the SHAPE EDITOR Tool, start a straight line:

1. Click where you want to start the line. You can start a line at either end; you don’t
have to work left to right, or top-to-bottom. This creates a point handle, and is
displayed as a red square to indicate that it is the selected handle.

2. If necessary select the MAKE LINE button on the InfoBar ("L"). This ensures the next
click will draw a straight line segment.

Selected point handle Either click where you want the next point
handle to be, or click and drag, and then
o release the mouse button when the line is

correct. This creates a line segment and
selects the new end point handle.

Original point handle “ %
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Mixing curved and straight lines

To create an object which is a mixture of straight and curved segments, just switch
between the MAKE CURVE and MAKE LINE buttons as you create the object (you can also
press "L" or "C" on the keyboard.)

Note: You can also use the keyboard shortcut "X" to create a Cusp Join or "S" to create
a Smooth Join while using the SHAPE EDITOR TOOL. These affect the way two line
segments come together. A Cusp Join creates 2 independent Bezier control handles
that you can edit separately. With a cusp join, you can create a sharp angle. A Smooth
Join creates a symmetrical join that works like a see saw. If you drag one Bezier control
handle down, the opposing control handle goes up.

To draw a curved line segment:

This is similar to starting a straight line (described above).
Add: 7/ 9 g ( )

1. Click where you want to start the line.

2. If necessary select the MAKE CURVE button (shortcut “C".)

3. Either click or drag (as described for straight lines) to create a second point handle,
and a curve segment will be added to the line.

Curve handles A curve segment has CURVE HANDLES associated with
the selected point handle. You can drag these to
adjust the angle and radius of the curve.

Selected handle

Extending the line

Make sure an end point handle is the selected handle (red outline) and then just click
again to add a new line or curve section. Each successive click places a new point
handle and draws a new line segment to the selected point handle.

Finishing the line

1+ click completes the line (keeps it selected), or press "Esc" to finish the line and de-
select it. After this, additional clicks will start a new line.
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Adding a new point handle

The SHAPE EDITOR TOOL has three modes, depending on whether no point handles are
selected (a click will start a new line), an end handle is selected (a click will add a new
section), or one or more other point handles are selected (you can drag or change the
handles).

The InfoBar shows the current mode.
Add: - /

o NEw: Click to start a new line,
¢ ADD: Click to extend the line,
e CHANGE: Drag or delete point handles to change.

This applies to the SHAPE EDITOR TOOL only.
To the end of a line:
Make sure the line is selected, then: . / Click here
1. If necessary, click on the end point to O ‘/
select it.

2. Position the pointer and click to add
a new section.

To the middle of a line:

L }

Make sure the line is selected, then;

1. Click on the line to add a new point handle Click here

into the line
2. Drag the point handle to the required position.

To the start of a line:

If the end point is selected, clicking on the start point closes the shape (this is described
in "Closing a shape” ). To add a new control handle to the start of a line:

1. Finish the line using "Shift + click".
2. Click on the start handle.
3.  Position the pointer and click.
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Selecting multiple point handles

You may want to select several point handles to delete them, move them as a group, or
change a region of points to curved or straight lines. To do this:

1.  Select one point handle in the normal way by clicking on it.
2. "Shift + click" the other point handles to select them ("Shift + click" also deselects.)
- Or"Ctrl + Shift + click" on a point handle to select all point handles on the line.
- Ordrag the mouse pointer diagonally to create a selection rectangle. All point
handles in the rectangle are selected.
- Or "Shift + drag" diagonally to create a selection rectangle. This adds all points
within the rectangle to those already selected.
3. If the line has one or more selected point handles:
- End moves the selection to the end of the line.
- Home moves the selection to the start of the line.
- Tab moves the selection to the next point handle towards the end.
- "Shift + Tab" moves the selection to the next point handle towards the start.

The start and end points are significant when applying arrows.

Deleting points

Select the point handle(s) as described above and either click the
DELETE POINTS button (SHAPE EDITOR TOOL InfoBar), or press "Del".

Moving point handles—Shape Editor Tool

You can move one or more selected handles:

¢ Drag the handles using the mouse.
e Or use the arrow keys on the keyboard.

Or to move a single handle, type new values into the text boxes on the InfoBar (see
below).
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Using the text boxes on the InfoBar

Y2000 R 50 R C20.20% R e center pair of text
RN T 70.0p% [RAPSPEN T E T [RAPRORIN O F 5 S R boxes always shows the
XIY co-ordinates of the

selected point.

The surrounding X/Y fields show the co-ordinates of the curve handles on either side of
the selected point.

X/IY co-ordinates are relative to the bottom left corner of the page by default for print
document and top left for web documents. You can change this in the "Grid and ruler"
(on page 298) tab in the options dialog.

If the selected point is on the end of a straight line section, the left fields show the length
and angle of the line. You can adjust either by entering a new value and pressing return.

FEERTES « »
va v [

o Length and angle for straight line
e Position of selected point
e Position of curve handle

Smoothing a line

Imported shapes or shapes from tracers may have unnecessary points on a line. Lines
with too many points can be unwieldy and can slow down rendering. Xara Web Designer
7 can smooth the line to remove unnecessary points.

__._.——-D-\___
O} s | .—-"‘{— J\C
Select all the points on the part of the line you want to smooth (see above). Drag

selecting around the region in the SHAPE EDITOR TOOL is probably the easiest way to
select a large number of points.
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Drag the smoothing slider on the end of the SHAPE
EDITOR InfoBar.

E/—/_—B\

Removed points are remembered so you can make further changes to the smoothing of
the line by adjusting the slider. Removed points are discarded when you make further
edits to the line by dragging a handle (for example).

Tip: to make sure important points are not deleted, make sure they are not selected
("Shift+ click" on a selected point deselects it).

Constraining the line

When dragging a point handle, holding down the
constrain key ("Ctrl") will constrain the movement to
multiples of the constrain angle (controlled from the
OPTIONS dialog, GENERAL tab). When dragging a curve
handle the angle is constrained.

Constrain angles

Changing curves

Using the curve handle

Dragging the curve handle will adjust the curvature of the adjoining curve segments.

Move the curve handle towards or away from the point

./?(\ handle to pull the curve in the required direction.

Dragging the line segment

You can also change the curve by dragging the line segment between points.

AN

Move over line to As you drag the Release the mouse
show this arrow line is re-shaped
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Notice the difference between dragging the line to change its shape, and clicking on the
line to add a new point handle. Dragging a straight line segment changes it to a curved
line segment.

Making sharp corners

Normally, Xara Web Designer 7 draws a smooth curve through a point handle. For this,
the two curve handles either side of a point handle are linked. Moving either curve
handle also moves the other.

Sometimes you will want a sharp corner, and to achieve this, you need to unlink the
curve handles:

1.  Double click the point handle,
2. Or select the point handle and either:

N A Click the cusP JOIN button, or press "Z".

You can now move each curve handle independently.

Making smooth curves

To convert a sharp join into a smooth curve:

1. Double click the point handle,
2.  Or select the point handle and either:

- 2 Click the sSMOOTH JOIN button, or "S".

The two curve handles become linked and move to opposite sides of the point handle.
This may change the shape of the curve.

Smooth join Cusp join
Curve Handles are linked Curve Handles are independent

Balancing curves

Balancing makes the two curve handles the same distance from the point handle, which
gives smoother, more symmetrical curves. To balance a curve, select the point handle,
then drag one of the curve handles with "Shift" held down. As you drag one curve
handle the other one will move to be exactly opposite it and the same distance from the
point handle.
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Changing a straight line to a curve (and vice versa)

1. Select the point handles at both ends of a line segment. For several line segments
select all bordering point handles.

2. Click the Make curve 0 or Make line 9 button on the InfoBar, or press "L" or
"C" (these shortcuts only work in the Shape Editor Tool).

After changing the line type, you may need to move the curve handles for a smooth
transition between curved and straight line segments.

You can select several line segments and convert them all. The point handles at both
ends of the segment must be selected.

Joining lines
You can only join lines if both are selected (the point handles are shown on both lines):

Using the SELECTOR TooOL, hold down "{" and click on the lines to select them (if you are
already in the SHAPE EDITOR TOOL, you can press "Alt + S" to temporarily go into the
SELECTOR TOOL, "{t+ click" to select the second line, then "Alt + S" again to return to the
SHAPE EDITOR TOOL).

Selecting objects is described fully in "Selecting objects (on page 97)".

Once both objects are selected, in the SHAPE EDITOR TOOL, drag the end handle of one
line over the end of the other line. As you drag the mouse pointer will show a + symbol
to indicate that the lines will be joined..

Drag an end point
over another end . .
point to join lines ... like this

If the ends of the two lines are already very close to each other (but not joined), then you
can either zoom in or drag the end point away, and then back again so it's over the end
point, and you see the + sign to indicate a join will occur.

To create a filled shape, drag the other two end handles together. Because you join the

end handles, you can only join lines and not shapes. Shapes are closed objects and so
have no end handles.
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Splitting a shape
If you want to split (break) a line or shape: Either select an existing point handle on the
line or outline of the shape, or create a new one where you want to break the line. Just

click on the line in the SHAPE EDITOR Tool (see above).

Click on the BREAK AT POINTS button, or press "B".

If you split a line, there is no visible change. However, if you move the point handle, then
only part of the line moves. If you split a shape, it changes to being a line. Any fill
disappears.

Closing a shape

A shape is a closed object with no start or end handle. Only shapes can be color filled.

To close a shape:

1. Create an open object with the end point handle
close to the start handle. All the point handles
(except the end handle) should be in their required
positions.

2. Position the pointer over the end handle.

3. Drag the end handle over the start handle and
release the mouse button. The two handles snap
together.

1. Create an open object with all the control handles
in their correct positions. Do not create the final
line segment.

2. Move the pointer over the start point. A + appears
to the right of the pointer when it is over the start
handle.

3. Click to create the final line segment and close the
shape.

Or:

1. Choose the SHAPE EDITOR TOOL.

2. Click on an end point to select it.
3. Pressthe "" key.
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Any of these closes the shape. If there is a current fill color, the shape is filled with that
color.

Changing the line width (thickness)

To change the line thickness or the outline thickness of a shape, first select the object or
objects:

Type a new line width into the text box on the STANDARD control bar or 2
. . px v
choose the default line thickness from the menu.

Line thickness is traditionally measured in points, abbreviated to pt. 1 point is 1/72™ of
an inch (about 0.3mm), which is slightly less than the thickness of one screen pixel
when viewed at 100% zoom.

You can use any of Web Designer’s standard measurement units.

You can enter the thickness value in any unit, and Xara Web Designer 7 will convert it to
the correct number of Points. E.g. you can enter 0.5cm, and you will get a line half a
centimeter thick, but it will show just over 14pt in the line width field.

If you have no object selected and you change the line thickness value, this changes the
default for all new lines.

Note: A zero width line is a special case, and should not normally be used. This draws a
line one device-pixel wide. The actual size will therefore depend on the device the
drawing is displayed on. On a monitor screen one pixel is clearly visible and is never
shown anti-aliased. On devices such as printers and particularly on image setters, which
have a much higher resolution, the line is almost invisible (zero width lines in imported
files are converted to 0.25pt).
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Changing the line width (thickness)

To change the line thickness or the outline thickness of a shape, first select the object or
objects:

Type a new line width into the text box on the standard control bar or

2
choose the default line thickness from the menu. o -

Line thickness is traditionally measured in points, abbreviated to pt. 1 point is 1/72™ of
an inch (about 0.3mm), which is slightly less than the thickness of one screen pixel
when viewed at 100% zoom.

You can enter the thickness value in any unit, and Xara Web Designer 7 will convert it to
the correct number of Points. E.g. you can enter 0.5cm, and you will get a line half a
centimeter thick, but it will show just over 14pt in the line width field.

If you have no object selected and you change the line thickness value, this changes the
default for all new lines.
Creating rectangles and squares

To create a rectangle:

n e Use the RECTANGLE ToOL ("Shift + F3", or "M").

Click and drag on the canvas to draw a rectangle.

Creating a square

To create a square rather than a rectangle, hold down "Ctrl" while dragging.

Creating and Editing rounded corner rectangles

To give your rectangle rounded corners, select it and then press the
“Curved corners” button on the RECTANGLE TOoOL infobar.
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You can then drag on the selection handles shown on the corners to adjust the diameter
of the rounded corners.

You can resize rectangles using either the RECTANGLE TOOL (by dragging on the handles
shown at the corners) or the SELECTOR TOOL.

Note that if you change the aspect ratio of a rounded corner rectangle using the
SELECTOR TOOL (by stretching it in one dimension only) the aspect ratio of the rounded
corners is not stretched, it is maintained. However if you have multiple objects selected,
or if you're stretching a group containing a rounded corner rectangle, the aspect ratio of
the corners is not maintained.

Creating circles and ellipses

To create an ellipse or circle:

n Select the ELLIPSE TOOL ("Shift + F4", or "L").

The RADIUS AND DIAMETER buttons automatically create circles.

o Radius

@ Diameter
e Bounds creation

With the BOUNDS CREATION button selected, drag on the canvas to draw an ellipse. Hold
down "Ctrl" while dragging to create a circle rather than an ellipse.

Select the RADIUS option to draw circles. The start point of a drag determines the circle’s
center.

Select the DIAMETER option. Now the start point of a drag determines the position of the
edge of the circle.

You can convert an ellipse into a circle at any time by double clicking on a control
handle.
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Color Handling

Xara Web Designer 7 gives wide control over applying, creating and altering the colors
of objects. For simple documents, you can just choose colors from the on-screen color
palette, the Color Line. More advanced color operations are described later.

The color line

The Color Line is displayed at the bottom of the window. It shows you the current fill and
line colors, provides access to the color editor and provides a palette of pre-defined
colors including a special "no color".

4 6

@ coLor swaTcH: The outer part of the color swatch on the left-hand end of the Color
Line shows the line color and the center shows the fill color. These are the colors
of any selected objects, or the current color attributes if no objects are selected.

9 n This button provides access to the color editor (on page 144)

e COLOR PICKER: Use the eye-dropper to pick a color from any part of the document
or any part of the computer screen. See Using the eye-dropper to pick colors (on
page 145) for details.

9 NO COLOR: Clicking this applies a "no color fill". Shift-clicking applies "no color" to a
line. Note that this is not the same as 100% transparent. "No color" and
transparency are different. A shape with transparency applied remains a solid
shape whereas a shape filled with "no color" is effectively hollow. The NO COLOR
button can also be used to restore the original colors to a photo which has had a
contone color applied.

Current Fill color
Current Line color
If the length of the Color Line exceeds the window, you can scroll through the Color Line

with the scroll bar below or by "Alt + dragging" the Color Line.

Xara Web Designer 7 provides several options for the displayed size of the Color Line
(described in Customizing Web Designer).
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Colors on the color line

<

o e
s

1 rounded rectangle: Drag to create a new rectangle; Click to select an obj

o Theme Colors: First comes the Theme Colors (if present in the document, see
below). Theme colors are used to give templates and designs theme colors, so that
the color scheme of a design can easily be changed without editing every object in
it individually.

e Linked Colors are represented differently on the color line by smaller rounded
rectangles, so it's much easier to distinguish which are normal independent Theme
Colors and which are linked to a parent.

e Palette colors: There are 46 pre-defined palette colors. There are 5 shades of 7
standard hues and 10 shades of grey, black and white. Palette colors are not
editable (i.e they are not Named Colors) and are designed as a simple, limited
selection of colors to apply to objects (either by dragging on to the object or
clicking).

Little markers in the color icons shows which of the named colors (if any) or palette
colors have been applied to the selected object(s).

* W Diamond markers show the colors used by the selected objects. A diamond
in the top-left corner indicates the fill color, in the top-right corner indicates
the line color.

Cross-shaped markers show the current color attributes if there are no
objects selected. Line color on the right, fill color on the left.

B 3@ Triangular markers show the colors of a fill if you have applied one.

This works also when choosing a color with the color picker from existing objects, see
Using the eye-dropper to pick colors (on page 145). The color line markers update
immediately and indicate the color of the object under the eye-dropper as you're
dragging around.

Re-ordering colors on the color line

You may prefer to re-arrange colors on the Color Line. To do this, "Ctrl + drag" colors
along the Color Line. This also reorders the COLOR GALLERY. Only named colors can be
re-arranged on the Color Line.
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Color line context menu

Click on a color on the Color Line to show a context sensitive menu with the following
options:

EDIT Opens the color editor with the selected color (not
available for palette colors)

SET FILL COLOR / SET LINE COLOR Set the fill or line color of the selected object with this

color
RENAME Rename a named color (not available for palette
colors)
DELETE Delete a named color (not available for palette colors)
OPTIONS Opens the General tab of the Options dialog.

If the selected object is a bitmap, you can also see SET CONTONE DARK COLOR / SET
CONTONE LIGHT COLOR. See Bitmap coloring (on page 183) for more information.

When clicking the “no color” swatch, the fill and line color options are replaced by: CLEAR

FILL COLOR / CLEAR LINE COLOR. This sets the selected object's relative attributes to "no
color".

Applying fill & line colors by drag & drop

e To apply afill color to an object (selected or unselected), drag a color from the Color
Line and drop it into the center of the shape.

e To set the line or outline color, drop it on the outline, not the center.

e To change the current fill color, drag a color into a blank space.

e To change the page background color, "Ctrl + drag" a color onto the page
background.

When dragging colors an indicator beside the pointer tells you what effect dropping the
color will have:

[%D Set flat fill color (seen when you drag over an object) or the intermediary colors of
a multi-color fill (on page 186)

[% | Setline color (seen when you drag over a line).

[%“ﬂ Set the current fill color (seen when you drag over an empty space).
[%ﬁ’ Set start color of graduated fill (seen when dragged over start of fill).
[%5 Set end color of graduated fill (seen when dragged over end of fill).

%] Set page background color (seen when you drag a color onto the page).
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Instead of drag & drop, if you have an object selected, you can just click on the Color
Line. This opens the Color Line context menu where you can set the line or fill color.

In any other case, you can alter the line color by "Shift + clicking" on the Color Line.

If a photo or a bitmap-filled shape is selected, then clicking on the Color Line will
contone the bitmap. That means, the bitmap is converted to greyscale (black and white)
and the selected color is used as a contone light color. The contone dark color is usually
black. You can set both contone colors via the Color Line context menu (see above).
See Bitmap coloring (on page 183) for more information.

To set a fill or line to no color (clear), perform the operations
as outlined above but use the "No color" option instead of a
color.

Editing an object’s color

To edit the fill color of the selected object(s):

Choose "UTILITIES" > "COLOR EDITOR" ("Ctrl + E").

Or click the EDIT coLOR icon on the Color Line.

Or right click the object and choose FILL COLOR

Or double click on the current line and fill color icon on the Color Line (the edge of the
leftmost panel).

To edit the line color of the selected object /s

e "Shift + click" on the EDIT COLOR icon
¢ Or double click on the current line and fill color icon (the edge of the leftmost panel).

This displays the coLoR EDITOR which allows you to select from any color of the
spectrum. Unlike most graphics programs the Color Editor can remain on screen while
you continue to work. It changes to reflect the color of the selected objects, and so you
can easily and directly adjust the color of the selected object.
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The Color Editor

The Color Editor is used to change the color of objects in the document.

\."" Color editor

B [Current fill color | ~ 74

o When editing a color you can drag the eye dropper to pick colors off screen, even
from other open windows

e Select the color to edit: Fill color/Line color of the selected object or any of the
named theme colors
Click to show extended color controls

@ Previous color

Actual color
Drag here to select any shade of the selected hue
Drag here to select any hue

The easiest way to create a new color is to select the hue along the bottom color strip.
All possible shades of this hue are then shown in the top section, so just click or drag in
the top section to select the new color. You'll notice the selected objects change color as
you adjust them in the color editor (called "live preview").

For example to select a pink color, which is a pale shade of red, select red along the
bottom section and then select a very pale red (pink) from the top right area of the top
section.

Previous and Current color

As you drag on the color editor the two small color swatches in the upper right of the

color editor show the current color and the previous (before you started changing the
color). This is useful if you want to make a small change and want to compare the old
and new colors.
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Using the eye-dropper to pick colors

Instead of selecting hues and shades on the COLOR EDITOR you can instead pick a color
from any part of the document or any part of the computer screen—even from other
windows and programs.

To do this just click and drag on the eye dropper icon. As you drag you see the color
editor continuously picks up the color under the eye dropper. Release the mouse button
when you have the desired color. This is an easy and quick way to use the same color
again or copy colors from photos or from one object to another.

The color picker doesn't simply sample the screen (RGB) color. Instead, if you point to a
shape with a solid fill color, the sampler will pick up the actual color of that shape,
including the color model (RGB, HSV or CMYK), so the color is copied exactly to the
selected object(s). If the target color is a named or palette color, instead of simply
copying the color the color picker will apply the same color to the selected object(s).

If the object under the mouse pointer is complex (eg. has transparency applied) and the
color cannot be determined, screen RGB color is applied.

r/g The color sampler shows a small popup at the mouse
il pointer which indicates the color that is being sampled at
that point. This will either be the palette color name, the

name of a named color, or the color model and color
value.

[Ha¥(19.1, 22.2%, §3.1%)]

Advanced color operations

Click the SHOW ADVANCED OPTIONS icon on the color editor to reveal the lower
part of the dialog that provides more options.

. -
2 3

h i

Normal color 4‘

o No fill color

e HSV color values

9 RGB hex value

9 Color type: See Creating a Tint, Shade or Linked color (on page 149)

Here you can enter precise RGB (or HSV) color values. The most common requirement
for web graphics is to enter a hex RGB color. The H, s and v fields allow you to specify
the color as HSV (hue saturation value) values in percent. In the # field you can enter

RGB value in hexadecimal numbers (0-F). Also a 'No fill color' button and a help button
is available here.
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Local colors and Theme colors

Web Designer has two types of color:

e LOCAL COLORS are used in only one place in the document. Each object has a
separate color and nothing is shared. This is useful if you want to change the color of
an object without affecting other objects. Local colors are the easiest method and best
for simple documents that use relatively few colors. "Applying color" and "Editing an
object’s color" above describe local color handling.

e THEME COLORS can be used again and again in the document. (As such, they are like
styles in a word processor.) Theme colors are used in templates and assure a
consistent look of your page elements like buttons or navigation bars. Any edits you
make to a Theme color are immediately reflected on all objects and parts of the
drawing that use that color. You can also copy Theme colors between documents. If
there are any Theme colors already present in the design and you load or paste
templates from the Designs gallery containing Theme colors with the same name, you
will be asked if you want to match the actual color of the imported Theme colors to the
existing ones. The Theme colors from the Templates are consistently named so when
you import elements from different themes colors are matched perfectly.

Theme color schemes

Many of the web themes offered in the DESIGNS GALLERY and in separately purchasable
Template Packs include alternative color schemes which can easily be applied to
websites which use the same theme, to transform the color scheme instantly. The color
schemes are normally found in the Designs Gallery in each theme, after all the page
layouts and separate graphic elements that make up the theme. They all have "Color
scheme" in their titles in the Designs Gallery, so they are easily identified.

To apply a color scheme to your website, simply drag the scheme from the Designs
Gallery and drop it on your page. You can try applying the color schemes of one theme
to a website created from the templates of another theme. But you will get mixed results
doing this and some schemes will not work acceptably with some themes. So for best
results stick to the color schemes of the theme that you used to create the site.

One of the color schemes provided with each theme matches the default colors used by

that theme. This allows you to easily return to the original colors if you prefer, after
experimenting with the alternate schemes.

Editing theme colors

To display the named color in the COLOR EDITOR so it can be edited choose from the
menu in the COLOR EDITOR or drag & drop the color from the Color Line onto the COLOR
EDITOR.

You can then edit the color as required. All objects that use this color are automatically
and immediately updated to show the new color.
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To rename a THEME COLOR while editing it, right click on the coLOR EDITOR and select
RENAME or right click the color on the Color Line and select RENAME.

To delete a named color, right click on the color in the Color Line and choose DELETE.

Importing named colors

When a design is imported into the current document (e.g. import from the DESIGNS

GALLERY, import a XAR file or paste objects in from another design) if there are any

named colors in the imported design which have the same names but different color
values as colors in the current design, an alert appears as follows:

Match colors

:q/ Do you want to match o
-,

Don't Match

W Don't

If you want the imported objects to inherit the colors of your current design, choose the
“MATCH” option. This makes all objects using a given named color use the existing
instance of that color as it appears in the current document.

Alternatively if you want the imported objects to keep their own independent colors,
select the “DON’'T MATCH” option. This adds new named colors into your design, with a
number appended to the color names to distinguish them from the colors already in the
current design. This allows the imported objects to keep their original colors.

Note that if you import objects from lots of different designs and choose “DON'T MATCH”
each time, you will end up with a large number of separate Named Colors on your color
line.

The match prompt above includes a “DON'T ASK ME AGAIN” checkbox. If you check this,

the option you choose will be assumed for all future imports, without asking you again.

However this only applies during the current session, so after a program restart you will
be asked again on the next import if there is a color clash.

Using the MATCH option means that you can choose a template, change its theme colors
and then import more templates of the same theme and the imported designs will
immediately pick up your modified theme colors.

For example, import a red graphical button from the DESIGNS GALLERY, change its main
theme color from red to green, then import a red logo graphic of the same theme and
choose the “MATCH” option. When the logo appears in your design, instead of being red
it will have picked up your chosen green theme color automatically. Since most themes
have their main theme color named “Theme color 17, you will also usually get good
results when importing graphics from different themes and matching the colors.
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Normal colors, Tints, Shades and Linked colors

Normal colors

These are the normal stand-alone colors you apply to objects.

Xara Web Designer 7 can also define colors that are linked to another color, that is
when the parent color changes the linked color will change as well. There are three
ways you can link a color to its parent TINTS, SHADES, and LINKED COLORS. These are
very powerful techniques that allow, for example, single-click re-coloring of complex
shaded drawings. Some of the example clipart uses this technique.

Tints

Tints are based on other colors (called the parent color) and are always a paler version
of the parent. They have two main uses:

e Where you have paler shades of a parent color and you may want to change the
parent color in future with the tints automatically updating.
e To extend the range of colors available from printing inks.

For example, a 25% red tint gives a pink color. Therefore using just a red ink you can
have both a pure red and a pink using only one ink. Similarly, if just using black-and-
white printing, it's often useful to be able to use tints to create various shades of gray.

If you are printing with a limited range of colors (it's usually cheaper to print one or
two color, instead of full or four color printing).

A tint can be based on any type of color, including another tint.

Any changes you make to the parent color also change tints based on it. For example,
you might define the color pink as 50% of a red parent color. Changing the parent color
to orange automatically changes pink to light orange.

Shades

These allow both lighter and darker colors to be created all based on a parent color.
Changing the color of the parent changes all associated shades. For example, a
drawing of a car might use shades for the highlight and shaded regions of the car body.
A single edit to the parent changes all the colors of the entire body but keeps the
shading correct. Setting up shades this way is more time consuming but it is a very
powerful way of altering colors.

For best results, the parent color should be a "pure" saturated color. When using the
HSV color mode, saturation and value should ideally be 100%. When viewed in the
COLOR EDITOR the cross should be in the top left-hand corner.

Linked colors

Linked colors are similar to shades but give greater flexibility. These are also based on a
parent color but you define which attributes you want the linked color to share with its
parent. For example you can create a linked color that is a more or less saturated
version of the parent, but the hue and lightness / darkness follow the parent.
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Creating a Tint, Shade or Linked color

See above for a description of TINTS, SHADES and LINKED COLORS (on page 148). They
are useful where you want a lighter or darker shade to track that of a parent color.

TINTS, SHADES and LINKED COLOR have to have a master "parent" color, which needs to
be a named color, so that when you change this parent color, the tint will change as
well. So, if necessary, first create a named color (see Creating new named colors).

To create a tint, shade or linked color:

1. Select the object or objects to which you want to apply the color.

2. Open the COLOR EDITOR showing the advanced options.

3.  Select the "normal color" drop-down menu and select the TINT, SHADE, Or LINKED
option.

4.  From the PARENT dropdown menu, select the named color that you want this color
to be linked to.

5. Adjust the TINT, SHADE or LINKED COLOR on the top section of the color editor.

If the tint, shade and linked color options aren’t included in the color type drop down list,

this probably means you haven'’t yet created a named color to link to, or that you are
editing the one and only named color in the design.

W Color editor X" |'\¥ Color editor

[ [Local fill color -

Help

Tint of another color v Shade of another color v
EIC S ] Theme Color 1 - I E [l] Theme Color 3 -
mint: 2Ry = shade: [ 2 [EER >

On the left you can see the new color is a tint of the parent "Theme Color 1" and so the editor
provides only paler tints of the parent color. On the right, if you select a shade for "Theme
Color 3", you get to choose any lighter or darker shades of the parent color.
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If you want to use this color in many places in the document it's recommended that you
also make this a Named Color, so it appears on the Color Line, for easy picking. Just
click on the New Named Color label icon on the top of the Color Editor and give it a
name. It will now appear on the Color Line where you can pick it for use on other
objects.
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Text Handling

Introduction

The text editing facilities of Xara Web Designer 7 are very like your text editor or word
processor, but in addition it provides a range of features you won't find in those
programs:

4

You can enlarge or magnify text to a huge degree.

You can apply the range of normal Xara Web Designer 7 attributes
and effects: fills, transparency, color fades, shadows, and still
continue to edit the text.

You can convert the outlines of characters to shapes which can be
edited just like all normal shapes.
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Fit text to a curve. All text can be rotated, skewed and stretched.

Terminology

FONT or TYPEFACE: A set of characters with a consistent style.

FONT FAMILY: A set of similar fonts. For example Garamond and Garamond ltalic are
different fonts from the same Garamond family.
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JUSTIFICATION: An alternative way of describing text alignment. Left aligned text is
sometimes called left justified, or flush-left, or ragged right.

MONOSPACED: All the individual characters of a monospaced font have the same width.
Sometimes referred to a fixed width fonts. Useful for program listings. Courier is the
most common monospaced font. Most fonts are proportional spaced fonts, meaning the
characters vary in width.

POINT: Text or font sizes are traditionally measured in points, abbreviated to pt. 1ptis

approximately 1/72nd inch, so 72pt text is approximately linch tall, although different
fonts of a given size can vary.

The Text Tool

Use the TEXT TOOL ("F8") to enter or edit text.

TEXT TOOL InfoBar Left Side

@ ront

Font Size
Bold
Italic

Underlined
Justification
1
S
S

TEXT TOOL InfoBar Right Side

Subscript/Superscript
Line Spacing
Paragraph Spacing
Bulleted Lists
Numbered lists
Indent

Outdent

Spell Checker

00000

Xara Web Designer 7 supports three basic type of text objects
¢ Simple text lines: Click on the page, and type.

e Text columns: Click and drag to create a column, and type.
e Text areas: Click and drag diagonally to create a rectangular area, and type.
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After you've created any text object you can transform it (rotate, scale, skew) and can
apply all the normal attributes, fill color, transparency, etc, using the normal tools. You
can also attach it to a curve. The text will remain editable.

The Font Menu

Live font size pop-up

Helvetica 45 Light »
Palatino Linotype
Times New Roman

B 7 U

Fonts used in
this document
Arial

>
Arial Black 4
Comic Sans MS »
v
»

Courier New
Georgia

Web safe fonts Impact

Lucida Sans
Palatino Linotype
Tahoma

Times New Roman
Trebuchet MS
Verdana

Regqular
Italic
Bold

Bold Jtalic

Styles available
for the selected font

183thCentury
( Abbess
Acclamationltal
AcmeFont
Addled

AGaramond ’
All other fonts < ixtanin
ALIENENLUUNIEND
MLMONIE SNOw
Amsthyat
\ Andale Mono IPA ObOdOfOhOj
AsticFont
Arial »
Arial Black 4

The font menu lists all installed fonts, and is split into three sections. The top section
displays those fonts that are currently used in the document. The second section shows
the “web safe” fonts. These are the fonts you can safely use in web pages, because all
commonly used web browsers will support these fonts. See Web Safe Fonts section.
The final section displays an alphabetical list of all other installed fonts. Each font name
is displayed in the menu using its own typeface, making font selection easier.

Those fonts for which multiple font styles are available are shown with small black
triangles against them on the right hand side of the menu. Simply hold the mouse
pointer over such a font name for a second or two and a small sub-menu appears to the
right of the main menu, listing the available styles of that font. While this sub-menu is
displayed, you can move the mouse pointer over it to select the desired font style.

Web Safe Fonts

Only a small set of fonts can be used safely for the main text of a website - only those
fonts that you know will exist on the computer of the viewer of your website. Although
there are no guarantees, there is a common subset of fonts that are widely used by
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something like 98% of all computers, including Apple Mac and some Linux computers.
These fonts are called the 'web safe fonts', and are listed in a separate section of the
font menu. If you try and export a website using non safe fonts you will get a warning.

Live Font Preview

As you move the mouse pointer over any entry in the font menu, the selected text in the
document is instantly updated to preview the font. This is not a permanent change until
you actually click on the required font. Moving the mouse pointer over the menu will
revert back to the initial font until you move over another entry. This is great for very
rapidly previewing large numbers of fonts.

If you hold down the "Shift" key while traversing the font menu, then the font selection is

not updated instantly, there is a short pause before it is updated. This is useful if you find
that instant preview slows down your traversal of the menu (perhaps if you have a large

amount of text selected).

Live Font Size preview

Next to the font size menu is a small pop-up slider control, like that used elsewhere in
Web Designer. This provides a direct, live font size control, and will adjust the font size
of the selected text in real-time as you drag the slider.

Click to display font size pop-up

As with the pop-up sliders used elsewhere this can be used two ways. "Click + release”
on the arrow and the pop-up will appear and stay on screen. You can now drag the
slider, or use the mouse scroll wheel over the control to rapidly adjust the values. So in
this case, this provides a fast way of adjusting the point size using the mouse wheel to
see the results directly on the page of the document as you work.

The alternative method of using the pop-up slider is to "click + drag + release" on the
button and slider. This is a slightly more direct way of adjusting the control (requires less
clicks).

Instant font menu navigation

While the font menu is displayed, you can type the initial characters of the font name,
and the menu will be scrolled to that section of the list. E.g. if you type "ver" it will
instantly scroll and locate the Verdana font.

Simple text
If you wish to type a small amount of simple text, position the pointer where you want to
enter text and click. A red cursor appears where you clicked and you can now start

typing on the keyboard.

If you make a mistake, use "Delete" and "Backspace" in the usual way.
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Pressing "Enter" completes the line and starts a new line of text below it. The inter-line
spacing is controlled by the line spacing text box on the InfoBar.

By default text has no outline color. "Shift + clicking" on a color on the Color Line will
give the selected text an outline color - the thickness of which can be controlled by the
line width control, as usual. You will probably want to set the Line join type to be
rounded to give it a more smooth appearance (control at the top of the LINE GALLERY).

Line width is described in Changing the line width (thickness) (on page 137, on page
138). Applying color is described in Color handling (on page 140).

You can continue to enter text even after rotation, color filling or placing it on a curve.

Text in a column

If you are entering larger amounts of text, over multiple lines, using a column may be
more useful. Changing the width of the column will automatically re-flow the text.

To type a column of text:

1. Select the TEXT TOOL.
Move the mouse pointer where you want the column to start.

3. Drag right to create a horizontal line the width of the column. This red line just
shows you the width of the column. It is never exported or printed.

4. Type in the text. You don't need to press "Enter" at the end of a line. When the text
reaches the edge of the column, it automatically flows onto a new line.

NOTE: If you click away or change tools before you start typing, the text column will be
removed and nothing left on the page. Therefore always start typing after you've
dragged the column width line.

Instead of typing in the text you can create the text in a separate text editor or word
processor, copy it to the clipboard and paste it into Xara Web Designer 7. Copy and
paste supports RTF-formatted text.

Words only split across lines if they contain a hyphen character (minus key)

running across two lines, ning across two lines,
type in a hypen. type in a hypen.

The effect of typing a hyphen into "running"

If you type "Ctrl + -" (minus key) it inserts a soft hyphen which is a hyphen that only
appears if the word can wrap at the end of a line. This is particularly useful for narrow
columns of text, to avoid rivers of white, you might need to hyphenate some words.
Inserting a normal dash character will split the word at the end of the line. It's called a
'soft' hyphen because when the word appears in the middle of a line the hyphen
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vanishes (unlike a normal dash or minus character), so it intelligently hyphenates the
words only if it needs to.

When editing the text a soft hyphen is treated as an invisible character (it takes no
space), but you can tell it's in the text by moving the cursor left/right over where the
invisible character is.

A hard hyphen can be inserted by typing "Ctrl + Shift + -" (minus key). A hard hyphen is
one that will not cause a wrap at all. This is useful in situations where you have dashes
in words that you do not want split at the end of lines.

Changing the width of the column

Drag either of the two red handles at the ends of the line.

Changing the angle of the column

"{r+ drag" either of the red handles at the end of the line to change the angle of the
column. Alternatively, "Ctrl + drag" to restrain the line to the constrain angles. Or
alternatively you can use the SELECTOR TOOL to rotate the object in the usual way.

For more on constrain angles, see Introduction to Xara Web Designer 7.

Text areas

In the TEXT TOOL if you click and drag diagonally on the page you will create a
rectangular text area. The blinking cursor will be positioned in the top left corner and you
can type or paste text.

A text area can contain a "flowing" text story. This is where a single piece of text flows
from one text area to another. It's called flowing text because, like water, as you add or
remove text in one area it overflows into connected text areas or flows back from text
areas.

If the text overflows the bottom of the text area the overflowing text is shown gray,
although you can continue to edit this text as usual.

Connecting text areas—text flow

When text overflows the bottom of the text area, an overflow indicator is shown on the
bottom of the area. If you drag this over any other text area, the overflow text will flow
into the new text area, and the two areas become connected. This is shown with a flow
arrow.
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‘When text overflows the bottom of the text. ~ Dragging the overflow indicator from one

area, an overflow indicator is shownon text area to another will connect the two
the bottom of the area. If you drag this | areas so text flows from one to another.
over any other text area, the overflow text | You can link as many together as you

/ﬂ‘ require.

Overflowing text  yerfiow indicator

There is a quick way to create flowing text. If the text cursor in an area with overflowing
text, then just click-drag on the page to create a new text area. The new text area is
automatically connected and text will flow into the new area.

Tip: You can flow text from one area to another on any page, even earlier pages. If you
need to flow into an area many pages away, it's probably easier to use the above
method, although if you zoom out to a small page size you can drag the overflow arrow
across pages.

To disconnect one text area from another, just drag on the overflow indicator and drop it
away from any text area.

If you delete a text area that is connected to another only the area is deleted, the text
will simply re-flow into the remaining text areas.

Resizing text areas

Using the TEXT TooOL, you can click and drag on any of the corner control handles. The
text in the area will be reformatted to fit the new size.

Alternatively you can use the SELECTOR TOOL to resize the text object, but in this case
the behavior is different. If you resize a text object using the SELECTOR TOOL, the text
itself changes size. This is consistent with the normal operation of the SELECTOR TOOL.

However in the case of flowing text areas this would cause undesired side-effects; you
almost certainly do not want part of a flowing text story to be a different point size than

the rest. Therefore, the SELECTOR TooOL behavior varies depending on whether you are
resizing one text area that contains a flowing text story, or resizing the whole text story.
The rule is:

¢ If you resize a single unconnected text area (or simple text or text column) then the
area "container" and text content are resized together.

¢ If you select the text areas of the whole flowing text story (they have to be on a single
page) then a resize will resize the text and areas together.

e But if you resize a text area that is part of a flowing series of text areas, then only the
container size is altered and the text inside remains the original size, and will be re-
formatted to fit the new size. This is like resizing a text area with the TEXT Tool.

If you want to resize all text in a text story, select it all with "Ctrl + A", and apply the
required font size.
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You can rotate a text area, using the SELECTOR TOOL as normal, and the text will flow
through the rotated text area normally.
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Text flow is unaffected if you rotate any of the text areas

Hold down "Ctrl" while rotating to constrain the text rotation angle to 90° angles and
screen aligned angles.

Word count

The word and character count total of the current text is shown in the status line. This
also shows the number of overflowing words. If any region of text is selected, it shows
the count of this selection instead.

Text along a curve

To place text along a curve of your choice:

1. Create either basic text, textina ~ ThS 1S Som,q )
column or a text area (see - “f@&t ;»919/
above). %‘ialangrth-\s’

2. Select your text object and one
curve.

3. Choose "ARRANGE" > "FIT TEXT TO
CURVE".

Alternatively, select a curve or line and then in the TEXT TOOL, click on the line, where
you want the text to start, and type. This automatically fits the text along the line. When
you reach the end of the line the text will wrap onto a new line, immediately below the
start of the previous one.

If you do not want the text to wrap to a new line, "Shift + click" on the line.

To hide the curve so it’s not visible, select the SHAPE EDITOR TOOL and set the line color
to NO COLOR or a width of NONE. You can also edit the curve as usual this way.
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Applying color is described in Color handling (on page 140).

Adjusting the left and right margin of text on a curve

If you just start typing or place a column of text on a curve, you can change the start and
end position of the red handles. Just drag them along the curve as required. If you
center text it will be between these two margins.

Swapping sides of the line

Right click on the text and select the REVERSE TEXT ON CURVE menu option.

Alternatively, if you reverse the direction of the line (SHAPE EDITOR TOOL, REVERSE PATHS
button on the InfoBar), then the text will move to the other side of the line or, in the case
of a closed shape, move from the inside to the outside of the shape.

Editing text

Double clicking on a text object in any tool takes you into the TEXT TooL and places the
cursor at the click position in the text.

All the normal word processor-style cursor and mouse operations can be used. For
example:

¢ Click where you want to place the cursor.

¢ Use the left and right arrow keys to move left, right, up or down.

e Use "Ctrl + left and right arrow keys" to move left or right one word.

e Press "Home" or "End" to move to the start or end of the line.

e Press "Ctrl + Home", or "Ctrl + End" to move to the start or end of the text object.

Text selection:

"Shift + any” of the above keys to select text

¢ Double click to select a word

o Triple click selects a whole line of text, or "Ctrl + L"

e Quadruple (4x) click selects a paragraph of text

e Or just drag across the text in the Text Tool to select the text

o "Ctrl + A" will select all the text in the text object (you must be in the TEXT TOOL.)

If you have a text selection any attribute change will apply only to the selected region of
text. If you have only the cursor in the text, then any attribute change, say selecting a
new color, will only appear when you type new text.

Selecting the whole text object

There is a quick shortcut for selecting the whole text object. Instead of using "Ctrl + A" or
dragging across all the text, simply press the "esc" key. This removes the cursor but
selects the whole text (the status line will confirm 1 text object). This makes it easy to
apply an effect or attribute to the whole text story.
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For example, to change the font size of the whole text object, just press "Esc" and select
the new size from the InfoBar.

Swap case

Pressing "Ctrl + W" will swap the case of the character after the cursor and move the
cursor on. So, if you've accidentally typed a section of text with the caps lock key on, just
place the cursor at the start and press and hold "Ctrl + W".

You can swap the case of a selected region of text, the same way. The cursor will not be
moved.

Smart Quotes

When you type quote ' or double quote " characters, Xara Web Designer 7 will
automatically convert these into the more appropriate and aesthetically accurate
opening or closing quotes. So this changes 'this' into ‘this’ and "quotes" into
“quotes”. It's smart enough to understand the use of single quotes within words to
signify missing characters, so that 'don't' becomes ‘don’t’.

Entering special characters

There are a number of useful shortcuts to allow insertion of special characters, like © or
™ _ See Special characters (in Text Tool) (on page 318) section in "Menus and keyboard
shortcuts”.

All these shortcuts (with the exception of the hard space) are compatible with Microsoft
Word.

Entering dummy text (‘Lorem Ipsum’)

When creating page layouts, it's common practice to use dummy text, which is a type of
pseudo-Latin (it doesn't really mean anything), but has the overall appearance of typical
English text (or other similar Latin-based languages). The text begins "Lorem ipsum
dolor sit amet..."

Historical note: This same text has been used as dummy text going back more than
500 years in the print trade and parts of the actual Latin used can be traced to text
written more than 2000 years ago.

You can insert a paragraph of the "Lorem ipsum" text by typing "Ctrl + Shift + L" ("L" for
Lorem) while using the TEXT TooL. To insert a larger block of text, just press the key
combination a few times.

Spell checker

The TEXT TOOL includes a spell checker. To turn it on, select the SPELL CHECKER
icon on the TEXT TooL infobar, which opens a menu.
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Select “CHECK SPELLING AS YOU TYPE”. Now all [ PR s e sz
unrecognized words in your document and as you All unrecognized words in

type are shown with a red

type are shown with a red dashed underline. your document and as you !
dashed underlane ?

To correct a misspelled word, right click on it and

the context menu shows you suggested correct benasisadiien underline
spellings of the word at the top of the menu. under lane
Simply select one of the suggestions to replace under-lane

the word.

Language selection

The menu shown when you click on the Spell Checker icon on the infobar lists all the
languages for which you have dictionaries installed. By default the language
corresponding to the current locale setting is selected. You can choose different
languages for different text objects, so you can use text in multiple languages in your
document if required.

To change the language associated with a text object, select the text object, then in the
TEXT TOOL choose the required language from the Spell Checker menu. Now the text
object will be checked against the dictionary for the language you chose.

If you want to enter many text objects using a language other than the default, you can
change the current language text attribute so that you don’t have to change the
language on every text object individually. To do this, make sure you have nothing
selected (click an empty area of your design using the SELECTOR TooL). Then in the TEXT
TooL, choose the language you want to make current using the Spell Checker menu.
You will be asked if you want to set the current language text attribute. Click “Set” to
confirm. Now each new text object you create will be associated with the chosen
language. Note that this current attribute is not re-loaded when you save and load your
design. So you will need to repeat the above procedure to set the current language text
attribute again the next time you load the document, if you want to continue entering
new text objects using the same language.

If you have a text object which you don’t want to be spell checked at all, select the object
and choose the “No language (ignore)” option from the Spell Checker menu.

User dictionary

Words that you use regularly which are not in the dictionary provided with Xara Web
Designer 7 can be added to your own personal dictionary. Right click on the word and
choose “ADD TO USER DICTIONARY”. Now the word is no longer shown as being
misspelled. The user dictionary applies to all documents that you use on your computer
and it applies to all languages.

Synchronizing Text using Soft Groups

In some designs, you may find you need multiple text objects to always show the same
text, but perhaps using different styles. Normally when you want to change the text
shown on these objects, you'd need to edit each one individually.
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By adding such related text objects into a Soft Group, you can ensure that they will
always show the same text. To add the related text objects into a Soft Group, first make
sure that they all already have exactly the same text (otherwise they will not become
synchronized). Then select them all using the Selector Tool. Then select "ARRANGE" >
"APPLY SOFT GROUP" ("Ctrl + Alt + G").

Now when the text is edited on one text object, the others will be updated automatically,
even if they are scattered across different layers throughout your document. Note that
this synchronization still works even if some of the text objects are on locked or invisible
layers.

To ungroup a Soft Group, select "ARRANGE" > "REMOVE SOFT GROUP" ("Ctrl + Alt + U").
See the Soft Groups section of the Object Manipulation (on page 117, on page 50)
chapter for more information on Soft Groups.

Tabs, Margins and Indents

Rulers

To adjust tabs, margins and indents you need to turn on rulers in your document.
To do this:

e Choose "WINDOWS" > "SHOW RULERS" or right click a page and choose "sHOw
GRID/GUIDES" > "SHOW RULERS".

e Orpress "Ctrl + {+ + R".

e Or press "Ctrl + L" (when not in the TEXT TOOL).

The enhanced text features will only appear on the ruler when you are using the TEXT
TooL and when the text cursor is in a text story or the text object is selected when in the
TEXT TOOL.

In the TEXT TOOL when you drag the margins or tabs on the ruler, you get a temporary
vertical guide to make it easier to align the tabs or margins to objects elsewhere on the
page. In addition when dragging tabs or margins, if you have magnetic snap switched
on, these will snap to each other making it easier to position tabs and margins.

Margins and indents

Any changes you make are made to the current paragraph of text. (i.e. the paragraph
containing the text cursor) or, if you have a selected region of text, to the paragraphs of
the selected region.

You can apply changes to all text in a text story by selecting all the text within that story
("Ctrl + A"). To change more than one text story, select the text objects while in the
SELECTOR TOOL then change to the TEXT TooL and make the required changes.

k Left margin. Drag this to change the left margin of the text.

r First line margin. Drag this to change the left margin for the first line of the
paragraph (useful for lists, as shown below).
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1 Right margin. Drag this to change the right margin of the text.
Drag to change the Drag to change the right margin
first line margin
J Drag to change L.t .3 W JE 8
the left margin Xtreme Pro doesn't wrap text around,
(] k/l 39 4 E & b objects but you can use the right margin to
[ O T AT oA AT S o AN AT AT Y ol T ATEEE ol S simulate wrapping around an image.
«1) This is the first item in a numbered list. . you wish to place an
By having the left margin brought in, but image alongside a text
. . : : story you can bring in
the first line margin hgngllng to the left, the-right margin 1o make
you can create 'hanging' items such as space for the image
bulleted or numbered lists | PR SRS N tu

story. Only the lines
where you alter the right
margin will be affected.

Demonstrating the left margin and first line margin

Demonstrating a right margin

Text along a curve

If you have fitted a single line of text to the curve using the FIT TEXT TO CURVE option,
then the curve line is the margin. If the text is longer than the line it will just flow off the
end.

If you have clicked on the line or fitted a column of text to a curve or line then you have
left and right margin indicators (small red squares) that can be dragged along the line to
adjust the margins used for justification.

Tabs

By default, text stories are created with tabs set 0.5 cm apart. This means you can just
press "Tab" and your text will be moved along to the next tab stop. You only need to
define new tab stop positions if you want alternative tab spacing.

These default tabs are shown as faint Ls on the ruler:

v 1.z 3 4 5 & |}

Standard tabs, indicated by faint "L"s

Custom tabs

To create a custom tab position, just click on the ruler where you wish to place the new
tab. It will replace default tabs up to that point on the ruler.

For example:

L2000 ST TR R JUOTE TV L Y R

The triangle indicates a custom tab
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e To set more than one tab click multiple times on the ruler.

e To move a custom tab drag it along the ruler.

e Toremove a tab drag it off of the ruler (default tabs will come back).
Custom tab types

You can set different types of custom tab. By default, custom tabs are left align tabs.
This means that text will be aligned with the tab on the left of the text.

To change the tab type, click the tab icon on the ruler. Click to change
The following custom tab types are available. You are not the tab type
limited to just one type in a story, and can choose a different Vﬂ ﬁ
type then set additional tabs.

Jab 1

V Left align: The text will be aligned with the tab to the left.

v { 1 2 3 4 5 3 ‘ Y

Jabh1 Tah2 Tah3 Tabd|

v Right align: The text will be aligned with the tab to the right.

v Center align: The text will be centered on the tab.

1 L2 3 4 5 6, Y

Jab1 Tab2 Tab 3 Tabd4| .

v Decimal point align: The decimal points in the text will be aligned with
the tab. This is useful for lists and, however long the number, the
decimal points (periods) will be tab-aligned.

1 , 3 ! : 6
.Ham_dlsk_dﬂy_e—szg..g.g—. l =]
SATA cable $2.11

TFT monitor $139.00

How to creating hanging indents

Hanging Indents, as they are known, are where the first line of a paragraph has a
negative margin or a margin that hangs to the left of the normal left margin. Numbered
or bulleted lists are examples of hanging indents.

To create hanging indents:

1. Drag the left margin inwards.
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2.  Click on the ruler away from the left margin (creates a new tab stop) and drag this
tab stop to be exactly over the left margin.

3. Now each line will start outdented—you can insert any special character or number
and press "Tab" to move to the left margin. And (as with this paragraph) all
subsequent lines of text are indented to the left margin.

Repelling text objects

You can make any object in Xara Web Designer 7 repel text so that text underneath it
automatically flows around the object, instead of appearing underneath it. This makes it
easy to lay out pages containing long passages of text combined with photos and
graphics. Once you've set them to repel, you can adjust the positions of your graphics
and photos and the text will automatically adjust and reflow around them.

You can also choose to only repel text within a layer, which stops objects within a layer
from repelling text on other layers and also stops text on the layer being repelled by
objects on higher layers.

L

Nulla sit id aliqua in elit? In,
adipisicing dolor, qui non ea labore
aute commodo nisi. Duis cillum quis
esse, ea sed aliqua excepteur sint
exercitation lorem. Ipsum ullamco
aliqua consectetur dolore, sit
voluptate.
p Esse in mollit sunt ea officia dolor
e - consequat velit excepteur duis
minim. Laboris enim culpa laboris aute
magna esse nulla quis aute ullamco non.
Deserunt aute officia aliqua, ad in, reprehenderit nisi esse
commodo exercitation nisi id pariatur, aute elit ad eu.
Aliquip, excepteur do pariatur excepteur tempor.
Consequat cupidatat tempor irure voluptate ut fugiat est in aute nulla mollit laboris incididunt

amet in. Magna non est in esse ut exercitation dolore magna dolore nulla. Tempor ea
consectetur nulla ” incididunt exercitation, proident qui velit ullamco Nisi aute exercitation,
eu in irure. Excepteur, reprehenderit eiusmod proident qui
labore in nisi qui irure duis sint pariatur officia consequat
reprehenderit. Aute N labore sunt proident
mollit, esse sit ut incididunt lorem dolor.
Qui culpa g ullamco, exercitation dolore adipisicing
esse. Minim cillum eiusmod commodo
cupidatat: Aliqua non consequat in, fugiat non enim
sunt enim | officia nostrud dolor officia reprehenderit quis

magna, pariatur. Sunt culpa
fugiat !orem* aliqua. Eiusmod ullamco

cul pa proident sunt, eu, ea cillum ad
adipisicing minim sed nisi culpa ea. 7
Duis deserunt mollit sit ea enim deserunt excepteur W( / “  occaecat veniam do,

! ullamco laboris in,
~ dolor, consequat
minim deserunt

Making an object repel

To make an object repel text, right click it and select the REPEL TEXT UNDER option. Any
text in the same layer underneath the object will be repelled with a default margin of 5
pixels between the text and object. Note that repelling text objects only repel text that is
underneath the objects, not any text that is on top.
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Alternatively right click on the object and select REPELLING & ANCHORING to display the
Text repelling & anchoring dialog.

Text repelling & anchoring

Repelling

B Repel text around this graphic
This will only repel text that is under the graphic

Repel margin H V

Anchoring

B Move graphic with text

Click the REPEL TEXT AROUND THIS GRAPHIC checkbox.

If desired, set a repel margin for the object to set the space between the text and the
object. If you want a different height and width for the repel margin, click the padlock
symbol and enter the margin height in the H (horizontal) box and width in the v (vertical)
box. Click oK.

To turn off repelling right click the object and choose the REPEL TEXT UNDER option again
to deselect it. Or right click and select REPELLING & ANCHORING to display the Text
repelling & anchoring dialog again. Click the REPEL TEXT AROUND THIS GRAPHIC checkbox
to deselect it and click oK.

Note that single lines of text do not respond to repelling objects, only text areas and text
columns do.

To only repel text within the same layer as the repelling object, see Layer Properties (on
page 277).

Anchored Graphics

You can position any graphic, or group, so it's tied (anchored) to a position in some text,
so that as the text moves because of editing, the graphic object will move to remain at
the same relative position.

1. The quickest way to anchor a graphic or group is to right click it and choose the
ANCHOR TO TEXT option. However, if you also want to edit anchoring properties, you
can right click on the object and select REPELLING & ANCHORING to display the Text
repelling & anchoring dialog.

2. Click the MOVE GRAPHIC WITH TEXT checkbox.

3. By default MOVE VERTICALLY ONLY is also selected, so that your anchored graphic
will only move vertically as the text is edited. You can click to deselect this option to
allow the graphic to move horizontally with the text. This may be useful if, for
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example, the graphic is around the same size as the text height and you want it to

stay between specific words or in a specific place in a sentence.

An anchor symbol appears in the top left of the object, indicating it's now anchored.

Using either the SELECTOR TOOL or TEXT TOOL, click and drag the anchor symbol so

that a red arrow appears.

6. Move the arrow head and drop it in the location in the text where you would like the
object anchored. A red caret (inverted 'T' mark) indicates the anchor position.

7. Asyou edit the text around this caret mark, the anchor point and anchored object
moves with the text.

oA

cupidatat do nostrud pariatur dolor sit, eu dolor
exercitation consectetur ipsum. Exercitatiog.gulla

enim lorem, fugiat velit dolor fugiat Iblah-blahs elit

qui, fugiat exercitation sint, dolore essemUt amet .
pariatur consequat et e

amet dolor.

Exercitation ea magna
laboris anim. Ipsum nullg
quis do id laboris
occaecat. Sunt ad,
consectetur dolore
deserunt non commodo
irure, in esse elit aute fuiataboris ad afte tempor -
officia velit pariatur. Reprehenderit esse dolor,

nnie minim at a1 ad 1t ineiim Adnlare mallit in 2a

An anchored object displays an anchor symbol and an arrow pointing to the anchor point,
shown as a red caret mark.These disappear as you type, unless you're close to the anchor
point.

Note: If you drag the anchoring arrow to a place on the page where there is no text, the
arrow turns into a red anchor that indicates the object's anchoring properties will be lost
if it's dropped here. This also happens when the arrow is dropped on the object itself.
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However note that the anchored object will not move outside the area of the page as a
result of the anchor point moving. The anchored object will only move up to the edge of

the page.
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This is an example column of text with various graphic elements hanging to the left. Each of
these is anchored to the start of a line of text immediately to its right.

It's possible to anchor any graphic object or group, including groups containing text,
such as the example side-panel, shown above.

It's also possible to anchor objects to appear on top of, or below the text. The example
pale blue flower graphic, shown above, is anchored this way and will flow with the text.

NOTE: If an anchored object is also set to repel, only the text that the object is anchored

to is repelled.

NOTE: Repelling is restricted for repeating objects: Text inside a repeating group is only
repelled by repelling objects inside the repeating group. Individual repelling objects
inside a repeating group only repel text that is also inside the repeating group.
Repeating groups as a whole can repel any text stacked below on the page.
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Moving Anchored Objects

As new text is added or deleted, the object moves as the text flows, but will always
maintain its new position relative to the anchor point. You can move an anchored
graphic by dragging on it as usual. This changes its position relative to the anchor point,
but does not move the anchor point, which remains visible at the end of the anchor
symbol arrow as you click/move the graphic.

If you want to move the anchor point to another location within the text, click and drag on
the anchor symbol again to create a new arrow and drag it to the new location.

If you cut and paste the text containing the caret mark, the anchored object is also cut
and pasted.

Viewing the anchor point

The anchor point of an anchored object is only visible if you click the anchored object in
the SELECTOR TOOL or click in the surrounding text area in the TEXT ToOL.

When you click in a region of text with the TEXT TooL, it shows any anchors points within
an inverted 'T' symbol, and also draws an arrow from the anchor point to the anchor
symbol in the top left of each anchored object. So the easiest way to see all the anchor
points for any text is to click in it with the TEXT TOOL.

However, when you start to edit the text, the red caret, arrow and anchored symbol
temporarily disappear until you stop typing. If you are close to the anchor point, Web
Designer displays the caret mark, along with an arrow pointing to the anchor symbol, to
let you know when you're close.

Inline anchored objects

If you want to embed a small graphic into a line of text, such as an icon graphic like this

@; inline with the text, so it flows with the text, drag or paste the image in as an
anchored object that repels and position its anchor point anywhere in the copy. It's
recommended you use non-breaking space characters ("Ctrl + Space bar").

Soft Groups

You can anchor Soft Groups (on page 117, on page 50) the same way, even where part
of the group is on another layer. For example web buttons with mouseover effects or
pop-ups on different layers can be anchored in this way.

Removing an anchor

To remove an anchor from an object, right click it and choose ANCHOR TO TEXT again to
disable the option. Now when you click the object in the SELECTOR TOOL or in the text in
the TEXT TOOL, the anchor symbol is no longer displayed.
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Applying text styles

Changing the font size

10pt  w ' There are several ways to change the font size:

Type a new value into the size text box on the InfoBar and press .

Or select from the FONT size drop-down list on the InfoBar.

Or use the Font size pop-up slider (on page 154).

Or manually increase/decrease font size with the "Ctrl + Shift + >" and "Ctrl + Shift +
<" keyboard shortcuts. This applies only if all selected text parts are of the same font
size.

e Or use the SELECTOR TOOL to scale the whole text object.

Bold & ltalic
Click the BoLD or ITALIC button on the InfoBar ("Ctrl + B" or "Ctrl + ")

This applies the bold or italic variant of the current font.

Attention: Xara Web Designer 7 does not allow you to apply italic or bold to text if the
necessary italic/bold font is not installed. However you can easily emulate the same
effect. To embolden a font, just give it a small line width and apply a line color. To slant
a font, use the skew / slant feature of the SELECTOR TOOL. Read more in the "Font menu"
section

Text Underlining

U Click the underline button on the InfoBar to apply an underline to the
s Selected text.

The underline color and size is automatically derived from the text color and size.

Justification or text alignment

Justification always applies to the complete line. Any selected region is ignored.
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LEFT justification: Align the left-hand edge of the text to the initial click position.
CENTER justification: Centers the text around the click position.

RIGHT justification: Align the right-hand edge of the text to the initial click position.
FULL justification: This only applies when text is along a curve or in a column and
when there is at least one full line of text to justify.

Co0e

When using simple text the initial click position on the page is taken as the origin for text
justification.

Indents and Outdents

Indent a paragraph of text.

=8 Outdent a paragraph of text.

m M

Bulleted Lists

E You can turn any text into a bulleted list by selecting the text and then selecting
the bulleted list button on the infobar.

Each paragraph of text becomes a separate bullet. If you press return to finish a line at
the end of one bullet point, the next line starts with a bullet point to.

To finish entering a bulleted list, hit return on the end of the last bullet and then
immediately hit return again on the new bulleted line. This removes the last empty
bulleted line and allows you to start entering normal text again.

You can nest bulleted lists by pressing the indent button on the infobar. This
indents the current bulleted line and changes the bullet character to a different
style, to distinguish it from the parent bullet.

%

» (lick the Bullet list button and enter an item
e Press Return to start the next bullet point
o Click the Indent button to make an indented list of
sub-entries
o The bullet character changes for indented lists
= Thereis also
= athird
»  level
o Pressing Return on an empty bullet point ends the
sub-list and continues the parent list
e At top level Return on an empty bullet point ends the list.

Example of a nested bulleted list

To move a bullet point from a sub-list into its parent bulleted list, simply place the
text cursor in it and press the outdent button.

il
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So it's easy to make and edit arrangements of nested bulleted lists using the indent and
outdent buttons.

Numbered lists

You can create and edit numbered lists in just the same way as described for
bulleted lists above, using the numbered list button.

You can also choose the numbering scheme to be used for each list, using the LIST
PROPERTIES dialog. Place the text cursor in one of the numbered list points, press the
right mouse button and choose ‘LIST PROPERTIES..." from the context menu.

x

Numbered list properties

MNumber format

Starting value

In the dialog you can choose from a variety of numbering schemes and also enter the
value that should be used for the very first entry in the list. Then the number is
automatically incremented for the second and subsequent entries in the list.
Subscript & superscript

H Click the appropriate button on the InfoBar.

Normal text supscipe P>

Line spacing

g 3 100% A Line spacing allows you to change the space between two lines

s —*% (so affects vertical spacing).

Line spacing is measured in percentages (120%) or points (12pt). You can either type
the line space value in the text box or click the arrows to nudge the values.

A percentage setting has the benefit of scaling accordingly if you change your font size.
If a percentage is applied to a line of text with more than one font size, the largest font
size is used. For example, if a line contains 90% and 100% text, the line spacing is
calculated on 100%.

Paragraph Spacing

AL 'Y The last two fields on the end of the TEXT TooL InfoBar allow you to set
phoet R the spacing above and/or below paragraphs.

This is particularly useful where you want half line spaces between paragraphs.
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Like Microsoft Word, when you use both spacing above and below paragraphs, the
spacing between paragraphs is whichever is the greater value (it's not

cumulative). Paragraph spacing above paragraphs will move the first paragraph down in
a frame of text.

Text links

You can apply a link to any part of a text object, so that when the document is exported
as HTML the text shows as a clickable link in web browsers.

Use the TEXT ToOL to select the words or characters that you want to apply the
link to, then click the link button on the wes toolbar. 4

This brings up the wes PROPERTIES dialog, with the LINK Tab selected. On this tab you
can choose whether to link to a URL, to another page of your website, or even to a pop-
up layer.

By default when you apply a link to some text, the text is shown as underlined and with
the text link color that is defined for the current document. You can change the link color
and whether or not the links are underlined, on the weBsITE tab of the WEB PROPERTIES
dialog (right click and choose WEB PROPERTIES or choose WEB PROPERTIES from the
UTILITIES menu). You can also set the color to be shown when the user moves the
mouse pointer over a text link in a web browser (“Mouse Over Color”), and the “Visited
Color” which is used to display links which the viewer has already visited with their web
browser.

When setting the three global text link colors, you can either select existing theme colors
used in your website, using the drop-down lists, or you can click the EDIT button to bring
up the COLOR EDITOR S0 you can choose any color you like.

You can also choose to override the global text link colors for individual links if required.
On the Link tab of the Web Properties dialog, unselect the “Use common website link
colors” option. Then the selected link will be displayed using the text color that you set in
the document, instead of the global text link color.

Text inside groups for websites

When a document is exported as a website, all groups get exported as images. So any
text inside groups is not present as text in your exported website, and so it can’t be
picked up by search engines or selected and copied as text by a visitor to your site.

For graphical buttons, headings, logos etc. this is usually desirable as the text just forms
part of the graphic. But you may have more substantial pieces of text inside groups
which you want to remain as text in your exported web page. To arrange this, all you
need to do is apply the special name “HTMLText” to your text object. The easiest way to
do this is as follows:

1. Gointo the TEXT TooL and click on your text to insert the text cursor.

2. Press escape so that the whole text object becomes selected.
3. Open the Name dialog ("UTILITIES" > "NAMES...").
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4. Either select the "HTMLTEXT” name from the “APPLY NAME” dropdown list if you've
already used it in the current document, or type in the name “HTMLText”. Then
click “abp” to add the name.

Now, when you export your website, your text will remain as text and the rest of the
group will be converted to an image. All the text panels provided in the DESIGNS GALLERY
already have this name applied to the text objects inside them, so the text on the panels
will export as text.

Browsers can’t render rotated text, so you can’t use this name to force rotated text to be
exported as text. The name is ignored in this case.

Copying text styles

It's easy to copy the style of any text to any other region of text using the PASTE
ATTRIBUTES feature:

e Select the source region from where you want to copy the style. This can be as little
as a word (just double click).

e Select "EDIT" > "coPY" ("Ctrl + C").

e Select the region of text to which you want to apply the style.

e Select "EDIT" > "PASTE ATTRIBUTES" ("Ctrl + ©+ + A").

If you just have the text cursor positioned in some text when you PASTE ATTRIBUTES the
paragraph attributes will be pasted to this paragraph.

If you have a region of text selected, then PASTE ATTRIBUTES will paste all the visual
attributes of the source text.

Applying attributes to whole text stories

When you have the cursor in a simple or column text object, pressing "Esc" will select
the whole text object. You can then apply an attribute, say a color, and the whole text
object is altered. This is often quicker than performing "Select all" ("Ctrl + A").

With text areas this method only works if all text areas of the story are selected. You can
do this in the seLECTOR TOOL clicking and "Shift + clicking” on the different text areas to
select them. But this method is only possible if the text areas are on a single page. If
your text story flows over several pages and you want to change all the text, then it's
necessary to "Select all" ("Ctrl + A"), and then apply the required attributes.

Copying/Pasting formatted text (RTF)

You can copy "rich text" (as it's sometimes known) from other applications such as word
processors or editors and paste into Xara Web Designer 7 as text, and the fonts,
margins, line spacing and text links will be preserved. This makes it dramatically easier
to retain the style and appearance of your text.
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When you paste "Rich Text Format" (RTF) from other applications you are given the
choice of pasting the text in as "Unformatted text" which means it will appear in the font
and style at the cursor where you paste, or "Rich Text Format", i.e. it will retain the style
of the source text.

This also works the other way around. You can copy text in Web Designer and paste
into other applications that support rich text editing and the style (font, size, colors,
margins etc) will be retained. This will only work if you select and copy a single text
object or from a single text flow.

Some applications, such as Microsoft Word, have a "Paste special* menu option that
provides a wider range of paste options. These applications will sometimes allow you to
choose the format of the pasted object (text or graphic).

Seeing fonts in use

It is sometimes useful to see what fonts are used in your document, particularly if you
are sharing files with other Web Designer users who may not have the same fonts
installed.

For a complete list of fonts used in your document choose "FILE" > "DOCUMENT INFO".

Any fonts that are used in the document but are not currently installed on your computer
have NOT INSTALLED by them.

Another way to see which fonts are used in your document is to just open the font menu
of the TEXT TooL InfoBar. The top section shows fonts used in your document.

Font embedding

Xara Web Designer 7 stores the character shapes of all the fonts used in your
document. This means if you give someone else your design file, or transfer the file to
another computer, the text will still look exactly right, even if the correct fonts are not
installed on that computer. But this only embeds the characters that are used in the
document (the full font is not included). So on computers with the fonts missing, any text
that is added in the missing fonts may be missing the correct character shapes.

Browser text compatibility

It is a sad fact that different browsers display the same text slightly differently, usually at
a slightly different size or line length (so for example 10pt text is not displayed at 10pt
size but at the nearest whole pixel size instead (13 pixels).

Xara Web Designer 7 is designed to emulate the behavior of the most common
browsers and adjusts intermediate sizes to be whole pixels, and adjusts the line lengths
to closely emulate the text on Windows browsers. You can switch this adjustment off in
the OoPTIONS dialog, GENERAL tab (right click and choose PAGE OPTIONS or choose
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OPTIONS from the UTILITIES menu) by un-checking the 'SHOW WINDOWS COMPATIBLE TEXT
LENGTHS’ option.

Advanced note: If you're using Web Designer or switch this compatibility option off,
then if you enter any intermediate size, such as 13.6 pixels or 10pt, you will get text that
is exactly, accurately, scaled to this size. But be warned that most web browsers will
show this text as a slightly larger or smaller size than you see in Xara Web Designer 7.

A second consequence of this browser (mis)behavior is that at small font sizes, there is
a quite a large jump from one size to the next. So if you want a font size, say, between
9pix and 10pix, you can't have this. Most browsers cannot display an intermediate size
(whether you use Points, ems, or any other unit type). So you will see Xara Web
Designer 7 text sizes jump from one size to the next as you resize text objects.)
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Creating a graduated color fill

The process of creating a different fill is almost identical for all the fill
types:

Select the object or objects to which you want to apply the fill.

Select the FILL Tool ("F5")

Select the fill type from the dropdown menu

Click-drag across the object to create the fill. Or, drag one of the fill handles to

adjust the fill size and position

Ao~

Xara Web Designer 7 provides a smooth interactive live preview of the fill as you drag.
This provides a number of advantages over traditional dialog-based Fill Tools. Not only
does it require a lot fewer clicks, it's faster, and allows you to get the required start and
end positions right first time.

As you drag a fill arrow is created indicating the direction of
the fill. Fill handles can be selected and dragged to adjust
the position and angle of the fill.

Fill Handles

Coloring fills

Select one of the fill handles and click a color on the COLOR LINE or bring up the COLOR
EDITOR and choose a new color. You can press "Tab" to alternate between the fill
handles.

Changing selection

In the FILL Tool just clicking on an object will select it, and so it's not necessary to always
go into the SELECTOR Tool to select other objects.
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Fill types

Web Designer has these types of color fill:

FLAT FILLS - the shape has an even color or tone over its surface.

LINEAR FILLS - the color gradually changes from one color to
another.

CIRCULAR FILLS - the color change radiates out from a single point
in a circular pattern.

ELLIPTICAL FILLS - similar to circular fills except the change
radiates out in an elliptical pattern.

BITMAP FILLS - the object is filled with one or more tiled copies of a
bitmap or photo. All photos you see in Xara Web Designer 7 are
bitmap filled shapes (normally rectangles of course). Any photo
can be used, or any bitmap in the BITMAP or FILL galleries.

FRACTAL CLOUDS - produces a patchy random fill which is
especially useful for clouds or mist.

FRACTAL PLASMA - a patchy random fill which has more contrast
than a fractal cloud fill.

The FILL Tool lets you apply these fill types to the selected object(s) and to edit and
adjust the fills.

Automatic select inside

In the Fill Tool, an automatic "Select inside" is performed when you click on an object
that is a part of a group, instead of selecting the group as a whole. This makes it easier
for you to work on photos and fills inside groups. If you want to change the fill attribute of
a group (which is not very likely), you need to select the group using the SELECTOR TOOL
first.
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Fill Tool InfoBar

@ Fill Type

Fill tiling

Fill effect
@) Bitmap name

Fill handle/Resolution
Handle color/Grain

FILL TYPE selects the type of fill. Selecting from this menu:

¢ with a selected object, applies the fill to the object;
o without a selected object, sets the default current fill type, which is then used for
newly drawn objects.

FILL TILING is used when applying bitmap and fractal fills. The options are described later
in bitmap fills. Fill tiling changes the repetition of the fill effect. The options are:

¢ Simple-the fill is used only once, regardless of the size of the object. The area around
the single 'tile' is transparent.

¢ Repeating/repeating tile-repeats the effect so that it fills the entire object.

¢ Repeating tile inverted-only available on fractal and bitmap fills. This is similar to
repeating tile, but every other tile is inverted. This helps to hide the seams where the
tiles join.

A repeating elliptical fill inside an ellipse shape

FILL EFFECT is used for all fill types. It controls how the fill colors fade from the start color
to the end color:

¢ FADE-fades between the two colors in a linear fashion
e RAINBOW-blends along the shortest edge of the HSV color wheel. For example, a
blend from yellow to cyan runs yellow-green-cyan.

This option has no effect when the two colors are black, white or gray.

e ALT RAINBOW-similar to rainbow except the blend is along the longest edge of the
color wheel. For example, yellow to cyan runs yellow-red-magenta-blue-cyan.
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BITMAP NAME displays a pop-down menu showing thumbnails of all the bitmaps in the
BITMAP GALLERY and is an easy way to select the required bitmap/photo for a bitmap fill.

FILL HANDLE-tells you if the start or end handle is selected. This field is blank for flat fills.
RESOLUTION (bitmap and fractal fills only)-shows the resolution of the bitmap (as long as
you don't have a fill handle selected). You can type in a new resolution to change the
size of the bhitmap. Low resolutions show the individual pixels of the bitmap. You rarely
need a resolution greater than 150 DPI, even for typeset output. 96 DPI is good enough
for screen resolution.

FILL HANDLE COLOR (except bitmap fills)-indicates the color applied to the selected fill
handle.

Flat fills

To apply or change a flat fill:

1. Select flat fill from the fill type menu.
2. Choose a color from the COLOR LINE.

The Color Line is described in Color handling (on page 140).

Linear fills
To apply a linear fill:

1.  Select linear fill from the fill type menu (not necessary if
the object currently has a flat fill).

2. Position the pointer where you want to start the fill (this
can be outside the object).

3. Drag the mouse pointer to where you want the fill to end
(again, this point can be outside the object).

The arrow drawn on the selected object is called the fill arrow. It indicates the direction
and extent of the fill. You can select either end of the arrow by clicking it.

Moving the start or end handle of the fill
To change the direction and extent of the fill:
I_ 1. Move the pointer over the handle you want to move. When over the

! E,. handle, the pointer changes shape.
2. Drag the handle.
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Changing the colors in a fill

To change a color in afill:

e Drag & drop the color from the COLOR LINE onto a fill handle (you do not have to select
the handle first.)

« Or, drag & drop the color onto the object. Each fill has an imaginary center line
halfway along the fill arrow. Dropping the color on the start handle side changes the
start handle color, and the end handle side changes the end handle.

e Or, if one of the end handles is selected (it's shown highlighted) just click on a color.
You can press "Tab" to select the other fill handle, and click the color required for the
other end

The Color Line is described in Color handling (on page 140).

Each method changes the color of one handle only; they do not change any other
selected fill handles, or:

1. Select the required handle (or handles, also works with multiple objects).
2. Choose the required color from the Color Line.
3. This changes all selected fill handles.

Circular fills

For circular fills, applying the fill, moving handles and changing
colors are the same as for linear fills. The start handle is the
center of the fill.

Circular fills are useful for creating highlight effects.

Changing the height/width ratio of the object automatically changes a circular fill into an
elliptical fill (see below).

Elliptical fills

Applying an elliptical fill is similar to applying linear fills. As you
drag the mouse pointer, you first create a circle with two end
handles. You can then drag the end handles to create a suitable
ellipse.

"{+ drag" preserves the aspect ratio of the fill. "Ctrl + drag" constrains rotation to the
preset constrain angles. Moving handles and changing colors are the same as for linear
fills.

A quick way to apply a elliptical fill:

"Shift + drag" to create a elliptical fill.

www.Xara.com



182

The Fill Tool

Bitmap fills

L

2 3 4 5 6

@ Fill Type

g Fill Tiling
Not used

@ Bitmap name

Resolution
Not used

The BITMAP GALLERY is described in THE BITMAP GALLERY (on page 222) in the Photo
Handling chapter, for the FILL GALLERY see below (on page 186).

Bitmap fills are one of the most powerful fill types. It allows any photo or texture to be
used as a fill for any shape and you have direct immediate control over the size, angle,
position and tiling. You can color bitmap fills. You can use any type of bitmap as a fill,
including JPEG photos, and alpha-channel (semi-transparent) bitmaps.

When you import a photo file into Xara Web Designer 7 (eg. a JPG or PNG file) it
appears as a shape with a bitmap fill type. When such an object is selected the status
line shows it as a “photo”, but it is just the same as a shape that has had the photo
applied as a bitmap fill.

To fill a shape with a bitmap or photo fill, do one of the following:

o Drag any bitmap from the BITMAP GALLERY or from your Windows File Explorer over
any shape, hold "Shift" and drop, or

¢ Drag any fill from the FILL GALLERY onto the shape (there is no need to hold "Shift" to
drop in this case)

e Select 'Bitmap' from the left side drop down menu of the FILL TOOL INFOBAR, and then
select the required bitmap from the dropdown menu of bitmap names (this only shows
bitmaps that are or have been previously loaded).

You can fill an object with single or multiple tiles (repetitions of the bitmap image).
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Bitmap

- g
Object /™
outline

Single tile (photo) Repeating tile Repeat inverted-the tiles fit together
perfectly.

The fill has three handles. Use it for Resizing and re-positioning bitmap fills (on page
183). An alternative way to set the size of the bitmap is to type in a resolution into the
InfoBar field. You first have to un-select the fill handle by clicking anywhere on the
image away from a fill handle, then just type a new dpi resolution.

Replacing Bitmap Fills

If a shape already contains a bitmap, or is a photo, then you can just drag and drop a
new bitmap from any source, such as Windows Explorer, and it will replace the existing
bitmap. The new image is ‘best fitted’ into the shape so that it just fits in. Doing this will
also replace all other instances of that photo on the current page.

Holding down sHIFT while replacing a photo in this way causes the position, scale and
rotation of the bitmap fill to be preserved.

Bitmap coloring

You can color any bitmap or photo fill by just clicking on a color on the COLOR LINE
(make sure no fill handles are selected, by just clicking on the image). This will create a
Contone (technically a Duotone) which uses colors between black and the selected
color. Alternatively right click on the object and choose CONTONE > SET LIGHT COLOR Or
CONTONE > MAKE BLACK AND WHITE. You can also right click the color line and select
either the 'SET CONTONE LIGHT COLOR' Of 'SET CONTONE DARK COLOR'.

So, for example, to make a picture black and white, just requires you to click on the
White color patch on the color line.

To cancel any applied color, apply NO COLOR to either fill
handle. This restores the bitmap to its original bitmap colors.

The RESOLUTION box on the INFOBAR shows the resolution, which can be altered by
moving the fill handles or typing in a value.
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Resizing and re-positioning bitmap fills

Once the fill has been created, you can drag anywhere
on the image to re-position the fill inside the shape.

When you mouse over the outer fill handles the mouse
pointer changes into a “rotate” mouse pointer. Dragging
on these handles will stretch and rotate the bitmap fill
with the current aspect ratio locked; hold down "n" while
dragging to change the horizontal and vertical size
independently and to skew the fill. The InfoBar shows
you the resolution of the bitmap fill (you can adjust this,
and thus the bitmap size, by entering a new value).

To fill the ellipse on the left with the photo in the center;

1. Drag the photo or bitmap file from Windows Explorer (or from the Bitmap Gallery if
it is already used in the document) over the ellipse, and drop it while holding down
“Shift”. The Fill Tool becomes the current tool.

2. You can now adjust the angle and size of the image by dragging on the Fill
Handles.

The above example has a simple shadow - see the chapter on the Shadow Tool (on
page 191) for more information.
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Fractal fills

Xara Web Designer 7 supports two types of fractal fill which are mathematically created
naturalistic fill patterns. They are great for simulating sky and clouds or other natural
textures.

Each time you create a new fractal fill a new pattern is created. To replace an existing
fractal with a new pattern choose fractal from the fill menu again.

The GRAIN control on the INFOBAR
provides control over the graininess of
the pattern. Low values give a smooth
flowing pattern, and high values give a
grainy pattern.

You can adjust the size and position of the fractal fill in the usual way by dragging and
adjusting the fill handles. De-select the fill handles (click on the fill away from a handle)
to show the above resolution and grain controls.

Fractal clouds fill. On the left a grain of 1, on the right a grain of 50.

Fractal plasma fill. On the left a grain of 5, on the right a grain of 50.

Note the difference between grain and resolution. Grain controls the flow of the pattern.
Resolution sets the size of the fractal bitmap and how noticeable the individual pixels
are.

You can change the start and end colors of a fractal fill. Select the center or outer

handles and then apply a color using either the Color Line or COLOR GALLERY. To cancel
any applied color, apply no color.
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Multi-stage color graduations

Many of the graduated color fill types support multi-stage graduation fills, which means
instead of just fading from one color to another, you can go through a number of
different color fill stages.

Multiple Fill Handles

To add a new color stage to a graduation, select the Fill Tool so the fill arrow shows and
then:

¢ Either drag a color onto the fill arrow where required.
¢ Or double click on the fill arrow to create a new fill handle, and now click a color or
display the COLOR EDITOR.

You can re-position the fill handles by dragging.

With one fill handle selected pressing "Tab" will select the next. If the COLOR EDITOR is
open, this is updated to reflect the new fill handle

To remove a fill stage handle, just click on it to select, and press "Del".

The Fill Gallery

The FILL GALLERY contains bitmap textures suitable for use as bitmap fills. Only when
you use a fill is it copied into the document.

To display the FILL GALLERY:
< To display the FILL GALLERY click its tab in the galleries bar to the right of the

Web Designer window. Or you can toggle display of the FILL GALLERY by
choosing UTILITIES > GALLERIES > FILL GALLERY or pressing "Shift + F11".
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Fill gallery

Disc fills...

@ Brick (Download)
@ Fabric (Download)
[ Ground (Download)

gravel.jpg

gravel2a.jpg

pebblesd.jpg

Get fills...

gravel2.jpg

pebbles5.jpg

IMPORT - imports the selected bitmap into the document. A copy of the bitmap then
appears in the BITMAP GALLERY. You can also drag-and-drop the bitmap onto a blank

part of the page. This is usually easier than clicking IMPORT.

FILL - imports and applies the selected bitmap as:

o A bitmap fill to the selected object (if any).
e Or, if no objects are selected, it inserts the bitmap into the document as a new photo

object.

You can also drag-and-drop the bitmap onto an object to apply a bitmap fill.
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There are some differences between either dragging a bitmap from the BITMAP or FILL
GALLERY: When dragging bitmaps from the FiLL GALLERY and dropping on shapes to
create a bitmap fill, the fill will be tiled and the bitmap won’t be best-fitted into the shape.
This different behavior to that seen when dragging from the BITMAP GALLERY is because
normally textures are applied from the Fill Gallery and these should normally be tiled
and not best-fitted.

TRANSP - (transparency) imports and applies the selected bitmap as:

¢ A transparent bitmap to the selected object (if any).
¢ Or sets the current transparency attribute.

GET FILLS - download free fills from Xara.

BACKGROUND - set the selected fill as the page background.
REMOVE - delete the selected fill or folder.

DISC FILLS - add new fills from your hard drive or a CD.

MORE - lets you select the size of the preview icons and whether full information about
the bitmap is shown, as well as find and sort the fills.

STOP DOWNLOADING - if you have a slow connection and find getting fills from the Internet
too slow, you can stop downloading them and then resume later.

Find & Sort are described in the Document handling (on page 88) chapter.

Document handling (on page 88) includes general information about galleries.
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Transparency

— M The TRANSPARENCY Tool lets you specify how much of the underlying colors
L and objects appears through an object.

@ shape

Tiling
Bitmap name

@) Handle/Resolution
© Amount of transparency

You have control over the level of transparency from fully opaque to fully transparent.
Web Designer goes further than other programs by offering a wide range of different
graduated transparencies.

You can apply flat and graduated transparency to all types of objects including bitmaps.

Applying flat transparency

It's called "flat" transparency because all parts of the objects have the same
transparency, as opposed to graduated transparency.

1. Select the object or objects
2. Select the Transparency Tool ("F6")
3. Drag the transparency slider on the InfoBar

Xara Web Designer 7 provides live-preview. As you drag the transparency slider the
objects on the document are changed so you can see the effect immediately.

Applying graduated transparency

Graduated transparency works in a very similar way to graduated color fills (on page
177). You just drag on the objects in the TRANSPARENCY TOOL to create a fading
transparency. You have a very similar range of transparency shapes, the simplest being
linear, but you can also have circular or elliptical transparencies. To create a graduated
fade:

1.  Select the object or objects
In the TRANSPARENCY TOOL, drag across the objects to create a linear fade across
the object.

3. Select alternative transparency shapes from the dropdown menu on the InfoBar

You can select and adjust the position and transparency strength using the handles
shown on the object.
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Refer to Fills for more information on manipulating handles and the different fill shapes
(in this case transparency shapes)

Applying transparency to several objects

If you group objects and apply transparency, the whole group is treated as one object
and the entire group is made transparent. But if the objects are not grouped and you
apply transparency, each individual object is given a separate transparency and you get
an entirely different effect when the objects are overlaid.

Individual transparency (left) or group transparency (right)

Mixing individual and group transparencies

You can combine the methods above to create complex transparency combinations. For
example you could set an object to 50% transparency, then group it and apply a
transparency to the group as well. You are also able to apply a transparency to a group
first, and then later apply attributes to individual objects within a group. Just hold down
"Ctrl", click the individual object and change its attributes.
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Shadows

The Shadow tool

transparent (or "soft") shadows.

The sHADOW tool (shortcut Ctrl+F2) lets you apply, remove, and modify semi-

1
F
@ No Shadow
Shadow Types
g Shadow Blur
@) shadow Transparency
e Shadow Position

Xara Web Designer 7 has three shadow types:

e Wall where the shadow is cast on a wall behind the object
¢ Floor where the object appears to be standing upright on a surface.

Glow where the shadow is used to add a halo effect around the object

Wall Floor Glow
The transparency of soft shadows increases towards the edges, which gives a very

realistic effect. Shadows are resolution independent so you can scale them without
losing quality.
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Applying a shadow

Applying a wall shadow

To apply a wall shadow:

1. Select the object. u
2. Choose the sHADOW Tool.
3. Select the wALL button on the sHADow Tool

InfoBar.

4. You can drag the shadow away from or towards the
object to create more or less distance between the
object and the imaginary wall.

Alternatively to create a wall shadow you can:

1. Select the object.
2. Choose the sHADOW Tool.
3. Drag from the center of the object in the direction of the shadow.

Applying a floor shadow

1.  Select the object. u
2. Choose the sHADOW Tool.
3. Select the FLOOR button on the sHADow Tool

InfoBar.

4. Drag towards or away from the object to change the
size or radially to change the direction.
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Applying a glow effect

Adding a glow or halo behind an object can create dramatic graphics.

To create a glow effect:

1.

3.

Select the object. n
Choose the sHADOW Tool.

Select the gLow button on the sHADOW Tool

InfoBar.

Drag towards or away from the object to change the
size of the glow.

Blur the edges of the shadow

This changes the size of the shadow. A small

blur gives the effect of a sharp light source, a
large blur, a diffused or distant light source. It
is recommended that shadows are always
blurred slightly as this is more realistic.

No blur With blur

To blur the shadow edge:

1.

3.

Select the object

Choose the sHADOW Tool.

On the sHADOW Tool InfoBar either drag the blur slider or type a value into the text
box on the right.

Change the transparency of the shadow

A semi-transparent shadow is more
realistic than a solid shadow. But you can
change the transparency level of the
shadow to suit your needs.

No transparency With transparency
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To change the transparency:
1. Select the object
2. Choose the sHADOW Tool.

3. On the sHADOW Tool InfoBar, drag either the transparency slider or type a value
into the text box on the right.

75%

Changing the shadow color or fill effect

After applying a shadow to an object, you can change the shadow's color or fill effect.
You can apply any of Xara Web Designer 7's color effects including multi-stage fills.

How to change the shadow color:
For more on colors and the Color Line refer to Color handling (on page 140).

e The easiest way is to drag & drop a color from the Color Line onto the shadow (make
sure you drop the color onto the shadow and not the object).

¢ Alternatively, this method is slightly more complex, but you have full control over the
color:

1. Select the shadow using the SELECTOR Tool (make sure you select the shadow
and not the object).

2. Use the COLOR EDITOR to edit the color.
Removing a shadow
To remove a soft shadow:
1. Select the object

2. Choose the sHADOW Tool.
3. Select the NO sHADOW button on the sHADow Tool InfoBar. n
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Applying a shadow to several objects

The result of applying a shadow depends on whether the objects are grouped:

¢ |f the objects are grouped,
overlapping shadows merge
(they do not get darker if they
overlap).

¢ If the objects are ungrouped,
each object has a separate
Shadows on Shadows on shadow. Overlapping areas of

grouped objects ungrouped objects shadow are darker.

¢ [If you have several shadowed objects selected, any changes apply to all the
shadows.

Selecting objects using the Shadow Tool

Before you can apply or edit a shadow on an object, you must first select that object.
The regular way of selecting objects is to use the Selector Tool but you can also use the
SHADOW Tool, simply click on the object while in the sHaADow Tool.

Copying shadows onto other objects

Once you've got a shadow looking how you want it on one object, you can copy it onto
other objects using "PASTE ATTRIBUTES". Simply copy the object that has the shadow
("epiT" > "coPYy"), select the object or objects you want to paste the shadow onto and
choose "EDIT" > "PASTE ATTRIBUTES".
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Web Properties Dialog

The Web properties dialog is a multi-tabbed dialog which allows you to add and
configure most of the web related features in Xara Web Designer 7 and set different web
properties on objects, on pages and on your whole website. Open it by right clicking an
object and choosing WEB PROPERTIES or by using the “UTILITIES" > "WEB PROPERTIES...”
menu option (shortcut Ctrl + Shift + W).

Each tab of the dialog is also directly accessible using the buttons on the Web
Properties flyout bar, available on the Website toolbar.

B.A Do —
8

2HE3NANSHGN7

Link Tab

Website Tab

Page Tab

Image Tab
Mouse-over Tab
Placeholder Tab
Publish Tab
Create/Edit Navbar

O000000

The dialog is modeless, so you can leave it open while you select different pages and
objects in your document. This makes it easy to quickly set properties on different
objects and pages in your website. Use the ok button to apply your changes and close
the dialog, or the APPLY button to apply your changes without closing.

The following sections cover each tab of the dialog in turn.
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When the selected object is clicked:
O Do nothing
@ Link to Web or Email address: Correct automatically

@ Link to file (PDF, AV, etc.)

@ Pop-up photo: Settings

Use common website link colours (See Website tab)

Open link Not specified v

The settings on this tab apply to the selected object(s) or selected text. Typically you
use this tab to add a link to an object on your web page (eg. a button or photo), or to
some text, so that when a visitor to your site clicks on the object/text, they are redirected
to another page. You can add links to other pages in your website, to a URL (web
address) or even cause a pop-up window to appear.

To add a link to just some of the words in a paragraph of text, go into the TEXT TooL and
drag over the text you want to link, to select it. Then setup the link in this tab.

The main section of this tab allows you to choose what should happen when the
selected object or text is clicked.

Link to web address

Enter a web or email address to link to that address. If you leave the “CORRECT ADDRESS
AUTOMATICALLY” checkbox selected, your address will be adjusted if required when you
click ok or APPLY. For example, if you enter "www.xara.com" it will correct it to
"http://www.xara.com/".
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You can put an email address in the Link address field, in which case clicking the link
will launch the reader's email program with the To: field filled in. You can also optionally
specify the subject line to be used, add CC or BCC email addresses to be copied on the
email and even specify the default body text to be used. For example this sets the To
email address and all four optional parameters:

yourname@wherever.com subject:Email from website cc:another@wherever.com
bcc:yetanother@wherever.com body:Auto-generated email

Technical note: Xara Web Designer 7 encodes your email address to reduce the
likelihood that SPAM robots will find your email address from the web page. This
requires Javascript to be enabled in the browser (currently >95% of browsers).

Link to...

Select this option to link to another page in the current website, or if you are in a
presentation document, to link to the next or previous presentation step. The dropdown
list allows you to select which page or step to link to.

TIP: If you have many pages in your website document, giving each one a name makes
it much easier to set up and maintain your page links, because the page list will show
the page names instead of just “Page 2”, “Page 3”, etc.

See the Page Tab (on page 204) section below for details of how to setup page
names, or edit the names in the Page & Layer Gallery.
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In addition to an entry for each page in your site, the dropdown list also contains the
special entries NEXT PAGE/PRESENTATION STEP and PREVIOUS PAGE/PRESENTATION STEP.

Next/Previous page

Use these to add a link which leads to the next or previous page in your site. For the
purposes of such links, the page order is determined by the order of the pages as they
appear in Xara Web Designer 7. A “next” link on the last page links to the first page and
a “previous” link on the first page links to the last page.

Next/Previous presentation step
Use these to add a link which leads to the next or previous presentation step in your
site, if your website is a presentation document. The presentation order is also

determined by the order of the steps as they appear in Xara Web Designer 7, similarly to
next/previous page.
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Link to anchor

This option allows you to jump the visitor to a specific part of any page in your website.

To setup an anchor point, first go to the page and object you want to be jumped to.
Select the object and add a name to it by right clicking and choosing the NAMES... option.
Then select the object to which you want to add the link and choose the anchor name
you added from the list provided with the “Link to anchor” option.

Note that when you link to an object which is a long way down a web page, the web
browser automatically scrolls the page down so that your anchor object is visible.

NOTE: You cannot apply a transition to a link to an anchor.

Link to File

This link option is useful if you want to add a document, movie or any other file to your
website to make it available to your visitors. For example you may have a PDF
document that you want to make available.

Select the object or text that you want to link. Then turn on this Link to file option and
use the BROWSE button to browse for the file on your computer. The name of the file
appears in the text field to the left of the Browse button. Click OK and your link is
applied.

As well as applying the link, Xara Web Designer 7 has now taken a copy of your file and
placed it in the support folder for your design. This is a folder next to your .web or .xar
file. If your design is called "MySite.web", the support folder will be called
"MySite_web_files" alongside it. All the files in the support folder get published along
with your website and so that means your file will be published with your website and so
the link you just added will work. See the Document Handling chapter (on page 81) for
more information on support folders.

Note: Because there is a separate copy of your file held in the support folder for your
design, you need to update that copy whenever you modify the file and want to publish
the modified version. Or you can just go through the above linking process again and
browse for your updated file. Also if you move or copy your website design to another
computer, or give a copy to someone else, you need to make sure the support folder
accompanies the design file, since it now contains an important part of your website!

Pop-up layer

You can add any content you like to a separate layer on your page and have that
content shown as a pop-up only when your visitor clicks on a link. For example you
could add some descriptive text about a photo on your web page and have that text only
shown to the user if they click on the photo.
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To add a popup layer, first you need to add the layer itself using the PAGE & LAYER
GALLERY and add your pop-up content to that layer.
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See the PAGE & LAYER GALLERY chapter for full details. Then you can select the layer
from the layer list provided next to the “Pop-up layer” option.

Now when a visitor clicks on your object, the layer contents appear! Clicking anywhere
else on the page makes the pop-up disappear again.

Note that all the content on the pop-up layer is loaded as soon as the visitor visits your
page. So if you want to provide a lot of pop-up photos, use the Pop-up Photo feature
described below instead.

The “Getting Started” chapter (on page 65) includes some step by step instructions on
adding layer pop-ups.

Pop-up photo

This option gives you a very easy way to add pop-up photos and other photo gallery
features to your website, without adding any layers! Simply import your photo and use
the SELECTOR TOOL to scale it right down so it appears as just a small photo thumbnail
on your webpage. Then select it and choose this "POP-UP PHOTO" option.

Click the seTTINGS button next to this option to go to the IMAGE TAB, where you can set
the size of the pop-up photo, add a title and caption, and choose from many other
options. See the Image tab section below (on page 206) for details. Selecting the pop-up
photo option on this Link tab, also selects the pop-up photo checkbox on the Image tab
— both turn on the same pop-up behavior.

Use common website link colors

This option lets you choose how the selected text links should be displayed. It is
selected by default, meaning that the text link will show with the link color you have
defined for the whole website. You can set this color on the Website tab (see Website
Tab section).

If you uncheck this option, then the selected text link will keep the color that you give it
on the page. So you can give different links different colors if desired.

Open link in

This option does nothing if either of the “Pop-up layer” or “Pop-up photo” link options are
selected. But for other links it allows you to tell the web browser how the target web
page should be loaded. By default it is set to “Not specified” which usually means the
browser will open the link in the same browser window and frame as the link.
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The dropdown list contains four options that cause the browser to do special things. You
can select one of these options, or type in the name of a frame:

NEW WINDOW (_BLANK) Open the link in a new browser window.
SAME FRAME (_SELF) Open the link in this frame (the frame that contains this object).

PARENT FRAME (_PARENT) Open the link into the parent window or frameset that contains
this frame.

SAME WINDOW (_TOP) Open the link into the main browser window, replacing any existing
frames.

If you want the link to be loaded into a specific frame in the browser, type the name of
the frame in this field.
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Website Tab

Publish

Title

Description

rords [comma separated)

Underline Text links

Mouse Off
Mouse

Visited

Other

The settings on this tab apply to the entire current document/website, so it doesn’t
matter what object or page is selected.

TITLE, DESCRIPTION & KEYWORDS: These fields are just as described in the Page Tab (on
page 204) section above. You can optionally set these fields here so that they apply to
every page in your site, unless overridden by the Page Tab settings for a page. So for
example a page that doesn’t have its own title set in the Page Tab will get the title you
specify here.

HTML CODE (BODY): This button serves the same purpose as the HTML code (body)

button in the Page Tab, and allows you to enter and edit large amounts of HTML code to
the body section of all your website pages.
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If code is specified here in the WEBSITE TAB it is included in every page of your site in
addition to any code specified for each page in the Page Tab. This allows you to have
some code included on every page, while also adding other code to those pages that
need it.

Website Link Colors

This section of the Website Tab allows you to control how text links appear on your
website.

UNDERLINE TEXT LINKS: Underlining is commonly used to highlight clickable links in text,
so this option is selected by default. Uncheck it if you don’t want your text links
underlined.

MOUSE OFF: Here you can choose the color you would like to be used for all your text
links. You can either choose a named Theme Color from the dropdown list (if there are
any in your current document) or click the Edit button to open the Color Editor so you
can choose any other color.

MOUSE OVER: Text links will change to this color when a visitor moves the mouse pointer
over them.

VISITED: Text links that point to a page which the visitor has already visited will display
with this color instead of the Mouse Off color.

CLIP TO PAGE EDGES (enabled by default): If you have objects in your website that

overlap the web page borders, click this checkbox to crop these objects so that only the
portion on the page is visible. Deselect this checkbox if you would like the object to flow
over the page edge, so that even the portion that overlaps the pasteboard is displayed.
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Page Tab

Page filename M

Page title

Page description:

Page keywords (comma separated):

HTML Code Insertion

Code added to page in addition to any code specified on the
Website tab.

HTML code (body] Embedded in the <body> of this page

The options on this tab apply to the current page, not to the selected object(s). The
current page is indicated with black angle lines just outside each corner of the page. All
fields on this tab are optional; you do not necessarily need to fill in these fields for every
page of your site.

If you want the same title, description and keywords on every page of your site, you can
set these just once on the Website tab instead of setting them on every page here.

PAGE FILENAME: Use this field to set the name you’d like to be used for this page when it
is exported. So if you want the page to be exported as “home.htm”, set this field to
“home”.

It's usual to make the first page of a website “index.htm” or “home.htm”, because if a
visitor specifies a URL consisting of just a domain name with no page name (e.g.
“www.xara.com”) this is usually automatically mapped by the web server to the
index.htm page if it is present. Note that characters entered in this field are automatically
converted to lower case and accented characters and some non-alphanumeric
characters are not allowed. This is to reduce the chances of compatibility problems with
different web servers when you publish your website.

PAGE TITLE: You can optionally choose a title for your page. If set, this is used by web
browsers to show a page title in the browser window frame, or tab. For example at the
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time of writing the www.xara.com home page has the title “Graphics Software by Xara”
which you can see is shown by the web browser if you visit the site.

Advanced: The title is inserted into the page header using the ‘<title>’ HTML element.

PAGE DESCRIPTION: This page description text can be shown by search engines within
their search results when visitors find your page with an internet search. The page
description may also be displayed by browsers and other web services.

Advanced: The description is inserted as metadata into the page header
(‘<meta name="description" .....).

PAGE KEYWORDS: Here you can enter keywords which you want to be picked up by
search engines to help visitors find your site. Enter words which potential visitors are
likely to search for if they are looking for pages or sites like yours.

For those familiar with HTML, the keywords are entered into the page header as
metadata:-

Advanced: The keywords are inserted as metadata into the page header
(‘<meta name="keywords" .....).

HTML CODE (BODY): Click to open the HTML Code (body) dialog, where you can paste or
type large amounts of HTML code directly into the body of your web page. The code is
inserted unmodified just before the closing “</body>" tag.

These dialogs must be used with care because inserting invalid code or script into your
page may cause serious problems to the web page as a whole.

If you need to insert exactly the same code on every page of your site, you can use the

HTML code (body) button on the Website Tab of this dialog, instead of entering it for
every individual page using the Page Tab.
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Image Tab

Link Mouse-over Placeholder Image
Photo pop-up
Pop-up photo: Pop-up width: m pix  Options...

F'xjp-up Title

Image Caption [&lt Text)

Web image type

eme choose the type automatically

est for photos]  Quality:

Photo pop-up

This section of the IMAGE TAB lets you add pop-up photos and other photo gallery
features to your web page easily. Simply import your photo and use the SELECTOR TOOL
to scale it right down so it appears as just a small photo thumbnail on your webpage.
Then with the photo still selected, select the Pop-up photo checkbox on this tab. Choose
the size you would like for the pop-up photo by entering a value in the pop-up width field
(default 500 pixels). Preview your page and click on the photo thumbnail on your page,
to see the pop-up photo appear.

When you turn on the pop-up photo feature here in the IMAGE tab using the checkbox,
the corresponding option on the LINK tab is also automatically selected for you. That’s
because a click on the photo will show the pop-up photo, so you can'’t also set any other
clickable link on the same object. So any link you previously setup on the object, using
the Link tab, will be removed.

One big advantage of these photo pop-ups over pop-up layers (as described in the LINK
Tab section above) is that the large photo is only loaded by the web browser when the
visitor clicks on a thumbnail. Therefore this method is much more suited to presenting a
large number of photos on a gallery page, because only the small thumbnails are loaded
initially, making the page load quicker.

Note that this feature works on objects other than photos, such as shapes and groups,
but can’t be used directly on text. You can put text inside a group (Ctrl+G) to work
around this restriction.
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Pop-up title

Give the selected photo a title using this field and it is shown above the pop-up photo.
Note that you also need to turn on this title option in the Pop-up photo options dialog
(see below), because titles are not shown by default.

Popup Photo Options

Click the opPTIONS button to bring up the PoP-uP PHOTO OPTIONS dialog. Here you can
choose from a variety of options that change the way your pop-up photos are presented.

Popup photo options

Popup options
Dim page while popup is open
Show shadow behind popup

Show image title (From Image tab of Web Properties)

M show thumbnail strip at bottom of popup

B Automatically start slide show
Change phott seconds
ptions apply to all pages in the current website,

Cancel Help

Popup Options
The following options change the appearance of the popup photo.

DIM PAGE WHILE POPUP IS OPEN: With this option selected, the entire page is dimmed
whenever a popup photo is displayed. This helps emphasize the popup photo, so that it
stands out against the darker background of the page.

SHOW SHADOW BEHIND POPUP: This option puts a drop shadow behind the popup photo
window, again to help make it stand out against the page background.
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SHOW IMAGE TITLE: If you have entered title text (see above) for each of your photos, this
option causes that title to be above the popup photo.

Butterfly on flower

Note that title text is separate to any caption text, which appears below the photo. See
below for information on setting caption text.

Gallery Options
The following options turn on gallery features for your popup photos.

SHOW GALLERY BROWSER CONTROLS: Turn this on to show gallery controls on your popup
photo.

p=>1 X

This appears on top of your photo whenever the mouse pointer is over the photo. It
allows your site visitor to view the other popup photos in the current page, without
having to close the popup window and click on the thumbnails for the other photos. The
visitor can move to the previous or next photo, or start and stop an automatic slideshow
where each photo is shown for a few seconds before moving onto the next.

SHOW THUMBNAIL STRIP AT BOTTOM OF PHOTO: With this option on a strip of small photo
thumbnails appears below the popup photo window. This allows the visitor to jump to
any of your popup photos by just clicking on the thumbnails in the strip, again without
having to first close the popup photo window.

AUTOMATICALLY START SLIDESHOW: Turn this on if you want a slideshow to start as soon

as the user clicks on any of your popup photos. You can also choose how many
seconds each photo should be displayed for when the slideshow is playing.
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Note that the only photos included in the photo gallery are those photos on the current
page which are setup as popup photos. Any other photos on your page will not appear
in the gallery, so make sure you use the Link tab of the Web Properties dialog to turn on
the popup photo option on any photos that you want to be included in the gallery.

Image Captions

You can optionally show a caption below each pop-up photo. Enter the caption text in
this field in the Image Tab.

Note that this feature works on objects other than photos, such as shapes and groups,
but can’t be used directly on text. You can put text inside a group (Ctrl+G) to work
around this restriction.

For those familiar with HTML, this text is also used as the "ALT" text on the image that is
exported for the currently selected object, whether or not the image also has a pop-up.
Web browsers show this text on the page in place of the image, if the image can’t be
obtained for some reason.
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Web image type

Due to the nature of HTML websites, most objects you see and can select on the page
in Xara Web Designer 7 have to be converted to bitmap images during the process of
exporting your website. This all happens automatically for you when you preview and
export, but the controls on this tab give you some control over how these images are
created.

Remember that each group, shape, heading, logo, photo, panel background, etc. is
exported as a separate image. By looking at how the objects in your design are
grouped, you can control how many images are exported to make up your website. So
for example if you have 2 separate shapes in your design which are not grouped
together, they will be exported as 2 separate images. You can group the two shapes
(Ctrl+G) and then a single image is exported instead.

This section of the Image Tab lets you specify how the currently selected object should
be exported as an image. By default Xara Web Designer 7 will decide for you. This
means that normally photos will be exported as JPEG (which is usually the best format
for photos) and other objects as PNG (which is usually best for graphics). Photos which
have been rotated on the page, or which have a semi-transparent shadow applied, are
exported as PNG because JPEG does not support transparency.

You can force the selected object(s) to export as a JPEG or as a PNG, by selecting the

appropriate option. When the JPEG option is selected, you can also choose the JPEG
quality to be used for that image. Higher quality means a larger JPEG file size.

Mouse-over Tab

e Mouse-over Placeholder Image
When the mous er th ted object;
O Do nothing

@ Show popup test [Title)

@ Show popup layer

The options on this tab specify what should happen when a visitor moves the mouse
pointer over the selected object. So for example you can pop-up some text or a whole
layer of content when a visitor hovers their mouse pointer over a photo on your web

page.

By default when a pop-up layer is triggered it will appear instantly. But you can apply a
transition effect to the popup layer so that it appears with an effect, such as fading in or
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sliding in. Open the Layer properties (on page 277) dialog for the popup layer (select the
layer in the PAGE & LAYER GALLERY and press the PROPERTIES button) and go to the
Transitions tab where you can select the effect and effect speed for that layer.

SHOW POP-UP TEXT (TITLE): Here you can specify the "pop-up title" text for an object. Web
browsers show this as a small pop-up tool-tip when the visitor moves the mouse pointer
over the object. For example, if you have a photo thumbnail which brings up a larger
version of the photo when clicked (see the Image tab section for how to do this), you
may want to set the pop-up title text to "Click to enlarge". Then when the user moves
their mouse pointer over the photo thumbnail, they will see this tooltip.

SHOW POP-UP LAYER: Just as you can add a layer to your design which is shown only
when a user clicks on an object (see the Link Tab section), you can also specify that a
layer should be shown when the mouse pointer is moved over an object. When the
mouse pointer is moved off the object, the pop-up disappears again. Simply select this
option and select the layer you want to pop-up, from the list provided.

For example you can use this feature to pop-up a larger copy of a photo when the visitor
moves their mouse pointer over it. However note that all the content on the pop-up layer
is loaded as soon as the visitor visits your page. Therefore this method of showing pop-
up photos is not recommended if you have a large number of photos you want to show.
In this case use the Pop-up Photo (on page 41) feature described in the Link Tab
section.

Placeholder Tab

Placeholder

In exported website:

O Show selected object(s) unchanged

@ Replace with Flash

@ Replace with graphic file

@ Replace with HTML code

HTML code (body)

M Re-generate placeholder image automatically
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The Placeholder tab is used to add and edit manually editable widgets. These are
widgets you insert onto your web page by manually pasting in HTML code for the widget
or by importing a Flash or movie file. You won’t normally need to use the Placeholder
tab on widgets that you’ve added from the DESIGNS GALLERY, because the code and files
that make those widgets function are handled for you automatically. See the Website
Widgets (on page 261) chapter for full details.

To turn any normal object into a placeholder for a widget, select it and then open this tab
of the Web Properties dialog. Choose whether you want the widget to be based on a
piece of HTML code you’ve obtained from a widget website, a Flash file or a graphic file.
Browse for the file or paste in the HTML code. Click ok and now your object is a
placeholder object.

This means the object represents the dimensions and position of the content you've
added, but in your exported web page the object is replaced by the actual code or file
that you inserted.

However there is an easier way to add files or code to your site. Simply drag and drop

Flash or animated GIF files from Windows File Explorer onto your page. A placeholder
image is automatically generated for you and is placed on your page. A copy of the file
is added to the support folder of your design so that it gets exported and published with
your site. When you export and publish your site, the placeholder image is replaced by
the actual file you imported.

Similarly if you’ve copied some HTML code from a third-party widget website, you can
simply paste that code into Xara Web Designer 7 (make sure you are in the SELECTOR
TooL when you do this, not the TEXT TooL or it will be inserted as text!). Xara Web
Designer 7 detects the HTML and uses it to render a placeholder image which appears
on your page. You can also add a placeholder for HTML code directly into the body of a
page by clicking the HTML code (body) button, which brings up a scrolling dialog where
you can paste or edit large amounts of code, if necessary.

When you export/publish your site the placeholder is replaced by the actual code so that
your widget functions. See the Website Widgets chapter (on page 261) for more details.

Replace with Flash

Select this option to replace the placeholder object with a Flash animation. Use the
Browse button to locate the Flash (.swf) file you want to use.

The chosen file is automatically copied to the support folder for the current design, so
that when you export your website the file will be included in the _htm_files folder along
with all the generated images for your site. See the Document Handling (on page 81)
chapter for information about support folders.

Replace with graphic file

Select this option if you want to insert a graphic or image into your website in place of
the placeholder object (e.g.. a PNG, GIF or other web compatible image file). Use the
Browse button to select the file.

The chosen file is automatically copied to the support folder for the current design, so
that when you export your website the file will be included in the _htm_files folder along
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with all the generated images for your site. See the Document Handling chapter for
information about support folders.

Replace with HTML code

With this option you can paste HTML code which you’ve obtained from somewhere else
into the body section of your page; i.e., between the <body></body> tags. For example
many sites provide widgets that you can add to your page by pasting the HTML in here.
Follow the instructions given by the provider.

As mentioned above, you can just paste the HTML code directly onto your page instead
of inserting it in this dialog (while in the SELECTOR TooL). And using that approach
automatically gives you a placeholder image that looks just like the actual widget, so it’s
the recommended way to insert widget HTML code.

WARNING: You need to be careful to insert only code which you know is safe and from
a trustworthy source. Invalid or broken code will affect your published web page
because Xara Web Designer 7 simply inserts the code as you provide it, unmodified and
unchecked, into your page when it is exported.

If you use Xara Modules (www.xaraonline.com) you can paste a module snippet into this
field (or directly onto your page) to add your Module to your web page.

If the HTML code that you enter references external files which are expected to be found
in your website, then you need to copy those external files into the support folder for
your design. See the Document Handling (on page 70) chapter for information about
support folders. Once in the support folder, the files will be automatically copied to the
_htm_files folder of your website when you export. Therefore you also need to make
sure that any references to these files in the HTML code references them at the right
location.

Let’s take a simple example to make this clearer. Suppose | want to insert a small piece
of HTML code which adds an image to my website. The HTML code | add will need to
reference the image file somewhere. First | copy the image file, say “myLogo.gif’, into
the support folder of my document. If the document is “mySite.web”, the support folder
will be “mySite_web_files”. | know that when | export this website, | will export it to the
name “mysite.htm”. This means that all the generated images for my site, and a copy of
“myLogo.gif’ which | put in the support folder, will be exported to the folder
“mysite_htm_files”. Therefore | must make the HTML code I'm inserting reference the
image file in that location. So | may insert:-

<img src="mysite_htm_files/myLogo.gif" />

Note that this references the image file in the exported image folder location
(_htm_files), NOT directly in the support folder (_web_files), because only the exported
image folder gets copied to the web server along with my web page when the site is
published.

Of course if | really only wanted to put an image on my website, it's much easier to just

import the image into Xara Web Designer 7 directly! But this is a simple example that
shows how to add HTML code which references an external file.
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Check Embedding YouTube, Flash And Other Widgets (on page 28) for more examples!

Placeholder objects

The placeholder object is actually included in your website and it can be shown to the
visitor in some circumstances. For example if you've added a Flash animation, if the
visitors to your page do not have Flash installed in their web browser, or if they've
disabled Flash, the browser will show the placeholder image instead.

Therefore it's sometimes a good idea to make your placeholder object more than just a
black rectangle, or an accurate image of the widget that appears on your page. You may
decide to use a group as your placeholder object, where the group includes a text
message asking the visitor to install Flash so that they can see your Flash content.

REGENERATE PLACEHOLDER IMAGE AUTOMATICALLY: If this option at the bottom of the
PLACEHOLDER TAB is selected, then the placeholder image gets automatically generated
from the content you have added, whenever the content changes or when you resize the
placeholder object.

When you paste code or import files directly onto your page, as recommended above,
this option is selected automatically for the placeholder image that gets generated.
Sometimes it's useful to turn it off after inserting content this way, if you are happy with
the preview image and no longer want it to be re-generated if you change the content in
some way.

Publish Tab

You will need a web hosting company to host your website. Quite often your existing
Internet service provider will include ‘'web space' as part of your normal subscription.
Also the Profile control in this Publish dialog offers one or more hosting options that you
can take advantage of. See below for details. Most companies also offer the ability to
purchase your own domain name (e.g. like www.xara.com) and have this set to point to
your web pages.
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If you want Xara Web Designer 7 to publish your finished website to your web space
automatically, so it's live on the Internet, you need to enter the access details for your
web space on this tab.

Profiles

FTP Details

To allow you to publish your websites directly from this
program enter the details required to connect to your web
space using FTP. Get this information from your ISP,

FTP host address: ftp.webhoster.com

FTP username:

Enter password here only if you want it to be remembered
on this computer. Otherwise you will be asked for the
password each time you publish.

FTP password:

Sub-folder (optional): JELGY

The website URL is optional, but required if you want your
website to include a sitemap or be included in the user
gallery.

Website URL:

M Include my website in the user gallery More Info

Other settings
Re-publish changed files only

The first section of this dialog allows you to select a pre-configured profile. The profile
list contains two types of profile: those that you create yourself and which are stored on
the computer you are using (see Save in profile for details on how to create these); and
one or more standard profiles which are installed along with the program and which offer
you some different web hosting solutions for you to choose from.

Standard profiles: When you select a standard profile, a banner should appear
immediately below the profile list. This banner is downloaded from the web hosting
company (so it will only appear if you are online). Click a button on the banner to find out
more about that web hosting solution on the company’s website. If you decide to sign up
for hosting with one of the suggested providers, you will be given a username and
password with which to connect. You enter those details in the FTP Details section of
this dialog.
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FTP Details: Enter the FTP details you have for your web space here. You need to enter
at least the host address and username. You don’t need to enter the password at this
stage if you don’t want to. If it's missing you will be asked to enter it each time you
publish your website.

The optional Sub-folder lets you publish your website into a sub-folder, e.g. if you were
publishing to the xara.com domain (of course you can't do this) and wanted the web
address to be;

xara.com/products/web_designer

Then you'd set a sub-folder of '‘products' and a page name of 'web_designer'. If you set
a sub-folder this way then all the pages in your website will be published to this folder.

WEBSITE URL: Enter the full URL of your published website here if you would like your
website to be included in a user gallery, then click the INCLUDE MY WEBSITE IN THE USER
GALLERY checkbox if you would like your website to be included in a Xara or MAGIX user
gallery. This option is only enabled if you have added a valid website URL. After
publishing your site, Web Designer generates a thumbnail of your website and places it
in a Xara or MAGIX gallery of websites created by Web Designer users. Click the MORE
INFO button to learn more.

Note: Web Designer does not support sitemap creation.

Deleting a profile

To delete a profile, select it in the profile list at the top of the Publish dialog and click the
DELETE button next to it. You cannot delete the standard profiles.

Publishing

Once you've set your Publish details, you can then select FILE > PUBLISH WEBSITE. Your
website will be published.

Note: Many web servers use case-sensitive filenames. So, for example, the web
address xara.com/products.htm is not the same thing as xara.com/Products.htm. To
reduce confusion and the likelihood of errors Web Designer enforces that all page
names are all lower-case and contain only allowable characters. This means that
spaces are not allowed in page names. We suggest using an underscore as an
alternative separator.

Important: If you have not set any specific page name, then the name you exported to
last will be used for all the pages in your website. E.g., if you open a template website,
and export this as 'test' to your file system, and now publish this, it will be published as
test.htm to your web server, and all additional pages will be test_2.htm, test_3.htm etc.

If you have not set an export filename, when you first publish you will be asked to enter
a filename. index.htm is the usual name for the first page of a website.
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Re-publish changed files only

By default Xara Web Designer 7 keeps track of the files that make up your published
website and when you come to re-publish after making changes to your site, it attempts
to re-publish only the files that have changed. This makes re-publishing much quicker in
most cases.

However Xara Web Designer 7 does not know if you have deleted or modified files in
your web space using another tool. Therefore if you have any problems whereby your
published site does not match the locally exported copy of your site, you should arrange
for the whole site to be re-published. To do this, turn off the RE-PUBLISH CHANGED FILES
ONLY option at the bottom of the Publish tab. Then the next time you publish, every file
making up the site will be published, making sure that your published site is up to date.
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Introduction

Photos are an integral part of almost all creative work nowadays, from websites, to
flyers, brochures, DTP work and more.

Photo handling in Xara Web Designer 7 is different than you may be used to with other
graphics programs.

In Xara Web Designer 7 you can color, copy, crop and enhance photos as much as you
like. The object oriented, non-destructive nature of the photo handling means that, for
example, when you resize a photo, you are not really altering the original photo, but just
resizing a visual copy. The original imported image is saved in the .web file, so that you
can later edit, and resize again with no loss of quality. You can even un-crop cropped
photos.

The photo handling is astonishingly fast. You can open a 50 Megapixel photo, and
perform any of the enhance operations, and rotate the full resolution image in real-time.

This chapter covers the basic principles of manipulating photos and bitmap images in
Xara Web Designer 7. The operation of the Photo Tool is covered in the separate Photo
Tool chapter.

*Benchmarks based on photo compositions created with multiple hi-res JPG digital photos

Photo Objects

In Web Designer photos (or bitmaps) are just another type of object on the page. You
can drag and drop photos onto the page from your file explorer, and then you can
resize, rotate, copy and move them around just like any other object. Importantly you
can adjust the transparency, even graduated transparency and clip and cut shapes out
of photos with ease. The transparency feature lets you blend, merge or create
composite photos.

Where you might have to use layers in other photo tools, every object in Xara Web

Designer 7 is on its own layer and, just as with any object on the page, you can move it
forward to be in front, or backwards to be behind other objects.
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Importing Photos

Xara Web Designer 7 supports a very wide range of photo or bitmap types including
JPEG, PNG, TIFF and RAW digital camera images, as well as many more types. The
term "bitmap" is the general term encompassing all types, but interchangeable with the
word "photo".
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The easiest way to open an image is to drag the photo or bitmap file from your Windows
file explorer onto the Web Designer Window. Or you can select the FILE -> OPEN or
IMPORT menu options.

When importing high resolution photos (anything above 1920 pixels either wide or high)
into a web document, Web Designer automatically resizes the photo down to HD screen
size without asking you if you want to import a lower resolution version. For a web
document, even at the reduced size, there should be more than enough resolution in
your photos for high quality results on your website, so it’s rarely necessary to import
digital camera images at full resolution for web use.

If you drag and drop onto an existing photo it will be replaced. Drop onto the background
to import as a stand-alone photo.
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Replacing photos

If you drag and drop a bitmap file over an existing photo it will replace that photo, but
keep the same container or frame size. This makes it very easy to replace photos on
templates. You can use the FILL TOOL to adjust the size, position and angle of the photo
inside its outline. This is not true for photo documents (on page 237), where dropping a
photo on the page will always import it as a new document.

When replacing a photo or bitmap this way, it is sized to best fit in the existing picture
outline. If you hold "Shift" when replacing a photo, the new one will fit into the same
dimensions and rotation as the old photo. This is useful where you've manually adjusted
the scale or rotation of a fill and then want to replace the image with another which has
the same aspect ratio. If you hold "Ctrl" down when you drop, the photo will simply be
added to the document and will not replace any existing image.

If there are multiple copies of the same photo on a page, for example a small thumbnail
and a larger version on a pop-up layer, when you drag and drop replace, all copies of
the photo on that page will be replaced by the new one.

Replacing multiple photos at once

Most of the web templates provided in the DESIGNS GALLERY will allow you to replace
multiple images at once, by dragging and dropping multiple image files from Explorer
onto the canvas. Or use "FILE" > "IMPORT" and select multiple images in the file dialog
("Ctrl + click" adds to the current selection, "Shift + click" allows you to select a range of
files).

The incoming photos are used to replace the images in the document. As when
importing single photos, you will be asked if you want to import reduced size versions if
your photos are large. Replacement is performed left to right and top to bottom (normal
reading order). If you don’t drag in enough photos to replace all the replaceable photos,
you can go on to import more photo files the same way. Replacement carries on from
the next un-replaced photo. Therefore you can quickly fill the design with your photos.

If you import more photos than can be accommodated on the current page, any
following pages in your design will have their replaceable photos replaced too, using the
remaining incoming photos. If that would still leave a surplus of incoming photo files,
then the current page gets duplicated as many times as necessary to accommodate all
your photos.

This means you can very quickly build a photo gallery website showing your photos!
Just choose a gallery template from the DESIGNS GALLERY, then import your set of photo
files. The page is copied as many times as required to fit in all your photos. Make sure
you choose the reduced size option when importing a lot of large photos!

Using photos as fills

You can also use any bitmap as a fill style for any drawn shape. Simply drag the file
over the shape (which can be from your file system, or from the Bitmap or Fill galleries),
and hold the "Shift" key down before you drop. This will replace the existing color fill with
a bitmap, fitted to the object. Again you can use the FILL TOOL to adjust the size, angle
and position.
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Initial Photo size

When you import a JPEG it's initially sized to be 500 pixels wide.

To reduce the size, just drag a corner handle using the SELECTOR TOOL, or enter a new
width in the Selector TooL InfoBar width field.
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If you replace a photo using drag and drop, then the photo is sized to exactly fit the
container, and this means its size and resolution will depend on the size of the
container.

Photo resolution

One fundamental difference between Xara Web Designer 7 and other photo tools is that
when you resize a photo it retains the full resolution with which it was imported. Scaling
an image to be smaller, just increases the dpi or ppi (pixels per inch). In other words no
pixels are lost, they are just made smaller.

96ppi image on the left when scaled down to half size becomes twice the resolution, 192ppi.

The status line shows the resolution of any selected image. Retaining the full resolution
is important because it means you can see all the detail when you zoom in, and that
when printing the maximum resolution is sent to the printer. Also it means you can
enlarge all or part of the image and Web Designer retains the original maximum quality.

When saving your website (exporting the HTML) Xara Web Designer 7 automatically
converts the photos to the correct resolution required for the web page.
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Zero-memory Copies

One of the most revolutionary differences between Web Designer and other software is
that when you copy any photo on the page, it doesn't really make a complete new copy
of the original imported photo but instead just displays another 'view' of the original
image. Web Designer's rendering engine is fast enough that it can display any number
of copies of the same image 'on the fly' this way. This saves huge amounts of memory
and dramatically reduces files sizes.

This doesn't detract or limit what you can do with each copy, and they can be treated as
completely separate independent copies. Each copy does not have to be identical. You
can manipulate each as required, resizing, rotating, cropping, coloring or applying a
wide range of photo and transparency effects. All for no memory or native file size
increase.

This shows separate copies of the same image, each manipulated in a different way.
Each retaining the full resolution of the original imported JPEG, as you can see from the
right image. The memory (RAM and file size) is no more than the original JPEG size.
Because they are the same image displayed at different sizes the resolution, that is the

dpi or ppi, varies. In the above example the eye is 115dpi, (because the image has been
enlarged) while the image on the left is over 1200dpi.

The Bitmap Gallery

The Document handling chapter (on page 88) has general information about galleries.

The BITMAP GALLERY shows all the bitmaps or photos used in any document, along with
information about its pixel size and file size.
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You can open it by clicking it in the Galleries bar, or from within the "uTILITIES" >
"GALLERIES" menu, or "F11".
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Bitmap gallery

'imagel2 (Optimised)141', JPEG, 36 K
318 by 480 pixels, 0.2 MP, 24-bit, 96 dpi

‘gravel.jpg’, JPEG, 11K
250 by 156 pixels, 0 MP, 24-bit, 96 dpi

'c674h0073 (Optimised)2’, JPEG, 10K
233 by 175 pixels, 0 MP, 24-bit, 96 dpi

This shows the BITMAP GALLERY for the above document, and shows the original JPEG
image of the girl which is embedded into the native .web file. As mentioned above, all
copies of this image are displayed directly from the one master, so only the single image
is shown and not all four variants that appear on the page.

The following useful information is displayed about the original image:

e Filename of the original JPEG

e The file type, in this case a JPEG, and the file size, 1,006K. (This is the original size of
the file, and also how much of the .web file will be taken up by this image.)

e The pixel dimensions of the original, the Megapixel size (in this case just under 2MP)

e The color depth, in this case "24 bit" which is sometimes called true color. The Xara
image is a 4 bit image.

e The original resolution of the image, in these cases 96dpi
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The BITMAP GALLERY always contains a default bitmap, with the gray Xara image. This is
used as the default bitmap for bitmap fills and in cases where other bitmaps are missing.
It's useful to have as a placeholder as well.

As with all galleries, you can drag the objects from the gallery onto the page to create a
new copy. Or you can select an image in the gallery and click one of the buttons across
the top. The following section details the operation of the BITMAP GALLERY controls, most
of which are for the more advanced user.

Filling shapes with a bitmap

Select the shape on the page, then select the bitmap in the gallery and click the fill
button. Alternatively drag the image from the BITMAP GALLERY and drop it onto any
shape while holding "Shift". You can adjust the size, angle etc in the FILL TOOL.

Setting a Bitmap Transparency

This is for the more advanced user. You can use any bitmap as a transparency mask on
any filled shape or bitmap. The lightness of the bitmap affects how transparent the
selected object is. The bitmap transparency size, rotation and tiling can be controlled
from the TRANSPARENCY TOOL (on page 189) InfoBar.

Deleting images from the Gallery

When you delete a bitmap from the page, it remains in the BITMAP GALLERY. Any unused
bitmaps will be deleted from the file when saved and re-opened. However you can force
the deletion of any bitmap by selecting it and pressing the DELETE button. If the bitmap is
used in the document, it will be replaced by the standard Xara bitmap.

Setting the page background to a bitmap

Select the bitmap in the gallery and click the BACKGROUND button. This will tile the
image. When exporting the page as HTML, this image is tiled across the whole visible
page background of the browser, unless you’ve also given the pasteboard (the area
around the page) a different background.

Save

Select the bitmap and click save will save the original image. In the case of an
embedded JPEG this will save the original JPEG file. Other bitmap types are best
saved as PNG bitmap type.

Bitmap Properties

The PROPERTIES button will display information about the selected bitmap in the gallery.
It also provides a way to stop image smoothing when bitmaps are enlarged. Usually all
bitmaps are smoothed when enlarged, or zoomed into, on screen. There is a check-box
option in the Properties dialog to turn this feature off, so that individual pixels are visible
when you zoom in.

Wwww.Xara.com



Photo Handling

225

Embedded JPEG files

JPEG files are hugely compressed from their original state, being up to 10 times smaller
than the original uncompressed image. In the above example, the original
uncompressed image requires more than 7mb of memory, but as the BITMAP GALLERY
shows, this JPEG file is only 1mb. A very significant reduction. This is why JPEG images
are the standard file type for digital photography and use on the web.

When you drag and drop a JPEG file (or use the "Open" or "Import" menu options) the
original JPEG is stored in the document, and this is what is saved in the .xar file when
you save your document.

It's important to understand how this differs from other graphics tools, both vector
drawing software and photo editing programs. Other products will typically un-compress
the image and store the un-compressed "raw" image in memory and the native file when
you save to disc. What's more each copy you make is typically a complete copy of the
original raw image, as mentioned above. Make four copies of your photo and save your
file - it will be four times larger. In Xara Web Designer 7 the file is no larger, no matter
how many copies you make.

So by embedding the original JPEG file instead of saving the un-compressed image,
that's a file size saving of more than 7:1 compared to other graphics editors. The fact
that there are four complete copies of the image means that in this particular case the
memory used is more like 30 times less. So this represents a huge file size (and time)
saving over other graphics tools*.

*This is easy to test. Import a JPEG into your favourite graphics editor, make four copies,
perhaps change each one slightly, to be colored or blurred or rotated. Then save the native
file and compare it against the original JPEG size, and the equivalent .Xar file. A .Xar native
file is about the size of the original JPEG, no matter how many copies of the image are made.

Extracting the original JPEG

Right click on any image in the BITMAP GALLERY and select the SAVE menu option to
save the original JPEG back to your file system.

Lossless vs. Lossy

Because everything Web Designer does with your photos is based on the original
image, which remains untouched embedded in your file, everything it does is lossless.
There is no re-compression of images when saving the native .xar file.

Of course you can save or export your image as a compressed JPEG file, at any
required size, and in this case the image quality and detail will be reduced in a
"destructive" manner. Destructive here means that the original data or detail cannot be
recovered from a lower-resolution saved JPEG. Xara is a non-destructive editor
because the original photo data and detail is never lost, reduced or compressed in a
lossy manner in the native .xar file.
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Blending & Merging photos

By making copies of photos on top of each other, and applying different effects to the
copies, combined with Web Designer's advanced transparency controls, you can easily
create blended photo compositions. For example to selectively blur parts of a photo
takes a few seconds.

*
L3
Nty

4

3

»
5
Original photo Blurred copy Apply an elliptical Blended result
graduated transparency
to the face

By placing the blurred copy with the 'hole' created by the transparency effect over the
sharp original, the blended result shows the sharp face area through.

Creating copies of any object requires a single key press, or click (drag with right mouse
button). Blurring a photo takes a single drag on a blur slider of the PHOTO TOOL, applying
a gradated transparency is just another click-drag in the TRANSPARENCY TOOL, and finally
positioning the photos on top of each other takes a second. So the whole process takes

a few clicks, drags and just a few seconds in Xara Web Designer 7.

Photo display quality

Xara Web Designer 7 can display photos in one of five useful quality levels. The top two
settings smooth the screen pixels so avoiding visible pixels or rough sections along the
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edges (anti-aliasing). Change the quality level using the QUALITY entry in the wiINDOW
menu.

VERY HIGH Displays images using bicubic sampling. This displays images at the
QUALITY best quality, particularly for large hi-res images that are scaled down
(DEFAULT) or zoomed out a lot.

HIGH QUALITY Anti-aliasing on, but images are rendered faster and at lower quality.
FULL COLOR No anti-aliasing, thus showing individual pixels. This can be useful

when you're zoomed in and you need to clearly see the separate
image pixels. The downside is that images generally look poor
when reduced or enlarged resulting in clearly visible pixelation and
jagged "staircase" edges, especially if you rotate the image.

OUTLINE WITH Is particularly useful for seeing outlines of the various steps of a

BLEND STEPS blend. Blends are not supported in Xara Web Designer 7 but
imported .xar files could contain blends.

OUTLINE Only object outlines are shown. This is useful for finding and

selecting objects that are difficult to see due to other objects in front
of or behind them.

There is an additional control that allows you to stop all image smoothing or anti-aliasing
on images that are scaled up or zoomed in. In other words, instead of a smoothed
image, you see all the pixels when zoomed in. Open the BITMAP GALLERY and right click
on the image and select "properties”. In the dialog un-check the "Smooth when scaled
up" option. Now, no matter what viewing quality you select the image (and all copies) will
always show the un-smoothed pixels when enlarged or zoomed in.

Note: If you use the PHOTO TOOL sharpen / blur control then images have to be
displayed at maximum quality. So if you think the viewing quality has stopped working,
it's almost certainly because you have sharpened or blurred the image with the PHOTO
TOOL.

Saving & Exporting Photos

Selecting the sAVE option will always save a native .web file. To save a photo as a
JPEG, PNG or other image file type, it's necessary to use the EXPORT option, or the
shortcut "Ctrl + Shift + E".

There are two icons available on the top bar that are short-cuts to save
” ” the selection as JPG or PNG. These are in the flyout bar shown when you
move the mouse pointer over the Export HTML icon.

For photos we recommend saving as JPEG (sometimes called JPG) as this offers the
greatest compatibility and the best size / quality compromise.

When you export a JPEG or PNG, there is a SETTINGS option on the Save Dialog.

Selecting this provides many advanced export options, as well as compare side-by-side
alternative settings or even alternative file types such as PNG.
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When you export a JPEG, an export preview dialog is shown where you can adjust
many export options, as well as compare side-by-side alternative settings or even
alternative file types such as PNG.

The Export Preview dialog allows you to adjust the size, resolution, JPEG quality and
even select from 3 alternative export file types if you so wish. The default values should
be fine for all normal purposes and you can just click the export button to save your
photo.

Things to remember when exporting:
o First select the object or objects you want to export
e The default exported size of the image will be the size you see on screen at 100%

zoom.

The Export Preview dialog (on page 288) is described in more detail here.

Tip: You can control the JPEG quality in the Export Settings dialog on the Options tab.
The default and recommended value is 75%

Palelle Options | Bitmap Size Wil  The JPEG system is designed that a setting
of 75 is the optimum value. We recommend
B Progressive you do not save JPEGs at 100% quality, as
~ _ the results are visually identical to the 75%
JPEG Quality quality, only the file size and memory use is
0 100 dramatically increased with no benefit.

When saving for use on the web it's quite possible to reduce the quality below 75 to
increase page view speed. The preview window shows the quality of any value you
select.

Tip: If you expect you may want to perform any further edits on your exported image, for
example to create the image again at another size, we strongly recommend saving the
.web file as well. This will preserve the lossless master image along with all its edits and
changes.

Example: To resize a photo and save as a new JPEG

This process is very quick and simple:

¢ Drop your photo onto Web Designer (either onto a blank page or onto the title bar to
create a new document)

e In the SELECTOR TOOL either drag a corner handle to resize the image, or enter the
required width or height into the "W" or "H" field on the InfoBar. Check the image size
is correct at 100%

Cize I <« Scale o100 %} B
"7 H INNEEE v - 77 H I %
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e Click the 'EXPORT SELECTION AS JPG' button on the top bar.
¢ Enter a filename, Click the SETTINGS button if you need to control the compression, or
just click sAVE

To save any image as a PNG go through the same process except choose the PNG file
type.

Photo Edit Attributes

All edits performed using the PHOTO ToOL (on page 240), such as any altering of the
brightness, contrast, color, blur or sharpen values, are all just stored on the photo as
Web Designer attributes.

Just as you can alter the color of a shape or line without altering the underlying shape,
SO PHOTO TOOL attributes alter the visible appearance of the photo without affecting the
original image (this is called non-destructive editing). Another way of looking at this is
that Xara Web Designer 7 just stores a list of edits applied to your photo, and you can
change, remove or add new edits. You can always recover the original untouched photo,
even after the brightness, resizing, even clipping or cropping.

Attributes can be copied and pasted between objects. Not only does this apply to
traditional attributes such as line color and thickness, it also works with all the PHOTO
TOOL attributes. So this means you can easily copy all the enhancements made on one
photo to any other using the copy / paste attribute feature.

This also applies to all other attributes of the photo, such as line width and color, photo

coloring (contoning), shadows, etc.; all these can be copied from one photo to another
using the same technique.

Editing the outline of Photos

You can use the SHAPE EDITOR TOOL to directly adjust the outline shape of a photo.
Similarly you can apply outlines the same way as for any shape, and shadow, etc.
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Using the SHAPE EDITOR TOOL you can push or pull
on the sides. This example also has a black outline
and soft shadow added. To restore the image back
to its original rectangular shape, select the "Un-clip”
in the clip mode of the PHOTO TOOL InfoBar.

When photos are edited this way, they are treated
like any normal vector shape, containing a bitmap
fill. This is why you can use the normal line and
shape editing features, and indeed you can use the
FILL TOOL to adjust the size, angle and position of
the photo "fill" inside the shape.

Cropping photos

G The easiest way to crop a photo is to just drag on it
when in the ENHANCE TOOL, Or you can just drag one
of the 8 control handles around the outside to adjust
the edge of any selected photo.

|l For more advanced cropping control, select the CLIP BUTTON on the PHOTO TOOL
@ flyout bar which provides aspect ratio control and precise numeric clipping control.

This also provides an Un-clip button that will remove any clip rectangle and restore the
original image.

One important feature is that this crop feature is really a dynamic clip, in other words it's
a non-destructive crop, and you can adjust the crop boundary afterwards to reveal
hidden parts of the photo. If you want to really crop - i.e. make this a destructive crop,
that really removes the invisible parts of an image then use the Optimize Photo feature.
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Cutting objects out of photos

Using the drawing tools, it's easy to draw around shapes and cut them out of the
background. You can use any of the Line Drawing Tools to do this. Perhaps the easiest
way is using the SHAPE EDITOR TooOL and draw a line around the edge of the shape you
want to extract. Zoom into your photo and then:

¢ In the SHAPE EDITOR TOOL use a type of "connect the dots" technique of sequential
clicks around the shape, using more closely spaced clicks for detailed areas and
fewer clicks for straight line or gentle curved areas.

¢ When you've gone around the object completely, close the line to be a solid shape by
joining the last segment to the first. This will create a filled shape, typically solid black.

e You can now cut this shape out of the photo by selecting both the new mask shape,
and the photo (shift click on the photo in the SELECTOR ToOL) and select the menu
option "ARRANGE" > "COMBINE SHAPES" > "INTERSECT SHAPES".

You can make further edits to the shape, using the Line Editing Tools, as the whole
photo remains inside the shape which acts just as a clipping mask.

In this example the cow has been given a floor shadow using the SHADOW TOOL.

www.Xara.com



232

Photo Handling

Coloring photos

With any photo selected just click on the Color Line to apply a color to any photo.
Clicking the white color patch and selecting 'SET CONTONE LIGHT COLOR' will turn any
color photo to be black and white. It's called a contone because it's a continuous tone
from black to white.

Simply click a pale yellow colour on the colour line to create a yellow contone picture.

Or, right click on the Color Line which shows a context menu for you to apply the
selected colour as either the light or dark color.

When you click on the
COLOR LINE you can select
any color as either the
Light or Dark contone
color. Or you can use the
COLOR EDITOR (Ctrl+E) and
choose any color you like.
The drop down menu at
the top of the Color Editor
controls whether you edit
the light or dark color.

Edit New color

Set Contone Light Color

Set Contone Dark Color k

s Options...

You can restore the original color of a photo by clicking the cross-hatched "no color"
patch on the left of the Color Line, or right clicking on it and selecting the "Restore color"
option.

Using Windows to capture screenshots

o Press the "Print screen" button on your keyboard. This places a screen capture of the
whole screen on the clipboard. Alternatively, select "Alt + Print screen" which will
capture just the current window.

e In Xara Web Designer 7 select "Ctrl + V" to paste, and select "Bitmap" to have the
results pasted onto the page.

You can now crop, add text annotation, resize as required and save the results. It's best
to save this type of image as a PNG file.

Resize, rotate and position a photo within its frame

Photos in Xara Web Designer 7 are treated like a "bitmap filled" rectangle. The shape of
your photo is really a fully editable outline around the image contained inside. So when
you crop, or edit the outline shape, you're not affecting the fill, which is clipped inside the
shape.
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Photos and bitmaps on the page are always contained within an outline shape. Not only
can you change the shape of the outline, you can also adjust the size, angle and
position of the photo within its frame using the FILL TooL. Just select the photo, go into
the FILL TooL and you will see fill arrows at right angles from the center (or you can go
into FILL ToOL, and click on the photo to select).

"~
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|

For example, to enlarge and rotate the image on the left inside its frame, select the FILL
TooL and drag on one of the arrowheads.

&

| V7 | W

e To resize drag on one of the arrow heads away from the center. You can hold "Ctrl" to
constrain the angle.

e To rotate the image, drag one of the arrowheads around the center.

¢ To re-position the image, drag anywhere on the image.

On the InfoBar of the FILL TOOL, you can select the
"repeating tile" option which makes the image a tiling
bitmap fill. By dragging the fill handles you can now
resize and rotate the image tile dimension. There is no
better demonstration of the speed of Xara Web Designer
7 than to do this with a huge multi-megapixel image.

If you have a Photo Group instead of just an ordinary photo object you can’t use the FiLL
TooL as described above to scale and rotate the image in its frame. If you want to
convert a Photo Group into an ordinary photo object so you can adjust it using the FILL
TOOL, you can use "UTILITIES" > "OPTIMIZE PHOTO" to do this. But note that this is
destructive in that thereafter you will not be able to modify any of the photo edits you've
applied to the photo.
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Horizon Straighten

Using the FILL TOOL, as previously described, means it's easy to straighten the horizon
of an askew picture.

o Select the Fill Tool and click on any photo. This will show the fill handles, which are
arrows showing the extent of the fill inside the shape.
¢ Drag on the end of one of the fill arrows to resize, and rotate as required.

The following shows a landscape (created using the panorama stitching feature of Web
Designer) that has a sloping horizon.

In the FILL TOOL, drag on one of the arrowheads to rotate and resize as required. You
can re-position the photo by dragging on the center handle of the fill arrows, or holding
"Shift" and pushing anywhere on the image.

Viewing a scaled photo at its full size

The zoom TO 1:1 button on the PHOTO TOOL infobar adjusts the zoom so that the selected
image is shown at full size, which is where each pixel of the image is mapped to each
screen pixel. This is useful if you want to edit an image that’s been scaled down on the
page, but want to see it at its full size while you work on it.
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Making a photo its full size

The SCALE PHOTO TO 100% button on the PHOTO TooL infobar takes the currently
selected photo and scales it to its full size on the page. So for example if the selected
photo is scaled down to 500 pixels wide, but the original imported photo was 1000 pixels
wide, the photo on the page will be scaled up to 1000 pixels wide. When the document
zoom is 100%, that means that each pixel of the image is mapped to each screen pixel.

Optimizing Photos and Bitmaps

With the ever increasing resolution and file size of digital camera JPEGs, if you have a
document containing many images, the file size can quickly become very large. For
example, a multi-page document containing 20 full resolution JPEGs, each of 5mb,
would produce a .xar file of over 100mb*.

Furthermore, these photos are often unnecessarily high resolution. Reducing a photo
from a 8 megapixel digital camera to be 2 inches (5 cm) wide on the page will result in
this image being around 1500 dpi. Whilst a very high resolution image gives greater
flexibility for printing (and you can zoom in, or enlarge small parts of the photo), this is
far higher than required for even the best quality commercial printing, and even more so
for web graphics or HTML production.

If you clip to a small part of the image, or cut-out only a small part of your photos, there
could be large parts of hidden image outside the visible area. For editing purposes this
"live crop" is a great feature, as you can un-crop, alter the size, position and scale and
everything remains as sharp as possible. But for finished documents you may want to
remove the invisible parts.
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The cut-out butterfly image still has the rest of the photo attached. If you go into the FILL
TOOL you can easily see this by resizing the fill inside the outline. So the parts of the
image outside the butterfly will probably be superfluous in your final document.

Right click a photo and choose OPTIMIZE PHOTO or choose "UTILITIES" > "OPTIMIZE
PHOTO..".. This dialog performs three important functions:

e Removing invisible parts of photos
¢ Reducing resolution of photos
e Converting PNG or bitmaps to embedded JPEGs to optimize file size

Selecting this menu option for any bitmap will display the opTIMIZE PHOTO dialog.

Optimise photo(s)

h i more Il‘lh rmation.

( hjl’u]r- phl_lh_l resolution:

W pix H

OR ution: m ppi

Image format:

O JFEG Quality:

@® FNG Quality:

Optimize

By default the settings are such that the photo will be optimized to a 96dpi (normal
screen resolution) JPEG at the size that it appears on your page. This is normally what
you will want for photos in your website.

You can change the resolution used in this dialog, by either choosing the physical size
you want for the optimized image (width/height in pixels), or by entering a different dpi
(eg. perhaps 150dpi if you want print quality).

If you choose the dpi option the value you enter is remembered and becomes the
default just for the current session. You can also maintain the photo's current resolution
by choosing CURRENT from the PPI list.

You can also choose to optimize as a PNG (produces much larger images, but better
quality for graphics and text images) or change the quality used for JPEG optimization
(higher quality means larger JPEG sizes).

If your photo is cropped, only the visible part of the image is preserved in the optimized
image.
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For printing, a photo resolution of 150dpi gives very good results, whilst 300 dpi will
provide the highest quality commercial printing (most people cannot tell the difference
between 150dpi and 300dpi, but the 300dpi requires four times as much memory or file
space).

Note: The optimum JPEG quality is 75%.WE DO NOT recommend saving JPEGs with a
quality at 100% - they are virtually indistinguishable from JPEGs saved at 75%, but use
considerably more memory and file space.

Warning: "OPTIMIZE PHOTO" is a "destructive" operation. When you save the file the
parts of the image removed are lost, and the resolution changed permanently (you can
of course undo the changes while the file is open for editing).

You can optimize multiple photos at once if you want them to all have the same DPI.
Select the photos you want to optimize and then choose the oPTIMIZE operation as
described above. If your photos have different dimensions, the option to optimize by
pixel size is disabled and you must just choose the required dpi.

Or you can use the "UTILITIES" > "OPTIMIZE ALL JPEGS" facility to optimize all the JPEG
photos in your document in one operation. Again in this case the optimize dialog
appears so you can choose the dpi to be used for the optimizations.

Note that after optimizing the original unoptimized and now unreferenced photo remains
in the BITMAP GALLERY. This means it is still in memory and so the memory requirements
of your design will not have been reduced. Simply save your design and reload after
optimizing, to eliminate the original large images.

Photo Documents

Sometimes it's useful to work on one photo alone, rather than as "objects on a page".
This is called a photo document or "photo mode" in Web Designer, and it behaves more
like a traditional photo editor. You can create a photo document in a number of ways:

* Drag a photo file from your file explorer onto the title bar or toolbar of Web Designer
e Select "FILE" > "OPEN" and select a photo file
¢ Create a blank photo document by selecting "FILE" > "NEW" > "BLANK PHOTO"

Photo documents are characterized by the following behavior differences compared to
traditional Web Designer documents:

e There is no visible white page. In fact the page dimensions are set automatically to
match the photo plus any other objects you've added.

e Photo documents have a 1 pixel grid by default and snap to grid is turned on. This
makes it easier to get pixel-accurate crop or clip regions.

e The Pasteboard (the area around the photo) is a darker color. This makes it easy to
distinguish at a glance between photo documents and drawing documents.

e The document zoom is set so that the photo fills the view and the PHOTO TOOL is
automatically selected as the current tool.
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¢ Dropping additional photo files on top of an existing photo just adds a new photo to
the document instead of replacing the photo in its frame. And the view will zoom out
S0 you can see the whole image.

¢ Images are not resized to be 500 pixels on import as they are in normal documents,
but are imported at 1:1, so that at 100% zoom you're seeing the image at full size.

e The pixel smoothing options are altered. By default it selects the "Very high quality"
display mode, which is best for images scaled down or zoomed out. It also has pixel
smoothing turned off when zooming in, so you can see the pixels are very large zoom
factors.

o [f you've opened a JPEG photo file as a photo document, when you save changes
your JPEG file will be overwritten. See Editing Photo Files below for details.

In all other respects Photo Documents behave like normal Xara Web Designer 7
documents. You can use all the normal drawing and text tools as usual. If you want to
create a photo document of a given size, you can alter the "canvas" or page size by
selecting "UTILITIES" > "OPTIONS" and the "PAGE" tab and entering the required
dimensions.

In Photo Documents two extra controls become enabled. The PREVIOUS and NEXT button
will move onto the Previous or Next image in the folder from which this image was
opened. This will close the current image, so you may be prompted to save the file.

Editing Photo Files

You can use Xara Web Designer 7 to easily edit your JPEG photos and save back the
modified JPEG. And unlike with most photo editors, you can do this multiple times
without loss of quality, even though the JPEG format is a lossy format (see Lossless
versus Lossy earlier in this chapter). That's because Xara Web Designer 7 is able to
save your edits in a lossless way, along with the original photo. Here’s how it works.

First open the JPEG, using FILE->OPEN, drag and drop, or in Windows File Explorer right
click and choose Xara Web Designer 7 from the "open with" list. The photo is opened as
a Photo document.

Edit the photo using the photo tools as described above.

If you then do FILE->SAVE (Ctrl+S), the JPEG file you loaded will be overwritten with the
modified image. However Xara Web Designer 7 also saves your photo in its native .web
format. This file is placed into a "Masters" folder alongside your JPEG file. It has the
same name as your photo file but with a .web extension. The .web file includes within it
your original photo without the modifications applied, and of course details of your edits.

In future if you load the modified JPEG file in order to edit it further, Xara Web Designer
7 will look in the Masters folder to see if there is a .web file available for that photo. If so,
the .web file is loaded instead of the JPEG file and you can continue editing from where
you left off. When you next save, the JPEG file is again overwritten and an updated .web
file also saved into the Masters folder.
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Of course if you don’t want to overwrite your original JPEG file with your changes, you
can use FILE->SAVE AS, to save the modified photo elsewhere, or use the many export
facilities to export your photo into different formats.

You can get hold of the original photo from the .web file by opening it, opening the
BITMAP GALLERY, right clicking on the photo and choosing the SAVE option.
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Introduction

The Photo Tool provides a direct and very fast way of cropping, adjusting the brightness
levels and sharpening photos, even for ultra high-resolution images. This tool provides:

¢ One-click auto-enhance your photos; this is particularly good for dull, underexposed
images.

e Manually adjust the brightness, contrast, color saturation, photo color temperature
and blur or sharpness of photos.

e Crop images. This is "live crop" so you can un-crop and adjust the crop at any time.

¢ A single-click "Compare" function to quickly compare changes against the original.

e Easy copy / paste all photo enhance edits between different images.

All these operations are interactive with live update. As you adjust the values, the image
is updated instantly. They are also all non-destructive, meaning that your original image
is not altered and you can always adjust or remove any adjustment.

Photo Tool Benefits

There are three major benefits of this tool:

1. It's non destructive
2. It's very, very fast, even for huge images
3. Photo Edits require no memory.

Benefits explained in more detail

The non-destructive point means that all edits do not affect the original image. You can
adjust or remove the edits and the original image remains unaffected. This differs from
most photo editors where an alteration makes a permanent change to the pixels of the
photo. In Web Designer you can adjust the settings as many times as you like in the
sound knowledge that you are not altering the real actual original photo data.

Even the crop feature is non-destructive (which is why it's called clip). You you can
restore the cropped areas and adjust or enlarge the crop region at any time, even after
you've saved a file.

The speed point is self-evident, but a good demonstration of the speed is to rotate a
very high resolution photo. In other tools you usually have to enter a number of degrees,
and then wait for this to be processed. In Xara Web Designer 7 you can drag rotate a full
resolution image in real time (or enter any rotation value), and it uses high-quality bi-
cubic image sampling to ensure the highest quality results.

The no memory point refers to the fact most photo editors need to make a copy of a
bitmap in memory in order to provide an undo capability, and usually one copy each
time you adjust or edit. For large, hi-res digital photos this can mean very large amounts
of memory being required for your photo editing (a typical 8 mb digital photo requires 32
mb of memory; make ten edits and that's 320 mb of memory). Xara Web Designer 7
requires zero memory. You can make as many edits as you like and make as many
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copies of your photo in your document, and the additional RAM and file space required
by for this is zero.

Finally, JPEG images are embedded into the native .xar file, and not expanded into raw
images as they are in other graphics tools. This means a native file size typically 10
times smaller. Combine this with the zero memory copies, the real-time enhance
features described above and it's quite possible to have file sizes 30 times or more
smaller than with other graphics tools. And that means they are much, much quicker to
handle, save, process and transfer.

Using the Photo Tools

G To access the PHOTO TOOLS, move your mouse pointer over the Camera icon in
the main toolbar on the left of the window. A flyout bar appears with icons for
each of the available photo tools.

8 e

If you're in the Selector Tool a double click on a photo will switch into the PHOTO TOOL.

Common photo functions

The following buttons are available on the infoBar when you are in the ENHANCE or CLIP
photo tools.

aNrrar 25

Rotate by 90° controls

The two rotate icons will rotate the selected photo or photos by 90 degrees anti-
clockwise or clockwise.

Previous & Next

When you 'open' a photo using Xara Web Designer 7 the photo is loaded into a new
Photo Document, because Web Designer assumes you want to edit or view the photo
itself rather than use it as part of a drawing or other document. When you've opened a
photo you can use the 'Previous' and ‘Next' buttons on the PHOTO TooL infobar to close
the current photo document and open the next (or previous) photo in the same folder as
the current photo. This allows you to browse through the photos in a folder, without
having to open and close each one individually. If you've made any unsaved changes to
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the photo you'll be asked if you want to save the changes when you press previous or
next.

See Photo Handling for more information on Photo Documents.

Zoom 1:1
Select a photo and click the Zoom 1:1 button.
(B!

The zooMm TO 1:1 adjusts the zoom so that the selected image is shown at full size, which
is where each pixel of the image is mapped to each screen pixel. Use this option if you
want to work on a photo at full size in a document where you have scaled the photo
down.

Scale photo to 100%

The SCALE PHOTO TO 100% operation takes the currently selected photo and
LI scales it to its full size. It also puts the photo onto the pixel grid.

So for example if the selected photo is scaled down to 500 pixels wide, but the original
imported photo was 1000 pixels wide, the photo on the page will be scaled up to 1000
pixels wide. When the document zoom is 100%, that means that each pixel of the image
is mapped to each screen pixel.

Enhance Tool

) Click the Camera icon to enter the ENHANCE TOOL.

The Photo Tool provides a direct and very fast way of cropping, adjusting the brightness
levels and sharpening photos, even for ultra high-resolution images. This tool provides:

¢ One-click auto-enhance your photos; this is particularly good for dull, underexposed
images.

o Manually adjust the brightness, contrast, color saturation and blur or sharpness of
photos.

e Crop images. This is "live crop" so you can un-crop and adjust the crop at any time.

¢ Display a brightness levels histogram of your photo.

o Adjust the brightness levels curve for more advanced levels control.

o Correct color casts or white balance.

¢ A single-click "Compare" function to quickly compare changes against the original.

e Easy copy / paste all photo enhance edits between different images.

All these operations are interactive with live update. As you adjust the values, the image
is updated instantly. They are also all non-destructive, meaning that your original image
is not altered and you can always adjust or remove any adjustment.

There are three major benefits of this tool:

1. It's non destructive
2. It's very, very fast, even for huge images
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3. Photo Edits require no memory.

The non-destructive point means that all edits do not affect the original image. You can
adjust or remove the edits and the original image remains unaffected. This differs from
most photo editors where an alteration makes a permanent change to the pixels of the
photo. In Web Designer you can adjust the settings as many times as you like in the
sound knowledge that you are not altering the real actual original photo data.

Even the crop feature is non-destructive (which is why it's called clip). You you can
restore the cropped areas and adjust or enlarge the crop region at any time, even after
you've saved a file.

Enhance  Xf m v O m F o oes m ¥ == m v B m » " Compare

The first six InfoBar buttons to the left (not shown above) are common to all tools and are
described above

Auto-Enhance
Brightness

(V)

Contrast

Color Saturation
Color Temperature
Blur / Sharpen
Compare with original

0000

In this tool you can adjust brightness, contrast, saturation, temperature, and
blur/sharpen. You can either enter values directly into the text fields or use a small pop-
up slider for adjusting the values interactively.

Pop-up slider controls

The pop-up sliders can be used in one of two ways:

1. Click and release the pop-up arrow. The slider control now remains on screen and
you can adjust the values as many times as you like by dragging the slider control.
Alternatively, if the mouse is held over the control, the mouse-wheel can be used to
make small adjustments up or down. The slider will hide when you click anywhere
else in the document.

2. Oryou can click & hold the mouse button down, and drag over the slider bar to
adjust the value. When you release the mouse the pop-up vanishes. This is a
quicker more direct way, since it requires only one click & release to alter the
values.
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Auto Enhance

Clicking the "ENHANCE" button will analyze the overall brightness and contrast of the
picture and automatically adjust the enhance values to obtain the best image. It is
particularly effective with under-exposed (dark) images. After applying automatic
enhancement to a photo you can adjust the values that were chosen, using the controls
to the right of the "enhance" button. Clicking the "comMPARE" button will restore the
original, clicking it again restores the last enhance values.

Brightness/Contrast/Color Temperature/Saturation
Brightness Contrast - Saturation ﬁ Color Temperature

The image is altered as you adjust these values. The saturation alters the color intensity.
At the minimum setting of -100 this will make a picture black and white. The Color
Temperature control makes a picture more ‘warm’ or ‘cool’.

Blur/Sharpen

This control blurs images if it's taken below zero, and sharpens images above 0. For
sharpen it's recommended that only small values be used, and typically only on images
that have been reduced in size a lot. You can enter blur values larger than the -100
maximum value available on the slider. E.g. entering -400 will produce a very blurred
image.

Compare & Restoring the original

The cOMPARE button can be used to reset all the ENHANCE TOOL values back to their
defaults, returning your photo to its original state. Press the compare button a second
time, your previous values are reinstated. Therefore you can use the compare button to
quickly toggle between your edited photo and the original photo so you can see the
effects of the changes you've made.

Because all the enhance and levels alterations are non-destructive, pressing compare
simply removes the enhance attributes, so restoring the original image. The compare
button can be used at any time after an image has been altered.

Cropping or clipping images

The simplest way to clip a photo is just start dragging on or across the photo with the
ENHANCE TOOL selected. The clipping is performed instantly after releasing the mouse.
The resulting clipped photo has clip handles around it, where you can adjust the clip
borders afterwards.

S —k]
,\‘\"_. 7_\“!"
e
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This is a non-destructive operation meaning that you can both adjust the clip region after
you've copped the image and even un-crop to restore the whole image. A way to look at
the process is that it just adjusts the picture outlines, but the whole picture remains
clipped inside the rectangular outline. This is why it's called a clip, and not crop,
although it serves the same goal as a traditional CROP TOOL.

You can select different photos while using the photo tools by just clicking on them. This
also works for photos inside groups.

Clip Tool

Alternatively you can enter cLIP TOOL by selecting the Clip icon on the PHOTO TOOL fly-
out bar. This provides a range of addition crop options. You can enter exact pixel values,
and select from various crop aspect ratios

For interactive clipping and some more options regarding aspect ratio, enter the
CLIP TOOL with the cLIP TooL button.

This alters the InfoBar to look like this:

M 5.25¢cm 'I_D -

H [ ockaspect @32 @43 @169 O Curent

As you drag over the photo, the clip rectangle is highlighted.

¢ You can adjust the region by dragging on the corner or side handles

¢ You can push the region around by just dragging inside the clip region

e Select the cLIP button or just double click inside the clip region to perform the clip
operation.

You can tell whether a photo has been clipped or not from the status bar which will
describe it as a "clipped photo".
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Clear

Press the "CcLEAR" button, or just click outside the marked clip region to clear the current
clip rectangle.

Rule of Thirds

There's a photography guideline that helps the composition of many photographs called
the "rule of thirds". Put simply this involves placing key objects in your photos at thirds
across your picture. For example it's often better to position the horizon one third of the
way down a picture rather than being across the center. When you drag a clip region
across your photos lines are displayed at thirds across and down the image to help
position objects to follow these composition guidelines.

Tip: Search for "rule of thirds" on Google for more information.

Un-clip

Press the uN-cLIP button with any clipped photo selected, to restore the original photo.
This restores the clip rectangle, which you can adjust or clear by clicking outside it.

The uN-cLIP button in the cLip TooL will change the outline of any clipped photo, and
also arbitrarily formed shapes with a bitmap fill, to that rectangular outline of the
complete photo or bitmap used as the fill. You may have to select the Clear button to
clear the crop rectangle (or click outside the rectangle).

Adjusting the clip region

Because the un-clip button restores the clip rectangle (showing the area outside faded),
you can easily make fine adjustments to a clipped photo. Just select the photo, press
the Un-clip button and adjust the sides of the clip rectangle as required. Double click
inside the photo to clip it again.

Width / Height

After drawing a clip rectangle, you can enter values directly into the width and height
fields on the InfoBar to set the clip rectangle dimensions to exact values.

Lock Aspect

Select the "LocK ASPECT" check-box to constrain the clip rectangle to a specific aspect
ratio as you drag. The radio buttons to the right of the check-box determine the aspect
ratio used. Select "CURRENT" to maintain the aspect ratio to that of the photo before the
clip. Note that the clip rectangle automatically changes between landscape and portrait
orientation as you drag a corner of the rectangle. So if you drag sideways it tends to
create a clip in landscape orientation. If you drag downwards more, then it will create a
clip region in portrait orientation.

The common preset crop aspect ratios are available of 4:3 (most consumer digital
cameras and old-style TVs and monitors), 3:2 (that of traditional film cameras and higher
end SLR digital cameras), and 16:9 (aspect ratio of widescreen TVs).

You can override the lock-aspect option by using "Ctrl" while dragging. So if you're
dragging out a clip rectangle (or adjusting one) without aspect ratio lock, then holding
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"Ctrl" will lock the aspect to the last selected aspect ratio. Similarly if you have lock
aspect option on then "Ctrl" will temporarily un-lock the aspect ratio.

Clipping in Photo Documents

In photo mode, there is a one-pixel grid applied to the photo (when at 96dpi, the default
resolution) and the clip rectangle snaps to this grid. This makes it very easy to get pixel

exact clipping. For highly accurate or exact pixel snapping, it's recommended to operate
in photo mode and to zoom in so you can see the pixels clearly.

See Photo documents (on page 237) for more information.

Photo Tool Notes

1. You can select different photos while using the PHOTO TOOLS by just clicking on
them. This also works for photos inside groups.

2. Ifyou click and drag, while in the ENHANCE TOOL, it will start a crop on the photo
that you started dragging on. Or, if you start dragging on the background, the crop
will be applied to the first photo you touch during the drag.

3. The uN-cLIP button in the cLiP TooL will change the outline of any clipped photo,
and also arbitrarily formed shapes with a bitmap fill, to that rectangular outline of
the complete photo or bitmap used as the fill. You may have to select the Clear
button to clear the crop rectangle (or click outside the rectangle).

4.  All photo operations can be fully undone. Unlike traditional photo or pixel editors,
the original photo is never altered. So this means you can make as many changes
as you like, as often as you like, and save and load .xar/.web files as often as you
like, and there is no degradation of the image (all edit operations are non-
destructive and loss-less) and give no increase in file size.

5. All the PHOTO TOOL options, including the levels control, operate on bitmap filled
objects, as well as stand-alone photos.

6. Opening a photo with Xara Web Designer 7 (using "FILE" > "OPEN") opens it as a
Photo Document. After editing it, you can overwrite your photo file by just doing a
"FILE" > "SAVE" ("Ctrl + S"). A .web or .xar file is also saved into a Masters folder
alongside your modified photo, preserving your original photo and edits. See the
Photo Handling chapter (on page 218) for more details.
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Navigation Bars

Most websites have a navigation bar, either horizontal or vertical, from which all the
important pages of the site can be accessed.

ome

Xara Web Designer 7 includes special support for navigation bars (known as Navbars
for short), making it easy to add, edit and delete buttons. The buttons in a Navbar can
adjust their widths to match their labels automatically and they are repositioned
automatically after any changes you make. You can even add dropdown menus and
sub-menus to your bar and opt to have buttons automatically added and deleted as you
add and delete pages.

Advanced users can create their own bars from button designs of their own, and modify
the button designs used in an existing Navbar and have the new design applied across
the whole bar.

Using template Navbars

You can create Navbars yourself from any button design, but most users will simply use
the many template Navbars available in the DESIGNS GALLERY. If you want to create
your own, see the section describing how to do that later in this chapter.

All the Navbar designs in the gallery are associated with a particular theme, and are
carefully designed so that they fit nicely into the page designs of that theme. Therefore
most websites can be built without ever adding a Navbar manually — they are already
built into the page templates of each theme. However every theme also provides its
Navbars as standalone elements, so you can add one to your web page by simply
dragging it from the gallery and dropping it onto your page.

Changing the colors of a template Navbar is done the same way as changing the color
of the other elements of a theme — by applying a new color scheme from the DESIGNS
GALLERY, or by editing the named theme colors on the Color Line. See the Getting
Started chapter for details on this.
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Navigation bar properties dialog

The best way to edit the labels, links and other attributes of a Navbar, and to add or
remove buttons, is to use the Navigation Bar properties dialog. Double click on a bar to
bring up the dialog, or right click on it and choose ‘EDIT NAVIGATION BAR’ from the context
menu.

Navigation Bar Properties

Orientation Justification
O Horizontal @ Vertical O Left (grows to the right) @ Centre @ Right (grows to the left)

Settings
[ Adjust button widths to labels [ Keep all button widths the same Button spacing:

M Site navigation bar {automatically links to all pages and appears on all pages in site)

Buttons and menus
Button and menu Tooltip
+ Home wiww, xara,comflinkf

Products wiww, xara,comflinkS
Store wiww, xara,comflinkf
News wiww , xara,comflinkf
- Gallery wiww, xara.comflinkf
Contact wiww, xara, com/linkS
- blog wiww, xara.com/flinkf
- About wiww , xara, comflinkf
{Double-Click To Add Button)

Menu style. ..

Ungroup K Cancel Help

The upper half of the dialog allows you to set various properties of the Navbar. The
lower half allows you to add and remove buttons and menus and to edit the labels and
links of each button and menu entry.

This is a modal dialog, meaning that you can’t interact with the canvas while the dialog
is on screen. However all the changes you make in the dialog are immediately reflected
in your Navbar on the canvas, so you can see the result straight away. The changes you
make in each dialog session are confirmed when you click ok, or they are undone if you
click CANCEL.

Orientation

Choose whether you want your Navbar to be horizontal or vertical. For vertical Navbars
you will normally want to make all buttons the same width (the width of the widest
button), so you get a rectangular bar. See the "ADJUST ALL BUTTONS TO WIDEST LABEL"
option below, which controls this.
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Justification

Choose how you want your bar to behave when its length changes as you edit labels
and add/remove buttons. A LEFT JUSTIFIED horizontal bar will grow to the right as you
add more buttons or make the button labels longer. And the left edge of the bar stays in
the same place on the page. Similarly a RIGHT JUSTIFIED bar keeps its right edge in the
same place and grows to the left. And a CENTER JUSTIFIED bar grows to left and right
equally. Choose the centered option if, for example, you want a horizontal Navbar
centered at the top of your page.

For vertical bars, the justification options change to Top, Center and Bottom. As for
horizontal bars, the setting determines whether the bar grows upwards (Bottom),
downwards (Top), or both (center) when buttons are added.

Adjust button widths to labels

Turn this option on if you want your buttons to be stretchy, so they grow and shrink as
required to fit in the label text applied to the button. With this option off, your buttons will
remain the same size and so a label that’s too long for the button will extend beyond the
edges of the button.

All buttons the same width

This option is enabled only if the above ‘Adjust button widths to labels’ option is on.

Select this option to make all your buttons the width of the widest button in the bar. For
vertical Navbars this is almost always desirable so that you get a rectangular bar. For
horizontal bars it often makes the bar look neater with each button the same size, but it
requires more space and so you may not be able to fit as many buttons into your bar
with this option turned on.

Button spacing

Here you can choose to have some space between each button in your horizontal
Navbar, if you don’t want each button to sit right up against its neighbor. Simply enter
the number of pixels of space you would like and see the result on the canvas
immediately. Sometimes you may want to make this value negative so that there is a
small overlap between your buttons. This is useful if your button design is such that you
see an undesirable join line between the buttons when there is 0 spacing.

Site navigation bar

This is a very important option on the NAVBAR DIALOG, Which turns on automatic linking
so that buttons and links are added to your bar for you, as you add pages. And all
changes you make to the bar are reflected on every page of the site as soon as you
close the Navbar dialog.

Normally you have this option on only if you want your Navbar to appear on all pages of
your website. However you can manually delete the bar from pages if desired.

Wwww.Xara.com



Navigation Bars

251

Moving and transforming a site navigation bar

If you move a site navigation bar on the page, the bar is also moved on all the other
pages on which it appears. Similarly if you scale the bar to make it larger or smaller
using the SELECTOR TOOL, again the same transformation is applied to the copy of the
bar on the other pages. No other transformations of a Navbar using the SELECTOR TOOL
are supported (rotation, skew, scaling in one dimension).

Automatic page linking

Whenever you add a new page to your site, a link to that page will be added to your site
navigation bar for you and the new page will be given a copy of the bar, if it doesn’t
already have one. If your bar has an unused button on it, then the first such button will
be linked to your new page. If all buttons are already linked, a new button is
automatically added to the end of your bar and it is linked to the new page. In either
case, the label of the button is changed to match the name of the new page, if it has a
name, or to "New page" otherwise. Normally you will want to immediately edit this new
label in the Navbar dialog.

When you delete a page from your website, the button linking to it on your site
navigation bar is automatically deleted for you, on all pages of your site.

Turning site navigation bars on and off

When you turn the site navigation option on or off in the Navbar dialog, the change is
reflected in all copies of that bar on all pages of your website.

Deleting a site navigation bar from a page

If you don’t want the site navigation bar on a particular page of your site, you can simply
click on it to select it on that page and hit "Delete". You'll be asked whether you want to
delete the bar from just that page, or from all pages.

However after removing the bar from one or more pages, note that if you subsequently
turn off the site navigation bar option (perhaps in order to edit the button design, which
can’t be done with the option on), and then later turn it back on again, the bar will be
added automatically to all the pages of your site that don’t have it.

Templates & Site navigation bars

All the single page templates in the DESIGNS GALLERY have their Navbars set to be site
navigation bars when you load them from the gallery to start a new website document.
This means you can rapidly build a small website with all pages linked to the bar, without
having to add buttons and page links manually. Similarly all website templates have site
navigation bars turned on. If you don’t want this behavior, simply turn off the site
navigation bar option on the NAVBAR DIALOG.

The standalone Navbars presented with each theme in the gallery do not have site
navigation turned on by default. This is because any user adding bars manually is less
likely to want that bar on every page of their site, with a link to every page. But again,
the option can easily be turned on in the Navbar dialog if required.
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Other points to note

If you delete a button which points to one of your pages, or change the link on it to point
elsewhere, no special action is taken to restore a button link to the page. It's assumed
you decided that you didn’t want a direct link to that page in your site navigation bar.
New buttons and page links are only created when a page is added.

Buttons & Menus

Edit the button labels, links and other button attributes using the table and tree controls
in the lower half of the NAVBAR DIALOG. Each row in the table corresponds to a button in
the bar, or to an entry in a menu under one of the buttons.

Buttons and menus

Button and menu Tooltip

Home

About

Products

Store

News

Gallery

Contact

Blog

(Double-Click To Add Button)

DN B W -

+
+
+
+
+
+
+
+

Adding & editing buttons

To add a button, double click in the first column where it says "Double-Click To Add
Button". A new row is added below the row for the last button. Or click the ADD button at
the bottom of the dialog to add a button following the selected button. You can
immediately start editing the label for the new button. Press return to complete the label
edit, or click away from the label.

You can edit any button label by first clicking the appropriate row to select it and then
clicking again in the first column to start editing the label.

To set the link on a button, double click on the URL field, or if the row is already selected
you can just single click on it. The WEB PROPERTIES LINK DIALOG appears. This should
look familiar as it's the same Link dialog (on page 197) that you use for adding other
links to your page, so you have the same link options available. A few options are
disabled because they are not applicable to Navbar and menu links, such as the pop-up
photo option which only works when applied to a photo.

You can also set the tooltip text for each button using the 3rd column. Edit the text the
same way as you edited the label text. In the exported web site the text entered appears
as a small pop-up tooltip when the mouse pointer is held over your button or menu
entry.
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Adding menus and sub-menus

In the first (label) column, you’ll notice that there is a plus icon '# to the left of each label.
This is a tree control and clicking the plus icon next to a button label, expands that
button node, allowing you to add a menu to that button.

Click on the DOUBLE-CLICK TO ADD MENU ITEM text below the button to start adding a
menu. Or click the ADD button at the bottom of the dialog to add a menu item below the
selected item. A new row appears in the table for each menu entry you add. You set the
label, link and tooltip for each menu entry the same way you do for buttons. And you can
add sub-menus to any menu the same way — by first expanding the menu entry node of
the tree.

Buttons and menus

Button and menu

Page: 1
& it Dmg- 2
-)- Products Page: 3
| [+ Televisions (No URL set)
+-DVD Players (No URL set)
(No URL set)
& Page: 4
- News Page: 5
+- Gallery Page: 6
+1- Contact Page: 7

Menu separators

You can add a separator into your menu by clicking the ADD SEPARATOR button at the
bottom of the dialog. The separator is added following the currently selected menu item.
Separators allow you to visually group together related items in your menu.
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Menu Styles

Click on the MENU STYLE... button to bring up the MENU STYLE DIALOG. This allows you to
change how the menus appear and behave on your Navbar.

Menu style

Font: Spadng

M Bold Border (px):
Font size: Animation: Instant v
Direction: Transparency (%):
Horizontal offset:

Colours

Menu background: Edit

Menu text: Edit

Menu background (over): Edit

Menu text (over): Edit

Border: Edit

Cancel

Font

Choose a font to be used for the text on your menus. Only the web safe fonts are listed,
which are the fonts that all visitors to your site should have. There is also an option to
make the font bold and you can change the font size used.

NOTE: This doesn’t change the font used for the button labels of your bar, only the font
used on menus. To change the button label font, see the section about this later in this
chapter.

Direction

Choose the direction in which your menus should open. For horizontal Navbars you'll
normally want this to be downwards and for vertical bars either left or right depending on
where on the page your bar is located.

Spacing
With this setting you can add space between the entries in your menu, spreading them
out and making the menu larger as a result.

Border
Add a border to the panes of your menus by entering a border width in pixels.

www.Xara.com



Navigation Bars

255

Animation
By default menus will open instantly, but here you can choose to have the menu
animating as it opens.

Transparency

You can choose to have your menus semi-transparent, so that your page can be seen
through the menu panes. Enter the level of transparency you would like as a
percentage.

Horizontal offset / Vertical offset
You can offset the menu panes horizontally or vertically from the buttons. Just enter the
number of pixels of offset required.

Updating your Navbar across all pages

As described above, if you have the SITE NAVIGATION BAR option turned on for a Navbar
then all changes that you make to the bar on one page are automatically applied to all
the other pages too, including the location of the bar on the page.

However if you don’t have that option turned on, set the navigation bar object to be a
repeating object (right click and choose REPEAT ON ALL PAGES) that appears on every
page and all changes you make to any instance of the object automatically update on all
pages. See the Object Handling chapter for more information on repeating objects.

On canvas editing

You can edit your button labels directly on the canvas using the TEXT TOOL. Just
go into the TEXT TooL and click in the label text to start editing it.

If the text object is a repeating object (right click and choose REPEAT ON ALL PAGES) all
changes you make to one instance of the object automatically update across all
instances.

Changing the font on Navbar buttons

You can change the font used for the button labels on a Navbar easily. Select the bar by
clicking on it. Then go into the TEXT ToOL and select from the font list on the left of the
TEXT TOOL INFOBAR. As you move the mouse pointer over the different fonts in the list,
the Navbar updates immediately so you can see how that font would look. Select the
required font. If your bar has a mouseover state, it is also updated to use the same font.

Similarly you can change the size of the font using the font size control which is next to
the font selection list.
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Importing & pasting Navbars

If you import or paste a Navbar into your document, the site navigation option on that
Navbar is turned off automatically, if it was on. This is to avoid any conflicts with any
existing site navigation bar in your document.

However if the incoming bar is of the same theme and type as the existing site
navigation bar in your site (i.e., are part of the same repeating group), it will immediately
be updated to match that existing site navigation bar. Hence in this case the bar will not
appear on your page in its original form.

If the bar is of a different theme or type (ie., are not part of the same repeating group), it
will appear unmodified.

Creating your own Navigation Bars

You can create a Navbar from any button design. The DESIGNS GALLERY contains many
different button designs, or you can draw your own. See the ,Creating your own
Mouseover Buttons (on page 63)" section of the Getting Started chapter for information
on how to do this.The button may or may not include a mouseover state.

To create a Navbar, select the button and then select "ARRANGE" > "CREATE NAVIGATION
BAR". The NAVIGATION BAR DIALOG appears and you can immediately add more buttons
to your bar, just as for other Navbars.

You can also create Navbars with more than one button design (so you can have
different designs for the first and/or last button in the bar). See the section below, which
describes how to do that.

Button design restrictions

There are some rules you must follow when creating your own buttons for use in
Navbars.

Stretchy button limitations

In order to get reliable results when your buttons are automatically stretched you are
advised to make sure that there are no path control points or graduated fill/transparency
control points in the horizontal area occupied by the button label text object.

Text in a button

Each state of the button design must be a group object containing a text object that can
serve as the button label. This text object should be a simple text object, not a text
column or text area. That is, it should be created in the TEXT TOOL by clicking on the
page and typing, not by first dragging a text line or text box.

Soft grouping button states

If there are several states in your button, e.g., mouseoff and mouseover, they need to be
soft grouped together, so that they stay together when one state is moved or otherwise
transformed.
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Button margins

In this section we refer to the ,margins" as being the spaces between the button label
and the ends of the button. For stretchy buttons (those with the ,Adjust button widths to
labels" option switched on) this is determined by the master button from which you
create the Navbar. By adjusting the margins on the master button, you set the margins
for the other buttons in the bar, which are based on it.

The easiest way to change the margin on the first button is as follows:

1. Open the NAVBAR DIALOG
Turn off the ADJUST BUTTON WIDTHS TO LABELS option, so buttons don’t stretch as
label text is changed.

3. Change the label on the master button (the first button unless you have multiple
button designs in your Navbar — see later section). Choose any dummy label text
which is the appropriate length to give you the margins you want on the master
button.

4. Turn the ADJUST BUTTON WIDTHS TO LABELS option back on again. All buttons get
the same margins you set for the master button.

5. Set the master button label text back to what it should be.

Button Text 1 Button Text 2 Button Text 3 Button Text 4

Original bar

Button Text 2 | Button Text 3 | Button Text 4

Bar with a modified smaller margin

Button Text 2 Button Text 3 Button Text 4

Bar with a modified larger margin

If your Navbar has different designs for the start/end (see below for how to achieve that),
then the start and end designs have their own margins that can be controlled separately.

Advanced - Editing a Navbar button design

However your Navbar was created, you can modify the button design it uses. For a
Navbar where all buttons are the same design, the very first button in the bar is used as
the master button from which all the other buttons are copied. Therefore by modifying
the first button design, you modify the design for the whole bar.

Editing inside

For some bars you can do some editing of the button design directly on the first button,
using select inside. This allows you to select shapes inside the button group. See the
information about the SELECTOR TOOL in the Object Handling chapter for details of select
inside.
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However you cannot do select inside editing, if either of the following options are turned
on in the Navbar dialog.

e SITE NAVIGATION BAR
e ADJUST BUTTON WIDTHS TO LABELS

If either of these options are turned on and you attempt a select inside, you'll be
prompted and given the option of opening the Navbar dialog so that you can turn off
these options and then try again.

With the options off, you can use select inside and modify the shapes that make up your
button using the usual drawing tools.

IMPORTANT: Remember that the first button in your bar is the master button for your
bar (unless you have different start and end buttons — see below). So you must modify
the first button. Then your changes to the first button are immediately applied to the
other buttons in your bar. If you modify a button other than the master, the changes will
not be applied and will be lost as soon as you modify your bar.

Ungrouping, editing and regrouping

If you want to do any significant editing of a button design, it's best to ungroup the
components that make up the Navbar and then regroup them again afterwards.

To ungroup your bar, select the Navbar by clicking on it on the canvas and then do a
normal ungroup operation ("ARRANGE" > "UNGROUP" or "Ctrl + U"). Or click the UNGROUP
TO EDIT GRAPHICS button at the bottom of the Navbar dialog.

Note: If your Navbar had the "Site navigation bar" option turned on, you’ll need to turn
that option back on again if required, after regrouping your modified bar.

Once your bar is ungrouped, it is no longer a navigation bar. You are left with a separate
button group for each button state. Also, if the "ALL BUTTONS THE SAME WIDTH" option
was turned on, ungrouping might change the button widths because this option is only
effective while the buttons are part of a Navbar. Although you should only make the
design changes to the master button(s), you’ll normally want to leave all the other
buttons on the page. They are used when you regroup your Navbar, to recover all your
button labels, links, etc., so that you don’t have to re-enter them again.

If you have a mouseover state, the 2 groups that make up the master button will be ,soft
grouped"” so that they stay together when you drag them around the page. Separate
them using "ARRANGE" > "REMOVE SOFT GROUP" ("Ctrl + Alt + U"). You can then further
ungroup each button state on the MouseOff and MouseOver layers ("Ctrl + U"), in order
to work on their respective designs. See the "Creating your own Mouseover Buttons"
section of the Getting Started chapter (on page 63) for information on how to make
buttons.

Remember to regroup each of the button states and then put the soft group back to

keep the two button states together once you’re done editing. Do this by making sure
both layers are turned on in the PAGE & LAYER GALLERY (on page 270), select both button
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state groups and then "ARRANGE" > "APPLY SOFT GROUP". See the Object Handling
chapter for more information on soft groups (on page 117, on page 50).

I's a good idea to test your button works as expected by previewing your page, before
re-assembling the bar. To put your bar back together, select the modified button and
choose "ARRANGE" > "CREATE NAVIGATION BAR".

Navbars with different first or last buttons

Sometimes you may want a bar which has different first and last buttons. For example,
perhaps a bar with rounded ends but with rectangular buttons in the middle.

Home Products Store News Gallery Contact Blog About

Navbars like this need 2 (if just one end should look different) or 3 (if both ends should
look different) button designs. Position the button designs in order from left to right as
you would like them to appear in a horizontal Navbar. Or from top to bottom as you
would like them to appear in a vertical bar. Then select all 3 button designs (along with
their mouseover states if they have them) and choose "ARRANGE" > "CREATE NAVIGATION
BAR".

When you create a bar from more than one button like this, Xara Web Designer 7 needs
to know how you would like those buttons to be used in the bar. Therefore a dialog is
displayed, asking you to choose from a range of options.

V¥ Create Navigation Bar

You are creating a NavBar from more than one button group. Please specify whether the
same design should be used for all buttons or whether the designs of the start and end
buttons differ.

O All buttons the same
Design of 1st button is replicated for all buttons. D D D

@ First button different
Design of 2nd button is replicated for all other buttons. G D D

@ Last button different
Design of 1st button is replicated for all other buttons. D D D

All buttons the same: Choose this option if you want all the buttons in your bar to be the
design of the first button you selected. This is the most common type of Navbar.

FIRST BUTTON DIFFERENT: If the first button is to be of a different design to the rest of the
buttons in the bar, choose this option.
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LAST BUTTON DIFFERENT: If the last button is to be a different design to the rest of the
buttons in the bar, choose this option. An example where this is necessary is a bar
which shows a divider between each button in the bar. All but the last button would need
the divider to appear on the right of the button design.

Home| Gallery| Support| About Us | Contact

The last button in this example is different, it has no divider at the right border

FIRST AND LAST BUTTON DIFFERENT: This option allows you to specify different button
designs for the first and last buttons, to give your bar end caps. Of course you must
have selected at least 3 buttons for this option to be valid.

Home Products Store News Gallery Contact Blog About
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Website Widgets

This chapter describes how to add dynamic content to your website, such as movies,
animations, forms and thousands of the available gadgets such as page counters and
currency converters. We refer to these using the general term of "website widgets", or
just "widgets" for short.

Xara Web Designer Beginner's Guide
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Widgets & placeholders — it’s all automatic!

In Xara Web Designer 7 a widget is any object you can place on your web page that
displays some sort of dynamic content, that may also be interactive. That content may
be sourced from an external website (e.g., a news feed widget) or may be published
with the website (e.g., a slideshow widget cycling through a selection of photos). On the
Web Designer canvas, a widget is represented by a static ‘placeholder’ image that
defines the position and dimensions of the widget on the page. And attached to that
placeholder is the HTML code and files (e.g., Flash, Javascript, photos, etc.) that make
the widget function in the exported page.

A placeholder is normally an image that looks like a static snapshot of the widget itself,
but it can be a simple rectangle or any other object. The placeholder usually has the
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same dimensions as the widget, so that you can sensibly position it with respect to other
content on your page.

The good news is that placeholder images are normally rendered automatically for you
by Web Designer.

Types of Widget

There are basically three types of widget, which differ in the way that you customize and
configure them in Xara Web Designer 7. A brief description of each type follows, but
more detail about each type is provided later in this chapter. However for all three types
of widget you can simply double click on the placeholder image to edit them.

Web Editable Widgets

When you customize these widgets, a web browser window opens up onto the remote
website that provides the widget and you configure and customize the widget using that
web interface.

Locally Editable Widgets

These widgets are edited in Web Designer itself, but typically in a separate multi-page
document that makes the whole set of content for the widget easily editable. For
example, for a slide show widget that cycles through 10 photos, all 10 photos would be
easily visible and editable within the widget's multi-page document that's used to edit it.
Again, usually you'll insert these widgets from the DESIGNS GALLERY.

Manually Editable Widgets

These are widgets that you add manually by either pasting the HTML code for the
widget directly into Web Designer or by using the "UTILITIES" > "WEB PROPERTIES" >
"PLACEHOLDER" tab to insert the code. Or you create them by importing a file such as an
animation file or movie file onto your page.

No other interface is provided by Web Designer for editing the widget, other than the
PLACEHOLDER tab that allows you to change the file or code that defines the widget.

Widgets from the Designs Gallery

The easiest way to add widgets to your site is to choose from the selection provided in
the DESIGNS GALLERY. Look under the "Widgets, Forms & More (Download)" category
near the top of the gallery. The widgets in the gallery are automatically updated from
time to time, so that Xara can add, modify or delete the selection of widgets available to
you at any time. You will sometimes see the DESIGNS GALLERY update when you first
open it or when you first open a category folder.

To add a widget, just drag and drop it from the gallery onto your page. What happens
next depends on the type of widget. If it's a Web Editable Widget, a browser window will
open to allow you to configure the widget on the widget provider’s website. If it's a
Locally Editable Widget, a placeholder image will appear on your page. Double click on
the placeholder and a new document opens within Web Designer, which allows you to
customize the widget.
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Web Editable Widgets

When you drop one of these widgets onto your page from the DESIGNS GALLERY, a
window opens which is actually an Internet Explorer browser running inside Web
Designer. This is similar to the preview window shown when you click the preview page
and preview website buttons on the web toolbar. However this widget window has some
additional buttons at the bottom — more about those later.

B Create new widget: Google Gadgets o [0
GO ( )gle Add this gadget to your webpage % Link to this page

This is a preview of what the gadget would look like on your page. If parts of the gadget appear cut off,
try increasing the width and/or height. More about this gadget

m

UP_subject

«'nm“ World Business Poltics Science " » 4
Egypt protesters step up pressure

Tens of thousands gather in central Cairo for a
seventh day of protest against President Hosni
Mubarak, calling for a general strike

75! 1o pay higher tax rat

Three-quarters of a million more people are setto
become higher rate taxpayers in April, says the
Institute for Fiscal Studies

m

Bond composer Barry dies aged 77
Oscar-winning composer John Barry, famous for his
work on Born Free, Midnight Cowboy and the James
Bond films, dies in New York aged 77.

Cameron defends NHS overhaul plan

David Cameron defends the coalition’s plans to
overhaul the NHS in England, as MPs prepare to vote
on the bill

Yeates murder accused is remanded

A 32-year-old man accused of murdering landscape
architect Jo Yeates appears in court via a video link. -

Insert Cancel Help

Example widget insertion window, showing Google News gadget.

The browser window opens onto the website of the widget provider. Here you can find
out more about the widget if required, provide any data the widget requires and in most
cases also customize its appearance. Usually the widget website will also show you a
preview of what your widget will look like, complete with any customizations you've
applied.

Inserting

Press the HELP button at the bottom of the window to see some information to guide you
through the process of configuring the widget and inserting it on your page. For most
widgets, you need to get to the point where the widget website offers you the HTML
code that needs to be inserted into your web page. As soon as this is visible, you can
normally click the Insert button at the bottom of the window. Xara Web Designer 7 will
then find the HTML code and will insert it into your page for you.

For some widgets, Xara Web Designer 7 is unable to retrieve the HTML code from the
site directly and you need to first copy the code to the clipboard. Select the code in the
browser window and press Ctrl+C. Many widgets make this easy for you by providing a
copy button next to the code. Once you’ve copied the code, click the INSERT button.
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Automatic placeholder generation

When you press the Insert button, if Xara Web Designer 7 found the widget code the
widget website window is closed and you will see an indication that Xara Web Designer
7 is busy rendering a placeholder image. After a few seconds an image of your widget
appears on your page. For most widgets this is exactly the same size as the widget
itself, so you can position it where you like using the SELECTOR TOOL.

Now all you have to do is preview your web page and you should see your new widget
working on your page!

Widget site membership

Some widgets may require you to open an account with the widget provider, before you
can use them. Most are free, but some offer premium services over and above the free
offering. See each individual widget and the information on the widget provider’s site for
details.

Editing existing widgets

At any time you can double click the widget placeholder (or right click and choose EDIT
WIDGET) in your Web Designer's page to return to the widget provider’s website so you
can easily modify or replace the widget.

Those widget providers who give you an account, will normally also keep a copy of any
widgets you’ve created. This means you can sign into your account while going through
the insertion process above and then find, modify and insert a widget that you've
created previously. Inserting existing widgets is just like inserting newly created widgets
— just click INSERT when you are offered the HTML code, or copy the HTML code for the
widget to the clipboard and then click INSERT.

Locally Editable Widgets

Some widgets that you drop onto your page from the DESIGNS GALLERY won’t open a
browser window as described above for Web Editable Widgets. These are Locally
Editable Widgets that you edit directly in Web Designer using a separate document
window.

Editing

After dropping such a widget on your page, double click on it to edit. A new document
window opens in Web Designer (the widget’'s "editing document"). What that document
window shows will depend on the specific widget, but typically you'll see a multi-page
document that allows you to conveniently edit and customize all the content for the
widget.

Normally there will be some specific instructions shown to the side of or above the first
page, describing what aspects of the widget you can edit in the document and any
aspects that are not editable. In most cases, you can edit the text you see using the
TEXT TOOL, but you can’t normally change the font or style of the text. You can replace
photos by dropping new photo files onto the images from Windows Explorer, just as you
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replace photos in normal documents. And you can edit the photos using the PHOTO
TooL, adjust photos using the FILL TOOL, etc.

Look at each page in turn and customize the text and photos. Some objects may be
locked (clicking on them does nothing) which tells you that you can’t edit that aspect of
the widget, or perhaps it should be modified by changing unlocked objects on one of the
other pages. Any locked objects are present as a visual aid, to help make the context of
the unlocked editable parts of the design clear.

Adding more content

Some widgets will allow you to add more content to the widget by duplicating the pages
shown (right click on the page and choose DUPLICATE CURRENT PAGE). A slide show
widget may allow you to add more photos to it this way. After duplicating a page, change
its photos or text as required. The instructions in the widget will tell you whether or not
you can duplicate pages in this way to add content.

If you make any changes that the instructions say should not be made, usually those
changes will be ignored. However you may cause a widget to malfunction so please
change only the aspects of the design that the instructions say can be modified.

Resizing

Locally Editable Widgets are not normally resizable, so don’t change the size of the
placeholder object on your page, nor the page dimensions in the widget's editing
document.

Saving changes

When you've finished customizing, close the document and you'll be asked whether or
not you want to save the changes you've made back to your website document.
Alternatively, just hit "Ctrl + S" and the changes you've made will be saved and the
editing document closed, returning you to your website document.

The placeholder image that represents your widget should update, so that it reflects the
first page of the editing document. Preview your page to see the effects of your changes
on the working widget.

Adding movie & animation files

Xara Web Designer 7 includes direct support for some types of file that you are likely to
want to add to your website. For these files you can simply drag and drop them from
Windows Explorer onto your page, or use "FILE" > "IMPORT".

On import the file type is identified, an appropriate placeholder or link is added to your
page, and the file is copied into the support folder for your design. The support folder is
a folder which lives alongside your design file and is created automatically. If your
design file is called ,MySite.web", its support folder is ,MySite_web_files". The contents
of this folder are included along with all the image files for your site, whenever the site is
exported and published.
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MP4 & FLV movie files

Import an MP4 or FLV file and Xara Web Designer 7 inspects the file to determine the
aspect ratio and other information about the movie. It then inserts the movie file, and
some other files for a Flash movie player, into the support folder of your website. A
placeholder image resembling the movie player appears on your page.

Position and resize the placeholder using the SELECTOR ToOL, and then preview your
page. Click on the movie player play button to start the movie (you need to have Flash
installed). That's it! The movie player includes basic controls for adjusting volume,
starting & stopping and for jumping to any point in the movie.

Other movie formats

Xara Web Designer 7 doesn’t support other movie formats directly, but visit this web
page http://rdir.magix.net/?page=H1Q9XX0777AR on the MAGIX website for
information on how to easily convert movies into a format that can be added to your web

page.

Flash files

To include a Flash animation on your website, import the Flash (.swf) file. The Flash file
is copied into the support folder of your design, so it will be exported and published with
your website. And a placeholder image is rendered and placed onto your page.

You can resize Flash animations, so simply use the SELECTOR TOOL to resize the
placeholder image to the required size, and position it by dragging it around.

Preview your page to see your working Flash animation on your web page. Obviously
you must have Flash installed in order for it to play successfully.

Animated GIFs

Add an animated GIF to your page just the same way as for Flash files. Import or drag
and drop the GIF file onto your page. It gets copied to your design’s support folder and a
static placeholder image is generated for it. Resize and position the placeholder, then
preview your page and you’re done!

PDF Files

You can import PDF files into a web document in two different ways. Either import it so
that the contents of the file are copied onto your page (as when importing a photo). Or
you can link to a copy of the file in your website and have the file published with your
site. When importing a PDF file a prompt is shown to let you choose between these two
options.

When adding a link, the PDF file is copied into the support folder of your design, so it's

exported and published with the rest of your site. And a link is added which looks like
this on the page:

FOF '
A
Miuh:
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Clicking the link on your exported page normally opens the PDF file, but the exact
behavior varies depending on the user’s browser settings.

Widgets from other widget sites

There are hundreds or thousands of sites offering widgets of some form or another and
the DESIGNS GALLERY offers only a tiny subset of what is available on the web. Just
about all widgets are provided to you in the form of a small piece of HTML code. The
widget provider will normally give you some simple instructions on how to insert the
code into your web page, but with Xara Web Designer 7 it really is very simple.

Copy the code from the widget provider to your system clipboard, just as you copy text
in a word processor. Sometimes the widget provider may even provide a ‘copy’ button
which copies the code for you.

Then in Xara Web Designer 7 go into the SELECTOR TooL and then do a normal paste
operation (Ctrl+V). You'll see that Xara Web Designer 7 recognizes the HTML code and
immediately starts to render a placeholder image, just as it does when inserting a widget
from the DESIGNS GALLERY. The placeholder appears on your page, usually with the
most appropriate size for the widget. You can then preview your page to see your
working widget!

You can also paste widget code into both the head and body of your page using the
Placeholder tab (on page 213) of the Web Properties dialog.

NOTE: If you are in the TEXT TOOL when you paste the code, it will be pasted as text
instead of producing a placeholder! And once you’ve pasted the contents of the
clipboard as text once, it will continue to paste as text even if you switch to the SELECTOR
TooL and paste again. If you get into this position, return to the widget website and copy
the code again. Then do the paste while in the SELECTOR TOOL.

Resizing widgets

You can resize the placeholder images for Flash, MP4 movies and animated GIFs to
similarly resize the content as it appears on your page, because this type of content is
scalable. But most other widgets don’t support this and will always render the same size.

For these widgets the placeholder object merely determines the bounds of the area in
which the widget can render, so making the placeholder too small for the widget will
mean that the widget gets cropped in your web page. The placeholder image gets
regenerated whenever you resize it, so it will reflect any cropping of the widget too, as
shown in this example.

Buy Now Buy Nc
:.nsa‘e:._-“: P aca P
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Placeholder with default size Placeholder with reduced size

This is an example of the PayPal e-commerce ‘Buy Now’ button which enables you to
sell goods or services from your website. This Widget is one available from the DESIGNS
GALLERY.

Similarly making the placeholder larger for such widgets will merely result in empty
space around the widget, on the page and in the placeholder image. For widgets like
these which don't resize correctly when you resize the placeholder, it's best to stick with
the original default size.

There are some widgets which can be improved by resizing the placeholder, even if the
widget itself doesn’t scale. Some widgets will fill the container into which they are
inserted, which may mean they come out much bigger than required, with blank areas
filling the space. You can experiment by resizing the placeholder for such widgets in
each direction and this may make the widget smaller without losing the key parts of the
widget.

For example this Form widget has rendered much too wide and tall and so there is
wasted space below and to the right of the form controls. Resizing it down doesn’t
change the size of the form controls, it just results in the form being cropped. The result
is @ much neater form placeholder taking up much less space on the page.

Placeholder with default size Placeholder made narrower and shorter

Turning off placeholder re-generation

The placeholder image will be regenerated whenever you resize it or change the code or
file it's attached to. Sometimes you may want to turn off that regeneration so that the
placeholder image won’t change again. You can do this by deselecting the checkbox at
the bottom of the PLACEHOLDER TAB in the "UTILITIES" > "WEB PROPERTIES DIALOG".

Adding widget placeholders manually

If you don’t want Xara Web Designer 7 to create a placeholder image automatically, you
can set one up yourself. First create a placeholder object (perhaps a rectangle of the
appropriate size or an imported image that you want to use to represent the widget on
your page). Select the object and then open the Placeholder tab in the "uTILITIES" >
"WEB PROPERTIES".
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Or press the placeholder button on the Web properties flyout bar on the top bar.

In this dialog you can choose to associate the selected object with a Flash file or other
file, or with HTML code that the dialog allows you to paste into the head or body of the
web page. See the PLACEHOLDER TAB section of the Web Properties Dialog (on page
211) chapter for details on this dialog.

Normally you don’t want to select the "Re-generate placeholder" option if you want to
keep the placeholder object you've created yourself. Selecting the option will cause your
placeholder to be replaced with an image generated from the code or file you have
specified in this dialog.

More Information

See the website at http://www.xara.com/widgets for more information on widgets. And of
course, keep an eye on the DESIGNS GALLERY, which is regularly updated with new
widgets.
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Page & Layer Gallery

The Page & Layer Gallery

Note to users of older versions of this software: This replaces the LAYER GALLERY

By default the Page & Layer Gallery is displayed open on the right hand side of the Web
Designer window when you open or create a new document. If you prefer, you can
unpin, move, dock or close the gallery - see Galleries (on page 88) for more information.

If you have previously closed the PAGE & LAYER GALLERY, which is open by
default, you can reopen it by clicking the PAGE & LAYER GALLERY tab on the
Galleries bar, or press F10.
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The Page & Layer Gallery lists every page and all the layers in each page. It provides a
way to select, hide, lock and re-arrange layers.

It can work at two different levels. At the top level it can list only the PAGES, and provides
a direct and easy way to re-arrange the order of these (by dragging), to name, copy and
delete pages.

At the next level down it can show all the LAYERS on each page - and you can similarly
re-arrange the stacking order, rename as well as lock and hide any layer.

The hierarchy of items is like this:

Pages
Layers
...etc

Some of the key features of the PAGE & LAYER Gallery include:

Page control

¢ Displays a list of pages

New page mode displays a narrow list of page thumbnails for easy page navigation
Add new page, duplicate or delete pages

Re-arrange the page order by dragging

Rename pages
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Layer control

o Displays a list of all layers on each page, from the bottom (usually background layer)
to the top most layer

Create new layers, delete, re-order and rename layers

Hide or show layers

Lock layers (which makes the layer non-editable)

Solo a layer - turn all other layers off

In addition the PAGE & LAYER Gallery shows a thumbnail of each page.

Page & Layer Gallery
New page Duplicate
Delete Help...

o - e
Haoam@Et'mw
SUEERE
5 gallery

The Page & Layer Gallery in collapsed 'Pages' mode, showing 5 pages of a web document.
Page 4 called 'News' is the selected page.
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New layer Properties... Pages Locate

Duplicate Delete Layers More...
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Page background

The News page has been expanded, by clicking on its small right facing arrow, to show all the
layers on this page.

The bottom layer 'Page background' is locked. The layer called MouseOff is the active or
current layer, that is where all new objects will appear. The top 5 layers are hidden (closed
eye icon), so only the MouseOff and Page background layers are visible in the document.

Note the right two columns indicate (and control) whether the layers are editable (a pale
arrow) or locked (padlock icon) and whether they are visible on the page (pale open eye icon)
or hidden (darker closed icon).

Clicking on these icons will change the visibility and / or the locked or editable nature of each
object.
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Pages

Clicking the PAGES button on the top of the PAGE & LAYER GALLERY (or right clicking in the
gallery and choosing sHOw PAGE LEVEL) will display only the pages in the document,
collapsing the layer level.

You can re-order pages by dragging on the item in the Page & Layer Gallery, or by right
clicking a page and choosing MOVE PAGE UP/DOWN.

You can rename a page right clicking it and choosing RENAME PAGE. As well as being a
useful way to identify pages in long documents, the page name is used when exporting
your document as a website. For this reason in web documents it's not possible to use
certain characters or symbol characters in the name (they are not accepted as web
page names).

The NEW PAGE, DUPLICATE and DELETE buttons will do as they imply. Note that you must
first have selected a page (click on it so it's highlighted in blue as shown above) in order
for these buttons to work on pages. (If you had selected a layer, for example, then they

would operate at the layer level).

Alternatively you can right click a page and choose the options NEW PAGE, DUPLICATE
CURRENT PAGE and DELETE CURRENT PAGE.

The NEW PAGE option will create a blank page the same size as the selected, current
page.

' You can expand (open) the page to show the layers of the page by either clicking on
the small right facing arrow, or by double-clicking on the page thumbnail.
Performing the same operation again will collapse (close) the page view.

Layers

What are layers? Everything in your document has a stacking order - that is new items
are placed on top of older items on the page, in exactly the same way as if you were
adding bits of paper onto your desktop. You can click to select and move any object, but
with more complex documents that have dozens, maybe hundreds or thousands of
items, your work area can be become cluttered and difficult to organize. You might want
to work on items hidden by others on top.

Layers are a useful way of organizing more complex pages or drawings that contain
many separate parts. Using layers you can group a collection of items together and then
turn the whole collection on or off (make it visible or hidden) in one easy operation. You
can think of a layer like a transparent plastic folder holding a stack of separate papers.
By opening the folder you can access its contents, and re-arrange the contents. But your
desk may have a stack of such folders, and just as you can also re-arrange the folders,
you can similarly re-arrange the layers.
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So layers are groups of items. Layers can be made invisible, to hide parts of your
document, which makes your work areas less cluttered and easier to manage. You can
give layers names, and you can easily create new layers or delete them. And just as you
can click the small arrow icon to open a page and view its contents (the layers on the
page), you can do the same to each layer to view the contents of that layer.

When you select any object, the layer it's on is shown on the status line at the bottom of
the window.

The steps within a presentation document are actually just different layers within the
document. Presentation layers, however, are named presentation steps. You are given
the option to convert layers into presentation steps when you convert a web document
into a presentation. To turn a layer into a presentation step, click the PRESENTATION
LAYER checkbox in the Web transition tab of the Layer Properties (on page 277) dialog.
The layer is renamed ‘presentation step N', which retains the layer stacking order.

The Current Layer

When you create any new object on the page, it's placed in one of the layers, called the
active layer or simply the current layer. On a blank document this will either just be
called Layer 1 or, in the case of web documents, it's called MouseOff. The current layer

is shown with a selection arrow R .

Important: All new drawn items, shapes, photos, text, and all pasted items, are placed
on the current layer marked with the k symbol.
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You can change the current layer simply by clicking on its row in the Page & Layer
Gallery. It's important to understand that you can have a selected object on any layer or
even multiple layers, and these need not be the current layer. The current layer, with the
arrow, only indicates where new items will be placed.

Page & Layer Gallery

New |ayer Properties... Pages
Duplicate Delete Layers

= Holiday photo 4 -

= Holiday photo 3 -

= Holiday photo 2

= Holiday photo 1 -
-
©

= MouseOver
= MouseOff RB=
= Page background

This example Page & Layer Gallery shows the current layer is called MouseOff (the current
page is called news). So if you draw anything new it will be placed on the MouseOff layer.

Four layers are hidden (called Holiday photo 4, Holiday photo 3, Holiday photo 1 and
MouseOver). The 'Page background' layer is locked.

Make the current layer always visible

It's possible that the current layer can be hidden or even locked. Just clicking on a layer
to select it and make it the current layer does not normally change its visible or locked
state. But there is a preference in the General (on page 296) tab of the Options dialog
(right click a page and choose PAGE OPTIONS or choose OPTIONS from the UTILITIES
menu) to make the current layers always visible and editable (unlocked). If you select
this option then whenever you select any layer in the Page & Layer Gallery it's made
visible and unlocked. Moving to another layer will restore the previous visible and locked
state of the layer you just moved from.

Layers on websites

In websites saved from Web Designer, layers are used for mouseover or pop-up effects
(in the web browser the contents of these layers are displayed when you move over
items on the page).

You can find more details on this in the Getting Started chapter in the Layers,
Mouseover (Rollover) & Pop-ups (on page 61) section.
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Soft Groups and Layers

Soft Groups (on page 117, on page 50) are unusual because they are groups of objects
that can span different layers. (Normal groups have to be contained within one layer).
When you select any part of a soft group the other parts are also selected, even if they
are on hidden or locked layers.

Layer Operations

Clicking the LAYERS button on the top of the PAGE & LAYER GALLERY will display only the
layers on the current page. This is a mode - the layers button stays depressed. While in
layers mode, as you move to different pages the layers for the current page are always
shown and all other page nodes are collapsed. Click the LAYERS button again to turn off
layers mode.

You can re-order the layers, that is the stacking order on the page, by using drag and
drop on the layers in the PAGE & LAYER GALLERY.

You can rename a layer by performing a second (slow) click on the layer name. (The
first click would select the layer.) This is very like file renaming in Windows Explorer.

Holding the mouse pointer over the small layer icons £ will show a thumbnail of the
contents of the layer.

When you have selected a layer (clicked on it, to highlight the layer) the NEw, DUPLICATE
and DELETE buttons on the top of the PAGE & LAYER GALLERY will do as they imply. The
NEW button will create a new blank layer and place it at the top of the stack. You can re-
arrange the order by dragging it to the required position.

The pupPLICATE button will copy the layer and its contents and place it on top of the stack
- that is on top of all other objects on the page.
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Layer Properties

This opens the Layer Properties dialog.

o Layer properties

Layer  Guides

Layer

BEI Holiday photo 4

Visible Editable
B Background layer (will not print)

M Text repelling within layer only

Cancel

Creating layers and editing layer properties

Using the Layer tab you can:

Create a new layer or edit an existing one.

Make the layer editable and visible by default.

Define the layer as a web page background that will not appear when printed.
Specify that all objects in the layer will only repel text objects (on page 165) within the
same layer. This prevents text on the layer being repelled by objects in other layers
and is useful for popup layers in web pages.

Using guidelines

The Guides tab allows you to create layer guidelines at precise numeric values and
choose a color for guide layer objects.

See the GUIDE OBJECTS & GUIDELINES section in Object handling (on page 114) for more
information on using guidelines.

Special Layers

There are several special types of layer. They appear in the Page & Layer Gallery and
can be turned on and off as usual, but behave slightly differently.

www.Xara.com



278

Page & Layer Gallery

BACKGROUND LAYERS are non-printing layers that appear at the bottom of the document,
under everything else. When you apply a color to the page background (drag and drop
color from the color line) this will create a PAGE BACKGROUND layer automatically.
Normally this is locked.

When saving a document as a website, Background layers are converted to web page
backgrounds. See the Getting Started (on page 19) chapter for more details on setting
web page backgrounds and using the background layers.

The GUIDES LAYER is where guidelines or guide objects are placed. When you create a
guideline this automatically creates a Guides layer. You can select the Guides layer and
place anything you like on this layer - and it will act like a snapping guide (if you have
'snap to guide' on).

See Guide Objects and Guidelines in the Object Handling chapter to find out more!

Hiding Layers

The rightmost two columns of icons in the PAGE & LAYER GALLERY control the visibility
and locking of layers.

Clicking on the open eye @ icon will hide the layer on the page, and the icon will turn to
a closed eye ® . Clicking again will revert the layer to be visible.

When any item is hidden, it becomes invisible on the page and can no longer be seen or
selected. The way to get hidden items back is to click its closed eye * icon.
Alternatively you can click the MORE... button and select sHow ALL option, which un-
hides all items on the current page.

Solo Mode

If you click any of the E icons in the column next to each layer, it will 'solo’ this layer
which means it hides everything else, except this layer. You can now work on this layer
in isolation. Clicking the E putton again will restore everything back to how it was
before.

You can also click and drag down the column of H icons to quickly browse through the
layers in isolation from everything else.

To exit the Solo mode, either click the EJ button again or the larger E button on top of
the Gallery.

Locking Layers

Clicking the open padlock icon a on the right end of a layer row will lock the layer (icon

N .
changes to a closed padlock ). Now you cannot select any object on that layer. Any
clicks on locked items will go straight through it, as if it's not there, and select items
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underneath. Clicking the padlock icon will unlock that layer again. Alternatively you can
click the MORE.. button and select the UNLOCK ALL option.

Soft Groups

There is one exception to the locked rules. If an item on a locked layer is part of a Soft
Group (on page 117, on page 50), then selecting and operating on that Soft Group will
also select and operate on any locked items in that Soft Group (this is the intended
operation of Soft Groups).

Show All & Unlock All

(]
o i

These two controls on the top of the Page & Layer Gallery are a short-cut to show all
items on the current page or unlock all items. They are a temporary override of all the
individual layer settings. Clicking the controls again will restore the previous state. So
this is a quick way of showing or unlocking everything, on all layers, performing some
operation, and then restoring the previous state.

When either button is selected (the buttons are shown pressed in), then it's not possible
to change the state of individual items. Un-select the buttons to enable the normal
operation of the layer visibility and locking state.

Clicking the MORE button will display menu options to SHOW ALL ON PAGE and UNLOCK
ALL ON PAGE.

These are similar to the above, but they are not a toggle option. So selecting either
option will turn all layers on or unlock all layers, and there is no easy way to restore the
previous state - other than individually re-selecting the hidden or locked state of all the
separate items.

Moving Objects Between Layers

There are several ways to move objects between layers. First select the object or
objects you want to move, then;

e cuT the object (Ctrl+X or right click and cuT). Ensure the target layer is the current

layer (shown with k , click the layer if it's not) and then right click and choose PASTE or
PASTE IN PLACE. Note that if you cut or copy multiple items that are on different layers,
the layer structure is preserved when you paste. ltems are pasted to the same layer
they were copied/cut from, instead of being pasted to the current layer. If you want to
paste all such items to the current layer, ignoring the layer structure, use the PASTE IN
CURRENT LAYER option instead. If you want to retain layer structure, choose PASTE IN
PLACE IN CURRENT LAYER. These paste options are also in the clipboard fly-out bar on
the top bar, as well as the EDIT menu.

¢ Right click and choose ARRANGE then MOVE TO LAYER IN FRONT / MOVE TO LAYER
BEHIND to shift the selected objects one layer up or down.
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e Ensure the target layer is selected as current, then find the selected item in the PAGE
& LAYER GALLERY (click the LOCATE button), right click and select MOVE TO CURRENT
LAYER.
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General notes on exporting and importing

Web Designer offers a wide range of import and export options.
Firstly, it is important to note the distinction between saving and exporting files:

e SAVING deals with storing your work so that you can open it and work on it at a later
date. Xara Web Designer 7 saves your work in the .web file format. Think of this as
the "master document” format.

e EXPORTING deals with converting to other supported formats. Exporting allows you to
use and distribute your designs.

Recommended formats

The universal export formats, that can be read by the widest range of programs and
used on the web are the bitmap formats, GIF, PNG and JPEG. These are also
guaranteed to look exactly as you see on screen in Xara Web Designer 7. PNG is
recommended for web graphics and JPEG for photos.

Import and Export Supported File Formats

You can change the order of supported import and export file formats in the FILE >
EXPORT and FILE > IMPORT dialogs by editing the FileFormats.xml file found in the
program folder where you installed Web Designer.

Import formats

It is important that you use the three letter file extensions listed below when you load
files into Xara Web Designer 7.
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Bitmap Import Formats

.BMP Windows Bitmap

.CUT Halo CUT (256 color)

.DCM Digital Imaging and Communications in Medicine (DICOM) image format
.DCX DCX

.FAX Fax image from a fax received or created with fax software

.GIF Graphics Interchange Format

.ICO Microsoft Windows Icon (16 color)

JPG JPEG

.MXB MAGIX Bitmap

.PBM UNIX monochrome

.PCD PhotoCD

.PCT PICT

.PCX PCX Paintbrush

.PDF (see importing a PDF file)

.PGM UNIX grayscale

.PNG PNG

.PPM UNIX color (up to 24 bit)

.PSD Photoshop (see importing and exporting PSD files (on page 287))

.RAS Sun Raster

.SGI Silicon Graphics Image

.TGA TrueVision TARGA

.TIF TIFF (RGB, RGBA with alpha-channel transparency & CMYK).

Xara Web Designer 7 supports: fax TIFF files (black and white images. Multi-page faxes
will be imported as multiple pages); Mac or PC byte order TIFF files; TIFF with layers
and transparency (if saved from Photoshop the rules for blend mode compatibility are
the same as for PSD files); JPEG in TIFF (transparency is not possible in this case).
XBM X Windows (2 color)

XPM X Windows (256 color)

WBMP Wireless Bitmap Image. Black and white (1-bit) bitmap image format used by
mobile devices.

EPS Import Formats

(Al lllustrator EPS

.EPS ArtWorks

.EPS lllustrator EPS

.EPS CorelDRAW 3 & 4 EPS

.EPS FreeHand 3.0 EPS

.EPS Photoshop EPS (For importing data from Photoshop into Xara Web Designer 7,
use PSD files instead of EPS files for best results).

.EPS Xara
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Other Import Formats

.ACO Adobe Color Swatch

.ACT Adobe Color Table

ART Xara Studio

\WEB Xara Webster files

.AFF Acorn Draw

.CDR CorelDRAW (3,4 & 5)

.CDT CorelDRAW Template

.CMX Corel CMX 5 & 6

.CPL CorelDraw Palette

.DRW Acorn Draw

.GIF GIF Placeholder

.HTM, .HTML Graphics on HTML pages
\WMF Windows Metafile (16bit)

.EMF/ WMF Enhanced Windows Metafile
.FLV FLV Placeholder

.MP4 MP4 Placeholder

.PAI MAGIX Photo Clinic Image

.PAL CorelDraw, Windows and PaintShopPro palettes
.PDF PDF Placeholder

.RTF Text

.SWF Flash Placeholder

XWR Widget Placeholder

\WIX For internal use by Xara

Export formats

Bitmap Export Formats (see GIF, PNG and JPEG export dialog overview (on page 288))

.GIF CompuServe GIF

JPG JPEG

.PSD Photoshop (see importing and exporting PSD files (on page 287))
.PNG PNG

Other Export Formats

.EMF/WMF Enhanced Windows Metafile
.HTML, .HTM (Web pages and websites)
.RTF Rich Text Format
WEB, WIX, .XAR Xara

Importing files
To import a file:

e Select "FILE" > "IMPORT" - This normally merges the file's contents into the existing
document. With some formats you get the choice of importing the document into the
current page or adding it as a new page. With some other formats you are given the
option of either importing the file data conventionally, or adding a link to the file and
including it in your published website.

e Or select "FILE" > "OPEN" - This opens the file as a new document.

www.Xara.com



284

Importing and Exporting

Xara Web Designer 7 supports drag and drop import of files. If you drag a file from your
File Explorer onto an open Xara Web Designer 7 document it will import the file and
place it on the current page, centered on the drop point. Or drag & drop a suitable file
from Windows Explorer onto any bar or the title bar of Web Designer's window - it will
open the file as a new document.

Replacing Image Files

You can replace any loaded image or image-filled shape with your own images. To
replace an image simply drag your own file (JPEG, GIF, PNG, BMP) from your Windows
File Explorer and drop it on top of the picture that you want to replace. Your photo will
automatically be scaled appropriately to replace the existing photo. The new photo will
be selected and you'll be put into the FILL ToOL (on page 177) so that you can easily
adjust the position and scale of your photo if desired. You can also replace multiple
images using multiple image files with some web templates, in one operation.

See the "Replacing photos” section of the Photo Handling chapter for more details.

Importing a Photoshop PSD file

To import a PSD file, import the file as normal with File > Import, or just drag and drop
the .psd file into Xara Web Designer 7.

The layers in the PSD file, and the layer visibility setting will be preserved and will
become Xara Web Designer 7 layers. You can view them by opening the PAGE & LAYER
GALLERY.

Tip: if you have separate objects in Photoshop that you wish to be able to move and
change independently of one another in Xara Web Designer 7, place them on separate
layers in Photoshop before exporting.

PDF Import

PDF is a complex vector graphics format that has evolved over 10 years or more and
contains numerous sub-formats and options. PDF was designed as a portable document
format for viewing and printing only, and was not intended as a file format for
transferring data between applications. However Xara Web Designer 7 should load the
vast majority of PDF files.

PDF is now the recommended way of transferring vector files from Adobe lllustrator to
Xara Web Designer 7. Save as PDF and then import the resulting file into Xara Web
Designer 7.

The following points are worth noting:

e Multi-page PDF files are imported as multi-page documents in Xara Web Designer 7.
e Text in PDF files is typically broken into many separate small text objects in the PDF
file. This doesn’t stop it viewing and printing, but means when imported what might
appear as one or more continuous paragraphs of text is not. Xara Web Designer 7
tries to re-assemble the lines of text into lines and paragraphs of editable text, but

often you will find the text broken into separate text objects.
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¢ In order to make it easier to extract just the text of a PDF file, a new layer is created
containing just the text on that PDF page. Use the PAGE & LAYER GALLERY to view this
layer.

What might not work:

e Many PDF files include embedded fonts. It's not possible to legally extract and install
these fonts onto your system. So if you do not already have the fonts used in the PDF
file you will find alternative fonts have been substituted.

¢ Files that are encrypted or password protected cannot be imported.

¢ Any text in PDF files that use embedded subset fonts will not be readable or editable.

PDF is a highly complex format, and often can't be imported perfectly. The best way to
import it may depend on how you intend to use it. The "OPTIMISE FOR VIEWING" option
attempts to make the imported result look as similar to Acrobat as possible, but it may
be more difficult to edit (it could have many nested clipviews for example). The
alternative “OPTIMISE FOR EDITING" option strips out some constructs which are difficult to
manually edit (for example, nested clipviews).

RAW photo import

You can import RAW digital camera files, either by using the Import menu option or just
drag & drop the file onto the Web Designer window.

Supported file extensions include: *.crw, *.cr2, *.rw2, *.nef,*.mrw,*raf,*.kdc,*.orf,
*.dng, *.ptx, *.pef, *.anw, *.x3f

However there are many different extensions used for RAW files by different camera
manufacturers, so if you have a RAW file with a file extension not listed above it's worth
trying to import it anyway.

Importing images from a website

You can import graphics directly from web pages on the Internet into your document.
Notice the difference between this menu option, which loads all the graphics from a web
page, and Import, which loads a single graphic from disk.

To import from a web page:
1. Choose "FILE" > "IMPORT GRAPHICS FROM WEB" (or "Ctrl + Alt + W").
Type in the web address (URL) of the page or graphic you want to import. If the

URL is a page, all the images on that page will be imported.
3.  Click IMPORT.

Exporting files

To export a file:

¢ Right click and choose EXPORT
¢ Or select "FILE" > "EXPORT".
e Or press "Ctrl + Shift + E".
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An EXPORT dialog box will appear. Choose a name for your file, and select the required
format from the SAVE As TYPE dropdown list. Some of the supported formats are detailed
below.

Exporting as Windows metafiles (.wmf)

Files in this format can be read by Word and several other programs.

Exporting as Extended Metafile Format (EMF)

Modern Windows applications support this enhanced type of vector graphic format. This
format is also available to applications that provide a Paste Special menu option.

Note that Xara Web Designer 7 can contain features, such as advanced fill styles, that
cannot be represented in vector formats such as EMF. In this case parts of the image
will be exported as bitmaps. Those vector parts that can be exported as vectors are
exported as vectors.

Quick export of HTML and web graphics formats

You can use the dedicated options in the FILE MENU to quickly export web pages and
web graphics, without selecting the formats from the full list of available export formats
shown when you use "FILE" > "EXPORT".

e "FILE" > "EXPORT WEBSITE": Export the current website document to a location of your
choice on your computer.

e "FILE > "EXPORT JPEG": Export the current selection, or current page, to a JPEG file.

e "FILE" > "EXPORT PNG": Export the current selection, or current page, to a PNG file.

For more information, see the Getting Started chapter.

Exporting as a bitmap

JPEG, GIF and PNG are universal formats supported by most modern computer
applications. PNG is the highest quality. JPEG is better suited to photographic work, but
can produce acceptable, compact files (you can control the quality and file size).

GIF format only supports 256 colors, and although common on many websites, PNG is
a better format. PNG also supports semi-transparent graphics (use the True Color +
Alpha option), but this is not correctly supported by older Microsoft Internet Explorer
versions (it is by all other web browsers).

The fewer colors you have in a file, the smaller the file and the lower the quality.
However, when using 256 colors or less Xara Web Designer 7 provides very advanced
techniques to simulate a much wider range of colors, and so you can get very high, near
photographic quality results using only 256 colors or less.

See also GIF, PNG, BMP and JPEG export dialog overview (on page 288).

Important

Bitmaps are output at the current view quality so for best results make sure that
"WINDOW -> QUALITY" set to VERY HIGH QUALITY.
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Exporting a Photoshop PSD file

Photoshop is a bitmap editor, so when exporting to PSD format all the vector objects in
Xara Web Designer 7 are rasterized. You can select the resolution (dpi) when exporting.

Always save your work in Xara Web Designer 7 prior to exporting. Then, if you wish to
alter your original objects in the future, just load Xara Web Designer 7, make any
changes and then export the required objects again.

To export as a PSD file choose "FILE" > "EXPORT" then select ADOBE PHOTOSHOP in the
SAVE AS TYPE list.

Layers

Layers in Xara Web Designer 7 are retained when exporting to PSD format. Each layer
is rasterized as a separate PSD layer, including layer names. Layers visibility is also
passed through, so layers set to invisible in Xara Web Designer 7 will be exported and
set to invisible in Photoshop. You can turn the layers on and off in Photoshop using the
LAYERS palette.

Text

You can export text from Xara Web Designer 7 to be editable text in Photoshop, but the
text must be on a layer on its own (on import you may be asked to update the text
objects for them to be editable in Photoshop.)

Text that is on a layer with any other graphic objects will be rasterized into that layer,
and thus not be editable.

Export DPI
You will be able to set the DPI of the bitmaps in the exported PSD file.

€ . /| ADPI of 96 is th | Wind
PSD Export Settings o170 IS the norma A Indows

screen resolution, and so exporting at
96dpi will appear in Photoshop at the
same size at 100% as it does at
100% in Xara Web Designer 7.

Resolution in DP: | g5 =

(#) Export just wisible objects
() Export whole page area

[ 0Ok [ Cancel

For print work you should choose a higher DPI.

You can select to export the whole Xara Web Designer 7 page area or just the areas of
the visible objects only.

Summary

In order to get maximum compatibility and editability in Photoshop:
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e For the parts of your drawing that you want to remain separate layers in Photoshop,
place them on separate layers in Xara Web Designer 7.

¢ If you want your text to be editable in Photoshop, place it on a layer of its own, with no
other graphic objects.

JPEG, PNG and GIF export dialog overview

——— ' Eidiiep Lot The Export settings dialog has two
- P s P preview windows, IMAGE A on the left
and IMAGE B on the right, so you can
compare alternative export settings
or file types, side-by-side. Just click
on the left or right preview window to
change the active preview.

I&J_L—.v 135 plsad:, 2400

7752 b Above the preview window is a small
dropdown that lets you select from
the most common three export
types, JPEG, PNG, and GIF.

B Put HTML Image Tag On Clipboard

When you have selected preview A or B you can then adjust a wide range of export
options using the five tabs below the preview. Some options, such as the Palette
Options are only applicable to some file types such as PNG and not relevant to JPEG

type.

Other options under the oPTIONS tab change depending on the file type. e.g. when
exporting a JPEG this is where you can set the required quality.

So the process for exporting an image:

1. Select the object or objects on the page you want to export

2. Select the Export menu, or "Ctrl + Shift + E", enter a file name, and select file type
from the drop down list. The main export type will display the above preview dialog.

3. In this Preview dialog adjust the settings if you want, or skip this if you're happy
with the default settings

4. Click the EXPORT button

For most commonly used JPEG and PNG formats, at step 2 you can instead use the
direct operations available in the FILE MENU: EXPORT JPEG and EXPORT PNG. The export
dialog shown includes a “Settings” button which takes you to the export settings dialog
shown above.

Most export settings are remembered for the next time you export. For example if you
adjust the JPEG quality, the next time you export a JPEG it will remember the last
quality setting.

Exported Image Size

When you export the normal default size is the same as you see on screen at 100%
zoom. The pixel size is shown under the preview window. You can adjust the pixel
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dimensions either by adjusting the object size on the page before you export, or by
entering alternative pixel or dpi values in the BITMAP SIZE tab.

Preview Controls

These buttons alter the preview of the images, but do not affect the exported file:

e zoom TooL: Click on a preview to zoom in. Shift-click to zoom out. Drag
over an area of the preview to zoom into that area.

e PUSH TooL: Lets you drag the image around in the preview window.

e ZOOM TO FIT: Scales the preview image to fit the window.

e ZOOM TO 100%: Scales the image to full-size (100%).

e ZOOM TO RESOLUTION OF IMAGE (1:1): Has no effect for GIFs. Scales the

image so one pixel in the bitmap is one pixel on screen. This is useful for
previewing detail in the bitmap.

The following tool is only relevant to files using less than 256 colors (but you will see the
result when you have the PALETTE OPTIONS tab selected):

COLOR SELECTOR: Moving the pointer over the image highlights the color under
the pointer. Click to select that color in the palette. You can then use PALETTE
OPTIONS buttons (described below) to alter that color.

PREVIEW: The preview button is available on all tabs of this dialog. It updates the preview
windows to reflect any changes you have made to the export options.

Palette Options tab

This tab allows you to alter the color settings of your exported image.

Dithering & Palette

The DITHERING and PALETTE options only apply when you export with 256 color or less,
and affect how the image is displayed and its color palette. It is recommended to always
use an OPTIMIZED PALETTE. Set DITHER to none, which produces smaller files but may be
banded, or ERROR DIFFUSION, which creates higher quality results, but larger files.

Color Depth

Choose the number of colors your bitmap requires. The more colors, the larger the file
(usually), and the higher the quality. The TRUE COLOR option supports up to 16 millions
colors. TRUE COLOR + ALPHA includes semi-transparent features such as soft shadows
and transparency. For applications that support alpha-channel PNG files this is the
recommended format.

If you choose 256 colors of less, you have the option to use simple transparency (Wine

glass icon-see below). This doesn't support semi-transparent pixels, only "on/off" fully
opaque or fully transparency pixels, and so can produce jagged edges.
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Max Colors

If you select a Color Depth of 256 or less you can control exactly how many colors are
used in the file. This provides a high degree of control over quality vs. file size. Just
enter the required number of colors and press the PREVIEW button to preview.

Buttons

These buttons (except TRANSPARENT BACKGROUND) apply when exporting 256 color
images or less. These files are created with a limited palette of colors, and these
controls provide a great degree of control over those palette colors. See COLOR
SELECTOR above on how to select a color, or click on a color in the COLOR PALETTE).

E Lock a Color

You can specify the number of colors you want in the palette of exported bitmaps. You
may want to ensure that certain colors always appear in the palette; you can lock these
colors. Click on a color to select it, then select the Lock button. A small square appears
in the bottom left of the color to tell you it is a locked color.

Make a Palette Color Web Safe

When clicked this button will shift the selected color to be one of the 216 common web
browser palette colors. This is a legacy system that is no longer particularly important or
relevant, as nearly all computers can display millions of colors, and there's no benefit in
restricting web graphics to only this limited palette.

Make the Image Background Transparent

Make any areas not covered by the selected objects transparent. Selecting this option
automatically makes one entry in the palette transparent.

Make a Palette Color Transparent

Make this color entry transparent. Note the difference between this option, which makes
parts of the selected objects transparent, and Make The Image Background
Transparent which makes those areas behind the selected objects transparent.

Delete a Palette Color

Delete this color from the palette. Any areas in the bitmap that use the deleted color
then use the nearest color in the palette. The fewer colors in the palette, the smaller the
bitmap file.

Restore a Previously Deleted Color

Undelete a deleted color.

Wwww.Xara.com



Importing and Exporting

291

Add system colors

Adds 28 colors to the palette. These colors are the regular Windows system colors and
a number of primary colors. This ensures the palette includes a spread of colors and
may improve the quality of the image, particularly if it contains a wide range of colors.
You may need to experiment with this option to get the best results.

Bitmap Size tab

With this tab, you can change the size of the exported image.

Bitmap Size and Resolution

You can change the size of the exported bitmap by changing:

e sIzEe: Type the required width or height into one of the fields. Note that the aspect ratio
of the bitmap is fixed, so changing one dimension automatically changes the other.
SIZE is more suitable than scALE if you want to create a bitmap of a particular size in
pixels.

e SCALE: (Dimmed for JPEG & PNG). This lets you scale the bitmap up or down by a
percentage. SCALE is more suitable than Size if you want, for example, a bitmap 50%
bigger than the original.

e RESOLUTION: (Dimmed for GIF & BMP) Type the resolution into the pri field. If you are
exporting an image for viewing on screen (i.e. a website), you do not need a setting
higher than 96 DPI. 96 DPI also ensures the bitmap is the same size as the objects
on screen (at 100% magnification).

Area to Save

The bitmap can be created using one of these areas of the document:

e PAGE: The whole page area.

e DRAWING: The area covered by objects.

e SELECTION: The area covered by the objects in the selection. Only available when
objects are selected.

Anti-aliasing

Anti-aliasing improves the appearance of graphics by smoothing jagged edges:

e MAINTAIN SCREEN ANTI-ALIASING: The exported bitmap uses the exact same
positioning as shown on screen, and so has identical anti-aliasing. This can result in
the edges of objects being slightly blurred because they do not fall exactly on pixel
boundaries.

e MINIMIZE VISIBLE ANTI-ALIASING: This will slightly reposition the objects by fractions of a
pixel to minimize the anti-aliasing around the edge of the exported bitmap. If in doubt
which option to use, select this.

Put HTML Image Tag on Clipboard

This lets you save out the basic HTML IMG tag information when you save the bitmap.
You can then paste the tag into your text or external HTML page editor.
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Options tab

With this tab you can alter JPEG compression and turn on progressive/interlacing
options if required.

Progressive: (JPEG only) Selecting this option creates a progressive JPEG. This is
useful when the JPEG is large and used on a web page. Web browsers will start
displaying the image before the JPEG file has completely downloaded.

JPEG Quality: (JPEG only) A low setting will result in a small file with a loss in quality
whereas a high value will give only slight file size reductions, but high quality. Note that
a setting of 100% will still compress the file. A setting of 75% gives good compression
without causing a noticeable loss in quality for most uses.

Interlaced: (GIF and PNG only) This is like progressive JPEG. In the browser the
picture first appears as a low resolution image. As more of the file loads, the resolution
increases.

Transparent: (GIF and PNG only) This makes any areas not covered by the selected
objects transparent. Selecting this option automatically makes one entry in the palette
transparent.

Export each layer to a file of its own: Selecting this option when exporting a design
that contains multiple layers results in a separate file being exported for each layer. The
names of each layer (as set in the PAGE & LAYER GALLERY) are used to nhame the
exported files.

Browser Preview

Using the A and B preview boxes in the EXPORT dialog box (shown above), you can
select the best compromise of file size and quality for web graphics. However the best
test is checking how the graphic looks in a web browser. This tab provides a number of
options for that preview. Click the BROWSER PREVIEW button to launch your web browser
and preview the graphics before exporting.

The Designs Gallery

This gallery provides professionally designed templates, from complete web pages and
websites to individual items of clipart you can use to spice up any design.

To open this gallery:

e Choose "UTILITIES" > "GALLERIES" > "DESIGNS GALLERY".
e Or click the DESIGNS GALLERY tab on the Galleries bar.
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Designs gallery

Disc designs...

Introduction
Examples
Presentations
Animated Banners (GIF)
Text Panels
Photos

Landscape

[ Portrait

FFFFFVY

Australian Outback

Autumn Barn Owl

You can search using keywords, and sort the gallery contents. See DOCUMENT HANDLING
(on page 88) for more information on using galleries. When you open the gallery, if you
are online it will automatically download designs and widgets from the Web Designer
servers and these appear immediately in the gallery. Check back regularly to see the
latest widgets and free templates that are available.To open a template as a new
document double-click on it. To import a template into your current open document, drag
it and drop it into your design. Page templates are added as new pages to your current
document when you do this. Other templates and widgets are dropped onto your current
page.

When you drag and drop a widget, a web browser window opens up onto the widget
website, allowing you to configure the widget to suit your needs. When you've finished,
click the Insert button at the bottom of the browser window and the widget is inserted
into your page with a static placeholder image. You see the static image when viewing
the page on the Xara Web Designer 7 canvas, but you see the real widget when you
export and preview your website. See the WEB GRAPHICS & WIDGETS chapter for more
information.
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Changing the blank template document

The blank template documents are the options available under "FILE" > "NEW".

Pre-designed templates are available from the DESIGNS GALLERY (or "FILE" >
"NEW FROM DESIGNS GALLERY").
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To add a template document:

1. Open an existing document ("FILE" > "OPEN", or "Ctrl + O") or create a new
one with the NEw button on the Standard control bar or "Ctrl + N".
2. Make any required changes (these could be changing the page size,
adding a logo or adding a message). You can edit the template document
just like an ordinary document.
3. When you are happy with the changes choose "FILE" > "SAVE TEMPLATE"
and choose a template name.

To make your new template the default template (i.e. which is there when you first open
Web Designer, and which appears when you press "Ctrl + N") check the USE AS DEFAULT
TEMPLATE option when saving the template.

Displaying your own icons in browser tabs: favicons

You may want to display your own customized icon, for example, a logo, on your site's
page tabs when they are displayed in a web browser. Web Designer allows you to do
this by applying the name ‘favicon' to your custom tab icon.

To create a 'favicon', draw or drag on to a web page the image that you want to use.
The image can be any size as it will be scaled to the right size automatically when
displayed in a browser.

Click it then click the Names button to the right of the SELECTOR TooOL infobar.

In the Names dialog, type 'favicon' into the APPLY NAMES box and click AbD then CLOSE.

E R
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Preview your website in your choice of web browser. The easiest way is to click one of
the Preview icons and in the Xara Web Designer 7 preview window, and then choose
one of the web browsers in the top right of the preview window.

Your web page tab is displayed with the custom icon, as shown in the example below.

index X

You can only use one favicon per website. Publish your website and view it to see your
favicon.

Tip: Internet Explorer and Chrome don't show the favicon if the page is loaded from your
local disc, which is normally the case when you’re building and previewing your website
before publishing it. At time of writing, Firefox does show it even for local pages, so use
it to check your favicon. Once your site is published the favicon should work in all
popular web browsers.

Options in the Utilities menu

Keyboard shortcut: "Ctrl + Shift + O" or right click the page/pasteboard and choose PAGE
OPTIONS.

This menu option opens the oPTIONS dialog box. This lets you set various options for
Web Designer.
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General tab
This page describes the General tab of the Utilities, Options dialog

General (Grid and Ruler
eneral Dptions
B Current layer aly le and editable
k before setting current attribute

Make groups be transparent

I AETEER Maintain imported layers names w

Recent file |i

Marquee Object ction

QO Select only items inside rectangle

@ Select items touched by rectangle

Document editing
Document is intended to be

Sh compatible text lengths

Angle constraint m Di

dista
Nudg Tpx

Recent file list size

The File menu shows a list of the most recently loaded or saved files in its ‘Open recent’
sub-menu. This list gives a quick way to reload any of those files. This option lets you
change the number of files listed (between 1 and 20 files).

Current layer always visible and editable
With this option selected, selecting a layer in the PAGE & LAYER GALLERY automatically
makes it visible and editable.

With this option unset, the visible and editable states of a layer remain unchanged when
you select that layer.

Ask before setting current attribute

This applies when changing a current attribute (this happens when you change an
attribute with no objects selected). With this option set, you are asked to confirm
whether you want to change the attribute. With this option unset, the change is made
without confirmation.
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Make groups be transparent as a whole.

See Transparency (on page 189) for more on transparencies.

When applying transparency to a group of objects, by default Web Designer will apply
the transparency to the group as if it were one object (i.e. you will not see individual
transparencies within the group). Unselecting this option will make Web Designer add
transparency to each object in the group separately.

Maintain imported layer names

With this option set, layer information is preserved when you import templates or other
files. With IMPORT LAYERS INTO THE ACTIVE LAYER instead selected, all imported objects
appear in the current layer and the layering information in the incoming data is ignored.
IMPORT LAYERS INTO NEW LAYERS Will create a layer for each imported layer.

IMPORTANT: Note that you should not change this setting if you use any of the web
templates in the DESIGNS GALLERY. Most web templates have multiple layers which are
used to implement mouseover effects. These typically have layers MouseOff and
MouseOver and so when importing these designs it's important that these layers are
preserved and merged with the same layers in your document.

Marquee Object Selection

This option enables you to change the default setting for marquee selection (where you
drag a selection rectangle over the objects you want to select). So you can choose to
have objects touching the selection rectangle selected or only the objects wholly inside
the rectangle.

Angle constraint

This applies when rotating or moving an object with "Ctrl" pressed.
You can either select from the menu or type in a value in degrees.

Document is intended to be a website

This option tells Xara Web Designer 7 that the document is primarily intended to be
exported as a website. It subtly changes the behavior of the program in terms of how it
handles links on objects. With this option turned off, if you apply a link to an object which
is inside a group, that link will do nothing in the exported website because the whole
group is exported as one image and so the link on just one of the group’s members is
ignored when exporting the website. However with this option turned on, the link is
automatically promoted up to the group, just as if it had been applied to the group
instead of to one of its members. So for example if you inadvertently apply a link to the
text on a button, instead of to the whole button, with this option on the link is applied to
the whole button for you. This option is on by default in all web templates.
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Show Windows compatible text lengths

See Browser text compatibility (on page 175) in the TEXT HANDLING chapter.

Nudge size

This applies when moving objects using the arrow( | keys on the keyboard.

This text box defines how far the object moves for each key press. If the document uses
scaled units (for example, linch to 1mile), this text box shows the distance in the scaled
units.

When nudging, "Ctrl" and "Shift" increase the nudge distance by five and ten times,
respectively.

Duplication distance

"EDIT" > "DUPLICATE" (Ctrl + D) creates a duplicate which is offset from the original
object. These text boxes set the offset distance.

Positive values create the duplicate above or to the right of the original object.

Negative values create the duplicate below or to the left.

Grid and Ruler tab

This page describes the Grid and Ruler tab of the Utilities, Options dialog

General Grid and Ruler

(Grid and Ruler options for "Untitled10'

Grid and Ruler spacing

Major spacing m
Number of subdivi 3 m

Origin (0,0 point)

O Tothe Right @ To the Left
@® Upwards O Downwards

Grid and Ruler spacing

MAJOR SPACING defines the distance between the major grid and ruler divisions. The
units used for the grid and rulers are defined by the units you use for the major spacing.
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For example entering a major grid spacing of 2cm will set the grid and ruler units to
centimeters regardless of the page units specified in the units options.

Coordinate Direction

Here you can change the direction of page coordinates.

Mouse tab

This page describes the Mouse tab of the Utilities, Options dialog

Mouse aqe Size Backups

e ophions

Mo utton function

Left mouse button  EXII e 3 iv

Middle mouse button [wheel): Push Tool

Mouse wheel movement [+Ctrl to swap)
Q Zoom infout
s hift 0 SCro efl.-"rightj

Reset defaults

snap radii

Mouse button function

Web Designer gives you a range of possible actions when you click either the left or
right mouse buttons. For example, if you're left-handed, you may prefer to use the right-
hand button as the normal button. You would therefore assign the normal click to the
right mouse button (you can also set both buttons to have the same action if you wish).

Possible actions:

e Normal click - At least one button should always be assigned as the normal click.

e "Shift + click".

e "Ctrl + click".

e "Alt + click".

e Display a pop-up menu (see below).

e Toggle full-screen mode (described in Document Handling (on page 75)).

e Zoom in or out -click to zoom in, "Shift + click" to zoom out (described in Document
Handling (on page 76)).

e PUSH TOOL (as if you pressed "Shift + F8")
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The pop-up menu contains options suitable for the object you click on. For example, for
most object types the menu contains CUT, COPY, PASTE, DELETE, DUPLICATE, CLONE
(these are described in Object Handling (on page 97)).

MOUSE WHEEL MOVEMENT: You can change the mouse wheel action here between
Scrolling and Zooming.

Click RESET DEFAULTS to return to the original button assignments. This has immediate
effect; you don't need to click oK or APPLY NOW.

The Windows Control Panel also lets you swap the left and right mouse buttons.

Magnetic Snap Radii

Snapping is described in Object Handling (on page 114).

These text boxes define how close you can drag an object before it snaps to a magnetic
object. These are distances on the screen and independent of any document scaling.

Page Size tab
This page describes the Page Size tab wd of the Utilities, Options dialog

Mouse Page Size Backups

Page layout options for ‘Untitled10’

760 pix web page [SYGA) v

M 2l pages in we

4 Show page shadow during editing

If the “ALL PAGES IN WEBSITE THE SAME SIZE” option is unselected, then pages in your
document can be given different sizes using this dialog. To set the page size, choose
one of the paper sizes provided in the dropdown list, or choose “Custom” and then enter
the width and height required in the field s provided.

Backups Tab

This tab allows you to turn the automatic backup facility on and off. This facility saves a
copy of all your modified open documents at regular intervals. It's recommended that
you work with this backup option turned on, so your work is saved regularly. You can
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also choose whether you are prompted about unsaved documents when closing the
program, or if instead all open documents should be backed up and restored for you
when you next start up.

See the Document Handling chapter (on page 83) for full details about these facilities.

Control bars

You can move Web Designer's control bars to different places around the window, re-
order the buttons, create new control bars, move or copy buttons between control bars
and many other operations.

You cannot change the tool-dependent InfoBar or the contents of the fly-out bars which
are on the main toolbar and top bars.

Full screen mode

Web Designer has two configurations of control bars:

¢ One configuration appears when the window is its normal size.
e The second configuration appears after you choose "WINDOW" > "FULL SCREEN".

Any changes to one configuration of control bars (for example, resizing or moving) have
no effect on the other configuration. Changes to individual buttons (for example, setting
an option) apply in both normal and full screen modes.

Displaying & hiding control bars

Control bars The display of control bars is controlled by
the CONTROL BARS dialog box ("wiNnDOW" >

[¥] Infobar "CONTROL BARS")
Feathering 1 . ) .
] Animation Ney. Against the name of each control bar is a
[ Toolbar check box. A tick in the check box shows
Mask that the control bar is currently displayed.
[¢]_Standaid Click on the required control bar's check
Use large butt box to display or hide that bar.

Docked and free floating control bars

Normally, control bars are docked (attached to the edges of the window). Moving the
window also moves docked control bars.

Control bars can also be floating. These do not follow movements of the window.

www.Xara.com



302

Customizing Web Designer

Website x

XE

E’ o;) ! HTI%_

3
¢ |

Floating control bar Docked control bar

You can hide a floating control bar either using the CONTROL BARS dialog box (described
above) or by clicking its CLOSE icon.

To make a control bar float, drag it away from the edge of the window either onto the
editing area or off the Web Designer window.

To dock a control bar, drag it over:

e The edge of the window.
e Or the menu bar.
e Or another control bar.

A floating control bar has a double line outline while dragging. This changes to a single
line when in a docking position. If you want the control bar to remain floating, hold down
"Ctrl" while dragging.

Resizing a control bar

Move the pointer over the edge of the control bar. It changes to a double-headed arrow.
You can now drag the edge to resize the control bar.

Creating new control bars

To create a new control bar:

o Drag a button onto the editing area or off the window. This opens a new control bar
containing the button.

Or click NEW on the CONTROL BARS dialog box. This lets you create a new control bar
and allocate a name to it. The new control bar is empty. You can then drag buttons to it.

Moving buttons is described below.
Deleting control bars
You can only delete control bars that are empty. Therefore move any buttons to another

control bar. Close the control bar (either click on the cLOSE icon or use the CONTROL
BARS dialog box). The control bar is automatically deleted when you quit Web Designer.
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Moving buttons and tools

To move buttons or tools:

1. Move the mouse pointer over the button you want to move.
Hold down "Alt" (left ALT) to move the button or "AltGr" (right ALT) to copy the
button when used on user-defined control bars and other control bars. Although on
the predefined "Button palette” both ALT-keys do only copy the button.
3. Drag the button to:
- A different place on the same control bar.
- Or another control bar.
- Or onto the editing area/off Web Designer to create a new control bar.

You cannot move buttons onto or off the InfoBar.

Hiding buttons and tools

Move the unwanted buttons or tools to another control bar and then hide that control bar
(described above).

If you need the button or tool in the future, use the CONTROL BARS dialog box to redisplay
the control bar.

You cannot delete buttons or tools.
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Menus and Keyboard Shortcuts

File Edit Arrange Utilities Window Help

Introduction

This chapter describes the operations available on each of the menus and those
available via keyboard shortcuts. In many cases the operations described in this chapter
apply to the selected object. In most cases, the described action also applies when you
have several selected objects. We use selected object as shorthand for selected object
or objects.

Often you can select options from either a menu, a control bar or a keyboard shortcut.
Where a button on a control bar and/or keyboard shortcut exists, these are shown after
the menu name. For example, the following means there is a button on the STANDARD
control bar that has the same effect as selecting new, or you can use the shortcut "Ctrl +
N".

New (Standard control bar or "Ctrl + N")

File menu

New (Standard control bar or Ctrl+N)

Opens a new document.

New from Designs Gallery

This option opens the DESIGNS GALLERY if it's not open already, allowing you to choose a
template for a new document. Click on the folder icons in the gallery to open a folder
and double-click on a template thumbnail to start a new document using that template.

You can also open the DESIGNS GALLERY by clicking the tab in the Galleries bar.
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Open (Standard control bar or Ctrl+O)
Opens a new editing window and loads a file into it. This file can be:
o A Web Designer .web file to view or edit an existing Web Designer document,

e Or any of the other import formats (see Importing & Exporting (on page 281) for a list
of formats). This opens a new document with the file.
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Open recent

A list of the most recently loaded or saved files. Provides a quick way to reload any of
these files.

You can change the number of files in this list (refer to Customizing Web Designer (on
page 294) for details).

Close (Ctrl+W)

Closes the current editing window. Web Designer remains loaded. You are warned if the
file has unsaved changes.

Save (Standard control bar or Ctrl+S)

Saves the selected document.

Save As

Lets you save the selected document under a different name or to a different directory or
drive.

Save All

Saves all loaded documents.

Save Template

Saves the selected document as a template document (see Customizing Web Designer
(on page 294)).

Import (Ctrl+Alt+l)

Loads a file into the selected document. The file can be any of the import formats (see
Importing & Exporting (on page 281) for more information).

Note the difference between oPEN and IMPORT: both load a variety of file formats but
OPEN opens a new document. IMPORT loads the file into the current open document.

Export (Ctrl+Shift+E)

Or right click and choose EXPORT.

Lets you export the document in any of the export formats supported by Web Designer
(see Importing & Exporting (on page 281) for a list of formats).

Export JPEG

HTML JPG PNG Also in Export toolbar. Or right click and choose Export -
L Export JPEG.)

Lets you export selected objects, a page or the whole document as a JPEG.
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Export PNG

HTML JPG PNG ¢ Also in Export toolbar. Or right click and choose "EXPORT" >
" "EXPORT PNG".)

Lets you export selected objects, a page or the whole document as a PNG.

Preview web page (F12)

Export and preview the current page of the current website document.

P: You can also preview your page by clicking the web page preview button on the
mdl \Web toolbar.

Click a browser type at the top of the preview window to preview your page in your

referred browser.
b Previews your page in Google Chrome

E Previews your page in Mozilla Firefox

Previews your page in Internet Explorer

Previews your page in Opera

@ Previews your page in Safari

Preview Website

Export and preview the current website document. The document is exported to the
same location it was last exported to (overwriting files as necessary without prompting),
or to a temporary location if the site has not yet been exported. Then a browser window
is shown displaying the first page of the website.

[F' This is the quickest way to preview your site as you work on it. You can also preview
s=dl by clicking the button on the Web toolbar.

Export Website

HTML JPG PNG Also in Export toolbar.
I I <

Export the current document as HTML.
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Publish Website

This performs the same operation as the button on the Web toolbar. It exports
and then publishes the current website document to your web space.

If you haven't already entered the FTP details for your web space, the PUBLISH tab of the
WEB PROPERTIES dialog will be displayed first. Then if you haven’t already exported the
site locally, the export dialog will appear to allow you to do so. Then the website is
published to your web space. A progress indicator appears during the publishing
operation.

See the Getting Started (on page 67) chapter for more details on publishing.

Document Info

This displays an information box about the selected document, including which fonts are
used in the current document.

Page Options

Also right click and choose PAGE OPTIONS.
Allows you to edit the page layout, size, etc.

Exit

Closes all windows and removes Web Designer from memory. You are warned if any
files have unsaved changes.

Edit menu

Undo (Standard control bar or Ctrl+2Z)

Undo the previous operation. The description of this option reflects the last operation
performed. For example, uNDO cuT (refer to Undo & Redo (on page 96)).

Redo (Standard control bar or Ctrl+Y)

Cancel the last unDO command. The description of this option reflects the last UNDO
operation (refer to Undo & Redo).

Cut (Edit control bar or Ctrl+X)

Cut the selected object to the clipboard. The description of this option reflects the type of
object selected (refer to Object Handling (on page 101)).

Copy (Edit control bar or Ctrl+C)

Copy the selected object to the clipboard. The description of this option reflects the type
of object selected. The object remains in place in the document (refer to Object Handling
(on page 101)).
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Paste (Edit control bar or Ctrl+V)

Or right click and choose PASTE.

Paste the clipboard contents into the selected document. The wording of this option
reflects the contents of the clipboard (refer to Object Handling (on page 101)).

Sometimes, when you paste the contents of the clipboard into a document, it could be
inserted using several different formats. If this is the case the PASTE sPECIAL dialog box
will appear so you can choose a format.

Paste unformatted text

Pastes any text on the clipboard into your document without any formatting.

Paste in place

The same as PASTE, except your object will be pasted in the exact same position from
which you copied it. This is useful for moving objects from one layer or page to another,
without changing its X/Y position.

Paste format/attributes

Preserves the format (e.g., font and font size) or style attributes (e.g., line and fill color)
of the pasted object.

Paste in current layer

The same as PASTE IN PLACE, except your object will only be pasted into the current
layer.

This is useful if you want to display or hide just your pasted object when layers above or
below are displayed.

Paste in place in current layer

The same as PASTE IN CURRENT LAYER, except your object will be pasted into the current
layer in the exact same position from which you copied it.

Delete (Edit & Standard control bars or Delete)

Or right click and choose DELETE.

Delete the selected object. The description of this option reflects the type of object
selected (refer to Object Handling (on page 97)).

Select All (Ctrl+A)

Select all objects in editable layers (editable and locked layers are described in Layers
(on page 270)).

Clear Selection / Reset current attributes (Esc)

Deselect all objects. If nothing is selected, the current attributes (on page 54) are set
back to its default values. You can easily get this by pressing ESC twice.
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Duplicate (Edit control bar or Ctrl+Alt+D)

Or right click and choose DUPLICATE.

Copy the selected object placing the copy slightly offset from the original. The copy
becomes the selected object. The offset distance can be customized (see Customizing
Web Designer (on page 298)).

Clone (Ctrl+K)

Like buPLICATE copies the selected object, but places the copy directly over the original.
The copy becomes the selected object.

Pages
Or right click and choose PAGES.
The Pages submenu lets you add or remove pages from your multi-page document,

duplicate the current page or move the current page up and down. Read more on multi-
page documents in Multi-page Documents (on page 79).

Arrange menu

Move to Layer in Front (Arrange control bar or Ctrl+Shift+U)

Or right click and choose ARRANGE > MOVE TO LAYER IN FRONT.

Move the selected object forward by one layer. The selected object becomes the back
object in the new layer.

Bring to Front (Arrange control bar or Ctrl+F)

Or right click and choose ARRANGE > BRING TO FRONT.

Move the selected object to the front of all other objects in the same layer. See Object
Handling (on page 97) for more information.

Move Forwards (Arrange control bar or Ctrl+Shift+F)

Or right click and choose ARRANGE > MOVE FORWARDS.

Move the selected object one step towards the front (refer to Object Handling (on page
97)).

Move Backwards (Arrange control bar or Ctrl+Shift+B)

Or right click and choose ARRANGE > MOVE BACKWARDS.
Move the selected object one step towards the back (refer to Object Handling).

Put to Back (Arrange control bar or Ctrl+B)

Or right click and choose ARRANGE > PUT TO BACK.
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Move the selected object behind all others in the same layer (refer to Object Handling
(on page 97)).

Move To Layer Behind (Arrange control bar or Ctrl+Shift+D)

Or right click and choose ARRANGE > MOVE TO LAYER BEHIND.

Move the selected object one layer backwards. The selected object becomes the front
object in the new layer.

Group (Arrange control bar or Ctrl+G)

Or right click and choose GRouUP.

Group the selected objects together to appear as a single object (refer to Object
Handling (on page 97)).

uUngroup (Arrange control bar or Ctrl+U)

Or right click and choose UNGROUP.

Split the group or groups into separate objects. Dimmed unless the selected object is a
group. Or, for several selected objects, there is at least one group.

Apply soft group (Ctrl+Alt+G)

Or right click and choose APPLY SOFT GROUP.

Make the selected objects form a soft group. Unlike groups, soft groups can include
objects on different layers. Refer to Object Handling (on page 117, on page 50) for
details.

Remove soft group (Ctrl+Alt+U)

Or right click and choose REMOVE SOFT GROUP.
Disband the selected soft group, so the objects are separately selectable objects again.

Alignment (Ctrl+Shift+L)

Or right click and choose ALIGN.

Used to align several objects. Has no effect when a single object is selected (refer to
Object Handling (on page 118) for more information).

Fit Text to Curve/Remove Text From Curve

Or right click and choose FIT TEXT TO CURVE/REMOVE TEXT FROM CURVE.

Lets you fit a line of text to an arbitrary curve or remove text from a curve (see Text
Handling for more information).

Repelling and Anchoring

Or right click and choose REPEL TEXT UNDER, ANCHOR TO TEXT Or REPELLING AND
ANCHORING.
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Make the object repel underlying text, and anchor an object within a column of text. See
Repelling text objects (on page 165) and Anchored Graphics (on page 166) for details.

Create Navigation Bar

This command allows you to create a navigation bar from a single button. Read more in
chapter NAVIGATION BARS (on page 248).

Repeat on all pages (Shift+Ctrl+Alt+R)

Or right click and choose REPEAT ON ALL PAGES.

The selected object will be copied to the same place on all pages. The command
automatically creates an appropriate Repeating:AutoRepeat name and applies it to all
copies, so from this point on it will be updated when you select UPDATE REPEATING
OBJECTS.

Stop updating (Shift+Ctrl+Alt+0O)

Or right click and choose STOP UPDATING.

The "ARRANGE" > "STOP UPDATING" operation allows you to turn off the repeating nature
of an instance of a repeating object, or on all copies of that object in your website.

Read more in the Object Handling Chapter (on page 124).

Utilities menu

Galleries
Page & Gallery (Galleries control bar or "F10")

Displays or hides the PAGE & LAYER GALLERY.

Bitmap Gallery (Galleries control bar or "F11")

Displays or hides the BITMAP GALLERY (see Bitmap Handling (on page 222)).

Line Gallery (Galleries control bar or "F12")

Displays or hides the LINE GALLERY (see Drawing Lines).

Designs Gallery (Galleries control bar or "{t+ F10")

Displays or hides the DESIGNS GALLERY (see Importing and Exporting (on page 281)).

Fill Gallery (Galleries control bar or "{t+ F11")

Displays or hides the FILL GALLERY (see Bitmap Handling).

Color Editor (Ctrl+E)

Or right click and choose FILL COLOR.

Opens the coLoR EDITOR (refer to Color Handling).
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Names

Or right click and choose NAMES.
Opens the Apply/remove names dialog (on page 121).

Web Properties (Ctrl+Shift+W)

Or right click and choose WEB PROPERTIES.
Opens the weB PROPERTIES dialog, which allows web features such as links, pop-up
layers, anchors, etc. to be added to your web page document. You can also control how

images are exported for the web page and set various other web properties using this
dialog. See Getting Started (on page 19) for details.

Optimize Photo

Or right click and choose OPTIMIZE PHOTO.

Optimize bitmap resolution for use in Xara Web Designer 7 designs. See Photo
Optimization (on page 235) for details.

Optimize all JPEGs
Optimizes all JPEG photos in the design. See Photo Optimization (on page 235).

Check spelling as you type

This option activates the SPELL CHECKER (on page 160) in the TEXT TOOL.

Options (Ctrl+Shift+O)

Or right click and choose PAGE OPTIONS.

Opens the oPTIONS dialog box (described in Customizing Web Designer (on page 294)).

Window menu

Clear Selection / Reset current attributes (Esc)

Deselect all objects. If nothing is selected, the current attributes (on page 54) are set
back to its default values. You can easily get this by pressing ESC twice.

Multiple Page View

Or right click and choose MULTIPLE PAGE VIEW.

By default Web Designer shows only the current page of the currently open document.
Choosing multiple page view shows all the pages in your document.

New View

Opens a new window onto the selected document.
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Arrange Views

Displays all Web Designer windows as tiles.

Show Scrollbars

Toggles display of the scrollbars at the side and bottom of the Web Designer window.

Show Rulers (Ctrl + L)

Or right click and choose SHOW GRID/GUIDES > SHOW RULERS.
Toggles display of rulers to the top and side of the Web Designer window.

Control Bars

Displays the coNTROL BARS dialog box (described in Customizing Web Designer (on
page 301)).

Quality

Selects how objects are displayed from wire frame to anti-aliased (see Document
Handling (on page 87)).

Show Document Tabs

Toggles display of the document tabs that provide quick access to each open document
at the top of the Web Designer window.

Clicking on a tab makes that document the selected document. A "*" after the document
name indicates that it currently has unsaved changes.

Full Screen (8 on numeric keypad)

Toggles between full-screen and normal screen modes.

Show Grid (#)

Or right click and choose SHOW GRID/GUIDES > SHOW GRID.
Makes the on-screen grid visible (see Document Handling (on page 85)).

Show Guides (1 on numeric keypad)

Or right click and choose SHOW GRID/GUIDES > SHOW GUIDES.
Displays or hides the Guides layer which contains all guidelines and guide objects.

Snap to Grid (. on numeric keypad)

Or right click and choose SNAP TO > SNAP TO GRID.

With this option set, an object snaps to any grid point it is dragged close to (see
Document Handling (on page 114)).
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Snap to Guides (2 on numeric keypad)

Or right click and choose SNAP TO > SNAP TO GUIDES.

With this option set, an object snaps to any guide it is dragged close to (see Object
Handling (on page 114)).

Snap to Objects (* on numeric keypad)

Or right click and choose SNAP TO > SNAP TO OBJECTS.

With this option selected, dragging a handle close to another object snaps the handle to
the object; see Object Handling (on page 114) for more details. You can also adjust the
snapping distance; see Customizing Web Designer (on page 294) for more details.

Documents Loaded

A list of the currently open documents. Clicking on a name makes that document the
selected document ("Ctrl + F6" also switches between open documents). A "*" after the
document name indicates that it currently has unsaved changes.

Help menu

Xara Web Designer 7 help

Use the command <PROGRAMMNAME > HELP in the HELP menu to open the start page of
the program Help. Here you can work through the Help step-by-step and jump to
specific sections via the tree structure on the left-hand side.

Help

This command is available at almost every point of this program and opens the program
Help at the corresponding topic. Use this command to get help on any function of Xara
Web Designer 7.

Shortcut: F1

Movies

Goes to a web page containing tutorial movies on how to use Web Designer.

More Web Designer

In this menu there are useful internet links to Xara’s website and useful online
resources.

Tip of the Day

See the tip of the day. There is also a check box below the Tip of the Day where you
select whether or not you see a tip each time you start Web Designer.

Update program

This checks online for any available program updates.
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Firstly, you are shown a screen which tells you whether there is a major new version of
Web Designer that you could upgrade to. Then, if you've registered the program with
Xara, an automatic update process will start which will check for any free program
updates which are available. If there is an update available it is automatically
downloaded and then Xara Web Designer 7 is closed and the update is installed. The
program is then restarted automatically for you.

Use the REGISTER option in the HELP menu to register the program with Xara.

Affiliate program

If you didn’t sign up for the affiliate program when you unlocked Xara Web Designer 7,
you can use this option to join the program or to change the affiliate option you chose
previously. Select this option to bring up the affiliate dialog, which tells you all about the
affiliate program. You can start earning commission from your Xara Web Designer 7
website, or have it donated to charity, just by choosing from the three options shown in
the dialog.

Info pop-ups

Allows you to display 'tooltips' containing pop-up information as your mouse pointer
moves over toolbars, buttons, the color line and other items in the Web Designer
window.

About Xara Web Designer 7

Displays copyright info and version number of Xara Web Designer 7.

Register

Use this option to register your purchase online with Xara, so that you can get free
program updates, discounts on upgrades, special offers and other benefits.

Key shortcuts

The tools

SELECTOR TOOL
SHAPE EDITOR TOOL
RECTANGLE TOOL
ELLIPSE TOOL

TEXT TOOL

FILL TOOL
TRANSPARENCY TOOL
SHADOW TOOL
PHOTO TOOL

PUSH TOOL

ZOOM TOOL
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The galleries

DESIGNS GALLERY

FILL GALLERY

PAGE & LAYER GALLERY
BITMAP GALLERY

Zooming

Previous zoom
Zoom to selection
Zoom to drawing
Zoom to page
Zoom in (enlarge)
Zoom out (reduce)
Zoom to 100%
Zoom to 200%
Zoom to 300%
Zoom to 400%
Zoom to 50%

f + F10
T +F11
F10
F11

Ctrl + R

Ctrl + Shift + Z
Ctrl + Shift + J
Ctrl + Shift + P

Ctrl + + on the numeric keypad
Ctrl + - on the numeric keypad

a s wnN -

You can also zoom and slide the document using a mouse-wheel (Ctrl+Mouse-Wheel

zooms in/out).

Manipulating documents

When in the Text Tool, shortcuts marked with a star (*) have a different action-see below

(on page 318).

New document

Open document

Close document

Switch document

Print document

Save document

Import

Import graphics from Web
Export

Time a document redraw
Show grid

Show guides

Snap to grid

Snap to guides

Snap to objects

Select full screen

Show rulers

Undo

Redo

Ctrl+ N

Ctrl+ O

Ctrl + W

Ctrl + Tab

Ctrl+ P

Ctrl+ S

Ctrl + Alt + |

Ctrl + Alt + W

Ctrl + Shift + E

Ctrl + Shift + T

#

1 on numeric keypad

. on the numeric keypad
2 on the numeric keypad
* on the numeric keypad
8 on the numeric keypad
Ctrl + Shift + R or Ctrl + L*
Ctrl+Zor<or,

Ctrl +Yor>or.
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Manipulating objects

When in the Text Tool, shortcuts marked with a star (*) have a different action-see below
(on page 318).

Select all Ctrl+ A*
Select next object Tab

Delete the selection Delete *
Clear selection Esc

Bring object to front Ctrl+ F

Put object to back Ctrl+B*
Move object forwards Ctrl+ ¢ +F
Move object backwards Ctrl+ ¢+ +B
Move object to layer in front Ctrl+ ¢+ +U
Move object to layer behind Ctrl+ ¢+ +D
Group objects Ctrl + G
Ungroup objects Ctrl+ U
Clone object Ctrl + K
Duplicate object with offset Ctrl+D
Copy object to clipboard Ctrl+C

Cut selection to clipboard Ctrl + X
Paste object from clipboard Ctrl +V
Paste object in original position Ctrl+ ¢+ +V
Paste attributes Ctrl+ ¢+ + A
Create bitmap copy Ctrl+ ¢t +C
Add shapes Ctrl +1
Subtract shapes Ctrl + 2
Intersect shapes Ctrl + 3
Slice shapes Ctrl+4
Open the alignment dialog box Ctrl + ¢+ +L*
Web address Ctrl+ ¢+ +W

Move the selected objects: cursor (arrow) keys with the SELECTOR TOOL (see Nudging
objects (on page 101) )

Move the selected handles: cursors (arrow) keys in tools other than the selector.
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Text Tool

Cursor keys

Home

End

Ctrl + left/right cursor
Ctrl + Home

Ctrl + End

Ctrl + A
Ctrl+B

Ctrl + 1

Ctrl+ C

Ctrl + L

Ctrl + Shift + L
Ctrl +V

Ctrl + W
Ctrl + -

Ctrl + Shift + -
Ctrl + <

Ctrl +>

Alt + cursor keys

J
Delete

Backspace

Shift + cursor keys

Shift + End

Move the text cursor up up, down, left or right

one character at a time.

Move the text cursor to the start of the line.

Move the text cursor to the end of the line.

Move the text cursor left/right one word.

Move the text cursor to the start of the first line in a text
object.

Move the text cursor to the end of the last line in a text
object.

Selects all characters in a text object.

Apply the bold attribute.

Apply the italic attribute.

Copy the selected region of text to the clipboard.

Select all characters in the line containing the text cursor.
Insert 'Lorem ipsum' dummy text

Paste text at the text cursor position (if the clipboard
contains text).

Swap the case of the character to the right of the text cursor.
Insert Soft Hyphen (appears only when wrapping at line
end).

Insert hard hyphen (dash) to prevent a dash being
misinterpreted as a hyphen at line end.

Increase/Decrease font size of selected text (only if the
selection is all the same point size)

Increase/Decrease kerning/tracking.

Start a new line of text.

Delete the character to the right of the text cursor. If the
cursor is on the end of a text line, join this line to the line
below.

Delete the character to the left of the text cursor. If the
cursor is at the start of a text line, join this line to the line
above.

Select all text between the cursor position and the beginning
of the line.

Select all text between the cursor position and the end of the
line.

Special characters (in Text Tool)

Ctrl + Space
Ctrl + NumPad —

Ctrl + Alt + NumPad —
Ctrl + Alt +.(Full stop)
Ctrl + Alt + C

Ctrl + At + R

Ctrl + Alt+ T

Ctrl + Alt+ B

Hard space (words with hard spaces
between will not wrap at the end of a line)
- EN dash (An EN dash is longer than a
minus, and is a more correct ‘dash’)
— EM dash (An EM dash is a long dash)
Ellipsis (An ellipsis is three dots)

© Copyright
® Registered
™ Trademark
. Bullet
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Other

Color Editor Ctrl + E (opens and closes)
Options dialog Ctrl + Shift + O

Xara Web Designer 7 Help F1
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More about Xara Group

About Xara Group Ltd.

One of the oldest independent UK software developers, Xara has been developing
software since 1981.

From Wordwise, one of the earliest microcomputer word processors, to Xara Designer
Pro, the world's fastest, and many believe the world's best drawing and illustration
software, Xara has developed a wide range of products covering the whole realm of
publishing software. Xara has pioneered many technologies taken for granted
nowadays. From developing the world's first check-as-you-type spell checker, to award
winning desk-top-publishing software, to the first drawing software to provide real-time
anti-aliasing and transparency control, Xara continues to innovate and develop leading
edge technical solutions.

Xara has been involved in the Internet from the very beginning. Xara Networks, a
subsidiary of the Xara Group, was a pioneer Internet provider in the mid 1990s (no
longer part of the Xara Group). Xara does most of its business via the Internet and has
millions of online customers, worldwide.

Xara's first Windows illustration software, Xara Studio, was licensed to Corel and
distributed for many years as CorelXARA. When it came back under Xara control it was
enhanced and relaunched and is now sold as Xara Photo & Graphic Designer and Xara
Designer Pro.

Xara is headquartered in the historic house, Gaddesden Place, in the UK, north of
London.

In January 2007 Xara was acquired by MAGIX AG, and now operates as a wholly
owned subsidiary. MAGIX is a leading international provider of high-quality software,
online services and digital contents for multimedia communications. Since 1993, MAGIX
has been developing leading technologies for creation, editing, management and
presentation of photos and graphics, videos and music. Internationally, MAGIX operates
from branches in the USA, Canada, the UK, Germany, France, Italy, Spain and the
Netherlands. The product range is targeted towards laymen and professionals alike and
goes beyond the PC range to include seamlessly integrated online and mobile
applications.
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According to its retail sales figures, MAGIX leads in the multimedia software sector in
the most important European markets, and is one of the most successful competitors in
the USA. Fifteen years of market presence as well as one thousand awards worldwide
testify to the company's power of innovation.

Web Links

Xara Home Page — http://www.xara.com
Magix Home Page — http://www.magix.com
Other Xara products

There are trial versions and demo movies for many of these products at
http://www.xara.com/products.

Xara Photo & Graphic Designer 7 (formerly Xtreme) is

-1 ' Ay quite simply the best value and fastest all-in-one
DES R graphics package you'll find. For drawings or photo
work, for print or web graphics, it's the perfect choice.
. A See http://www.xara.com/products/designer for more

el information.

Xara Designer Pro 7 (formerly Xtreme Pro) is our top
of the range product and includes all the features and
DESIGNER templates of Web Designer Premium and Photo &
Graphic Designer. Plus it adds extra features that Pro
designers need including support for PDF/X,
PANTONE® and color separations, multi-core
processor support for extra speed, enhanced
import/export filters, a pro version of the photo
panorama tool and more.
See http://www.xara.com/products/designer for more
information.
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Version 7

Xara 3D Maker is solely designed to create the highest
quality 3D text and graphics, such as headings, logos,
tittes and buttons. It's the perfect way to add impact to
your web pages, mailshots, movies and presentations
(all images are fully anti-aliased for that smooth,
professional quality). Xara 3D Maker can also create
awesome 3D animations in seconds - GIFs, AVIs and
simple Flash movie sequences - and you can even
enhance your desktop by saving any animation as a
screensaver!

See http://www.xara.com/products/xara3d for more
information.

Create professional graphical NavBars and DHTML
menus in an instant with Xara Menu Maker - no
technical or design skills required.

See http://www.xara.com/products/menumaker for more
information.

Xara ScreenMaker 3D is a screensaver maker that's
fast, fun and easy to use. Create animated 3D text or
tumbling picture cube screensavers.

See http://www.xara.com/products/screenmaker3d/ for
more information.
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Copyright

This documentation is protected by law. All rights, especially the right of duplication,
circulation, and translation are reserved.

No part of this publication may be reproduced in form of copies, microfilms or other
processes, or transmitted into a language used for machines, especially data processing
machines, without the express written consent of the publisher.

All copyrights reserved.

All other product names are trademarks of the corresponding manufacturers. Errors in
and changes to the contents as well as program modifications reserved.

Xara is a registered trademark of Xara Group Ltd.
Xara Group Ltd. is an affiliate company of MAGIX AG.
MAGIX is a registered trademark of MAGIX AG.

Other mentioned product names may be registered trademarks of the respective
manufacturer.

This product uses MAGIX patent pending technology.

Copyright © Xara Group Ltd., 1994-2011. All rights reserved.

Xara Web Designer 7 end user license agreement

© 2011 Xara Group Ltd

IMPORTANT NOTICE: The Xara Web Designer 7 software ("Software") is the copyright
of Xara Group Limited ("Xara") whose principal place of business is at Gaddesden
Place, Hemel Hempstead, Herts, HP2 6EX, United Kingdom and may not be stored on
any computer or copied without the license of Xara. You are offered a license on the
terms of the End User License Agreement ("EULA") set out below.

If you accept the terms of the License Agreement, select the ‘| accept’ checkbox below.
Selecting ‘I accept’ and installing the Software constitutes acceptance of the terms of the
EULA. Please read carefully and accept the terms and conditions of the EULA before
installing the Software. Do not install the Software if you do not agree to the terms and
conditions of the EULA.

If you do not accept these terms and you have purchased the Software you may within
14 days of purchase return the CD-ROM containing the Software, unused and intact or
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in the case of a download a Letter of Destruction to your supplier together with proof of
purchase for a full refund.

Xara Web Designer 7 END USER LICENSE AGREEMENT ("EULA")
You are permitted to:

1. load or download the Software and use it only on a single client computer which is
under your personal control (unless you have purchased a network license, contact Xara
sales at www.xara.com); except that you may

2. copy the Software from one computer to another under your personal control provided
it is used on only one computer at any one time and only by you. The copies must
reproduce and include Xara's copyright notices;

3. transfer the Software (complete with all its associated documentation) and this license
to another person provided that person has agreed to accept the terms of this
Agreement and you contemporaneously transfer all copies of the Software you have
made to that person or destroy all copies not transferred. If any transferee does not
accept such terms then this license shall automatically terminate. The transferor does
not retain any rights under this Agreement in respect of the transferred Software or
license.

You are not permitted:

(a) to use the Software on any computer or system which permits electronic access to it
by more than one user (unless you have purchased a network license, contact Xara
sales at www.xara.com);

(b) to rent, lease, sub-license, loan, copy (except as expressly provided in this
Agreement), modify adapt, merge, translate, reverse engineer, decompile, disassemble
or create derivative works based on the whole or any part of the Software or its
associated documentation except as permitted by law;

(c) except as expressly provided in this Agreement, to use, reproduce or deal in the
Software in any way.

TERM

The license is effective until you terminate it by destroying the Software and its
documentation together with all copies. It will also terminate if you fail to abide by this
Agreement. Upon termination you agree to destroy all copies of the Software and its
documentation including any Software stored on the hard disk of any computer under
your control. If you are using the trial version of the Software then any rights to use the
Software or images created with it terminates with the expiration of the trial period.

OWNERSHIP
You own only any CD-ROM (or authorized replacement) upon which the Software was
supplied where it was not downloaded. You may retain such CD-ROM on termination

provided the Software has been erased. Xara shall at all times retain ownership of the
Software as recorded on the original CD-ROM and all subsequent copies thereof
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regardless of form. This Agreement applies to the grant of the license only and not to the
contract of sale of the CD-ROM.

INCLUDED ONLINE ACCESS TO THIRD PARTY SOFTWARE

The Software may provide online access to third party software, e.g. Widgets or
Gadgets, which are offered by third parties online. The Software can only provide
access to such software if your PC is connected to the internet. If you agree to this
EULA you agree that the Software may provide such access to third party software.

For clarification purposes: Xara is not the owner of such third party software and Xara
waives any responsibility and/or liability for such third party software. In particular Xara
does not warrant any availability of such third party software.

RESTRICTIONS

This license gives you the right to publish, distribute and display images created with
this Software, incorporating template graphics, photos, fonts and fills included with this
Software, with the following limitations:

1. The templates, graphics, photos and fonts supplied with the Software cannot be
redistributed, sold or published as an image collection or part of an image collection,
specifically but not exclusively they cannot be included in template, clip-art, font, texture
or photo collections whether on websites or distributed on electronic media such as CDs
or disks, nor can they be included as part of another product, in any form whether
commercial or otherwise. Notwithstanding the foregoing you may include the template,
graphic, photo or font as part of your project which may be used for your own or your
customer's purposes.

2. The photos included with the Software can be used and distributed for personal
purposes, but any commercial redistribution may require the purchase of an extended
license from Xara or its Licensors. Contact Xara Group Ltd for details.

3. Any copyright notices which are included in the HTML, Javascript or other code
exported by the Software must not be removed or modified.

4. Some fonts are provided by third parties who retain the copyright. In all cases
copyright is reserved by Xara or its licensors and is protected by international copyright
law.

5. You may not use the images included with or created with this Software for any
purpose which is prohibited by law.

WARRANTIES AND REMEDIES

1. Xara warrants that the storage media on which the Software may have been supplied
will be free from defects in materials and workmanship under normal use for a period of
90 days after the date of original purchase. If a defect in any CD occurs during such
period you may return it with proof of purchase to your supplier who will replace it free of
charge.

2. Xara warrants that the Software will perform substantially in accordance with its
accompanying documentation (provided that the Software is properly used on the
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computer and with the operating system for which it was designed) and that the
documentation correctly describes the operation of the Software in all material respects.
If Xara is notified of any significant error in the Software during the period of 90 days
after the date of original purchase it will correct any such error within a reasonable time
(by replacement if it chooses) or, at its option, refund the price of the Software (against
return of the Software and its documentation).

3. The warranties set out in paragraphs 1 and 2 above are your sole warranties and are
in place of all warranties conditions or other terms expressed or implied by statute or
otherwise, all of which are hereby excluded to the fullest extent permitted by law.
Paragraphs 1 and 2 also set out your sole remedies for any breach of Xara's warranties

4. In particular Xara does not warrant that the Software will meet your requirements or
that the operation of the Software will be uninterrupted or error free or that all errors in
the Software can be corrected. You load and use the Software at your own risk and in
no event will Xara be liable to you for any loss or damage of any kind (except personal
injury or death resulting from Xara's negligence) including lost profits or any indirect or
consequential loss arising from the use of or inability to use the Software or from errors
or deficiencies in it whether caused by negligence or otherwise, except as expressly
provided in this Agreement.

CONSUMERS

Nothing in this Agreement shall affect your statutory rights as a consumer.

LICENSE CONDITIONS OF OTHER MANUFACTURERS

If the licensed product contains additional software, or should additional software be
integrated — for example JQuery (or similar) Widgets or Gadgets - then compliance with
the use and license conditions of the manufacturer of said delivered additional software
is also compulsory. Any such license conditions will be presented when the additional
software is configured or on the Widget provider's website if the widget is configured via
such a website.

LAW

This Agreement shall be governed by English law.

If you have any questions concerning this Agreement please write to Xara Group
Limited, Gaddesden Place, Hemel Hempstead, Herts, HP2 6EX, United Kingdom.
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Xara is a trademark of Xara Group Ltd. The contents of this documentation and the
associated Xara software are the property of Xara Group Ltd and are copyrighted. Any
reproduction in whole or in part is strictly prohibited. For additional copies of the
software, please contact Xara Group Ltd http://www.xara.com. Xara Web Designer 7
license terms (on page 323).

Redistributable portions of Microsoft MSVC and MFC are copyright of Microsoft
Corporation. Microsoft, Internet Explorer, PowerPoint, Windows and Windows Vista are
either trademarks or registered trademarks of Microsoft Corporation in the United States
and/or other countries.

Adobe, Encapsulated PostScript, lllustrator, Photoshop, Dreamweaver, Fireworks,
Freehand, Flash, PostScript and Type Manager and are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

MAGIX is a registered trademark of MAGIX AG.
Apple, Macintosh and TrueType are registered trademarks of Apple Computer, Inc.

Corel, CorelDRAW and Paintshop Pro are either registered trademarks or trademarks of
Corel Corporation.

Xara Web Designer 7 uses the Mersenne Twister random number generator , Copyright
(C) 1997 - 2002, Makoto Matsumoto and Takuji Nishimura, and 2000 - 2003, Richard J.
Wagner. All rights reserved. Further copyright information can be found in the

MTRand.txt file located in the HelpAndSupport folder of your Web Designer installation.

Some program code is Copyright (c) 1996 Silicon Graphics Computer Systems, Inc.
Further copyright information can be found in sg.txt in the HelpAndSupport folder of your
Xtreme installation.

Some program code is Copyright (c) 1994 Hewlett-Packard Company. Further copyright
information can be found in the hp.txt in the HelpAndSupport folder of your program
installation.

Some import and export filters utilize color profiles from Adobe Systems Inc. The license
agreement can be found in the HelpAndSupport folder of your Xara Web Designer 7
installation.

This software is based in part on the work of the Independent JPEG Group.
Xara Web Designer 7 uses the zlib compression library www.zlib.net

Xara Web Designer 7 uses the ImageMagick library Copyright 1999-2007 ImageMagick
Studio LLC http://www.imagemagick.org. A copy of the ImageMagick license is included
in ImageMagick.txt in the HelpAndSupport folder of your Xara Web Designer 7
installation.

Web Designer's spell checker is based on the Open Source Hunspell library used
without any modifications under the Mozilla Public License Version 1.1. You can find a
copy of the Mozilla Public License in the file MPL-1.1.txt in the "dict" folder of your Web
Designer installation and a copy of the Hunspell source code at
http://hunspell.sourceforge.net/. The Xara Web Designer 7 distribution includes various
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language dictionaries which are distributed under various different licenses, for use with
the spell checker. See the text files in the "dict" folder of your Xara Web Designer 7
installation for details of each license. The Russian dictionary is Copyright (c) 1997-
2008, Alexander I. Lebedev. See README_ru_RU.txt in the “dict” folder of your
program installation for details and license.

All other trademarks or registered trademarks are the property of their respective
owners.
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